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Documentation Updates

The title page of this document contains the following identifying information:
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Support

Visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As 
a valued support customer, you can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract.  To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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Welcome to This Guide

This guide describes how to work with HP Business Availability Center 
Dashboard.

This chapter includes:

 ➤  How This Guide Is Organized on page 13

 ➤  Who Should Read This Guide on page 14

 ➤  Getting More Information on page 15

How This Guide Is Organized

The guide contains the following parts:

 Part I Dashboard

Describes how to work with Dashboard and the Dashboard views, how to 
use the Top View, Console, Filters, Geographical Map, and Custom Map tabs 
to display the view’s data.

 Part II Flow Maps

Describes how to use the Flow Map tab to display the flow maps of Business 
Process Insight CIs, TransactionVision CIs, or custom CIs. 

 Part III Reports

Describes how to view the Dashboard reports, and how to use the report 
repository. 
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 Part IV External Display

Describes how to display Dashboard data outside of Business Availability 
Center, using the Dashboard Ticker, in a Yahoo! Widget window, or on a 
mobile device.

 Part V KPIs

Describes how to manage the Key Performance Indicator (KPI)s (KPIs) of a 
configuration item (CI) (CI).

 Part VI KPI Assignments

Describes how to manage the factory and custom KPI assignments that are 
activated under certain conditions and add KPIs, rules, context menus, and 
context menu items to specific CIs.

 Part VII Repositories

Describes the KPI Repository, the Business Rule Repository, the Context 
Menu Repository, the Context Menu Item Repository, and the Tooltip 
Repository that enable you to manage the Key Performance Indicators 
(KPIs), business rules, context menus, context menu items, and tooltips 
available in Dashboard.

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center platform administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center data collector administrators

➤ HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.
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Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the HP Business Availability Center Deployment Guide PDF.
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1
Introducing Dashboard 

This chapter includes general information about Dashboard.

This chapter includes:

Concepts

 ➤  Dashboard Overview on page 20

 ➤  Dashboard Administration and Application on page 22

 ➤  How Dashboard Works on page 24

 ➤  Impact Modeling on page 25

 ➤  View Components on page 26

 ➤  CIs and Infrastructure Changes on page 29

 ➤  End User Monitors View and End User Locations View on page 30

 ➤  System Software Monitoring and System Hardware Monitoring Views 
on page 33

 ➤  Business Processes View for Business Process Insight on page 34

 ➤  Business Transactions View for TransactionVision on page 38

 ➤  Dashboard Application Components in the Service Report on page 42

 ➤  About Menu Options on page 42

 ➤  Dashboard General Notes and Tips on page 43

Tasks

 ➤  View Data in Dashboard – Workflow on page 44

 ➤  Customize the Way HP Business Availability Center Displays Views in 
Dashboard on page 49
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 ➤  Display Data in Dashboard on page 53

 ➤  Display a View Structure on page 56

 ➤  View Sample Details on page 57

 ➤  View a Business Impact Report on page 58

 ➤  View the SAR Compliancy Report on page 63

 ➤  Find Visible and Hidden Child CIs on page 64

 ➤  Set Up Sound Notification When KPI Status Changes to Critical on page 67

 ➤  Customize Dashboard Display and Refresh Rate on page 69

 ➤  Use the Troubleshooting Logs on page 71

Reference

 ➤  Dashboard User Interface on page 72

Troubleshooting and Limitations on page 99
Concepts

Dashboard Overview

Dashboard enables your team to monitor the health of business services and 
applications from the point of view of the consumers of those services—the 
business, its customers, and its partners.

This section includes the following topics:

➤ “Collecting and Aggregating Data” on page 21

➤ “Prioritizing IT Operations and Maximizing Business Results” on page 21
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Collecting and Aggregating Data
Dashboard uses data collected by HP Business Availability Center 
monitoring components, such as Business Process Monitor, SiteScope, and 
Enterprise Management Systems (EMS) integration tools, as well as data 
collected from external monitoring tools. HP Business Availability Center 
collects metrics about the end-user experience from a range of 
environments, including ERP, CRM, Web, and Citrix, and about the system 
performance from a range of back-end infrastructure components, including 
Web, application, database, and firewall servers.

The collected and aggregated data is used by the Dashboard Key 
Performance Indicator (KPI)s to provide quantifiable measurements that 
help you monitor how well your business is achieving objectives. The KPIs 
provide a real-time assessment of the present state of your business and 
processes, enable you to track critical performance variables over time, and 
help you assess the business impact of problems in the system.

At the top level, Dashboard provides an integrated view of critical 
applications and business processes; from there, you can drill down to the 
underlying IT infrastructure associated with these critical business processes. 
This drill-down view can be laid out in any number of ways, such as by data 
centers, by technology clusters, by geographical locations, and so on.

Prioritizing IT Operations and Maximizing Business 
Results
Dashboard helps you to prioritize IT operations and maximize business 
results by:

➤ Presenting global system component data organized into a logical and 
relevant framework.

➤ Providing integrated, scalable, cross-application views that reflect the health 
of mission-critical services and applications in real time. This enables IT 
operations teams to continuously manage the health of mission-critical 
services and applications from one central location.

➤ Providing a common view of how IT operations are meeting line-of-business 
goals. This enables better communication between the teams, and the 
alignment of management and IT operations around customer-centric 
values.
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➤ Providing the ability to assess actual customer impact, so that IT teams can 
prioritize response according to business impact and optimize resource 
utilization to meet critical business objectives. The end result is better 
quality of service for your end users.

➤ Providing a big-picture perspective, enabling you to see how a performance 
issue impacts the availability of any part of your business and to quantify 
the business impact of a potential failure.

➤ Providing operational-level service level management reporting. Dashboard 
uses Service Level Management data to provide an indication of whether an 
SLA is in breach of contract, or might be in breach in the near future.

Dashboard Administration and Application

Dashboard administration and application are accessed from two different 
areas of HP Business Availability Center.

This section includes the following topics:

➤ “Dashboard Administration” on page 22

➤ “Dashboard Application” on page 23

Dashboard Administration
To access the Dashboard Administration tabs, select Admin > Dashboard.

You use Dashboard Administration to enable you to:

➤ Edit the KPIs attached to a configuration item (CI), and to attach new KPIs 
to CIs in the KPIs tab. The KPIs you create are displayed in Dashboard to 
help the user monitor how well the business is achieving its objectives and 
assess the business impact of problems in the system. For details, see “KPIs 
Page” on page 409.

➤ Create a custom map to display real-time indicators icons representing CIs 
in the view on a custom image in the Custom Map tab. For details, see 
“Custom Map Page” on page 230.
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➤ Create an association between geographical locations and status indicators 
on a geographical map in the Geographical Map tab. For details, see 
“Geographical Map Page” on page 212.

➤ Configure a KPI assignment in the KPI Assignments tab. For details, see 
“Define Assignment Configuration Dialog Box” on page 452.

➤ Access the Dashboard Repository in the Repositories tab. The repository 
provide definitions for objects in the HP Business Availability Center 
system. Many of these definitions can be customized as required by your 
organization. For details, see “Repositories Overview” on page 475.

Dashboard Application
To access the Dashboard Application tabs, select Application > Dashboard.

You use the Dashboard application to:

➤ Display the components of the active view in a hierarchical, top-down 
graphic in the Top View tab. For details, see “Top View Page” on page 136.

➤ Display comprehensive data in one central location, regarding the CIs 
selected in View Explorer. For each CI, the Console page tabs provide 
information regarding the CI’s hierarchy, KPIs, business impact, alerts, and 
changes and incidents. For details, see “Console Page” on page 152.

➤ Display a filtered list of CIs, according to the selected filter option in the 
Filters tab. For details, see “Filters Page” on page 187.

➤ Display an association between geographical locations and status indicators 
in a geographical map in the Geographical Map tab. For details, see 
“Geographical Map Page” on page 212.

➤ Display icons representing CIs in the view on a custom image in the Custom 
Map tab. For details, see “Custom Map Page” on page 230.

➤ Display the flow map that corresponds to the selected Business Process 
Insight or TransactionVision CI in the Flow Map tab. For details, see 
“Introducing Flow Map” on page 237.

➤ Display the Dashboard reports: KPIs Distribution Over Time, KPIs Over 
Time, KPIs Summary, and KPIs Trend reports. For details, see “Reports User 
Interface” on page 269.
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How Dashboard Works

The physical and logical entities in your system, such as hardware, software, 
services, business processes, and so on, are represented in Dashboard by 
configuration item (CI)s. The CIs are stored in the HP Universal CMDB, and 
organized into hierarchical format based on the interdependencies in your 
organization’s IT environment. 

Each CI is assigned one or more KPIs showing current operational status or 
business impact over time by the assignment or propagation mechanism. 

The monitor CIs receive real performance metrics from the monitoring data 
collected by HP Business Availability Center monitoring tools, and KPI 
status for these CIs is calculated from that data. For more information, see 
“Statuses or Values” on page 28.

Status propagates up the CI hierarchy, from the monitor CIs, through parent 
(leaf) CIs, and up to the highest CI. For most parent CIs, KPI status is based 
on an aggregation of statuses for all child CIs defined by the propagation 
(the calculation method used for this aggregation varies, according to the 
KPI’s business logic). For details about the propagation, see “KPI Assignment 
Management Overview” on page 420.

You can view a subsection of the UCMDB CIs in service views in Dashboard. 
Each service view provides a different aspect of your organization’s IT 
universe, enabling you to focus on the IT area that is of interest.

The child CIs for a CI may not be visible in a view, but the KPI status shown 
is still based on the status propagated up from both visible and hidden child 
CIs.

The incoming data is updated every 30 seconds (configurable default value), 
so that the status information displayed in Dashboard represents the 
ongoing availability of your organization’s infrastructure components. 

This section contains the following topics:

➤ “Monitoring Performance Problems” on page 25

➤ “Monitoring Service Level Agreements” on page 25
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Monitoring Performance Problems
When a performance problem is identified, you can drill down to locate the 
source of the problem, view event reports, and track problem handling. You 
can also move directly to the appropriate pages in HP Business Availability 
Center to view reports for problematic components, measurement data over 
time, and general monitoring data.

Dashboard also enables you to view operational status from the viewpoint 
of geographical locations, so you can see which locations are impacted by 
problems. 

In addition, you can isolate and manage enterprise problems discovered in 
HP Business Availability Center, and identify likely suspects that are at the 
root of the problem using the Problem Isolation application.

Monitoring Service Level Agreements
Service Level Management enables you to track applications, infrastructure, 
and services according to the service contracts you have with internal or 
external customers.

In Dashboard, you can view an SLA information bar that gives you 
advanced warning of any potential breaches of contract, and you can act 
proactively to fix a problem before it causes financial damage. 

Impact Modeling

In Dashboard, views show the topology of the CIs that were selected in the 
UCMDB as being part of the view definition. The views also display the 
status of the KPIs of the view’s CIs. 

The status of a KPI is calculated at the monitor CI level and propagated at 
the group CI level. A KPI’s status is propagated from a child CI to a parent CI 
according to the propagation definition only when the parent CI and the 
child CI are linked by either an Impacted By (Directly) or an Impacted By 
(Potentially) calculated relationship. 

For more details about these types of relationships, see “Impact Modeling 
Overview” in Model Management.
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View Components

The CIs and relationships produced by the various CI-generating tools that 
operate within HP Business Availability Center, are stored in the 
configuration management database (CMDB). 

The service views displayed in Dashboard are built from CIs contained in 
the UCMDB. These CIs are mapped together to build views that meet your 
business requirements and objectives, and monitor what is important to 
you. (For a more detailed explanation of how views are built, see “Working 
with Views in IT Universe Manager” in Model Management.) 

This section includes the following topics:

➤ “Topology” on page 26

➤ “CIs in Views” on page 27

➤ “KPIs in Views” on page 27

Topology
Each view has a specific set of CIs and a topology that provides a hierarchy 
of CIs. For details, see “Display a View Structure” on page 56.

Each CI has only one instance in the CMDB. Different views can look at the 
same CI. 

The view displays the topology of the CIs, and the statuses of the different 
KPIs attached to the CIs. For details on how the KPI statuses are assigned to 
the CIs at the different levels of the topology, see “Impact Modeling” on 
page 25.

Details on specific views are provided in subject-related documentation; for 
example Real User Monitor views are detailed in “About Real User Monitor 
Views” in Using End User Management.

Note: The OMi-related views only appear if you are using HP Operations 
Manager i. For details, see Using HP Operations Manager i.
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CIs in Views
The CIs at the lowest level of the hierarchy represent the monitor CIs, such 
as SiteScope monitors, Business Process Monitor transactions, or metrics 
from other external monitoring sources. The upper levels of the hierarchy 
represent logical groups. CI names are either taken from the external source, 
or are defined by the administrator as part of the CI properties.

The views may also contain dynamic hierarchies generated by the Dynamic 
Node Factory definition file. These hierarchies are created in the CMDB at 
runtime, based on the incoming samples. The parent for a dynamic 
hierarchy is a Dynamic Node Factory CI. Note that the CIs under the 
Dynamic Node Factory parent do not generally have option menus. For 
more information on dynamic hierarchies, see “IT Universe Manager – 
Dynamic Node Factory” in Model Management.

Note: The OMi-related views only appear if you are using HP Operations 
Manager i. For details, see Using HP Operations Manager i.

KPIs in Views
Factory KPIs and factory business rules that can be associated with the KPIs 
are provided in the Repositories. Those KPIs and business rules can be 
combined in assignments and propagations. The factory KPIs and business 
rules can be customized. For details about the repositories, see “Repositories 
Overview” on page 475.

KPIs and business rules are assigned, using the KPI assignment mechanism, 
to monitor CIs. KPIs and business rules are propagated, using the KPI 
propagation mechanism, up the CI’s hierarchy in the view. For details about 
the KPI assignment and propagation, see “KPI Assignment Management 
Overview” on page 420.

You can also manually assign additional KPIs to CIs in Dashboard 
Administration. For details, see “Add KPI to Multiple CIs/Edit KPI/Edit KPI 
for Child Transaction Dialog Box” on page 397.
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For each CI in a view, one or more KPI columns are displayed. For example, 
Availability, System, Performance, and so on. For a list of the KPIs used in 
Dashboard, see “List of Dashboard KPIs” on page 512.

For each CI, each KPI column contains status icons or values, representing 
how the KPI objective is met. For details on KPI status, see “KPI Status” on 
page 355.

In the case of data coming from the Business Process Monitor, the KPIs and 
business rules assigned to the CIs are defined in the Business Process 
Monitoring source adapter. For more information, see “Business Process 
Monitoring Source Adapter Details” in Model Management.

Note: The OMi-related KPIs and business rules only appear if you are using 
HP Operations Manager i. For details, see Using HP Operations Manager i.

Statuses or Values

The status or value information displayed in Dashboard views is real-time 
data calculated by the online Business Logic Engine (using the business rules 
associated with the KPI). The Business Logic Engine takes data directly from 
the samples sent by the monitors in the bus.

The status or value information is propagated from the monitoring CIs to 
the higher levels of the CI hierarchy in the view using specific mechanisms.

The monitoring views (for example End-User Monitors view) display the 
created CI hierarchies for the monitored sources. When data is received over 
the Bus for a monitor, you can open the monitoring view in Dashboard and 
view status information for the CIs. You can use the CI hierarchies created in 
the predefined monitoring views as the building blocks for defining your 
own customized views. For more information, see “Working with Views in 
IT Universe Manager” in Model Management. 
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CIs and Infrastructure Changes

When changes are made to your organization’s infrastructure, they are 
detected by the discovery process or by monitors monitoring external 
sources. Dashboard checks the engine every 60 seconds (default setting), for 
configuration changes received from the external sources. The structure and 
content of the CI hierarchies are then automatically updated and deployed 
to the Dashboard application. Some settings of the source adapters may 
affect the hierarchy of the view; for example, Transactions/locations in the 
Business Process Monitor source adapter. For more information, see 
“Business Process Monitoring Source Adapter Details” in Model Management.

In addition, changes made within HP Business Availability Center, by 
changing the profiles in End User Management Administration or manually 
updating CIs in CMDB Administration, are also automatically deployed to 
Dashboard.

For details on where to see the changes, see “Monitoring Changes in 
Dashboard Overview” on page 111.
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End User Monitors View and End User Locations View

The End User Monitors View and End User Location View display the data 
for the monitor CIs corresponding to Business Process Monitor transactions, 
or metrics from other external monitoring sources, and for the logical group 
CIs. The End User Monitors View and End User Location View display the 
data for the monitor CIs corresponding to SiteScope monitors, Business 
Process Monitor transactions, or metrics from other external monitoring 
sources, and for the logical group CIs.

➤ End User Locations View. The End User Locations View TQL is as follows:

If you select the Regular hierarchy structure, the view displays only the 
Business Process Group CIs. For details about the Regular structure, see 
Hierarchy Structure in “New/Edit Source Adapter Dialog Box” in Model 
Management.
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If you select the Transaction/Location hierarchy structure, the view displays 
the following CIs. For details about the Transaction/Location structure, see 
Hierarchy Structure in “New/Edit Source Adapter Dialog Box” in Model 
Management.

The End User Locations View provides relevant information (apart from a 
list of Business Process Group CIs) only if you select the 
Transaction/Location hierarchy structure.
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➤ End User Monitors View. The End User Monitors View TQL is as follows:
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If you select the Regular hierarchy structure, the End User Monitors View 
displays the following hierarchy.

Note that the Business Process Transaction from Location CIs do not display 
the location information.

If you select the Transaction/Location hierarchy structure, the view displays 
the following CIs:

The Business Process Transaction from Location CIs display location 
information.

System Software Monitoring and System Hardware 
Monitoring Views

The System Software Monitoring view displays the applications connected 
to the system monitors and to the SiteScope measurements.
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The System Hardware Monitoring displays the hardware elements (for 
example, the host machines) connected to the system monitors and the 
SiteScope measurements.

Business Processes View for Business Process Insight

Business Process Insight data collectors send data and topology to Business 
Availability Center. The topology and data are about the business process 
flows and business process steps that you monitor to obtain meaningful 
impact data about the health of your business. For more information on 
defining business processes in Business Process Insight, see Reference 
Information for Business Process Insight.

The HP Business Availability Center templates for Business Process Insight 
create the processes topology in the CMDB using the Universal CMDB API. 
The topology includes group CIs and monitor CIs for the monitored 
Business Process Insight system. 
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In HP Business Availability Center, the Business Processes view has the 
following topology:

This section includes the following topics:

➤ “Business Process Insight CIs” on page 35

➤ “HP Business Process Insight KPI Assignment Group” on page 36

➤ “Access HP Business Process Insight Application” on page 36

➤ “Drill Down to HP Business Process Insight-Related Reports” on page 36

➤ “Topology for Business Process Insight” on page 37

➤ “KPI Assignments for Business Process Insight” on page 38

Business Process Insight CIs
The CIs are as follows:

➤ The Business Process CI represents the Business Process flow in Business 
Process Insight. 

➤ The BPI Business Process Monitor CI is a child of the Business Process CI. It 
represents the Business Process Insight business process. 

➤ The Business Process Insight Step CI represents an activity (a step) in the 
Business Process flow in Business Process Insight. The Business Process 
Insight Step CI is a child of the Business Process CI. 
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➤ The BPI Business Process Step Monitor CI monitors the corresponding 
activity in the Business Process flow in Business Process Insight.

➤ The BPI Monitor CI monitors as defined by the BPI monitor definer. At the 
same time as each new monitor definition is created in the BPI database 
tables, a BPI Monitor CI is created in the UCMDB. The BPI Monitor CI stores 
the Monitor Name, Description, Type, Units, Collection Interval, Threshold 
Operator, Server Name and Instance Threshold limits (where specified) as 
defined in Business Process Insight.

For details, see "Configuration Items Stored in the UCMDB" in Using Business 
Process Insight.

HP Business Process Insight KPI Assignment Group
In Dashboard, the HP Business Process Insight KPI assignments group adds 
KPIs, rules, context menus, context menu items, and tooltips to those CIs.  
Status for these CIs can be viewed in Dashboard in the Business Processes 
view. 

Note: Service Level Management has its own sets of KPIs and rules that are 
attached to CIs within agreements.

Access HP Business Process Insight Application
You can access the Business Process Insight application using a context 
menu option in the Business Availability Center application. For details, see 
“Menu Options” on page 75.

Drill Down to HP Business Process Insight-Related Reports
You can drill down to Business Process Insight-related reports using context 
menu options in the Business Availability Center application. For details, see 
“Menu Options” on page 75.
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Topology for Business Process Insight
All the sample information sent by Business Process Insight data collectors is 
displayed by the Backlog, Volume, Business Impact, Value, and Duration 
KPIs attached to the BPI Monitor, BPI Business Process Step Monitor, 
Business Process Insight Step, BPI Business Process Monitor, BPI Value 
Monitor, BPI Duration Monitor, and BPI Custom Value Monitor CIs and 
propagated to the Business Process CI. To display BPI Value Monitor or BPI 
Duration Monitor CIs, you must define a value or a duration monitor in the 
BPI Monitor Definer.

In addition, the Business Process CI is assigned the Business Health and 
Operational Status KPIs. The rules listed in the table below calculate the 
statuses of those KPIs based on data obtained from Business Process Insight 
samples.

Note: The Business Health KPI in version 7.50 was renamed Business Impact 
in version 8.0. A new Business Health KPI has been added to the topology.

The Business Process Insight Menu, and the Business Process Monitor 
Group Menu context menus, Go to BPI context menu item, and the tooltips 
corresponding to the rules listed in the table below, are preconfigured to 
provide the appropriate infrastructure to work with the Business Process 
Insight-related CIs in Dashboard. For details about the KPIs, rules, context 
menus, context menu items, and tooltips, see “Repositories – Overview” on 
page 476.

In Dashboard, the KPIs that are preconfigured to work with Business Process 
Insight are:

➤ “Backlog” on page 514 

➤ “Business Health” on page 515

➤ “Business Impact” on page 516

➤ “Duration” on page 518 

➤ “Value” on page 533 

➤ “Volume” on page 535
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Descriptions of the KPIs, and lists of which rules are relevant for each KPI, 
can be found in “List of Dashboard KPIs” on page 512.

Note: The KPIs listed in the table use special icons in Top View in 
Dashboard. For details, see “KPI Icons in Top View” on page 140.

KPI Assignments for Business Process Insight
The KPI assignments for Business Process Insight when working in 
Dashboard are different from the KPI assignments for Business Process 
Insight when working with Service Level Management.

Business Transactions View for TransactionVision

In the Business Availability Center Dashboard tabs, you can use the Business 
Transactions view to monitor the real-time performance and health of your 
business transactions. For information on setting up business transactions, 
see “Introducing TransactionVision” in Using TransactionVision.

The business transaction KPIs in the view reflect the data received in the 
latest sample (there is no aggregation of the sample data in Dashboard). For 
example, if a KPI has a value of $2000, this value is only for the data 
received in the last sample, the value from the previous sample was not 
added to it. For information on the KPIs used for the TransactionVision data, 
and how to see status for the KPIs, see “KPIs and Rules for TransactionVision 
Data” on page 41.

This section includes the following topics:

➤ “Mapping End User Transactions to Business Transactions” on page 39

➤ “KPIs and Rules for TransactionVision Data” on page 41
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Mapping End User Transactions to Business Transactions
The Business Transactions view provides status information for back-end 
monitoring from TransactionVision, including CIs representing business 
transactions, and CIs representing the infrastructure elements that the 
business transactions are dependant on, as discovered by the 
TransactionVision sensors. For more information on the creation of the 
infrastructure CIs, see “CMDB Population Job” in Using TransactionVision.

You can add the end-user perspective by mapping end-user transactions 
from Business Process Monitor and Real User Monitor to the business 
transactions. As a result of this mapping, the following information is 
available in Dashboard:

➤ the branch for a Business Transaction CI includes KPI status information 
from the end-user perspective.

➤ the Flow Map page displays the Transaction Topology Flow Map for a 
transaction, including worst status Application and Performance 
measurements for the Web Clients component. For details, see “Transaction 
Topology Flow Map” in Using TransactionVision.

You set up the mapping in End User Management Administration, when 
defining Business Process profile and Real User Monitor transactions, or 
while editing existing transactions. Each transaction can be mapped to only 
one Business Transaction CI (but multiple Business Process Monitor and 
Real User Monitor transactions can be mapped to a single Business 
Transaction CI). For details, see “Map End-User Transactions to 
TransactionVision Business Transactions” in Using End User Management.

See the following pages for information on where you perform the mapping:

➤ For mapping Business Process Monitor transactions while creating new 
Business Process profiles or adding new transaction monitors to profiles, see 
“Set Transaction Properties Page” in Using End User Management.

➤ For mapping existing transactions in a Business Process profile, see “Edit 
Transaction Page” in the Business Process Monitor section of Using End User 
Management.
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➤ For mapping new and existing Real User Monitor transactions, see 
“New/Edit Transaction Page” in the Real User Monitor section of Using End 
User Management.

A task flow for performing the mapping is provided in “Map End-User 
Transactions to TransactionVision Business Transactions” in Using End User 
Management.

The following picture shows part of the Business Transactions view in the 
Dashboard Top View page. The Business Transaction CI Bond has attached 
TV Monitor CI (Bond monitor), BPM Transaction from Location CI 
(BpmTradeBond), and J2EE Application CI (TradeDemo) with its underlying 
infrastructure element CIs.
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KPIs and Rules for TransactionVision Data
There are seven KPIs that are used for TransactionVision data in Dashboard:

➤ “Backlog” on page 515

➤ “Delays” on page 517

➤ “Duration” on page 518

➤ “Exceptions” on page 519

➤ “Failures” on page 520

➤ “Value” on page 534

➤ “Volume” on page 536

Descriptions of the KPIs, and lists of which rules are relevant for each KPI, 
can be found in “List of Dashboard KPIs” on page 512.

The KPIs and rules used by the TransactionVision data CIs in Dashboard are 
automatically assigned by the KPI Assignments mechanism, as described in 
“Edit Group Page” on page 469. Backlog, Delays, and Volume KPIs are 
always assigned by default to the Business Transaction and TV Monitor CIs; 
the Exceptions, Failures, and Value KPIs are each assigned by default, only if 
the corresponding attribute rule is defined for the business transaction in 
TransactionVision. (You can see which attribute rules are defined in the 
Properties page for the TV Monitor CI. For more information, see 
“TransactionVision Data in Business Availability Center” in Using 
TransactionVision.)

The Duration KPI must be manually assigned to the CIs.

The rules for the TV Monitor CI are all sample-based, and by default 
recalculate data for each new sample.

The Business Transaction CIs by default use the Business Transaction Group 
Rule for each business transaction KPI. This rule assigns value and status to 
the KPI by taking the value and status directly from the KPI for the child TV 
Monitor CI.
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The business transaction KPIs do not include predefined objective 
thresholds. (The objective thresholds are used to assign a status to the KPI, 
based on the KPI value.) As each business transaction represents an 
individual business event, with individual business objectives, you need to 
set appropriate objective thresholds for each business transaction KPI, so 
that it displays a meaningful status. Until objective thresholds are defined, 
the KPI displays data with Info (blue) status in Dashboard.

You can edit the default KPIs and rules assigned to the CIs, and define 
objective thresholds for each KPI, in the Admin > Dashboard > KPIs tab.

Dashboard Application Components in the Service 
Report 

You can build Service Reports based on data from data sources from the 
Dashboard application. You can add Service Reports as portlets in My BSM 
or in Report Manager. After you have added Service Reports to the Report 
Manager, you can add the reports as custom report components to benefit 
from all the custom report capabilities. For details, see “Service Report 
Overview” or “Report Manager Overview” in Reports.

About Menu Options

From the Top View, Console Hierarchy, and Filters tabs in Dashboard and 
from View Explorer in other tabs, you can access context menu options. 

You access menu options by right-clicking a CI in View Explorer or by 
clicking the grey arrow button to the right of the CI in Top View, Console 
Hierarchy, and Filters tabs.

Depending on the selected view and selected CI, you can, among other 
possibilities, drill down to other HP Business Availability Center 
applications or to SiteScope, or open standalone reports or views. For 
example, you can view a trend report on the End User Management page, 
including measurement data for the CI over a specified time period.

The menu options that are displayed depend on the selected view and the 
selected CI. They can be a subset of the available options. 
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For details on the options, see “Menu Options” on page 75.

For advanced information on the various menu options, see “Context Menu 
Repository” on page 697.

Dashboard General Notes and Tips

Note the following when working with Dashboard:

➤ It is recommended that you use Microsoft Internet Explorer as your browser 
when using the Dashboard application.

➤ User access to Dashboard views is limited by the viewing permissions 
specified for the user. If you cannot see a view, contact your administrator. 
For details, see “Permissions Overview” in Platform Administration.

➤ The first time you access Dashboard, you may experience a short delay while 
Dashboard compiles the page.

➤ Dashboard uses the timestamp of the database machine hosting the 
HP Business Availability Center database. The times displayed in the tooltips 
reflect the time zone setting on that computer. If you customize the time 
zone setting in HP Business Availability Center using the Admin > Personal 
Settings > General Settings option, then the customized time zone is also 
used in Dashboard.

➤ When Dashboard does not receive data for a Business Process profile because 
a Business Process Monitor is stopped (while the profile itself is not 
stopped), this is not specifically indicated in the tooltip. In this case, after a 
while the tooltip Status parameter displays Not up to date, and the Warning 
parameter displays the number of seconds during which no data has arrived.

Tasks
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View Data in Dashboard – Workflow

To display data in views specific to your organization, create SiteScope 
monitors, Business Process and Real User Monitor monitors and run 
Discovery and Dependency Mapping on your system. The discovery process 
populates the CMDB. HP Business Availability Center collects data about 
end-users, business processes, and systems, and displays the data in 
topologies (views) relevant to your organization. Views display system 
performance data about your network and applications.

The flowchart describes how to view data in Dashboard. 
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This section describes the processes to follow to view data in Dashboard.

This task includes the following steps:

➤ “Prepare the Monitors” on page 45

➤ “Analyze Data on the Dashboard Bus” on page 47

➤ “Check Factory KPIs, Rules, Context Menus, Context Menu Items, Tooltips, 
CIs and Views” on page 47

➤ “Create Views” on page 48

➤ “Customize Dashboard Display” on page 48

➤ “Customize the Views in Dashboard” on page 48

➤ “Access External Applications from Dashboard” on page 48

➤ “Results – Display Data in Dashboard” on page 48

 1 Prepare the Monitors
To import data into HP Business Availability Center you must set up 
monitors as follows:

 a Create SiteScope Monitors. Create SiteScope Monitors to collect network 
and system data about your system for use in HP Business Availability 
Center. SiteScope monitors information is displayed in System views. For 
details, see “Configure SiteScope for Monitoring – Workflow” in Using 
System Availability Management.

 b Create Business Process and Real User Monitor Profiles and Monitors. 
Create Business Process and Real User Monitor profiles and monitors to 
collect performance data for HP Business Availability Center. Business 
Process and Real User Monitor monitors information is displayed in End-
User Monitor views. For details, see “General and Administration” in 
Using End User Management.
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Note: You can map Business Process Monitor and Real User Monitor 
transactions in End User Management Administration, to business 
transactions from TransactionVision. For details, see “Map End-User 
Transactions to TransactionVision Business Transactions” in Using End 
User Management.

 c Configure Diagnostics Servers and Probes to Monitor Your Applications. 
Configure the servers and probes that are going to be used by Diagnostics 
to monitor your applications. For details, see HP Diagnostics Installation 
and Configuration Guide.

You must also specify the Diagnostics server details in Admin > 
Diagnostics. For details, see “HP Diagnostics and HP Business Availability 
Center Integration” in Solutions and Integrations.

 d Customize KPI Assignments – Optional. You can customize the 
appropriate KPI assignment rules. KPI assignment rules are designed to 
automatically assign to a specified CI, the appropriate KPIs, rules, and 
context menus when a specified condition occurs. The condition is 
usually when one of the CI’s attributes has a specified value in the sample 
that is sent to HP Business Availability Center. For details on customizing 
KPI assignments, see “Manage KPI Assignment Groups” in Using 
Dashboard.

If required, you can customize the SiteScope KPI Assignments. For details, 
see “Work with the SiteScope Assignment Group” in Using Dashboard.

 e Customize the Source Adapters. If required, customize the Business 
Process Monitor, or Real User Monitor source adapters. For details, see 
“Configure a Source Adapter – Workflow” in Model Management.

 f Run Discovery and Dependency Mapping. Collect information about 
your system by running Discovery and Dependency Mapping to enable 
you to discover the IT infrastructure resources and their 
interdependencies, such as applications, databases, network devices, 
servers, and so on. Each discovered IT resource is delivered to, and stored 
in, the configuration management database (CMDB) where the resource 
is represented as a managed configuration items (CIs). 
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Discovery is an ongoing, automatic process that continuously detects 
changes that occur in the IT infrastructure and updates the CMDB 
accordingly. You do not need to install any agents on the devices to be 
discovered. Discovery and Dependency Mapping processes have 
corresponding views that are automatically correlated with the CIs 
discovered during discovery and displayed in views. For details, see 
“Discovery and Dependency Mapping Content – Overview” in Discovery 
and Dependency Mapping Guide.

 2 Analyze Data on the Dashboard Bus
To view and analyze the data on the bus, check the log file.

The log file contains the samples that are currently on the HP Business 
Availability Center bus with real data. You can use the data to properly set 
up selectors for Dashboard KPIs. For details, see “KPIs in Views” on page 27.

For details about the samples and their fields, see “Data Samples” in 
Reference Information.

 3 Check Factory KPIs, Rules, Context Menus, Context Menu 
Items, Tooltips, CIs and Views
Check the factory components to make sure the data and the hierarchy you 
see in the views is what you want. For details about the factory KPIs, rules, 
context menus, context menu items, and tooltips, see “Repositories” on 
page 473.

To check the factory CIs, select Admin > Universal CMDB > Modeling > CI 
Type Manager.

To check the factory views, select Admin > Universal CMDB > Modeling > 
View Manager.
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 4 Create Views
The IT Universe model in the CMDB can be very large, holding thousands of 
configuration items (CIs). A view enables you to build a subset of the overall 
IT Universe model, containing only those CIs relating to a specific area of 
interest. Some views are automatically created when you use standard 
SiteScope, Business Process and Real User Monitor profiles and monitors. 
You can also define your own pattern, perspective, or template-based views 
to display only the information that is relevant to your organization’s 
business needs. For details, see “Create a Template Based View” in Model 
Management.

 5 Customize Dashboard Display
You can customize some aspects of the Dashboard display and the refresh 
rate of the display. For details, see “Customize Dashboard Display and 
Refresh Rate” on page 69.

 6 Customize the Views in Dashboard
You can customize the views themselves. You can set up geographical maps 
and custom maps. You can customize the display of the view in the other 
Dashboard tabs. For details on customizing the views in Dashboard, see 
“Customize the Way HP Business Availability Center Displays Views in 
Dashboard” on page 49.

 7 Access External Applications from Dashboard
To access external applications from Dashboard, create a Dynamic URL 
context menu option. For details, see “Create a Dynamic URL – Scenario” on 
page 495.

 8 Results – Display Data in Dashboard
Use views, Dashboard tabs, and other capabilities to display data in 
Dashboard. For details, see “Display Data in Dashboard” on page 53.
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Customize the Way HP Business Availability Center 
Displays Views in Dashboard

You can customize the way HP Business Availability Center displays views in 
Dashboard. 

The flowchart describes the process of customizing the way a view is 
displayed in Dashboard to reflect your organizational requirements. 

This task includes the following steps:

➤ “Set Your Views in CMDB For Display in Dashboard” on page 50

➤ “Modify KPI Defaults in Dashboard Administration – Optional” on page 50
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➤ “Specify the Time Format Used in a CI Last Status Update Time – Optional” 
on page 51

➤ “Define a Custom Map in Dashboard Administration – Optional” on 
page 51

➤ “Configure Geographical Map in Dashboard Administration – Optional” on 
page 52

➤ “Acknowledge Performance Problems” on page 52

➤ “Display Data in Dashboard” on page 52

➤ “Customize Dashboard Tabs – Optional” on page 52

 1 Set Your Views in CMDB For Display in Dashboard
HP Business Availability Center provides several default views. If required, 
you can create custom views (pattern, perspective, or template views) in 
CMDB Administration. 

For details on pattern, perspective, or template views, see “Create a Template 
Based View” in Model Management.

 2 Modify KPI Defaults in Dashboard Administration – Optional
Monitor CIs associated with default sources generally have default KPIs. For 
example, Business Process Monitor, Real User Monitor, and SiteScope 
monitor CIs that you configure in End User Management Administration or 
System Availability Management Administration, all have default KPIs.

Note that CIs with default KPIs that are placed under other CIs in a view 
generally propagate their KPIs upward to the parent CIs.

You can:

➤ Change the default business rule assigned to a KPI.

➤ Change the properties of the default business rule. 

➤ Modify or delete a KPI associated with a higher level CI in a view if the KPI 
has the following characteristics:

➤ It originates from a lower level CI.

➤ It was propagated upward.
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➤ It is not appropriate for the higher lever CI (for example, if you want to 
only see performance and not availability). 

➤ Add a new KPI to a higher level CI. Proceed as follows: select Admin > 
Dashboard, select a view, and click the KPIs tab. For details, see “KPIs Page” 
on page 409.

➤ Save historical data for a KPI if you want to see the associated data in the KPI 
over Time report. For details, see “Persistent Data and Historical Data” on 
page 366.

 3 Specify the Time Format Used in a CI Last Status Update Time – 
Optional
You can modify the default time format (am/pm hh:mm:ss) used in a CI Last 
Status Update Time. A CI Last Status Update Time information is usually 
displayed in tooltips. The time format is specified using a key. The key is 
translated into a localized format in the LocaleDate_<locale>.properties file.

To modify the time format, select a valid key from
<Gateway server root directory>\AppServer\resources\
LocalDate_<locale>.properties, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the selected key in the Time Format Key 
of CI Last Status Update Time entry in the Dashboard Application - Filtering 
Properties table. 

 4 Define a Custom Map in Dashboard Administration – Optional
You can add status indicators to a custom image. The status indicators 
display the real time status for specified CIs. Each status indicator displays 
the worst status from all KPIs associated with that CI. For example, if you 
place on the image a status indicator for a Line of Business CI, the status 
indicator displays the worst status of all KPIs associated with the Line of 
Business CI.

The custom image can be useful for representing data centers, geographical 
distribution of IT resources, and so on. To add a custom image, select Admin 
> Dashboard, select a view, and click the Custom Map tab. For details on 
creating a custom map, see “Display a View in a Custom Map” on page 225.
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 5 Configure Geographical Map in Dashboard Administration – 
Optional
You can specify a geographical location in the location parameters for a CI 
in CMDB Administration. To define geographical locations for CIs, select 
Admin > Universal CMDB > Modeling > It Universe Manager. Select a CI in 
View Explorer. In the Information Pane, select the Properties tab and click 
Edit.

Those status indicators automatically appear, at the defined location, on the 
geographical map corresponding to views that include those CIs. When 
there are multiple CIs with the same defined location, one status indicator is 
displayed for the location, showing the worst status for all KPIs associated 
with all CIs at that location.

You can zoom and center the geographical map to focus on the parts of the 
map relevant to the associated view. To zoom and center the geographical 
map, select Admin > Dashboard, select a view, and click the Geographical 
Map tab. For details, see “Display and Customize a View in Geographical 
Map” on page 200.

 6 Customize Dashboard Tabs – Optional
You can customize the way the Dashboard tabs display the data. For details, 
see each tab description. For a list of the tabs and links to their descriptions, 
see “Dashboard Administration and Application” on page 22.

 7 Acknowledge Performance Problems
For details, see “Acknowledge Performance Problems” on page 102.

 8 Display Data in Dashboard
You can use views, Dashboard tabs, and other capabilities to display data in 
Dashboard. For details, see “Display Data in Dashboard” on page 53.



Chapter 1 • Introducing Dashboard

53

Display Data in Dashboard

You can display different aspects of the data obtained from different profiles 
and monitors using views, Dashboard tabs, and other capabilities. 

Each step is optional. You can perform the steps in any order.

This task includes the following steps:

➤ “Display the Components of the Active View in the Console page” on 
page 53

➤ “Display a Filtered List of CIs, According to the Selected Filter Option” on 
page 54

➤ “Display an Association Between Geographical Locations and Status 
Indicators Using a Maps Applet” on page 54

➤ “Display Icons Representing the View’s CIs on a Custom Image” on page 54

➤ “View the Dashboard Reports” on page 55

➤ “Display Sample Details” on page 55

➤ “Display Real-time Change Information” on page 55

➤ “Find Visible and Hidden Children CIs in a Specific View” on page 55

 1 Display the Components of the Active View in the Console page
To display the components of the active view:

➤ In a Hierarchical, Top-down Graphic, select Applications > Dashboard > Top 
View. For details, see “Display and Customize View Information in Top 
View” on page 121.

➤ Arranged in a Hierarchical Tree, select Applications > Dashboard > Console > 
Hierarchy. For details, see “Hierarchy Tab” on page 157.
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You can also:

➤ Display KPI Over Time Status and Federated KPI Values for CIs in the Active 
View. Select Applications > Dashboard > Console > KPIs. For details, see 
“KPIs Tab” on page 159.

➤ Display Business CIs and SLAs Impacted by CIs in the Active View. Select 
Applications > Dashboard > Console > Business Impact. For details, see 
“Business Impact Tab” on page 161.

➤ Display CI Status Alerts Triggered by CIs in the Active View. Select 
Applications > Dashboard > Console > Alerts. For details, see “Alerts Tab” on 
page 164.

➤ Display Planned Changes and Actual Changes Made to CIs, and Incidents 
Opened for CIs. Select Applications > Dashboard > Console > Changes and 
Incidents. For details, see “Changes and Incidents Tab” on page 165.

 2 Display a Filtered List of CIs, According to the Selected Filter 
Option
Select Applications > Dashboard > Filters. For details, see “Display and 
Customize a View Information in Filters” on page 173.

 3 Display an Association Between Geographical Locations and 
Status Indicators Using a Maps Applet
Select Applications > Dashboard > Geographical Map. For details, see 
“Display and Customize a View in Geographical Map” on page 200.

 4 Display Icons Representing the View’s CIs on a Custom Image
Select Applications > Dashboard > Custom Map. For details, see “Display a 
View in a Custom Map” on page 225.
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 5 View the Dashboard Reports
Select Applications > Dashboard > Reports, and select one of the following 
reports: KPIs Distribution Over Time, KPIs Over Time, KPIs Summary, and 
KPIs Trend reports. For details, see “Reports User Interface” on page 269.

 6 Display Sample Details
For details, see “View Sample Details” on page 57.

 7 Display Real-time Change Information
For details, see “Analyze Real-Time Change Information” on page 112.

 8 Find Visible and Hidden Children CIs in a Specific View
For details, see “Find Visible and Hidden Child CIs” on page 64.
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Display a View Structure

To display the components and the topology of a view, select Admin > 
Universal CMDB > Modeling > View Manager, select the view in the tree to 
display the view structure in the central pane.

Example

To display the components and topology of the End User Monitors View, 
select Admin > Universal CMDB > Modeling > View Manager, expand 
Monitors in the tree, and select the End User Monitors View in the tree. The 
view is as follows:
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View Sample Details

If required, you can set up Dashboard to provide data from the last sample 
that arrived for a monitor CI. This data is viewed in the Event Details dialog 
box for the CI. The Event Details dialog box displays all of the parameters 
for the CI, and provides the values of the parameters at the last update. 

This task includes the following steps:

➤ “Set Up to Display Last Sample Details in Dashboard” on page 57

➤ “Display the Last Sample Information” on page 57

 1 Set Up to Display Last Sample Details in Dashboard
You can set up an individual rule attached to a KPI or all rules to save the 
last sample details in memory. For details, see “Set Up Rules to Display the 
Last Sample Details” on page 578.

 2 Display the Last Sample Information
Click the Console or Filters tabs in Dashboard, and click the status icon for a 
monitor CI to open the Event Details dialog box. (If there is an associated 
Event Details dialog box for a CI, then the cursor changes to a hand when 
you hold the cursor over the status icon for the CI.) 

For details, see “Event Details Page” on page 407. 
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View a Business Impact Report

The Business Impact report displays information about how a CI impacts 
the Business Services it belongs to. Data about the affected Business Service, 
Application, and Business Process CIs includes KPI data, over-time data, and 
SLA data. For example, if a host CI has critical status, you can use the report 
to display the status of the Business Service CIs to which the host CI is 
attached.

This task includes the following steps:

➤ “Access the Business Impact Report for a CI” on page 59

➤ “Modify the Default KPIs and Rules Used to Display Data in Business 
Impact” on page 60

➤ “Send a Business Impact Report URL Using Direct Login” on page 61

➤ “Send a Business Impact Report URL With the Login Page” on page 62
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 1 Access the Business Impact Report for a CI
To view the Business Impact report for a CI, right-click the CI and select the 
Show Business Impact option. For details, see “Business Impact Report” on 
page 95.

Example

The following Business Impact report lists the Business Service CIs impacted 
by the DefaultDlient_SanityPBPM_1 CI. It also indicates, in the Business 
Details area, the status of the KPIs, the current and forecasting statuses of 
the SLAs that include the Business CI selected in the Business CIs Summary 
table. 



Chapter 1 • Introducing Dashboard

60

 2 Modify the Default KPIs and Rules Used to Display Data in 
Business Impact
The system derives the parameters needed to get the data displayed in 
Business Impact from default KPIs and rules. For example, from the Number 
of Open Incidents Rule the system derives the state and severity of tickets to 
be counted in the over time number of open incidents. 

If you change the KPI or rule to be used in the Business Impact report, you 
must configure the new KPI ID in Infrastructure Settings.

To modify the settings, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and locate the relevant entries in the Dashboard Application - Business 
Impact table. Modify the value of the following parameters:

➤ Number of Open Incidents KPI. Sets the ID number of the KPI that defines 
open incidents in the report. The default is 2600 for the Open Incidents KPI.

➤ Number of Open Incidents Rule. Sets the ID number of the rule that defines 
open incidents in the report. The default is 2600 for the Open Incidents 
rule.
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 3 Send a Business Impact Report URL Using Direct Login
You can send a Business Impact report to a recipient using one of the 
following options:

➤ An XML file containing all the relevant data for generating the report in any 
application. The information included in the report can then be used by 
another application, like Change Control Management or HP operation 
applications (Network Node Manager, Service Desk, and so on). 

Use the following URL:
http://<server_name>/<HP_BAC_web_application_context_name (usually 
topaz)>/TopazSiteServlet?createSession=true
&requestType=login&directLogin=true&directLoginEncrypted=true
&userlogin=<user_name>&userpassword=<password>
&applicationId=bam&customerId=<customer_id>
&portlet_url=/service-impact/main/xml.do?ciId=<CI_id> 

➤ A URL that accesses the HTML report. 

Use the following URL:
http://<server_name>/<HP_BAC_web_application_context_name (usually 
topaz)>/TopazSiteServlet?createSession=true
&requestType=login&directLogin=true&directLoginEncrypted=true
&userlogin=<user_name>&userpassword=<password>
&applicationId=bam&customerId=<customer_id>
&portlet_url=/service-impact/main/page.do?ciId=<CI_id> 

The following parameters are used in the URLs:

➤ <user_name> and <password> are the HP Business Availability Center 
user name and password and must be encrypted according to what 
HP Business Availability Center is using.

➤ <customer_id> is the code of the customer. 

➤ <CI_id> is the internal number of the CI. Select Admin > Universal CMDB 
> Modeling > IT Universe, select the CI in the tree. The internal number 
of the CI appears in the ID box in the Properties tab in the Information 
pane.
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 4 Send a Business Impact Report URL With the Login Page

Note to HP Software-as-a-Service: Sending a Business Impact report URL 
with the login page is not supported.

You can send a Business Impact report to a recipient using the following 
options:

➤ An XML file containing all the relevant data for generating the report in any 
application. The information included in the report can then be used by 
another application, like Change Control Management or HP operation 
applications (Network Node Manager, Service Desk, and so on). 

Use the following URL, to display the login page: 
http://<server_name>/<HP_BAC_web_application_context_name (usually 
topaz)>/login.jsp?portlet_url=/service-impact/main/xml.do?ciId=<CI_id>

The URL displays the login page and, after you enter the user name and 
password information, opens the report.

➤ A URL that accesses the HTML report, included in an alert notification. For 
example, if an alert assigned to a host CI is triggered and the alert includes 
the URL of the Business Impact report for the host CI, the user can view 
information about the impact of the host CI on the Business Service CI. For 
details, see “Create Event-Based Alert Schemes – Workflow” in Alerts.

Use the following URL, to display the login page: 
http://<server_name>/<HP_BAC_web_application_context_name (usually 
topaz)>/login.jsp?portlet_url=/service-impact/main/page.do?ciId=<CI_id>

The URL displays the login page and, after you enter the user name and 
password information, opens the report.

The following parameter is used in the URL: <CI_id> is the internal number 
of the CI. Select Admin > Universal CMDB > Modeling > IT Universe, select 
the CI in the tree. The internal number of the CI appears in the ID box in 
the Properties tab in the Information pane.
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View the SAR Compliancy Report

HP Service Automation Reporter (SAR) manages service compliance through 
dynamic discovery, capture, and enforcement of entire software stacks.

You can access the SAR Compliancy report from the Dashboard tabs. 

This task includes the following steps:

➤ “Specify the URL of the SAR Server” on page 63

➤ “Display the SAR Compliancy Report” on page 63

 1 Specify the URL of the SAR Server
To specify the URL of the SAR server, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Foundations, select 
Integrations with other applications, and locate the HP Service Automation 
Reporter application URL entry in the Integrations with other applications - 
HP Service Automation Reporter table. Enter the URL of the SAR server.

 2 Display the SAR Compliancy Report
To view the SAR Compliancy report for a Host CI, in the Top View, Console, 
or Filters tab, right-click a Host CI and select the Go to Report > SAR 
Compliancy Report option. 

For details about the SAR Compliancy report, see HP Service Automation 
Reporter documentation.
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Example

Find Visible and Hidden Child CIs

A CI’s child CIs can be specified as included (visible) or excluded (hidden) in 
a specific view. The status of any child CI, visible or hidden, has an impact 
on the status of its parent CI in any view where the parent CI appears. For 
details on including or excluding child CIs, see the Hide CIs from View 
option in “View Editor” in Model Management.

This task includes the following steps:

➤ “Find the Visible and Hidden Child CIs For a Specific CI” on page 65

➤ “Search for the Views That Include a Specific Child CI” on page 65
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 1 Find the Visible and Hidden Child CIs For a Specific CI
In either the Top View tab, Console Hierarchy tab or Filter tab in Dashboard, 
right-click the CI and select the Find Visible and Hidden Child CIs option to 
open the Find Visible and Hidden Child CIs dialog box and list all of the 
selected CI’s child CIs that appear in the CMDB (visible and hidden). 

For details, see “Find Visible and Hidden Child CIs Dialog Box”. 

 2 Search for the Views That Include a Specific Child CI
In View Explorer, click Search to perform a search for the CIs whose names 
include the selected child CI’s name string in all views, and display the 
results in the View Explorer search page. For details, see “Search for CIs in 
Search Mode” in Model Management. 

Click the appropriate CI in the list to display more information about the 
selected CI in the selected view.

If the CI is not visible in any view, in Dashboard, the following message is 
displayed: Search is complete. There are no results to display for the current 
search parameters. The CI is not visible in any view in the following 
situations:

➤ It is included in the CMDB but does not belong to any view.

➤ It belongs to a view but the Hide CIs from View option has been selected 
for its parent CI in that view. A CI’s child CIs can be specified as included 
(visible) or excluded (hidden) in a specific view. The status of any child 
CI, visible or hidden, has an impact on the status of its parent CI in any 
view where the parent CI appears. For details on including or excluding 
child CIs, see the Hide CIs from View option in “View Editor” in Model 
Management.
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Example

You might have the situation where, in a specific view, the Availability KPI’s 
status of the parent CI’s is Critical while the Availability KPI’s status of the 
CI’s child CIs are OK. When this happens, you would like to know what 
caused the status of the Availability KPI to be Critical. 

Use the Find Visible and Hidden Child CIs option to list all of the child CIs of 
the selected CI in the CMDB. After the list of child CIs is displayed, you can 
search for the views the child CI belongs to and then display the child CIs 
details in the specific view.

The Find Visible and Hidden Child CIs page displays the following 
information:

➤ The name of the selected CI, whose child CIs you want to list, the CI’s 
KPIs, and their status in the current view.

➤ A list of the child CIs (visible and hidden) that appear in the CMDB, their 
KPIs and their status. In the Visible column, a checkmark indicates that 
the child CI is visible in the view and an X indicates that the child is 
hidden in the view.
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Set Up Sound Notification When KPI Status Changes to 
Critical

You can set up Dashboard to play an alert sound when the status of a KPI 
changes to Critical in the Console or Filters tab.

When the view is loaded for the first time, no sound is played for the KPIs 
that are loaded at Critical status.

When the sound is switched on, a sound alert is played:

➤ In the Console tab. When the Console tab is currently displayed, and a KPI 
in the view changes status to Critical (red). The Critical status icon flashes 
until the next screen refresh. If a CI in a hidden part of the view has 
changed to Critical but does not change the status of any of the CIs in the 
currently displayed branches, no sound is heard.

➤ In the Filters tab. When the Filters tab is currently displayed, and a KPI in 
the view changes status to Critical (red). The Critical status icon flashes until 
the next screen refresh. 

This task includes the following steps:

➤ “Set Up the Sound Notification Option” on page 68

➤ “Switch On the Sound Option in the Console or Filters Tabs” on page 68

➤ “Modify the Alert Sound – Optional” on page 68

➤ “When Using Mozilla, Download a Plug-in” on page 68
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 1 Set Up the Sound Notification Option
Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Sound 
Notification entry in the Dashboard Application - Sound Notification table. 
Modify the value to true to enable the sound notification or to false to 
disable it. The change takes effect immediately.

 2 Switch On the Sound Option in the Console or Filters Tabs
Switch on the sound option using the  button in the Console or Filters page. 
For details, see “Console User Interface” on page 151 or “Filters Page” on 
page 187.

 3 Modify the Alert Sound – Optional
The alert sound is a WAV file downloaded by the browser. 

To use another alert sound for Dashboard, if you have administrative 
permissions, access <Gateway server root directory>\AppServer\ 
webapps\site.war \bam\pages\sounds and replace the ding.wav file with 
your own .wav file (you must rename your file ding.wav). The change takes 
effect immediately.

 4 When Using Mozilla, Download a Plug-in
If you are using Mozilla, you must download a plug-in for playing WAV files, 
otherwise no sound is played.
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Customize Dashboard Display and Refresh Rate

You can customize some aspects of the Dashboard display and the refresh 
rate of the display. 

Note: All the steps in the task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Modify the Length of a CI Name” on page 69

➤ “Modify the Maximum Number of CIs to Be Displayed in Dashboard” on 
page 69

➤ “Modify the Dashboard Tabs Refresh Rate” on page 70

➤ “Customize Tooltips and Icons” on page 70

 1 Modify the Length of a CI Name
To change the default length (40 characters) of the CI name, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and in the Dashboard 
Application - Dashboard Layout Properties table, modify the CI name 
maximum character length entry. When the CI name is longer than this 
value, it is shortened in the display and a tooltip displays the complete 
name. 

 2 Modify the Maximum Number of CIs to Be Displayed in 
Dashboard
To change the default number of CIs that can be displayed in Dashboard 
Console and Filters pages, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and in the Dashboard Application - Dashboard 
Layout Properties table, modify the Displayed CI limit entry. Default is 3000.
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 3 Modify the Dashboard Tabs Refresh Rate
When you open a Dashboard tab for a view tree with a large infrastructure, 
you may experience a short delay while Dashboard builds the view.

The tab is refreshed every 30 seconds. If no change is made to the view, the 
display remains the same. If changes have been made to a view, or if CIs 
have been deleted from the view, that view’s information in the tab is 
automatically reloaded after 30 seconds and displays the changes. 

While reloading, the following message is displayed in the top right corner 
of the screen: The model has changed. Reloading... After reloading is 
complete, the following message is displayed in the top right corner of the 
screen: Top view has been updated with model changes. Last Update in the 
bottom left corner of the screen indicates the last time an update of the top 
view was reloaded. 

The refresh rate of the view can be modified. To modify the refresh rate, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the UI 
Refresh Rate entry in the Dashboard Application - Business Impact table. 
Change the default.

 4 Customize Tooltips and Icons
You can customize some aspects of the user interface.

➤ Modifying Tooltip Border and Header Colors. A KPI tooltip border and 
header have a default color that you can modify. For details, see “Change 
the Color of the Tooltip Border and Header” on page 821.

➤ Specifying a Different Icon Set. A different icon is used for the KPI status for 
each value range. 

You can replace the icons set in the Top View tab and for the KPIs in the 
other Dashboard. You can also replace the Trend and History icons with 
customized ones. For details, see “Change the KPI Status Icons” on page 394.
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Use the Troubleshooting Logs

This section describes how to create troubleshooting logs and how to use 
those logs to debug errors.

This task includes the following steps:

➤ “Use Dashboard Administration Logs” on page 71

➤ “Monitor Usage in the System” on page 72

 1 Use Dashboard Administration Logs
To facilitate the creation of troubleshooting logs, you must enable Debug 
mode. For details, see “About HP Business Availability Center Logs” in 
Reference Information. 

The logs are located in the <Data Processing server root 
directory>\log\EJBContainer folder:

➤ bam.app.rules.log. To verify the status of a KPI, scan the log file manually 
or use a script for errors in the rule calculations. The log should not 
contain any errors, such as Java exceptions. 

➤ TrinitySamples.log. To verify that samples have reached the HP Business 
Availability Center bus, scan the log file manually or use a script for 
samples coming from SiteScope or Business Process Monitor.

You can use the BusDiscovery utility to search for samples transmitted on 
the bus. The utility is available under the <Gateway server root 
directory>\tools\BusDiscovery directory. 

Use the following command to activate the utility:
D:\Temp\drv.log: sprinter -dc_attach localhost -dc_print_format 
sample_per_line -drv_log_file

The utility dumps the arriving samples into the following directory:
D:\Temp\drv.log
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 2 Monitor Usage in the System
You can monitor usage of the Dashboard application in a sessions log file. A 
line stating the number of users is added to the <HP Business Availability 
Center Gateway server root directory>\log\EJBContainer\bam.sessions.log 
file for each time period. For example, if a user accesses Dashboard, then 
closes HP Business Availability Center, then accesses Dashboard again, this 
counts as two user sessions in the log file.

To change the default time period, open the <HP Business Availability 
Center Gateway server root directory>\conf\settings\BACAppSettings.xml 
file, look for the keys: session.log.interval.0, session.log.interval.1, or 
session.log.interval.2., and change the key to match the required time 
period as follows:

Reference

Dashboard User Interface

This section describes:

 ➤  Find Visible and Hidden Child CIs Dialog Box on page 73

 ➤  Menu Options on page 75

 ➤  Node Details Dialog Box on page 94

 ➤  Business Impact Report on page 95

Key Represents:

session.log.interval.0 a 6 hour period

session.log.interval.1 a 12 hour period

session.log.interval.2 a 24 hour period
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Find Visible and Hidden Child CIs Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to list all of the selected CI’s child CIs that 
appear in the CMDB (visible and hidden). 

To access: In the Console Hierarchy or Filter tabs in 
Dashboard, right-click the CI and select the Find Visible 
and Hidden Child CIs option.

Important 
Information

A CI’s child CIs can be specified as included (visible) or 
excluded (hidden) in a specific view. The status of any 
child CI, visible or hidden, has an impact on the status 
of its parent CI in any view where the parent CI 
appears. For details on including or excluding child 
CIs, see the Hide CIs from View option in “View Editor” 
in Model Management.

Included in Tasks “Find Visible and Hidden Child CIs” on page 64

GUI Element (A-Z) Description

<KPI> The name of the child CI’s KPI and its status.

<Top part of page> Displays the name of the selected CI, whose child CIs 
you want to list, the CI’s KPIs, and their status in the 
current view.

Name The name of the child CIs (visible and hidden) that 
appear in the CMDB.
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Search Click the Search button to perform a search for the CIs 
whose names include the selected child CI’s name 
string in all views, and display the results in the View 
Explorer search page. For details, see “Working with 
View Explorer” in Model Management.

From the View Explorer search page, click the 
appropriate CI in the list to display more information 
about the selected CI in the selected view. If the CI is 
not visible in any view, in Dashboard, the following 
message is displayed: Search is complete. There are no 
results to display for the current search parameters.

Note: The CI is not visible in any view in the following 
situations:

➤ It is included in the CMDB but does not belong to 
any view.

➤ It belongs to a view but the Exclude all child CIs 
option has been selected for its parent CI in that 
view. For details on including or excluding child CIs, 
see the Hide CIs from View option in “View Editor” 
in Model Management.

For more details, see “Find Visible and Hidden Child 
CIs” on page 64.

Visible A checkmark indicates that the child CI is visible in the 
view.

An X indicates that the child is hidden in the view.

GUI Element (A-Z) Description
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Menu Options

The menu options displayed in Dashboard tabs depend on the selected view 
and the selected CI. They can be a subset of the options described in this 
section. 

For more information about menu options, see “About Menu Options” on 
page 42. 

The available options are:

Main Option (A-Z) Description and Sub-Options

Acknowledgment This menu lists options that enable you to use the acknowledgment utility. 

Acknowledgment 
Details

This option is available for all CIs. 

Opens the Acknowledgment details page that 
displays information about the CI’s 
acknowledgment. 

For details, see “Acknowledgments Details Dialog 
Box” on page 109.

Set/Unset 
Acknowledgment

This option is available for all CIs. 

Opens the Set/Unset Acknowledgments page where 
you can set or clear the CI’s acknowledgment. 

For details, see “Acknowledgment History and 
Details Dialog Box” on page 108.

Business 
Transaction Flow 
Map

This option is available for TV Monitor CIs. 

This menu lists options that enable you to open specific capabilities filtered 
by the selected CI.

Completed Opens the TransactionVision Flow Map for 
completed instances of the business transaction. For 
details, see “Transaction Topology Flow Map for the 
Dashboard” in Using TransactionVision.

In-Process Opens the TransactionVision Flow Map for instances 
of the business transaction that are in process. For 
details, see “Transaction Topology Flow Map for the 
Instance Topology” in Using TransactionVision.
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Drill to Diagnostics This menu lists options that enable you to open specific pages in the 
Diagnostics application filtered by the selected CI. This option is displayed 
only if you have Diagnostics installed.

Layers View This option is available for:

➤ All Probe Group, and Probe CIs in the Diagnostics 
View.

➤ Business Process Step CI, in the End User 
Monitors View. 

Note: This option is displayed only if you have 
Diagnostics installed.

Opens the Layers (Load) view, with the following 
characteristics:

➤ For a Business Process Step CI, the view displays 
the layers of the transaction that corresponds to 
the Business Process Step CI.

➤ For a Probe Group CI, the view displays the 
performance metrics for the Probe Group.

➤ For a Probe CI, the view displays the performance 
metrics for the Probe. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Server Requests This option is available for the Real User Monitor 
Business Process Step CIs in the End User Monitors 
View.

Note: This option is displayed only if you have 
Diagnostics installed.

Note: If you drill down from a RUM Page Monitor CI 
that is not monitored by HP Diagnostics, the Server 
Requests View in the HP Diagnostics application you 
access using the right-click menu option might show 
incorrect data. 

Opens the Server Requests View in the 
HP Diagnostics application with the URLs that 
correspond to the Real User Monitor Business 
Process Step CIs selected. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Main Option (A-Z) Description and Sub-Options
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Drill to Diagnostics 
(continued)

Summary View This option is available for all Diagnostics Probe 
Group and Diagnostics Probe CIs in the Diagnostics 
View. 

Note: This option is displayed only if you have 
Diagnostics installed.

Opens the Diagnostics Probe Group Summary View 
for the probe or the probe group in the 
HP Diagnostics application. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Transactions View This option is available for all Business Process Step 
CIs in the End User Monitors View.

Note: This option is displayed only if you have 
Diagnostics installed.

Opens the Transactions view that displays 
performance metrics for the transactions being 
executed by your applications. The transaction that 
corresponds to the selected Business Process Step CI 
is highlighted.

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Expand more levels Note: This option is only available in the Top View tab.

Opens a number of levels (7 by default) below the selected level of the Top 
View tree.

Main Option (A-Z) Description and Sub-Options
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Expand to problem Note: This option is only available in the Top View tab.

Collapses the branches where CIs do not have Critical or Major statuses.

Example: 

In the End User Monitors view, Cust_1_BPM_1 is red. 

Right-click Cust_1_BPM_1 and select the Expand to problem option to get 
more information about the problem by displaying lower levels of the view 
and by collapsing non-problematic branches.  

Main Option (A-Z) Description and Sub-Options
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Filters This menu lists filters that you can use to display subsets of the selected CI’s 
children on the Filters page. 

Filter Subtree This option is available for all CIs. 

Opens the Filters page, which displays the selected 
CI subtree filtered by the active filter.

Filter Subtree 
Monitors 

This option is available for all CIs. 

Opens the Filters page, which displays the monitor 
CIs in the subtree of the selected CI filtered by the 
active filter.

Show Complete 
Subtree 

This option is available for all CIs. 

Opens the Filters page, which displays the complete 
subtree of the CI as if it was filtered by the Show All 
active filter. This filter appears in the Active Filters 
box.

Show Subtree 
Monitors 

This option is available for monitor CIs. 

Opens the Filters page, which displays the monitor 
CIs in the subtree of the CI as if it was filtered by the 
Show Monitors Only active filter. This filter appears 
in the Active Filters box.

Find Visible and 
Hidden Child CIs

This option is available for all CIs. 

Returns all of the visible and hidden child CIs of the selected CI as they 
appear in the CMDB.

For details, see “Find Visible and Hidden Child CIs” on page 64.

Go to BPI This option is available for Business Process, BPI Monitor, and BPI Monitor 
CIs.

Opens the Business Process Insight application. For details, see Using 
Business Process Insight.

Main Option (A-Z) Description and Sub-Options
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Go to Report This option is available for all CIs.

This menu lists options that enable you to access all types of reports that 
display information about the selected CI.

BPI Monitors Over 
Time

This option is available for all BPI Duration, Value, 
or Custom Monitor CIs.

Opens the BPI Monitors Over Time report. For 
details, see BPI Application Reports in Using Business 
Process Insight

Business Process 
Over Time

This option is available for all BPI Business Process 
Step Monitor or BPI Business Process Monitor CIs.

Opens the Business Process Over Time report. For 
details, see BPI Application Reports in Using Business 
Process Insight

Change Rule This option is available for all CIs whose properties 
have changed. 

Opens the Change report for the CI. The Change 
report displays information about the changes made 
to the properties of CIs for all CIs that were assigned 
to keep this information.

For details on the report, see “Change Report Page” 
in Model Management.

Main Option (A-Z) Description and Sub-Options
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Go to Report 
(continued)

Configuration Item 
Status Alerts

This option is for all CIs. 

Opens the Configuration Item Status Alerts report 
for the CI. The Configuration Item Status Alerts 
report lists all of the alerts that occurred in the 
specified period of time.

For details on the report, see “Configuration Item 
Status Alerts Report” in Alerts.

Diagnostics Web 
Service Topology 

This option is for Web Service CIs. 

Opens the Diagnostics Service Topology view for the 
selected Web Service CI, for the past half hour. For 
details on the report, see the HP Diagnostics User’s 
Guide.

End User Summary This option is for Real User Monitor-specific CIs. 

Opens the End User Summary report. The End User 
Summary report displays data for specific end users 
configured for Real User Monitor in End User 
Management Administration. 

For details, see “End User Summary Report” in Using 
End User Management.

For details on the Real User Monitor views, see 
“About Real User Monitor Views” in Using End User 
Management.

Event Count Over 
Time

This option is for Real User Monitor-specific CIs. 

Opens the Event Count Over Time report. The Event 
Count Over Time report displays data for all events, 
or sessions with events, in monitored applications 
that you configured in End User Management 
Administration, broken down by time intervals. 

For details, see “Event Count Over Time Report” in 
Using End User Management.

For details on the Real User Monitor views, see 
“About Real User Monitor Views” in Using End User 
Management.

Main Option (A-Z) Description and Sub-Options



Chapter 1 • Introducing Dashboard

82

Go to Report 
(continued)

Event Summary This option is for Real User Monitor-specific CIs. 

Opens the Event Summary report. The Event 
Summary report displays a summary of events in 
monitored applications that you configured in End 
User Management Administration. 

For details, see “Event Summary Report” in Using 
End User Management.

For details on the Real User Monitor views, see 
“About Real User Monitor Views” in Using End User 
Management.

Event Summary 
(Errors Monitor)

This option is for RUM Error Events CIs. 

Opens the Event Summary report. For details, see 
“Event Summary Report” in Using End User 
Management.

Event Summary 
(Event Monitor)

This option is for RUM Informational Events CIs. 

Opens the Event Summary report. For details, see 
“Event Summary Report” in Using End User 
Management.

Event Summary 
(HTTP Error 
Monitor)

This option is for RUM HTTP Error Events CIs. 

Opens the Event Summary report. For details, see 
“Event Summary Report” in Using End User 
Management.

Event Summary 
(Information Event 
Monitor)

This option is for RUM Informational Event Monitor 
CIs. 

Opens the Event Summary report. For details, see 
“Event Summary Report” in Using End User 
Management.

KPIs Over Time This option is for all CIs. 

Opens the KPIs Over Time report for the CI. The KPIs 
Over Time report shows the status or value, over 
time, of selected CIs and KPIs that are accessible 
from the Dashboard application.

For details on the report, see “KPIs Over Time 
Report”.

Main Option (A-Z) Description and Sub-Options
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Go to Report 
(continued)

Operations Health This option is for Web Service Operation, SiteScope 
Monitor, and Diagnostics Web Service Monitor CIs.

Opens the Health Report in the HP Business 
Availability Center for SOA application filtered for 
the specific operation. For details, see “Health 
Report” in Solutions and Integrations. 

SAP Transaction 
Changes

This option is for SAP-specific CIs. 

Opens the SAP Transaction Changes report. The SAP 
Transaction Changes report displays the SAP 
transactions and SAP transports and the impact of 
transports on each transaction. 

For details on the report, see “SAP Transaction 
Changes Report” in Solutions and Integrations.

For details on the SAP System view, see “SAP Systems 
View” in Solutions and Integrations.

SAP Transport 
Changes

This option is for SAP-specific CIs. 

Opens the SAP Transport Changes report. The SAP 
Transport Changes report displays the changes 
inside the Transport and the impact on the SAP 
transaction. 

For details on the report, see “SAP Transport 
Changes Report” in Solutions and Integrations.

For details on the SAP System view, see “SAP Systems 
View” in Solutions and Integrations.

SAR Compliancy 
Report

This option is for Host CIs.

Opens the SAR Compliancy report. For details, see 
“View the SAR Compliancy Report” on page 63.

Main Option (A-Z) Description and Sub-Options
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Go to Report 
(continued)

Server Summary This option is for Real User Monitor-specific CIs. 

Opens the Server Summary report. The Server 
Summary report displays data for the servers 
monitored by the Real User Monitor probe. 

For details on the report, see “Server Summary 
Report” in Using End User Management.

For details on the Real User Monitor views, see 
“About Real User Monitor Views” in Using End User 
Management.

Session Analyzer This option is for Real User Monitor-specific CIs. 

Opens the Session Analyzer report. The Session 
Analyzer report displays session data for specific 
applications configured for Real User Monitor in 
End User Management Administration. 

For details, see “Session Analyzer Report” in Using 
End User Management.

For details on the Real User Monitor views, see 
“About Real User Monitor Views” in Using End User 
Management.

Siebel Cross-
Performance

This option is for the Siebel Application Server, 
Siebel Web Server Extension, Siebel Component 
Group, Siebel Component, and Siebel Web 
Application CIs. 

Opens the Cross-Performance report for the CI. The 
Cross-Performance report displays the behavior of a 
measurement running on several monitored servers, 
or the behavior of several measurements from 
various types of monitors running on one 
monitored server. 

For details on the report, see “Cross-Performance 
Report” in Using System Availability Management.

Main Option (A-Z) Description and Sub-Options
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Go to Report 
(continued)

SiteScope Cross-
Performance

This option is for SiteScope Profile, SiteScope Group, 
and SiteScope Monitor CIs.

Opens the Cross-Performance report. For details, see 
“Cross-Performance Report” in Using System 
Availability Management.

SiteScope Quick 
Report

This option is for SiteScope Group and SiteScope 
Monitor CIs.

Opens SiteScope Quick Report. For details, see 
“Quick Report” in Using System Availability 
Management.

SiteScope Server 
Centric Report

This option is for Windows Resource Monitor and 
Unix Resource Monitor CIs under specific conditions 
described in the report description.

Opens SiteScope Server Centric Report. For details, 
see “Server-Centric Report” in Using System 
Availability Management.

Systinet Web 
Service Data

This option is for Business Unit CIs, Web Service CIs, 
and Web Service Operation CIs, when there is an 
integration between HP Business Availability Center 
and HP SOA Systinet. 

Opens the HP SOA Systinet application, focused on 
the relevant Web service. For details, see the HP SOA 
Systinet documentation.

For details on the integration with HP SOA Systinet, 
see “Integration of HP SOA Systinet” in Solutions and 
Integrations.

Transaction Analysis This option is for all CIs. 

Opens the Transaction Analysis report for the CI. 
The Transaction Analysis report provides an in-
depth picture of the performance of transactions. 

For details on the report, see “Transaction Analysis 
Report” in Using End User Management.

Main Option (A-Z) Description and Sub-Options
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Go to Report 
(continued)

Transaction Over 
Time

This option is available for TV Monitor CIs.

Opens the Transaction Over Time report. For details, 
see “Transaction Over Time Report” in Using 
TransactionVision.

Transaction 
Performance 
Summary

This option is available for TV Monitor CIs.

Opens the Transaction Performance Summary 
report. For details, see “Transaction Performance 
Summary Report” in Using TransactionVision.

Trend This option is for all CIs. 

Opens the trend report for the CI. Trend reports 
enable you to compare multiple measurements from 
several profiles. 

For details on the report, see “Trend Reports” in 
Reports. 

Triage This option is for Real User Monitor-specific CIs and 
for Siebel-specific CIs. 

Opens the Triage report. The Triage report displays 
transaction data for Business Process Monitor, and 
Real User Monitor profiles for the past day. 

For details, see “Triage Report” in Using End User 
Management.

For details on the Real User Monitor views, see 
“About Real User Monitor Views” in Using End User 
Management.

For details on the Siebel Sites view, see “Siebel 
Views” in Solutions and Integrations.

Web Services 
Health

This option is for Web Services CIs.

Opens the Health Report in the HP Business 
Availability Center for SOA application filtered for 
the specific. 

For details, see “Health Report” in Solutions and 
Integrations. 

Main Option (A-Z) Description and Sub-Options
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Go to Siebel 
Diagnostics

This menu lists options that enable you to open specific pages in the 
Business Availability Center for Siebel filtered by the selected CI.

Show Processes This option is available for Siebel Application Server, 
Siebel Component Group, and Siebel Component 
CIs. 

This option opens the Task Diagnostics Tool filtered 
by:

➤ The selected site, and server for Siebel Application 
CIs.

➤ The selected site, server, and selected Component 
Group CI for Component Group CIs.

➤ The selected site, server, selected Component 
Group CI, and Component CI for Component 
Group CIs.

For details on the Siebel Task Diagnostics Tool, see 
“Siebel Views” in Solutions and Integrations.

For details on the Siebel CIs, see “Default CITs in the 
Siebel View” in Solutions and Integrations.

For details on the Process Diagnostics Tool, see 
“Siebel Views” in Solutions and Integrations.

Main Option (A-Z) Description and Sub-Options
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Go to Siebel 
Diagnostics

(continued)

Show Running 
Tasks

This option is for Siebel Application Server, Siebel 
Component Group, and Siebel Component CIs. 

Opens a separate page with the Task Diagnostics 
Tool filtered by:

➤ The selected site, server, Running status, and 
Session type for Siebel Application CIs.

➤ The selected site, server, selected Component 
Group CI, Running status, and Session type for 
Component Group CIs.

➤ The selected site, server, selected Component 
Group CI, selected Component CI, Running 
status, and Session type for Component CIs.

For details on the Siebel CIs, see “Default CITs in the 
Siebel View” in Solutions and Integrations.

For details on the Siebel Task Diagnostics Tool, see 
“Siebel Views” in Solutions and Integrations.

Show Tasks in Error This option is for Siebel Application Server, Siebel 
Component Group, and Siebel Component CIs. 

Opens a separate page with the Task Diagnostics 
Tool filtered by:

➤ The selected site, server, and Exited with Error 
status for Siebel Application CIs.

➤ The selected site, server, selected Component 
Group CI, and Exited with Error status for 
Component Group CIs.

➤ The selected site, server, selected Component 
Group CI, selected Component CI, and Exited 
with Error status for Component CIs.

For details on the Siebel CIs, see “Default CITs in the 
Siebel View” in Solutions and Integrations.

For details on the Siebel Task Diagnostics Tool, see 
“Siebel Views” in Solutions and Integrations.

Main Option (A-Z) Description and Sub-Options
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Go to Siebel 
Diagnostics

(continued)

Siebel Database 
Breakdown

This option is for the Siebel Site, Siebel Application, 
and Siebel Enterprise CIs.

Opens the Database Breakdown tab in Business 
Availability Center for Siebel to enable you to create 
and analyze database logs that record the SQL 
activity between Siebel components and the Siebel 
database. 

For details, see “Siebel Views” in Solutions and 
Integrations.

Siebel SARM This option is for the Siebel Site, Siebel Application, 
and Siebel Enterprise CIs.

Opens the SARM - User Trace Breakdown tab in 
Business Availability Center for Siebel to enable you 
to create and record the SQL activity in each 
monitored Siebel site. 

For details, see “Siebel Views” in Solutions and 
Integrations.

Go to SiteScope This option is for SiteScope Profile, SiteScope Group, and SiteScope 
Measurement Group CIs. 

Opens the appropriate monitor page in SiteScope.

For details on SiteScope, see Using System Availability Management.

Go to 
TransactionVision

This option is for TV Monitor CIs. 

Opens the relevant report in TransactionVision.

Go to Problem 
Isolation

You can access the appropriate pages in the Problem Isolation application 
filtered by the selected CI. Problem Isolation enables you to isolate 
enterprise problems discovered in HP Business Availability Center, and to 
identify likely suspects to help in solving the root cause of the problem.

This option is available for all CIs. 

Opens the Problem Isolation application, which is also accessible through 
Applications > Problem Isolation. The user enters the application on the 
Problems List page.

Main Option (A-Z) Description and Sub-Options



Chapter 1 • Introducing Dashboard

90

HP Service Center This option is available for Business Service CIs or EMS Monitor CIs under 
Business Service CIs. 

Opens the HP ServiceCenter application.

Invoke Run Books This option is available for all CIs whose CI type is mapped to an 
HP Operations Orchestration (OO) run book.

Opens the Related Run Books page in a new window, where you can view 
the mapped run books and invoke them in OO. For details on the user 
interface, see “Related Run Books Area” of the Invoke Run Book page in 
Problem Isolation.

For details on integrating Business Availability Center with OO, see 
“HP Operations Orchestration Integration Overview” in Solutions and 
Integrations.

Note: To invoke run books from the Related Run Books page, you must have 
the necessary permissions for 00 in Business Availability Center. To access 
the Permissions page, select Admin > Platform > Users and Permissions. For 
details on this topic, see “Permissions Overview” in Platform Administration.

OVO Drill Down This option is available for HP Operations Manager-related CIs in 
Dashboard and Service Level Management views.

It enables you to access the HP Operations Manager application.

For details on this topic, see “Use the EMS Integration Tool for HP 
Operations Manager Server Events” in Solutions and Integrations.

Properties This option is available for all CIs. 

Opens the Properties dialog box appropriate for the CI. 

For details, see “Configuration Item Properties Dialog Box” in Model 
Management.

Show Business 
Impact

This option is available for all CIs.

Opens the Business Impact report that displays the impact of the current CI 
on the services that depend on that CI. If there are no services attached to 
the CI, the report is empty. For details, see “Business Impact Report” on 
page 95.

Show Event This option is available for Application Monitor CIs in the Netscout view. 

Opens the Netscout application.

Main Option (A-Z) Description and Sub-Options
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Show Impacting 
SAP Transports 

This option is available for SAP-specific Transaction and group CIs. 

For Transaction CIs, enables you to display all of the selected CIs and their 
child CIs that were affected by any SAP Transport CIs. For details, see “Show 
Impacting SAP Transports Report” on page 200.

Groups CIs represent the following CIs: SAP System, and SAP Application 
Component.

Show SAP 
Transport Impact

This option is available for SAP-specific Transport CIs. 

Enables you to display all SAP transactions that are impacted by the selected 
transport. For details, see “Show SAP Transport Impact Report” on page 199.

Show Related CIs This option is available for all CIs. 

Performs a search for related CIs and displays the result in the Search tab of 
View Explorer. 

For details on the Search tab, see “Search for CIs in Search Mode” in Model 
Management.

Main Option (A-Z) Description and Sub-Options
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Top View This menu lists options that enable you to display, in a standalone window, 
the Top View tree with the requested structure. 

Show Path to Root This option is available for all CIs. 

Opens a Top View page that displays the path from 
the selected CI to the root CI, in the Filters or 
Console tab. For example:

Main Option (A-Z) Description and Sub-Options
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Top View 
(continued)

Show Problematic 
Subtree 

This option is available for all CIs. 

Opens a popup with the same capabilities as the Top 
View tab. The popup displays all of the child CIs 
with Critical, Major, or Minor status and enables you 
to find the problematic child CI that causes the 
selected parent CI to have a status other than OK. It 
is enabled only for CIs that have at least one KPI 
with a status other than OK.

Example: The QTWeb medium CI has the following 
children:

Select the Top View >Show Problematic Subtree 
option for the CI to display the following children:

Main Option (A-Z) Description and Sub-Options
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Node Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view CMDB details on the CI.

To Access: In the Console Hierarchy or Filters tabs, 
click Details for the appropriate CI.

Important 
Information

By default, Details links are not displayed. 

To display Details links, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and 
in the Dashboard Application - Dashboard Layout 
Properties table, modify the Show element CMDB 
details link in UI entry. Default is false.

GUI Element (A-Z) Description

Calc Rule ID The ID number of the calculating rule.

CMDB ID The internal CMDB ID corresponding to the CI (the 
value returned by the field entity_id).

CMDB Property 
Name

The name of the CMDB property.

CMDB Property 
Value

The value of the CMDB property.

KPI CMDB ID The internal CMDB ID corresponding to the KPI (the 
value returned by the field kpi_id).

Result The result of the calculation.

System KPI (x) Where x is the KPI ID (the value returned by the field 
kpi_type).
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Business Impact Report

The following is an example of the Business Impact report. 
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Business Services Summary Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays information about the Business CIs impacted 
by the selected CI.

To access: In the Console or Filter tab, right-click the 
relevant CI and select Show Business Impact.

Important 
Information

➤ If there are no Business CIs attached to the CI, the 
report is empty.

➤ You can hide KPIs so they do not appear in the 
report. To hide KPIs, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, 
and locate the KPIs to hide in the report entry in the 
Dashboard Application - Business Impact table and 
add the KPI numbers separated by a comma. 

For example, to remove the Performance and 
Availability KPIs, enter 6,7. Removing KPIs has an 
impact on the value/status of the CIs to which those 
KPIs are assigned.

Included in Tasks “View a Business Impact Report” on page 58

GUI Element (A-Z) Description

Current Status The worst status of the KPI assigned to the selected 
Business CI.

Name The name of the Business CI impacted by the selected 
CI.

Click one of the Business CI in the list to display KPIs 
and SLA details in the <service> Service Details area. 
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Over Time Status 
Week to Date

The average status of the KPI over a predefined time 
period. The default is: week to date.

To modify the predefined time period, select Admin > 
Platform > Setup and Maintenance > Infrastructure 
Settings, choose Applications, select Dashboard 
Application, and locate the Default Over-Time Time 
Period entry in the Dashboard Application - Business 
Impact table and modify the entry value.

SLAs Current Status The worst status of all the SLAs where the Business CI is 
included. 

If the SLA Current Status is No Data and the SLAs table 
below the main table indicates: No information, the 
Business CI is not included in any SLA.

If the SLA Current Status is No Data and the SLAs table 
below the main table indicates: No Data, the Business 
CI is included in the SLA and the SLA worst status is No 
Data.

SLAs Forecasting The worst expected status of the SLAs where the 
Business CI is included. 

If the SLA Forecasting Status is No Data and the SLAs 
table below the main table indicates: No information, 
the Business CI is not included in any SLA.

If the SLA Forecasting Status is No Data and the SLAs 
table below the main table indicates: No Data, the 
Business CI is included in the SLA and the SLA 
Forecasting worst status is No Data.

GUI Element (A-Z) Description
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Service Details Area

The area includes the KPI and the SLAs tables.

KPI Table

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

SLAs Table

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Current Status The current status of the KPI assigned to the selected 
Business CI, as it appears in Dashboard.

KPI The list of KPIs attached to the selected Business CI.

Over Time Status The status of the KPI over a predefined time period, as 
it appears in the KPI Over TIme Report in Dashboard.

GUI Element (A-Z) Description

Current Status The current status of the SLA.

Customer The customer related to the SLA.

Expected Breach 
Date

The expected breach date of the SLA.

Forecasting Status The expected status of the SLA, based on extrapolation. 
For additional information, see “Business Services 
Summary Area” on page 96.

SLAs The list of SLAs where the selected Business CI is 
included. For additional information, see “Business 
Services Summary Area” on page 96.
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Troubleshooting and Limitations

This section includes troubleshooting and limitations for Dashboard.

Loss of Data after Renaming Transactions
If you rename a transaction in an HP Virtual User Generator script, Business 
Availability Center considers it as a new transaction. A new BPM Transaction 
from Location CI is created in the CMDB using the new name, and the CI 
with the old transaction name is removed after it stops receiving samples. In 
Dashboard, the new CI does not display trend and history status data from 
the period before the transaction name change.
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2
Acknowledge Problems

This chapter includes information about acknowledging problems in 
Dashboard.

This chapter includes:

Concepts

 ➤  Acknowledging Performance Problems Overview on page 101

Tasks

 ➤  Acknowledge Performance Problems on page 102

 ➤  Switch Off the Alert Sound When CI is Acknowledged on page 107

Reference

 ➤  Acknowledge Problems User Interface on page 107
Concepts

Acknowledging Performance Problems Overview

The Acknowledging utility enables you to track performance problems 
identified in your system and network infrastructure by keeping a record of 
when the problem was acknowledged and by which user. 

For details on how to perform the task, see “Acknowledge Performance 
Problems” on page 102.

Tasks
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Acknowledge Performance Problems

This section describes how to acknowledge a problem in Dashboard.

This task includes the following steps:

➤ “Display/Hide the Ack Column in the Console Tab – Optional” on page 102

➤ “Display/Hide the Ack Column in the Filters Tab – Optional” on page 103

➤ “Acknowledge a Problem” on page 103

➤ “View a Problem’s History” on page 104

 1 Display/Hide the Ack Column in the Console Tab – Optional
By default, the Ack column is displayed. The Ack column can be hidden by 
users with administrative permissions. To hide/display the Ack column, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click the Applications context, select Dashboard Application, and locate the 
Show CI Acknowledgment column in the Business Console area, and select 
false (hide the Ack column), or true (display the Ack column). The change 
takes effect immediately. 

Note: When you hide the Ack column, the Acknowledgment-related context 
menu options remain available. For details, see “Menu Options” on page 75.
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 2 Display/Hide the Ack Column in the Filters Tab – Optional
By default, the Ack column is displayed. The Ack column can be hidden by 
users with administrative permissions. To hide/display the Ack column, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click the Applications context, select Dashboard Application, and locate the 
Show CI Acknowledgment column in the Filtering Properties area, and select 
false (hide the Ack column), or true (display the Ack column). The change 
takes effect immediately. 

Note: When you hide the Ack column, the Acknowledgment-related context 
menu options remain available. For details, see “Menu Options” on page 75.

 3 Acknowledge a Problem
You can acknowledge a problem by clicking the Ack check box for a CI in 
the Console, and Filters tabs (you can clear the acknowledgment by 
selecting the check box again). For details, see “Acknowledgments Details 
Dialog Box” on page 109.

The acknowledgment icon is displayed in Top View for CIs corresponding to 
acknowledged problems. 

You can unset the acknowledgement by clicking the icon, in the Console 
and Filters tabs. 

You can also set/unset acknowledgment and view the CI acknowledgment 
history by using the context menu in the Top View, Console, and Filters 
tabs.

Note: The Ack check box is enabled only if there is at least one KPI defined 
for the CI, and at least one of the KPIs has a status other than OK (green).
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Example – Set an Acknowledgment

To acknowledge a problem, click the down arrow to the right of a CI and 
select Acknowledgement > Set/Unset Acknowledgment (you can unset the 
acknowledgement by selecting the same option and clicking OK).

In the Add details box, enter information about the acknowledgment.

Click OK to set or unset the acknowledgment depending on the previous 
status of the dialog box.

 4 View a Problem’s History
After a problem CI is acknowledged, or the acknowledged status is cleared, 
you can view the history in the Acknowledgment History and Details dialog 
box. For details, see “Acknowledgment History and Details Dialog Box” on 
page 108.
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Example – View Acknowledgment Details

A tooltip for the Ack icon displays the current status of the CI’s 
acknowledgment.

To view the details of the current acknowledgment or the acknowledgment 
history of the CI, click the down arrow to the right of a CI and select 
Acknowledgement > Acknowledgment Details. You can then select one of 
the following options:

➤ Acknowledgment details. Displays the details of the currently opened 
acknowledgment in the Acknowledgment details box.
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➤ CI history. Displays the details of all of the acknowledgments over time in 
the Acknowledgment details box.

The Acknowledgment details box displays the date and time when the 
acknowledgment status was modified, the name of the user who modified 
the status, and the type of action that was performed. For details, see 
“Acknowledgment History and Details Dialog Box” on page 108.

You can add information about the actions you are going to perform to 
solve the problem in the Add details box and then click Add to add the 
information you entered to the acknowledgment history.
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Switch Off the Alert Sound When CI is Acknowledged

If you set up for sound notification when a KPI’s status changes to Critical, 
you can select to turn the sound off when the KPI’s CI is acknowledged. This 
way, you do not get sound notification when any of the acknowledged CI’s 
KPIs status changes to Critical.

This task includes the following steps:

➤ “Set Up Sound Notification” on page 107

➤ “Set Up Mute When Acknowledge Option” on page 107

 1 Set Up Sound Notification 
Set up the sound notification. For details, see “Set Up Sound Notification 
When KPI Status Changes to Critical” on page 67.

 2 Set Up Mute When Acknowledge Option
Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Mute 
When Acknowledged entry in the Dashboard Application - Sound 
Notification table. Modify the value to true to mute the alert or to false to 
hear the alert. The change takes effect immediately. 

Reference

Acknowledge Problems User Interface

This section describes:

 ➤  Acknowledgment History and Details Dialog Box on page 108

 ➤  Acknowledgments Details Dialog Box on page 109
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Acknowledgment History and Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view the details of the current 
acknowledgment or the acknowledgment history of 
the CI.

To Access: Click the down arrow  to the right of a CI or 
right-click a CI in View Explorer and select 
Acknowledgment > Acknowledgment details. 

Included in Tasks “Acknowledge Performance Problems” on page 102

GUI Element (A-Z) Description

Acknowledgment 
details

Select to display the details of the currently opened 
acknowledgment in the Acknowledgment details box. 

Action The type of action that was performed:

➤ Clear. When the acknowledgment history was 
cleared.

➤ Unset. When the acknowledgment was unset.

➤ Info. Details were added to the acknowledgment 
without changing the acknowledgment status.

➤ Open. When the acknowledgment was set.

➤ Edit. When details were added to the 
acknowledgment.

Add Click the Add button to add the contents of the Add 
details box to the acknowledgment history.

Add details Add information about the actions you are going to 
perform to solve the problem. You can add information 
whether the acknowledgment is Open or Closed.

CI history Select to display the details of all of the 
acknowledgments over time in the Acknowledgment 
details box.

Clear Click the Clear button to clear the acknowledgment 
history.
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Acknowledgments Details Dialog Box

Date The date and time when the acknowledgment status 
was modified.

Message Displays the status of the acknowledgment or the 
information that was entered in the Add details box.

User The name of the user who modified the status.

Description Enables you to set or unset a CI acknowledgment.

To Access: 

➤ Click the down arrow  to the right of a CI and 
select Acknowledgment > Set/Unset 
Acknowledgment to open the Set/Unset 
Acknowledgment dialog box.

➤ Click the Ack icon to the right of the CI.

Important 
Information

The Ack check box is enabled only if there is at least 
one KPI defined for the CI, and at least one of the KPIs 
has a status other than OK (green).

A tooltip for the Ack icon displays the current status of 
the CI’s acknowledgment. 

The dialog box is a toggle dialog box. If you have 
acknowledged the CI, the top line in the dialog box is: 
The acknowledgment will be unset. If you have not 
acknowledged the CI, the top line in the dialog box 
displays: The acknowledgment will be set.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Add details Add information about the actions you are going to 
perform to solve the problem. You can add information 
whether the acknowledgment is Open or Closed.

OK Click the OK button to set or unset the acknowledgment 
depending on the previous status of the dialog box.
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3
Monitor Changes in Dashboard 

This chapter includes information about monitoring changes in Dashboard.

This chapter includes:

Concepts

 ➤  Monitoring Changes in Dashboard Overview on page 111

Tasks

 ➤  Analyze Real-Time Change Information on page 112

 ➤  View Changes for a Specific CI on page 115
Concepts

Monitoring Changes in Dashboard Overview

You can monitor changes made to CIs using the following capabilities:

➤ You can monitor the changes to CI properties in Dashboard by selecting the 
properties you want to monitor for changes for up to 20 CITs. Change icons 
displayed for the appropriate CIs, in the Console tab and in the Filters tab, 
indicate that changes were made to their change-monitored properties, in 
real time. You can view changes made to the monitored properties of 
additional CIs in the Change report. For details, see “Analyze Real-Time 
Change Information” on page 112.

➤ You can monitor the detailed changes logged by Change Control 
Management for a selected CI, if you are working with Change Control 
Management. For details, see “View Changes for a Specific CI” on page 115.
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➤ You can monitor the planned and actual changes made to the following 
CITs: History Attribute Change, History Relation Change, Planned Change, 
and IT Incident. For details, see “Changes and Incidents Tab” on page 165.

Tasks

Analyze Real-Time Change Information

This section describes the steps to follow to display real-time change 
information in the Console and Filters tabs, and in the Change report.

This task includes the following steps:

➤ “Set the CIT to Monitor Changes to Its Properties” on page 112

➤ “Set Dashboard to Monitor Changes” on page 113

➤ “Customize the Change Period” on page 113

➤ “Customize the Number of CIs Monitored for Real-Time Change” on 
page 114

➤ “View Real-Time Changes” on page 114

 1 Set the CIT to Monitor Changes to Its Properties
Configure up to 20 CIs that you want to monitor for changes to a specific 
property. The significant properties vary for each CIT. 

When the monitor changes option has been set for a CI, Dashboard 
continuously monitors that CI and all its child CIs, to see if a change occurs 
in one of the significant properties defined for the CIs.

You can set the monitor changes option for up to 20 CIs. After you configure 
20 CIs, a message is displayed when you try to set the option for another CI, 
stating that the limit has been reached. 

For each configuration item type (CIT) properties you want to monitor, 
select Admin > Universal CMDB > Modeling > CIT Type Manager, click the 
Attributes tab, select the CIT, click the Add button , and select Change 
Monitored in the Advanced area in the Add/Edit Attribute dialog box. For 
details, see “Add/Edit Attribute Dialog Box” in Model Management.
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 2 Set Dashboard to Monitor Changes
To display real-time changes for a CI and its children, select Admin > 
Dashboard > KPI, select the appropriate CI and select the Monitor changes 
check box.

If you clear the option for one or more of the configured CIs, the option 
becomes available for all CIs, until the 20 CIs limit is reached.

 3 Customize the Change Period
By default the Change icon is displayed for 24 hours (default value) after a 
change occurs. To modify the default time period (set at 1440 minutes (24 
hours)) select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, click Applications context, select Dashboard Application, locate 
the Changes period in the Change Impact Properties area, and enter the 
time period (in minutes) in the Value box. The recommended value is the 
default: 1440 minutes.

Note: The change takes effect after the server has been restarted.
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 4 Customize the Number of CIs Monitored for Real-Time Change
In the Console tab and in the Filter tab, a limited number (20 by default) of 
CIs and their child CIs can be monitored for real-time changes at any one 
time. This number can be customized.

Note: You can increase the default number of CIs that can be monitored but 
be aware that this might overload HP Business Availability Center.

To modify the default number of CIs that can be monitored for change in 
real-time, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications context, select Dashboard 
Application, and modify the value of the Maximum monitored CIs 
parameter in the Change Impact Properties area. The recommended value is 
20.

Note: The change takes effect after the server has been restarted.

For more information about real-time monitoring for change, see “Analyze 
Real-Time Change Information” on page 112.

 5 View Real-Time Changes
If a change occurs in one of the significant properties of the CI or the CI’s 
child CIs, you can view real-time changes as follows:

➤ Changes made to the first 20 CIs set to display real-time changes are 
displayed with change icons in the Console tab or in the Filters tab. To 
access the tabs, select Applications > Dashboard, select a view and click the 
Console or Filters tab.

➤ Changes made to other CIs are displayed in the Change report. The Change 
report enables you to view the changes made to CI’s properties for all 
properties that were selected to keep this information. For details, see 
“Change Report Page” in Model Management.
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View Changes for a Specific CI

To view details of the changes logged by Change Control Management for a 
selected CI, select Applications > Dashboard, select the relevant CI in View 
Explorer, and select the Changes and Incidents tab in the Console tab. For 
details, see “Changes and Incidents Tab” on page 165.



Chapter 3 • Monitor Changes in Dashboard

116



117

4
Dashboard Top View

This chapter describes Dashboard Top View.

This chapter includes:

Concepts

 ➤  Top View Overview on page 118

Tasks

 ➤  Display and Customize View Information in Top View on page 121

 ➤  Customize Top View Display on page 122

 ➤  Access an External Application from Top View on page 132

Reference

 ➤  Dynamic URL Parameters on page 134

 ➤  Top View User Interface on page 135
Concepts
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Top View Overview

Top View enables you to see the business availability of your system 
components at a glance. The CI bars in the tab provide a visual 
representation of real-time IT performance metrics mapped onto business 
applications, based on the hierarchy tree structure defined for each view. 
The connecting lines between the bars define the relationships between the 
CIs. For a detailed description of Top View, see “Top View Page” on 
page 136.  

By presenting an integrated, single view of essential applications and 
business processes, Top View provides you with an overall perspective on 
the health of your business services, and enables you to instantly assess how 
a performance issue impacts the availability of any part of your business. 
Each CI in the active view is color coded to indicate the worst status held by 
the CI’s KPIs.
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This section includes the following topics:

➤ “Interactive Map” on page 119

➤ “Understanding the Colors and the Icons” on page 119

➤ “Virtual Containers” on page 120

Interactive Map
The Top View tab presents an interactive map of the CIs that can be 
intuitively manipulated using the mouse, enabling you to drill down to 
specific branches of the tree and to focus on particular business areas or 
problem areas.

By default, the Top View tab displays four levels of CIs. The rest of the CIs 
are collapsed. You can expand CIs from the fourth level and see their child 
CIs.

The lines connecting the bars represent the branches of the tree. The bars 
and lines can be manipulated to change the amount of information 
displayed and the overall layout of the diagram, as described in “Top View 
Page” on page 136.

Understanding the Colors and the Icons
Each CI contained in the view is displayed as a bar, color-coded according to 
the current worst operational status for that CI. For details on color coding, 
see “KPI Status” on page 355.

The icons displayed under a CI bar identify the relevant KPIs for the CI. 
These icons are also color coded to indicate the status of that KPI. 
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Note: The root CI does not display KPI icons because it is a container and 
not a real CI.

For a list of the KPIs used in Dashboard, see “List of Dashboard KPIs” on 
page 512.

Virtual Containers
Virtual container CIs are displayed in Top View in regular CI bars, but their 
names appear between brackets. The bar is color-coded according to the 
current worst operational status for the group CI’s children CIs. You cannot 
right-click the bar to display context menu options.

Virtual containers are created by selecting the attribute by which you want 
to group the CIs in pattern views. For details, see “Node/Relationship 
Grouping Dialog Box” in Model Management.

Tasks
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Display and Customize View Information in Top View

This section describes the steps needed to display a view information in Top 
View, and gives examples.

This task includes the following steps:

➤ “Access Top View and Display the View Information” on page 121

➤ “Customize the Top View Display” on page 121

➤ “Filter the Relevant Information in Top View” on page 121

 1 Access Top View and Display the View Information
Select Applications > Top View to display the CIs of the selected view in a 
top-down, graphical diagram. Select the required view from View Explorer. 
The name of the selected view is displayed in the central bar of the diagram. 

The configuration items (CIs) in the view are displayed in hierarchical 
format within a single, interactive graphical interface. 

For details, see “Top View Page” on page 136.

 2 Customize the Top View Display
You can customize the layout of the hierarchy, use Chinese or Japanese 
characters, change the background or the bar’s colors, the fonts, and more.

For details on the available customizations, see “Customize Top View 
Display” on page 122.

 3 Filter the Relevant Information in Top View
Use context menu options to filter parts of the hierarchy and to handle 
acknowledgments. 

For details, see “Menu Options” on page 75.
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Customize Top View Display

You can customize the Top View display.

Note: All the steps in this task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Customize the Layout of the Hierarchy in Top View” on page 123

➤ “Modify the Default Refresh Rate of Top View” on page 125

➤ “Change the KPI Status Icons” on page 125

➤ “Viewing Chinese or Japanese Characters in Top View” on page 126

➤ “Change the Text Color in Top View Bars” on page 126

➤ “Change Fonts in Top View” on page 126

➤ “Change the Caption Font Size in Top View” on page 127

➤ “Modify the Number of CIs Displayed in Top View” on page 127

➤ “Specify the Maximum Length of the Line Between Two CIs” on page 127

➤ “Change the Number of CI Levels Displayed in Top View” on page 128

➤ “Change the Number of CI Levels That Can Be Expanded in Top View” on 
page 128

➤ “Hide or Display the View Bar in Top View When the View has a Single Root 
CI” on page 129

➤ “Change the Color of the CI Bar in Top View When the CI Status is OK” on 
page 129

➤ “Customize the Background Image for Top View” on page 130

➤ “Customize Top View Tooltips” on page 130

➤ “Set Up the Top View Debugging Mechanism” on page 131
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 1 Customize the Layout of the Hierarchy in Top View
You can customize the layout of the hierarchy in the Top View page. By 
default, the parent CI is displayed above the child CIs and the child CIs are 
close to the bottom part of the Top View tab.

To customize the layout of the hierarchy, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Top View Graph Layout entry in the 
Top View Properties area. Select the type of layout (listed below in 
alphabetical order).

Type of Layout Description

BOTTOM Default. The parent CI is above the child CIs and is 
centered on the page. 

LEFT The child CIs are to the left of the parent CI and the 
parent CI is centered on the page. 
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RADIAL The second level of the tree is distributed around 
the parent and the parent is centered on the page.

RIGHT The child CIs are to the right of the parent CI and 
the parent CI is centered on the page. 

Type of Layout Description
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Note: The change takes place immediately.

 2 Modify the Default Refresh Rate of Top View
The default refresh rate for Top View is 30 seconds. To modify the default 
refresh rate, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and enter the required refresh rate in the Top View data refresh rate entry in 
the Dashboard Application - Top View Properties table. 

 3 Change the KPI Status Icons
You can use different status icons. For details, see “Change the KPI Status 
Icons” on page 394.

TOP The parent CI is under the child CIs and is centered 
on the page. 

Type of Layout Description
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 4 Viewing Chinese or Japanese Characters in Top View
To view Chinese or Japanese characters in Top View, install the Chinese or 
Japanese packages. For details, see “Working in Non-English Locales” in 
Reference Information.

 5 Change the Text Color in Top View Bars
You can improve readability or customize Top View by changing the color of 
the text in Top View bars. 

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Top View 
Text Color Property entry in the Dashboard Application - Top View 
Properties table. Enter the appropriate color in the Value box, using the 
#RRGGBB format. Default is white (#FFFFFF). 

You must close all browser instances for the change to take effect.

Note: The setting affects both Top View in Dashboard and the Top View 
portlet in My BSM. 

 6 Change Fonts in Top View
To change the font displayed in Top View for all locales, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and locate the Top View Font 
Name entry in the Dashboard Application - Top View Properties table. Enter 
the appropriate font name in the Value box.

You must close all browser instances for the change to take effect.
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 7 Change the Caption Font Size in Top View
By default the size of the fonts used for Top View CI names (in the bars) is 9.

To change the default size, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the required value in the Top View 
caption font size entry in the Dashboard Application - Top View Properties 
table.

The change is immediate.

 8 Modify the Number of CIs Displayed in Top View
The maximum number of CIs displayed in Top View is 3000 by default.

To change the default value, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the required value in the Maximum 
number of nodes entry in the Dashboard Application - Top View Properties 
table. 

The change is immediate.

 9 Specify the Maximum Length of the Line Between Two CIs 

The default percentage by which you can extend the line between two CIs is 
1.5. This is a parameter of the applet that displays the view tree. 

To modify the default percentage, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the required value in the Top View Line 
Extension Percentage entry in the Dashboard Application - Top View 
Properties table. 

The change is immediate. 
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 10 Change the Number of CI Levels Displayed in Top View
By default, the Top View tab displays four levels of CIs. The rest of the CIs 
are collapsed. You can then expand a CI at the fourth level and see its 
children.

To modify the number of levels displayed when you open the Top View tab, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Top View 
Number of Levels entry in the Dashboard Application - Top View Properties 
table. Modify the value. Valid values are 2 to 100. This change is performed 
during the next log in. If you select 2, the name of the view and the top 
level CIs are displayed.

 11 Change the Number of CI Levels That Can Be Expanded in Top 
View
To change the default setting (7) for the number of levels of CIs that are 
displayed when you select the Expand more levels context menu item, on 
the Infrastructure Settings page, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Top View expand levels entry in the 
Dashboard Application - Top View Properties table. Modify the value. Valid 
values are 2 to 12. This change is performed during the next log in.
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 12 Hide or Display the View Bar in Top View When the View has a 
Single Root CI
You can select to hide or display the view bar in the Top View tab, when the 
view has a single root CI. 

To hide or display the view bar in Top View when the view has a single root 
CI, select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, choose Applications, select Dashboard Application, and locate the 
Hide view bar in Top View entry in the Top View Properties table. Set the 
parameter to:

➤ true. The view bar is not displayed as the root of the hierarchy, the root of 
the hierarchy is the single root CI. 

➤ false. The view bar is the root of the hierarchy. 

 13 Change the Color of the CI Bar in Top View When the CI Status 
is OK
You can modify the default green color (#66CC00) of the CI bar when the CI 
status is OK to another color or a different green. 

To modify the color, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and enter a different color in the Top View Green Color Property entry in 
the Top View Properties table. 
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 14 Customize the Background Image for Top View
To change the background color or add a background image to the Top View 
tab or to the NOC standalone page, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Applications, and locate in the Dashboard Application - Top 
View table:

➤ Top View Background Color Property. Modify the default value to change 
the color of the Top View tab background or of the NOC standalone page 
background. For example, you can display the Top View tab with a black 
background (#000000). You must close all browser instances for the change 
to take effect.

➤ Top View Background Image. Enter the name of the image you want to use 
as a background image for the Top View tab or the NOC standalone page 
and put the appropriate image in the following location: 
<Gateway server root directory>/AppServer/webapps/site.war/bam/

You must close all browser instances for the change to take effect.

 15 Customize Top View Tooltips
You can:

➤ Limit the number of lines displayed in the tooltip

If the tooltip includes more lines than the default number of lines, More... is 
displayed on the last line.

To change the default number of lines (8) displayed in the tooltip, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and enter the required 
number of lines in the Max lines in tooltip entry in the Dashboard 
Application - Top View Properties table.

➤ Modify the tooltip font size

The size of the fonts in Top View tooltips is 8 by default.

To change the default font size, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and enter the required font size in the Top View 
Tooltip font size entry in the Dashboard Application - Top View Properties 
table.
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➤ Display the weight information in the tooltip

You can add the weight of a CI’s KPIs to the CI’s tooltip for any CI in Top 
View. 

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Show 
weight property in tooltip entry in the Dashboard Application - Top View 
Properties table. Modify the value to true. Default is false (weight is hidden).

Note: 

➤ The setting affects both Top View in Dashboard and the Top View portlet 
in My BSM. 

➤ Using this option might affect the performance.

➤ Adding a weight to a CI is explained in “Relationship Page” in Model 
Management.

 16 Set Up the Top View Debugging Mechanism
To debug Top View, set the debug mode. Log messages are printed to the 
Java console.

To debug Top View, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and set the Top View Debug entry in the Dashboard Application - Top View 
Properties table to true. Default is false.
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Access an External Application from Top View

You can configure Dashboard Top View so that a user can open an external 
application from the right-click menu. 

This task includes the following steps:

➤ “Specify the URL of the External Application” on page 132

➤ “Attach the Open in New Window Context Menu Item to the Top View 
Context Menu” on page 133

➤ “Result” on page 133

 1 Specify the URL of the External Application
The Open in New Window option calls the specified URL in another 
window and supplies it with the values of the parameters you specified in 
the URL. The URL page uses the values of the parameters to display what is 
necessary. 

To specify the URL of the external application, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and locate the Top View URL to Open entry in 
the Top View Properties table. Enter the appropriate URL:

➤ Enter the URL of the application.

➤ Enter a dynamic URL that can be used, for example, to integrate external 
tools with HP Business Availability Center.

Use the following syntax (HTTP GET format):

Use only the parameters you need in any combination. For details about the 
parameters, see “Dynamic URL Parameters” on page 134.

For example:
http://<URL>?nodeName=NODE.NAME&nodeParentId=NODE.PARENTID
adds the CI name and the ID of the parent CI to the URL.

http://<URL>?nodeName=NODE.NAME&nodeId=NODE.ID
&nodeStatus=NODE.STATUS&nodeParentId=NODE.PARENTID
&nodeChildId=NODE.CHILDIDS
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➤ To reset the URL to the default (empty), click Default.

Note: 

➤ The change takes place immediately.

➤ You must disable your browser’s pop-up blockers to open a window with 
the external application.

 2 Attach the Open in New Window Context Menu Item to the 
Top View Context Menu
By default, the Open in New Window option does not appear in the context 
menus in Top View. To enable it you must assign it to the Top View context 
menu.

 a Select Admin > Dashboard > Repositories > Context Menus, and override 
the Top View context menu. 

 b In the Custom Context Menus area, click the Edit button for the Top 
View context menu. 

 c In the Context Menu Details dialog box, click New. 

 d In the Menu Entity Details, in the Context Menu Item list, select Show in 
top view and in the Sub–context Menu Items list, select Open in a new 
window. 

 e Click OK. 

 3 Result
The Open in New Window option is added to the right-click menu available 
in Top View.

Reference
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Dynamic URL Parameters

The parameters for a dynamic URL are: 

Constant Description

NODE.NAME The name of the CI. When the URL is executed, 
NODE.NAME is replaced by the name of the CI from 
which you want to open the URL The page specified 
in the URL opens and is filtered to display only 
information related to the CI.

NODE.ID The ID number of the CI. When the URL is 
executed, NODE.ID is replaced by the ID number of 
the CI from which you want to open the URL The 
page specified in the URL opens and is filtered to 
display only information related to the CI.

NODE.STATUS The status of the CI. When the URL is executed, 
NODE.STATUS is replaced by the status of the CI 
from which you want to open the URL The page 
specified in the URL opens and is filtered to display 
only information related to status. The available 
statuses are:

-4 downtime

-3 stop

-2 no data

-1 uninitialized

0 critical

5 major

10 minor

15 warning

NODE.PARENTID The ID of the parent CI. When the URL is executed, 
NODE.PARENTID is replaced by the ID of the parent 
of the CI from which you want to open the URL. 
The page specified in the URL opens and is filtered 
to display only information related to the parent CI.
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Top View User Interface

This section describes:

 ➤  Top View Page on page 136

NODE.CHILDIDS The ID number of the CI children. When the URL is 
executed, NODE.CHILDIDS is replaced by a list of 
the IDs of the children of the CI from which you 
want to open the URL. The page specified in the 
URL opens and is filtered to display only 
information related to the children CI.

NODE.NAME The name of the node.

NODE.ID The ID number of the node.

NODE.STATUS To filter by status, use NODE.STATUS.

NODE.PARENTID The ID of the parent CI.

NODE.CHILDIDS The ID number of the CI children.

Constant Description
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Top View Page

The following is an example of the Top View page. 
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Description Enables you to see the business availability of your 
system components at a glance. The CI bars in the tab 
provide a visual representation of real-time IT 
performance metrics mapped onto business 
applications, based on the hierarchy tree structure 
defined for each view. The connecting lines between 
the bars define the relationships between the CIs.

To Access: Select Applications > Dashboard, select a 
view in View Explorer, and click the Top View tab.

Important 
Information

Do not select a new view in the Role-Based Views list 
until the currently selected view has finished loading. 
Doing so may cause the browser to freeze. If this 
happens, close the Top View page, then close any other 
open pages, and reopen the page.

Note: You can add this report as a portlet in My BSM. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BSM.

Functionality:

➤ Click anywhere in the tab to change the emphasis of 
the graphic. The graphic rotates to display the 
components of the subtree for the nearest bar.

➤ Click and drag anywhere in the tab to move and 
rotate the graphic around that point.

➤ Increase or reduce the gap between each branch by 
holding down the ALT button on the keyboard and 
dragging the relevant bar.

➤ When you open the Top View tab, it displays by 
default the active view at the root level, centered 
around the view name bar. Any manipulation you 
do to the graphic is not saved; if you move to 
another tab, then when you return to Top View, the 
graphic reverts to the default display format.

➤ Double-click one of the following icons  to 
expand or collapse the CI’s subtree.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Included in Tasks “Display and Customize View Information in Top 
View” on page 121.

Useful Links “Top View Overview” on page 118

For details on the functionality of View Explorer, see 
“Working with View Explorer” in Model Management.

GUI Element (A-Z) Description

<CIs, Child CIs, and 
Root CIs>

The tree is built from branch parent and child 
configuration items (CIs) and monitor CIs. For details, 
see “Working with CIs” in Model Management. 

Right-click a bar to display the context menu options. 
For details, see “Menu Options” on page 75.

Click a bar to move the bar to the center of the graphic.

When you select a CI in View Explorer, Top View 
displays the selected CI centered in the tree with all its 
sub-branches expanded. If you select a CI in the Top 
View tree, it is highlighted in the View Explorer. 

<KPIs and their 
statuses/values>

For each CI, Dashboard displays the CI’s KPIs and their 
real-time status as a color-coded icon. For details, see 
“KPI Status” on page 355.

For details on the icons, see below.

<Right-click menu 
options>

Right-click a CI bar to list the available menu options. 
For details, see “Menu Options” on page 75.
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<View bar> When you select a view in View Explorer, Top View 
displays the selected view bar centered in the tree with 
all its root CIs expanded. 

➤ Expand and collapse the branches of a subtree by 
clicking the expand (+) or collapse (-) symbols, 
displayed in the bottom right corner of the bar. 

➤ When branches are too long to fit on the screen, Top 
View displays lines emerging from the bar, to 
indicate the number of branches and leaves that are 
hidden. Click the end of one of these lines to display 
the entire hidden branch.

Hold the cursor over a bar to enable the following 
functionality:

➤ The bar is outlined in grey.

➤ If the CI has a long name, the bar expands to display 
the full name.

➤ A tooltip provides status and performance data for 
all the KPIs of the CI. When you hold the cursor 
over a KPI icon a tooltip is displayed and provides 
status and performance data for the KPI itself.

Right-click the bar to display the available menu 
options. For details, see “Menu Options” on page 75.

GUI Element (A-Z) Description
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KPI Icons in Top View
A CI can have one of the following icons:

<View Explorer> When you select a CI in View Explorer, Top View 
displays the selected CI centered in the tree with all its 
sub-branches expanded. If you select a CI in the Top 
View tree, it is highlighted in the View Explorer. 

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

NOC View Click to display the top view tree in a separate window 
to be used by a Network Operations Center (NOC). 

To return to the Top View tab, close the Top View 
standalone window.

Only one instance of Top View can be displayed at a 
time; this means that if you are displaying the top view 
in the NOC View standalone window, you do not see it 
in the Top View tab and vice versa. 

Right-click a bar, in the view, to display the available 
menu options. For details, see “Menu Options” on 
page 75.

Icon Description

All other KPIs (with OK status)

Availability KPI (with OK status)

Backlog KPI (with No data Status)

Business Health KPI (with Major status)

Customer KPI (with OK status)

GUI Element (A-Z) Description
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Note: 

In the Top View tab, the icon for a CI with a Stopped or Downtime status CI 
is gray with a green border.

You can customize the set of icons used in Dashboard. For details, see 
“Change the KPI Status Icons” on page 394.

Duration KPI (with OK status)

OT Impact KPI (with OK status)

Performance KPI (with OK status)

PNR KPI (with OK status)

RT Impact KPI (with OK status)

System/HP System KPI (with OK status)

The CI has been acknowledged

User KPI (with OK status)

Volume KPI (with OK status)

Icon Description
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5
Dashboard Console

This chapter describes the Dashboard Console.

This chapter includes:

Concepts

 ➤  Console Overview on page 143

Tasks

 ➤  Customize the Console Page on page 147

 ➤  Customize the Hierarchy Tab on page 148

 ➤  Customize the Business Impact Tab on page 150

Reference

 ➤  Console User Interface on page 151
Concepts

Console Overview

The Console page enables you to view, in one central location, 
comprehensive data regarding the CIs selected in View Explorer. For each CI, 
the Console page tabs provide information regarding the CI’s hierarchy, 
KPIs, business impact, alerts, and changes and incidents.

If you set up an EMS Integration with Netuitive, the Console also displays 
Netuitive alarms. For details, see “Netuitive SI Integration” in Solutions and 
Integrations.
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For details on the Console page user interface, see “Console Page” on 
page 152. For customization options, see “Customize the Console Page” on 
page 147.

This section includes the following topics:

➤ “Hierarchy” on page 144

➤ “KPIs” on page 144

➤ “Business Impact” on page 145

➤ “Alerts” on page 145

➤ “Changes and Incidents” on page 145

➤ “Netuitive Alarms (optional)” on page 146

Hierarchy
This tab enables you to see child CIs and their KPI statuses. If you select a 
view in View Explorer, the top level CIs in the view are displayed. If you 
select a CI in View Explorer, this tab shows its child CIs. For each CI, the tab 
shows its assigned KPIs and their statuses.

For details on the Hierarchy tab user interface, see “Hierarchy Tab” on 
page 157. For customization options, see “Customize the Hierarchy Tab” on 
page 148.

KPIs
This tab enables you to see KPI status over time for the CI selected in View 
Explorer. 

In addition, if you have configured federation adapters to collect KPI values 
for this CI from outside HP Business Availability Center, this tab also 
displays the federated KPI’s status, last status change, and the source of the 
federated KPI. For details on setting up federation, see “The Federation 
Framework SDK” in Model Management.

For details on the KPIs tab user interface, see “KPIs Tab” on page 159.
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Business Impact
This tab enables you to see the business CIs and SLAs that are impacted by 
the CI selected in the active Dashboard view. 

The following impacted CI types are monitored by default: Business 
Services, Business Processes, and Applications. For details on how to 
customize business impact information, see “Customize the Business Impact 
Tab” on page 150.

From this tab you can also access the selected CI’s corresponding Business 
Impact Report. For details, see “Business Impact Report” on page 95.

For details on the Business Impact tab user interface, see “Business Impact 
Tab” on page 161.

Alerts
This tab enables you to see the CI status alerts triggered by the CI selected in 
View Explorer. 

To view information on the action taken following the alert, you can access 
the selected CI’s Status Alerts Report directly from this tab. For details, see 
“Configuration Item Status Alerts Report” in Alerts.

For details on the Alerts tab user interface, see “Alerts Tab” on page 164.

Changes and Incidents
This tab enables you to see the incidents opened for the CI selected in View 
Explorer, as well as planned changes and actual changes made to the CI.

Information on incidents and planned changes is collected from CMDB 
federation adapters. Federation adapters may be set up within HP Business 
Availability Center (such as the out-of-the-box adapter History Data Source), 
or outside HP Business Availability Center (such as Release Control or 
HP Service Manager). For details on setting up federation, see “The 
Federation Framework SDK” in Model Management. For details on the 
integration with HP Service Manager, see “HP Service Manager Integration 
with Business Availability Center Components” in Solutions and Integrations
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Information on actual changes is collected for CIs on the local machine, 
directly from the CMDB.

For details on the Changes and Incidents tab user interface, see “Changes 
and Incidents Tab” on page 165.

Netuitive Alarms (optional)
Alarms generated in Netuitive can be displayed in the Console if you set up 
an EMS Integration with Netuitive. For details, see “Netuitive SI Integration” 
in Solutions and Integrations.

If you set up this integration, your Dashboard Console contains an 
additional tab called Netuitive Alarms, which contains details on the alarms 
generated by Netuitive for the selected CI and for its child CIs. Alarms are 
shown for Host CIs, BPM Transaction from Location CIs, and Business 
Process Step CIs.

For details on the user interface, see “Netuitive Alarms Tab” on page 169.

Note: Some of the Console tabs show data that is collected from external 
systems (outside Business Availability Center). If an external system is not 
responding, the following message appears: External system is not 
responding.

Tasks
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Customize the Console Page

To customize the Console page, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications, and select Dashboard 
Application.

Within Dashboard Application, you can customize the Console page general 
settings using the following options:

➤ “Rename or Delete Tabs Displayed in the Console Page” on page 147

➤ “Modify Duration Settings for Console Tabs” on page 147

➤ “Modify Refresh Rates of the Tabs Displayed in the Console Page” on 
page 148

 1 Rename or Delete Tabs Displayed in the Console Page
To rename or delete a tab on the Console page, locate the View Console tabs 
configuration entry in the Dashboard Layout Properties table. 

➤ Within this XML file, each of the title fields shows a resource string key 
found in the <HP Business Availability Center home directory> 
\HPBAC\AppServer\resources\BamResources.properties file. If you edit 
the title field so that it no longer shows a valid resource string key, the text 
in the title field is used as the tab name. 

For example, to rename the Hierarchy tab as the Child CI tab, replace the 
text <title>view360.tab.title.hierarchy</title> with <title>Child CI</title>.

➤ To delete a tab, delete the section within the XML file beginning with 
<TabConfig> and ending with </TabConfig>, which contains information 
on the tab you want to delete.

 2 Modify Duration Settings for Console Tabs
By default, the Alerts tab displays KPI over time data for the previous day, 
and the KPIs, Business Impact, Changes and Incidents, and Netuitive Alarms 
tabs display data for the previous week. 

For each of these tabs, you can change these settings to previous week, day, 
or hour (up to the current time).
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To modify the KPI over time setting, locate the View Console tabs 
configuration entry in the Dashboard Layout Properties table. Modify the 
TimeRange entry value in the View Console tabs configuration entry. The 
possible values are:

➤ Scorecard.Portlet.Edit.TimeRange.PastHour

➤ Scorecard.Portlet.Edit.TimeRange.PastDay

➤ Scorecard.Portlet.Edit.TimeRange.PastWeek

 3 Modify Refresh Rates of the Tabs Displayed in the Console Page
By default, the Hierarchy tab and the Netuitive Alarms tab are refreshed 
every 30 seconds, and the other Console tabs are refreshed every five 
minutes. 

To modify refresh rates, locate the View Console tabs configuration entry in 
the Dashboard Layout Properties table. Modify the value of the refreshRate 
field in the View Console tabs configuration entry. Refresh rate is a value in 
seconds.

If you leave the refresh rate field blank, the default refresh rates apply. 
However, the <refreshRate/> field must exist in the xml to enable data 
display.

Customize the Hierarchy Tab

To customize the Console page tabs, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings > Applications, and select Dashboard 
Application.

Within Dashboard Application, you can customize the Hierarchy tabs using 
the following options:

➤ “Modify the Number of Levels Displayed in the Hierarchy Tab” on page 149

➤ “Display Children Expanded in the Hierarchy Tab” on page 149

➤ “Display Hierarchy Information in Columns” on page 149

➤ “Add a Details Link to CIs in the Hierarchy Tab” on page 149



Chapter 5 • Dashboard Console

149

 1 Modify the Number of Levels Displayed in the Hierarchy Tab
By default, when you select a CI or view in View Explorer, the Hierarchy tab 
displays the CI’s children (or the parent CIs in the view), which can be 
expanded to show their children. This represents two levels of hierarchy 
display.

To modify the number of levels that can be displayed in the Hierarchy tab, 
locate the Business Console - Number of display levels entry in the 
Dashboard Layout Properties table. You can select a value between 1 and 4. 
If you specify 1, the child CIs are displayed but cannot be expanded.

 2 Display Children Expanded in the Hierarchy Tab
By default, when you select a CI (or view) in View Explorer, the Hierarchy 
tab displays the CI’s children (or the parent CIs in the view), collapsed.

To display the children expanded when accessing the Hierarchy tab, change 
the Business Console - Default state in the Dashboard Application - 
Dashboard Layout Properties table to expanded.

 3 Display Hierarchy Information in Columns
By default, the Hierarchy tab displays a single table. To display the Hierarchy 
tab information in two or three columns, open the Business Console - 
Number children sections in the Dashboard Application - Dashboard Layout 
Properties table, and specify the number of columns you want to display. 
You can select a number between 1 and 3.

 4 Add a Details Link to CIs in the Hierarchy Tab
You can add a Details link to the CIs displayed in the Hierarchy tab, to 
display CMDB details such as CMDB ID, CMDB Property names and values, 
and KPI calculation results.

In the Dashboard Application - Dashboard Layout Properties table, modify 
the Show element CMDB details link in UI entry. Default is false. For a list of 
the details displayed in this link, see “Node Details Dialog Box” on page 94.
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Customize the Business Impact Tab

By default, the Business Impact tab can show the following CI types (CITs), 
if they are have an Impact relationship with the selected CI: Business 
Services, Business Processes, and Applications.

The following section describes how to modify which CITs can be displayed 
in the Business Impact tab, or which relationships are monitored in this tab.

Note: If you make changes using the following procedure, these changes are 
also reflected in the Business Impact Report. For example, if you add a CIT 
to be displayed in the Business Impact tab, this CIT also appears in the 
Business Impact Report. For details on this report, see “Business Impact 
Report” on page 95.

To modify which CITs are displayed in the Business Impact tab:

 1 Select Admin > Universal CMDB > Modeling > Query Manager, and select 
the SearchForBusinessImpact query.

Within this query, the ITU_Triggered node represents the CI selected in a 
view, and the Business_Impacted node represents the CITs which can be 
impacted by this CI.

 2 Right-click the Business_Impacted node and select Node Properties to open 
the Node Properties dialog box. Within the Attribute tab, modify the query 
to add or remove CITs. For details, see “Create a TQL Query” in Model 
Management.

Important: Do not change the name of the SearchForBusinessImpact query, 
or the name of the ITU_Triggered node.
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When modifying the query, note the following:

➤ Use an Or relationship between CIs, rather than an And relationship.

➤ Use the actual name of the CIT, rather than the display name. To see the 
actual name, select Admin > Universal CMDB > Modeling > CI Type 
Manager, and select a CIT. On the Details tab, the Name field displays the 
actual name. 

For example, to add the CI type Business Process Step, use the name bp_step, 
as it appears in the Name field on the Details tab.

 3 After adding or removing CITs from the query, you must add or remove 
them in View Manager from the view360_BusinessImpact view. 

Select Admin > Universal CMDB > Modeling > View Manager, and select the 
view360_BusinessImpact view.

 4 Add or remove CITs to the view, so that it corresponds to the query you 
defined in Query Manager.

To modify the relationships monitored in the Business Impact tab:

By default, the relationship type monitored in the Business Impact tab is the 
Impact type relationship. Use the following procedure to modify which 
relationships are monitored.

 1 Select Admin > Universal CMDB > Modeling > Query Manager, and select 
the SearchForBusinessImpact query.

 2 Right-click the Virtual Compound relationship and select Edit Compound 
Relationship. Within the Edit Compound Relationship dialog box, modify 
the relationships monitored by the query. For details, see “Compound 
Relationship” in Model Management.

Reference

Console User Interface

This section describes:

 ➤  Console Page on page 152

 ➤  Hierarchy Tab on page 157

 ➤  KPIs Tab on page 159
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 ➤  Business Impact Tab on page 161

 ➤  Alerts Tab on page 164

 ➤  Changes and Incidents Tab on page 165

 ➤  Netuitive Alarms Tab on page 169

Console Page

Console Page Top Pane

Description The Console page enables you to view, in one central 
location, comprehensive data regarding the CIs 
selected in View Explorer.

For each CI, the Console page tabs provide information 
regarding the CI’s hierarchy, KPIs, business impact, 
alerts, and changes and incidents.

If you set up an EMS Integration with Netuitive, the 
Console also displays alarms generated by Netuitive. 
For details, see “Netuitive SI Integration” in Solutions 
and Integrations. 

To Access: Applications > Dashboard > Console.

Important 
Information

For details on customizing the Console tabs, see 
“Customize the Console Page” on page 147.

Useful Links “Console Overview” on page 143

For details on the functionality of View Explorer, see 
“Working with View Explorer” in Model Management.
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 The Console page top pane provides KPI status, trend and history for the CI 
selected in View Explorer (note that this information only appears if you 
select a CI in the view).

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click the down arrow next to a CI name to access the 
menu options for that CI. Available options depend on 
the type of CI and the context menu defined for the 
CI. For details on the menu options, see “Menu 
Options” on page 75.

Click the up arrow (next to the Expand All button) to 
display information on the parent of the CI currently 
displayed.

The acknowledge utility enables you to track handling 
of performance problems by keeping a record of when 
the problem was acknowledged and by which user. For 
details, see “Acknowledge Performance Problems” on 
page 102.

Expand All/Collapse All buttons. Click to expand or 
collapse the CIs displayed in the Hierarchy tab. These 
buttons are shown only when one or more of the 
currently displayed CIs can be expanded or collapsed.

You can set up Dashboard to issue an alert sound when 
the status of a KPI changes to Critical in the Console. 
For details, see “Set Up Sound Notification When KPI 
Status Changes to Critical” on page 67 or “Switch Off 
the Alert Sound When CI is Acknowledged” on 
page 107.

Click to toggle the sound on or off. The icon tooltip 
indicates which action is performed if you click the 
button. 

<CI or View> Displays the name of the CI or the view selected in 
View Explorer (for example, sla_service1 in the image 
above).
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<KPI and 
status/value>

For each CI selected in View Explorer, Dashboard 
displays real-time KPI status. A color-coded icon 
represents the status assigned to the KPI for its current 
performance level. For details, see “KPI Status” on 
page 355.

The KPIs are ordered, from left to right, according to 
their Display Order defined in the Repositories. You 
can change this order by changing the values of one or 
more of the Display Order fields. See “KPI Repository 
page” on page 537. 

Tooltip:

➤ CI Name. The name of the CI.

➤ Status. The status of the CI (calculated according to 
one of the status calculation methods). It may also 
display:

➤ Not up to date. For decayed CIs, indicating that 
the CI has passed its timeout period. (For a 
SiteScope CI, this status is displayed after a 
SiteScope monitor is disabled.)

➤ Stopped. When a Business Process profile is 
stopped.

➤ Business Rule. The name of the rule that calculates 
the KPI status or value.

➤ Held Status Since. The date and time since which 
this CI has held its current operational status.

➤ Invisible Children. Might not appear. The number of 
child CIs belonging to other views, which are 
connected to this CI but do not belong to this view. 
For details, see “Find Visible and Hidden Child CIs” 
on page 64

GUI Element (A-Z) Description
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Console Page Tabs

 

<KPI History> The history status icon displays either the worst status 
or the average status for the KPI during a specified time 
period. For details, see “Trend and History” on 
page 362.

Tooltip:

➤ CI Name. The name of the CI.

➤ History Type. The type of history (worst status or 
average status) used when calculating history status.

➤ Historical Event. The worst or average status of the 
KPI in the selected time period.

<KPI Trend> The trend status icon shows the trend in real-time 
status for the KPI, using three directions: up, down, 
and no change. For details, see “Trend and History” on 
page 362.

Tooltip:

➤ CI Name. The name of the CI.

➤ Trend. The trend of the KPI in the selected time 
period.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Alerts Shows the CI status alerts associated with the CI 
selected in View Explorer. See “Alerts Tab” on page 164.

Business Impact Shows the business CIs and SLAs impacted by the CI 
selected in View Explorer. See “Business Impact Tab” on 
page 161.

Changes and 
Incidents

Shows planned changes and actual changes made to 
the CI selected in View Explorer, as well as incidents 
opened for the CI. See “Changes and Incidents Tab” on 
page 165.

Hierarchy Shows the child CIs of the view or CI selected in View 
Explorer. See “Hierarchy Tab” on page 157.

KPIs Shows the status of the Dashboard KPIs and external 
(federated) KPIs assigned to the CI selected in View 
Explorer. See “KPIs Tab” on page 159.

Netuitive Alarms 
(optional)

If you set up an EMS Integration with Netuitive, this 
tab shows Netuitive alarms generated for the CI and its 
child CIs. See “Netuitive Alarms Tab” on page 169.
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Hierarchy Tab

The following is an example of the Hierarchy page. 

Description If you select a view in View Explorer, this tab shows the 
top level CIs in the view. If you select a CI in View 
Explorer, this tab shows its child CIs.

For each CI, the tab shows its assigned KPIs and their 
statuses.

Click [+] or [-] to expand or collapse the displayed CIs.

To Access: Applications > Dashboard > Console > 
Hierarchy.

Important 
Information

For details on customizing this tab, see “Customize the 
Console Page” on page 147.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Indicates that the following changes have been made 
to change-monitored properties:

At least one change-monitored property of the 
CI has changed. 

At least one change-monitored property of the 
CI’s child CIs has changed.

At least one change-monitored property of the 
CI and at least one change-monitored property 

of the CI’s child CIs have changed.

A tooltip provides more information about the change.

For details on setting this feature, see “Analyze Real-
Time Change Information” on page 112.

<CI elements> The CI element fields on the Hierarchy tab also appear 
in the Top Pane section of the Console page (for 
example, KPI and status). 

These fields are described in the Top Pane section in 
“Console Page” on page 152.
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KPIs Tab

The following is an example of the KPIs page. 

Description Shows KPI status over time for the CI selected in View 
Explorer. 

If you have configured federation adapters to collect 
KPI values for this CI from outside HP Business 
Availability Center, the External KPIs area displays 
information about these federated KPIs.

For details on setting up federation, see “The 
Federation Framework SDK” in Model Management.

To Access: Applications > Dashboard > Console > KPIs.

Important 
Information

For details on customizing this tab, see “Customize the 
Console Page” on page 147.
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Dashboard KPIs Area
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

External KPIs Area
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

KPI The list of KPIs attached to the selected CI.

Past 
<Hour/Day/Week>

The status of the KPI over a predefined time period 
(default: Past week). 

To modify the predefined time period, see “Customize 
the Console Page” on page 147.

Tooltip:

The tooltip displays a text string containing the name 
of the status, the amount of time the KPI held this 
status during the time frame, and the percentage of 
time that the KPI held this status.

Status duration can be given in hours, minutes, and 
seconds (for example, 01:10:48) or in days and hours 
(for example, 30 days, 9 hours).

GUI Element (A-Z) Description

Additional 
Information

Description of the KPI. This is taken from the KPI’s 
Additional Information attribute; if this attribute is 
blank no information appears.

Last Status Changes The date and time from when this KPI has held its 
current operational status.

Name The name of the KPI which is assigned to the selected 
CI.
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Business Impact Tab

The following is an example of the Business Impact page. 

Source The source outside HP Business Availability Center, 
from which the federation adapter retrieved the KPI.

Status The current status of the KPI assigned to the selected 
CI.

GUI Element (A-Z) Description
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Impacted Businesses Area
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Shows current and over-time KPI status for business CIs 
impacted by the CI selected in View Explorer. The over-
time data is aggregated according to status.

The following impacted CITs can be displayed by 
default: Business Services, Business Processes, and 
Applications.

If you have configured SLAs, this tab also shows status 
details of any SLAs impacted by the selected CI. 
Impacted SLAs can only appear if a Service Level 
Management license has been installed.

To Access: Applications > Dashboard > Console > 
Business Impact.

Important 
Information

To modify which CITs are monitored for business 
impact, see “Customize the Business Impact Tab” on 
page 150.

For details on customizing this tab, see “Customize the 
Console Page” on page 147.

GUI Element (A-Z) Description

Current Status The worst status of the KPI assigned to the impacted 
CI.

Name The name of the impacted CI.

You can click on a CI to access its corresponding 
Business Impact Report. For details, see “Business 
Impact Report” on page 95.
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Impacted SLAs Area
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Past 
<Hour/Day/Week>

The status of the impacted CI over a predefined time 
period (default: Past week).

To modify the predefined time period, see “Customize 
the Console Page” on page 147.

Tooltip:

The tooltip displays a text string containing the name 
of the status, and the percentage of time that the KPI 
held this status.

Type CI type of the impacted CI.

By default the available CITs are Business Services, 
Business Processes, and Applications. To modify the 
default types, see “Customize the Business Impact Tab” 
on page 150.

GUI Element (A-Z) Description

Base forecast on: Time frame used by the Expected Breach Date column 
(default: Week).

Current Status The current status of the impacted SLA.

Customer The customer related to the impacted SLA.

Expected Breach 
Date

The expected breach date of the impacted SLA.

Forecasting Status The expected status of the impacted SLA, based on 
extrapolation. For details, see “Status Forecast for 
Agreements” in Using Service Level Management.

Give forecasting for: Time frame used by the Forecasting Status column 
(default: end of Month).

SLAs The list of SLAs where the selected CI is included.

GUI Element (A-Z) Description
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Alerts Tab

The following is an example of the Alerts page. 

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

SLA status for: Time frame used by the Current Status column 
(default: Month to date).

Description Shows CI status alerts triggered by the CI selected in 
View Explorer.

To Access: Applications > Dashboard > Console > 
Alerts.

Important 
Information

By default, alerts are shown for the past day. To modify 
this setting, see “Customize the Console Page” on 
page 147.

GUI Element (A-Z) Description

Alert Description Description of the status change that triggered the 
alert.

Alert Name The name of the alert.

Alert Time The time and date when the alert was triggered. The 
format is: dd/mm/yy hh:mm GMT[<offset>].

GUI Element (A-Z) Description
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Changes and Incidents Tab

The following is an example of the Changes and Incident page. 

Alerts Over Time 
report

Click to access the selected CI’s Status Alerts Report, 
which includes information on the action taken 
following the alert.

For details, see “Configuration Item Status Alerts 
Report” in Alerts.

KPI The KPI that triggered the alert.

Status The status which the KPI entered when the alert was 
issued, represented by a status icon. 

For details about the icons, see “KPI Status”.

GUI Element (A-Z) Description
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Description Shows incidents opened for the CI selected in View 
Explorer, planned changes for the CI, and actual 
changes made to the CI.

➤ Incidents and Planned Changes. Information on 
incidents and planned changes is collected from 
CMDB Federation Adapters. Federation adapters 
may be set up within HP Business Availability 
Center (such as the out-of-the-box adapter History 
Data Source), or outside HP Business Availability 
Center (such as Release Control or HP Service 
Manager). For details on setting up federation, see 
“The Federation Framework SDK” in Model 
Management. For details on the integration with 
HP Service Manager, see “HP Service Manager 
Integration with Business Availability Center 
Components” in Solutions and Integrations.

➤ Actual Changes. Information on actual changes is 
collected for CIs on the local machine, directly from 
the CMDB. The types of changes displayed are 
History Attribute Change, and History Relation 
Change. 

Attribute changes are displayed for each attribute 
marked as Change Monitored. For details, see 
“Add/Edit Attribute Dialog Box” in Model 
Management. 

Relationship changes are displayed if a relationship 
has been defined with a TRACK_LINK_CHANGES 
qualifier. For details, see “Qualifiers Page” in Model 
Management.

To Access: Applications > Dashboard > Console > 
Changes and Incidents.



Chapter 5 • Dashboard Console

167

Actual Changes Area
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Important 
Information

By default, data is also displayed for the child CIs 
which have an Impact relationship with the selected 
CI. If you deselect the Show data for child CIs 
checkbox, data is only shown for the selected CI. 

By default, actual changes and incidents are shown for 
the past week. The planned changes area shows the 
changes planned during the previous week, and those 
that are planned for the coming week. To modify these 
settings, see “Customize the Console Page” on 
page 147.

GUI Element (A-Z) Description

Attribute The name of the CI attribute that was changed.

Change Type The type of change that occurred.

Changer Description of the user or event that modified the CI’s 
property (for example, user name or Discovery).

CI Name The name of the CI that was changed.

Date The date and time at which the change occurred.

New Value The new value of the CI attribute.

Old Value The previous value of the CI attribute (before the 
change).

Related CI If the change involves a changed relationship between 
CIs, this field shows the name of the CI whose 
relationship with the selected CI was changed.



Chapter 5 • Dashboard Console

168

Incidents Area
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Planned Changes Area
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

CI Name The name of the CI that triggered the incident.

Closing Time The date and time at which the incident was closed.

Description Description of the incident.

ID Incident ID, as it appears in the source application (for 
example, within HP Service Manager).

Opening Time The date and time at which the incident was opened.

Origin The source of the incident.

Severity The severity of the incident as it appears in the source 
application (for example, within HP Service Manager).

Status The status of the incident as it appears in the source 
application.

Update Time The date and time at which the incident was updated.

GUI Element (A-Z) Description

CI Name The name of the CI for which the change is planned.

Contact Person The name of the contact person regarding the change.

ID Change request ID, as it appears in the source 
application (such as Release Control).

Impact Severity The degree of impact of the change, as it appears in the 
source application (such as Release Control).
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Netuitive Alarms Tab

Opened By The name of the person who opened the change 
request.

Planned End Date The time at which the change is scheduled to end.

Planned Start Date The time at which the change is scheduled to start.

Risk The degree of risk of the change, as it appears in the 
source application.

Status The status of the planned change, as it appears in the 
source application.

Summary A description of the planned change.

Description If you set up an EMS Integration with Netuitive, this 
tab displays alarms generated by Netuitive for the 
selected CI and its child CIs. For details, see “Netuitive 
SI Integration” in Solutions and Integrations. 

Alarms are shown for Host CIs, BPM Transaction from 
Location CIs, and Business Process Step CIs. You can 
drill-down from the tab to Netuitive and view alarm 
details.

To Access: Applications > Dashboard > Console > 
Netuitive Alarms.

Important 
Information

For details on configuring the Netutive integration, see 
“Display Netuitive SI Data in Dashboard” in Solutions 
and Integrations.

Alarms appear in the Netuitive Alarms tab as long as 
they have not been cleared in Netuitive. Once an alarm 
is cleared, it is no longer displayed in the Console.

The default refresh rate of this tab is 30 seconds, and by 
default alarms are shown for the past week. For details 
on customizing these settings, see “Customize the 
Console Page” on page 147.

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Alarm Category The alarm category; either Availability or Performance. 

Alarm Date The date and time the alarm was generated.

Alarm Type One of the following Netuitive alarm types: 

➤ Element Down. This indicates a real-time availability 
problem.

➤ SLO. This indicates that the CI is not meeting 
required service level objectives.

➤ Statistical. This indicates that the forecasted value of 
a metric is above or below a forecasted tolerance 
band (predictive alarm).

CI The name of the child CI which triggered the alarm. 

You can use this link to drill-down to Netuitive and 
view alarm details.

Severity The alarm severity; this can be Warning, Minor, Major, 
or Critical.

Source Application The application or function impacted by the alarm.

Subject The CI type as defined in Netuitive.
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6
Dashboard Filters

This chapter describes the Dashboard Filters.

This chapter includes:

Concepts

 ➤  Filters Overview on page 172

Tasks

 ➤  Display and Customize a View Information in Filters on page 173

 ➤  Search for Specific CIs and Filter the Results on page 174

 ➤  Create or Customize an Active Filter on page 177

 ➤  Create a Temporary Filter Using Quick Filter on page 178

Reference

 ➤  Dashboard Filters User Interface on page 180
Concepts
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Filters Overview

The Filters tab enables you to view operational status for specific segments 
or components of your business. The Filters tab displays (in a flat 
non-hierarchical way) the configuration items (CIs) that match the 
following criteria: they belong to the selected view, and at least one of their 
Key Performance Indicators (KPIs) has the status specified in the active filter. 

For details on the Filters tab user interface, see “Filters Page” on page 187.

Tasks
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Display and Customize a View Information in Filters

This section describes the processes for displaying and customizing a view 
information in the Filters tab, and gives examples.

This task includes the following steps:

➤ “Select a View in View Explorer” on page 173

➤ “Set the Active Filters” on page 173

➤ “Add a Details Link to CIs in the Filters Page – Optional” on page 173

 1 Select a View in View Explorer
The data displayed in the Filters tab depends on the view you have selected. 
For details, see “Filters Page” on page 187.

 2 Set the Active Filters
You use the Active Filters capability to create filters that enable you to filter 
the CIs displayed in the Filters tab, enabling you to focus on the specific 
view, on specific CI types or statuses, or on problematic areas. For details, see 
“Filters Page” on page 187.

You can also create a new active filter. For details, see “Create or Customize 
an Active Filter” on page 177.

You can also create a temporary filter. For details, see “Create a Temporary 
Filter Using Quick Filter” on page 178.

 3 Add a Details Link to CIs in the Filters Page – Optional
To add a Details link for every CI in the Filters page, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and in the Dashboard Application - 
Dashboard Layout Properties table, modify the Show element CMDB details 
link in UI entry. Default is false. 

The Details link enables you to view CMDB information about the CI. For 
details, see “Node Details Dialog Box” on page 94.
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Search for Specific CIs and Filter the Results

You can search for a specific CI using the View Explorer search function to 
filter the list of CIs that HP Business Availability Center displays. For more 
details on the Search feature, see “View Explorer” in Model Management.

You can locate CIs by their name, by related CIs, by their CITs, in the 
current view, or in all views. If, in addition to using the Search feature in 
View Explorer, you display the Filters tab in the right pane of the 
Dashboard, the resulting filtered report displays only the CIs that have been 
located by the search filtered by the selected filter in the Filters tab. 

For details on the Filters tab, see “Filters Page” on page 187.

Example – Searching for CIs in the Current View

You can search for CIs in the current view by name, related CIs, or CITs.

➤ The result is a list of all of the CIs corresponding to the search criteria listed 
in View Explorer. The Filters tab displays a filtered list of the CIs and the CI’s 
children CIs corresponding to the search criteria filtered by the active filter 
and the current operational status in each KPI for each of the CIs.  
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➤ If the search result is a single CI, or if you click one of the CIs in the search 
list results, the Filters tab displays the selected CI and its child CIs filtered by 
the active filter, and the current operational status in each KPI for each of 
the CIs. 
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Example – Searching for CIs in More Than One View

You can search for CIs in all views by name, related CIs, or their CITs.

➤ The result is a list of all of the CIs and the views that include them, 
corresponding to the search criteria listed in View Explorer. The Filters tab 
displays a filtered list of the CIs corresponding to the search criteria, filtered 
by the active filter and the current operational status in each KPI for each of 
the CIs. 
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➤ You can click a specific CI in the results of the search list to display in the 
Filters tab a filtered list of the CIs corresponding to the search criteria and to 
the selected view, filtered by the active filter and the current operational 
status in each KPI for each one of those CIs.  

Create or Customize an Active Filter

Active Filters enable you to focus on a specific view, CI type or status, or 
problematic areas.

The currently active filter is displayed in the Active Filters box in the Filters 
tab. You can select a different filter from the Active Filters list.

The Active Filters list contains the Dashboard predefined filters (shown as 
gray text strings) and any additional filters you defined (shown as black text 
strings). 

To define or customize filters, access the Filters tab, and select one of the 
following options:

 1 To define a new filter, click New. The Defining/Editing Filters Page opens. 
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 2 To use an existing filter as the basis for the new filter, select the filter name 
in the Select a filter list and then click Save As. The Filter Name dialog box 
opens, where you can specify a name for the filter you are creating. You are 
then returned to the Defining/Editing Filters Page.

For details, see “Filters Page” on page 187.

Example

The private: filter ver filter shown below is created to display the 
Application KPIs and Customer KPIs with the OK status. 

Create a Temporary Filter Using Quick Filter

Quick Filter enables you to display the selected view’s CIs whose KPIs have 
at least one KPI with the selected statuses. The filter is a temporary filter that 
persists until you log off, change its selection of statuses, or select another 
filter.

For details, see “Filters Page” on page 187.
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Note: You cannot save the settings you selected in Quick Filter, but you can 
create a similar filter using Active Filter. For details, see “Defining/Editing 
Filters Dialog Box” on page 181.

Example

The global: Show All report shown below includes all KPI statuses for the 
selected CI.  
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To display, temporarily, only the view’s CIs whose KPIs have Minor statuses, 
select the status in the Quick Filter bar and click Apply.

The filtered report includes only the CIs whose KPIs have the Minor status. 

Reference

Dashboard Filters User Interface

This section describes:

 ➤  Defining/Editing Filters Dialog Box on page 181

 ➤  Filter Name Dialog Box on page 187

 ➤  Filters Page on page 187
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Defining/Editing Filters Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Used to define new filters or customize existing filters

To Access: Click Application > Dashboard, and click the 
Filters tab. Select the view in the View Explorer. Click 
Active Filters.

Important The Filters tab has predefined filters you can use to 
display commonly required information. For details, 
see “Predefined Filters” on page 184.

Note:

➤ If more than one user is logged in at the same time 
using the same user name (for example, admin), then 
every time one of the users saves a change to the 
filters, the associated filters file is updated with a 
copy of that user’s filters. 

➤ The information displayed in the Filters tab is not 
refreshed while the Defining/Editing Filters dialog 
box is open. (This also applies when the 
Defining/Editing Filters dialog box is not in focus.)

Included in Tasks “Create or Customize an Active Filter” on page 177

GUI Element (A-Z) Description

To invert the selection use the Invert Selection button. 

Acknowledged Select one of the following options:

➤ All. To display all of the CIs whether they are 
acknowledged or not.

➤ Yes. To display the CIs that are acknowledged.

➤ No. To display the CIs that are not acknowledged.
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Cancel Click the Cancel button to exit the Defining/Editing 
Filters dialog box without saving your changes to the 
filter criteria for the currently displayed filter. 

Warning: The filter you create is saved and appears in 
the Active Filters list.

Clear All Click the Clear All button to clears all the selected filter 
fields.

Define filter Select the check box for each KPI status type that you 
want to include in the filter. 

Specify any combination of the listed filter criteria. The 
filter displays the CIs that meet all of the selected 
criteria, as follows:

If no status is selected for a KPI then all statuses are 
included in the filter.

Filter by Change Select one of the following options to filter by the CIs 
that are set to be monitored in real-time for changes 
(only 20 CIs and their children can be monitored at a 
time):

➤ Ignore Configuration Change. To display all CIs, 
whether their configuration changed or not.

➤ Only Changed Configuration Items. To display only 
the CIs whose configuration changed.

➤ Exclude Changed Configuration Items. To display 
only the CIs whose configuration did not change.

For details about how to set the CIs to be monitored for 
change, see “Analyze Real-Time Change Information” 
on page 112.

Filter by CI type Select one of the following options:

➤ All. All the CI types are included (monitor and non-
monitor CIs).

➤ All excluding monitors. All the CI types are included 
except for monitor CIs that are excluded.

➤ Monitors only. All the CI types are excluded except 
for monitor CIs that are included.

GUI Element (A-Z) Description
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New Click the New button to define a completely new filter 
in the Filter Name dialog box that opens. All the KPI’s 
statuses are cleared. 

Note: By default, a filter is called Custom Filter when 
you create a filter without assigning it a name.

OK Click the OK button to save your changes to the 
currently displayed filter and to close the 
Defining/Editing Filters dialog box.

Rename Click the Rename button to rename the filter; for 
example, when you are want to change the name of a 
filter you created.

Save As Select the filter name in the Select a filter list, and click 
the Save As button to use the selected filter as the basis 
for the new filter. The KPIs’ statuses that were selected 
for the filter you are using as a model are still selected.

The Filters Name dialog box opens, where you can 
specify a name for the filter you are creating.

GUI Element (A-Z) Description
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Predefined Filters

The predefined filters are:

Select a filter Click to modify an existing filter, select the filter in the 
box and click Select a filter. 

To use the selected existing filter as the basis for the 
new filter, select the filter name in the box, and click 
Select a filter. Then click Save As. The KPI statuses that 
were selected for the filter you are using as a model are 
still selected.

Predefined filters are used to include or exclude CIs 
according to their type, and KPIs according to their 
status. These filters cannot be modified or deleted. 

For details, see “Predefined Filters” on page 184.

Visibility Select the required visibility option:

➤ Private to create a private filter.

➤ Public to create a public filter.

Note: Visibility is displayed only to the administrator 
or to a user with the appropriate permissions.

Different levels of visibility are available. For details, 
see “Visibility Levels” on page 185.

Predefined Filter Name Description

global: Show All Displays all of the CIs, all their KPIs, and the status 
of the KPIs.

global: Show Errors Displays, for all CI types, only the CIs whose 
Availability, Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a critical status.

global: Show Errors – 
Monitors Only

Displays only the monitor CIs whose Availability, 
Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a critical status.

GUI Element (A-Z) Description
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Visibility Levels

The visibility levels you can select when defining a filter include:

global: Show Errors and 
Warnings

Displays, for all CI types, only the CIs whose 
Availability, Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a minor, major, or critical status.

global: Show Monitors 
Only

Displays only the monitor CIs, their KPIs, and the 
status of the KPIs.

global: Show PNR Displays, for all CI types, only the CIs whose PNR 
KPI has an OK, Warning, Minor, Major, Critical, or 
No Data status.

Visibility Level Filter Description

Global Global filters are predefined and built-in. They are 
available for all customer users. They cannot be 
modified. You can use them as templates to build 
public or private active filters. Their names have the 
following syntax: global:<name>. They appear in 
the list of active filters as gray text strings. For a list 
of global active filters, see “Predefined Filters” on 
page 184.

Public Administrators or users with the appropriate 
permissions can build public active filters. Those 
filters are available for all users at the specific 
customer. You can use the global active filters as 
templates to build public active filters. Their names 
have the following syntax: public:<name>. They 
appear in the list of active filters as black text 
strings.

Predefined Filter Name Description
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Private Users can build their own private active filters. 
Those filters are available only to the user who 
created them. You can use the global and public 
active filters as templates to build private active 
filters. Their names have the following syntax: 
private:<name>. They appear in the list of active 
filters as black text strings.

For each user name used when logging on to 
HP Business Availability Center, Dashboard creates 
an associated filters file. When you log on to 
HP Business Availability Center using a specific user 
name, you can only view and modify the filters 
contained in the associated filters file. The file is 
updated with the filter modifications made by each 
user who logs in under this user name, so any 
changes you make to the filters may overwrite 
modifications made by previous users.

Temporary Another type of private active filter. These filters are 
created when you select statuses in the Quick Filter 
and click Apply or when you use the Filter subtree - 
Monitors only option in a CI context menu. The 
name of the temporary filter is temp: Quick Filter. 
For details, see “Create a Temporary Filter Using 
Quick Filter” on page 178. You cannot save 
temporary filters.

Visibility Level Filter Description
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Filter Name Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Filters Page

The following is an example of the Filters page. 

Description Used to define a new filter name.

To Access: In Defining/Editing Filters, select Save As.

GUI Element (A-Z) Description

Name Enter the name of the filter.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to view operational status for specific 
segments or components of your business. The Filters 
tab displays (in a flat non-hierarchical way) the 
configuration items (CIs) that match the following 
criteria: they belong to the selected view, and at least 
one of their Key Performance Indicators (KPIs) has the 
status specified in the active filter.

To Access: Select Applications > Dashboard and click 
the Filters tab.

Important 
Information

➤ Sort the information displayed in the Filters tab 
according to the entries in any column by clicking 
the column header. Toggle between ascending and 
descending order by clicking the header again.

➤ If you select (in View Explorer) a specific CI, the 
filter works only on the CI’s subtree. 

➤ If you select the view's root, the filter is applied to 
the whole view.

➤ Hold the cursor over a CI to display its full name in a 
tooltip.

Customization: For details, see “Add a Details Link to 
CIs in the Filters Page – Optional” on page 173.

Included in Tasks “Display and Customize a View Information in Filters” 
on page 173

Useful Links “Filters Overview” on page 172

For details on the functionality of View Explorer, see 
“Working with View Explorer” in Model Management.

GUI Element (A-Z) Description

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.
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Filter Definition Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to toggle the sound on or off. The icon tooltip 
indicates the action you perform if you click the 
button. For details, see “Set Up Sound Notification 
When KPI Status Changes to Critical” on page 67 or 
“Switch Off the Alert Sound When CI is 
Acknowledged” on page 107.

Active Filters link Define or modify active filters in the Defining/Editing 
Filters dialog box. For more information, see 
“Defining/Editing Filters Dialog Box” on page 181.

Apply Click the Apply button to apply the Quick Filter 
selection to the display.

List of existing filters Select a filter from the Active Filters list. The filter can 
be one of the predefined filters or a custom filter.
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Quick Filter by 
Statuses

Quick Filter enables you to display CIs whose KPIs have 
one of the selected statuses. The filter is a temporary 
filter that persists until you log off, until you change its 
selection of statuses, or until you select another filter.

After you have selected a combination of filters to 
display a view’s data, you can further refine the report 
by selecting specific KPI’s statuses. The CIs that are 
displayed have at least one of their KPIs with one of the 
selected statuses.

Select a combination of KPI statuses in the Quick Filter 
bar. You can also use one of the options in the list to 
further filter the results:

➤ All. To display all types of CIs whose KPIs match the 
selected combination of KPI statuses selected in 
Quick Filter.

➤ Monitors only. To display only the monitor CIs 
whose KPIs match the selected combination of KPI 
statuses selected in Quick Filter.

➤ All excluding monitors. To display all types of CIs, 
except the monitor CIs, whose KPIs match the 
selected combination of KPI statuses selected in 
Quick Filter.

Note: You cannot save the settings you selected in 
Quick Filter, but you can create a similar filter using 
Active Filter. For details, see “Defining/Editing Filters 
Dialog Box” on page 181.

GUI Element (A-Z) Description
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Filtered CIs Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Indicates that at least one change-monitored property 
of the CI’s child CIs has changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details on setting this feature, see “Analyze Real-
Time Change Information” on page 112.

Indicates that at least one change-monitored property 
of CI itself has changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details on setting this feature, see “Analyze Real-
Time Change Information” on page 112.

Indicates that at least one change-monitored property 
of the CI and at least one change-monitored property 
of the CI’s child CIs have changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details on setting this feature, see “Analyze Real-
Time Change Information” on page 112.
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To access the context menu options, click the down 
arrow next to a CI name to access the menu options for 
that CI. Available options depend on the type of CI 
and the context menu defined for the CI. If no context 
menu is defined for the CI, the menu arrow is not 
displayed. If one of the menu options is not supported 
for the selected CI, that option is disabled. For details 
on the menu options, see “Menu Options” on page 75.

<Tooltip> Move the cursor above a KPI status icon to the Details 
tooltip that includes the following information: the 
name of the KPI and the name of the CI, the name of 
the rule used to calculate the KPI status, and the time 
and date when the KPI status changed to the current 
status.

Move the mouse over the Trend icon to display the 
name of the trend, the name of the CI, and the trend of 
the KPI in the selected time period. For details on the 
tooltip, see “Trend” on page 868.

Move the mouse over the History icon to display the 
name of the KPI, the name of the CI, and the type of 
history used when calculating the history status, and 
the worst or average status of the KPI in the selected 
time period. For details on the tooltip, see “History” on 
page 841.

<View Explorer> When you select a CI in View Explorer, Top View 
displays the selected CI centered in the tree with all its 
sub-branches expanded. If you select a CI in the Top 
View tree, it is highlighted in the View Explorer. 

GUI Element (A-Z) Description
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Ack Displays an icon that represents the CI 
Acknowledgment status.

Note: A tooltip for the Ack icon displays the current 
status of the CI’s acknowledgment.

The acknowledge utility enables you to track 
performance problems identified in the system and 
network infrastructure by keeping a record of when the 
problem was acknowledged and by which user. You can 
access the utility using context menu options or by 
clicking the Ack icon  that is displayed in an Ack 
column in some of the Dashboard tabs.

Note: A user with the appropriate permissions can 
show or hide the Ack column in the Dashboard 
application. To display/hide the Ack column, select 
Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications context, 
select Dashboard Application, and locate the Show CI 
Acknowledgment column in the Business Console area. 
Select false (to hide the Ack column) or true (to display 
the Ack column). The change takes effect immediately. 

Held Status Since The time and date when the KPI status changed to the 
current status.

KPIs Displays text or an icon indicating the current 
operational status of each CI. For an explanation of the 
color coding for status icons, see “KPI Status” on 
page 355. 

Name Displays the filtered list of CIs. You can click a specific 
CI name to move to that CI in the Console tab. The 
relevant CI is shown highlighted in the View Explorer. 
The arrow to the right of a CI name opens the options 
menu for the CI. For details, see “Customize Dashboard 
Display and Refresh Rate” on page 69. 

GUI Element (A-Z) Description
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7
Geographical Map

This chapter describes the Dashboard Geographical Map.

This chapter includes:

Concepts

 ➤  Geographical Maps on page 196

Tasks

 ➤  Display and Customize a View in Geographical Map on page 200

 ➤  Display a Geographical Map With Google Earth on page 204

 ➤  Create a Geographical Map for an Unavailable Zoom Level of a Specific Area 
on page 207

 ➤  Customize Virtual Earth on page 208

 ➤  Customize Maps Applet on page 210

Reference

 ➤  Geographical Map User Interface on page 211
Concepts
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Geographical Maps

In Dashboard, you can associate a geographical map with a view. If you have 
specified geographical locations for the view’s CIs, real-time status indicators 
representing the CIs statuses are displayed on the map at those locations. 
For details on the geographical map user interface, see “Geographical Map 
Page” on page 212.

In Dashboard Administration, in the geographical map, you can shift the 
map’s focus and enlarge or shrink the map to fit the view it represents. 
When you save the changes, the modified map is automatically displayed 
when you select the view in the Geographical Map tab in Dashboard 
Application. For details, see “Geographical Map Page” on page 212. 

If you have an Internet connection, geographical maps can be displayed 
using Virtual Earth. For details, see “Understanding Virtual Earth” on 
page 198. 

If you do not have an Internet connection, geographical maps can be 
displayed using a maps applet. For details, see “Understanding the Maps 
Applet” on page 199.

Note: The Virtual Earth map is only available in English and cannot be 
translated. For localization, use the maps applet. The Maps Applet does not 
display the names of cities or countries.

This section includes the following topics:

➤ “Location Status Information” on page 197

➤ “Understanding Google Earth” on page 198

➤ “Understanding Virtual Earth” on page 198

➤ “Understanding the Maps Applet” on page 199
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Location Status Information
The map displays color-coded status indicators that represent the worst KPI 
status for all CIs attached to the location at each geographical location. The 
color coding is the same as for other icons in Dashboard. For more 
information about color coding, see “KPI Status” on page 355.

The location is defined individually for group or leaf (monitor) CIs in a view. 
You can specify the CI location when you define a new CI or when you edit 
a CI’s properties. For details, see “Configuration Item Properties Dialog Box” 
in Model Management. You can also specify geographical locations for end-
user groups in “New/Edit End-User Group Page” in Using End User 
Management. If you do not specify a geographical location for at least one CI 
in the view, the Geographical Map tab displays only the map.

Each status indicator in the map can represent one or more CIs from the 
view with the same location. If you select a CI in View Explorer, the 
geographical map is redisplayed automatically and shows only the selected 
CI and the CI’s children status indicators if a location is specified for them. 
If you select another view, the geographical map reloads automatically to 
show the view’s CI status indicators in the appropriate locations.

If you search for a specific CI in View Explorer and you click the result of the 
search, the geographical map is not automatically redisplayed. The map is 
redisplayed only when you go back to browser mode. It shows only the 
selected CI and the CI’s children status indicators if a location is specified for 
them.
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Understanding Google Earth

Note to HP Software-as-a-Service users: This feature is not available when 
working with HP Software-as-a-Service.

You can view the geographical map information in a three-dimensional map 
using the Google Earth feature. This feature is available only to the 
administrator. 

Note: The integration of CI locations with your Google Earth installation is 
at the beta stage.

Understanding Virtual Earth
If you have an Internet connection you can display the geographical map 
using Microsoft MSN Virtual Earth. HP Business Availability Center 
integrates Virtual Earth online mapping functionality, available over MSN, 
to enable you to use the geographical map of a view. If the view’s CIs are 
assigned geographical locations, real-time status indicators are displayed on 
the map at those geographical locations. 

Virtual Earth geographical maps are based on Microsoft Network (MSN) 
technology and use dynamic HTML. 
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The Virtual Earth geographical map presents a flat geopolitical view of the 
planet where you can display the country borders, the geographical features, 
or both.

When you magnify the view, the main cities appear for the part of the map 
that is displayed on the screen.

Understanding the Maps Applet
The maps applet presents a flat geopolitical view of the planet. 

You can use the maps applet to display the geographical map of a view. The 
map displays the worst status at each geographical location and detailed 
information about the CI’s KPIs.  

Tasks
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Display and Customize a View in Geographical Map

This section describes the processes to view real-time status indicators in a 
geographical map, and gives examples.

This task includes the following steps:

➤ “Setup Requirements for the Map Applet” on page 200

➤ “Assign a Geographical Location to the Appropriate CIs” on page 200

➤ “Select the Display Technology” on page 201

➤ “Assign a Geographical Map to a View” on page 202

➤ “Refine the Geographical Map” on page 203

➤ “View the Geographical Map” on page 203

➤ “Adjust the Displayed Geographical Map” on page 203

 1 Setup Requirements for the Map Applet
The maps applet requires that Sun JRE plug-in 1.6.0_x (latest version 
recommended) be installed on the client machine.

The city names use UTF8 format. If HP Business Availability Center is 
working with a Microsoft SQL Server, or an Oracle Server that is not 
configured for UTF8 support, non-English characters (for example, é) are 
displayed as empty square brackets [ ].

 2 Assign a Geographical Location to the Appropriate CIs
To view the real-time status indicators corresponding to a view’s CI on the 
map, you must assign a geographical location to the relevant CIs in the 
view.

Select Admin > Universal CMDB > Modeling > It Universe Manager. Select a 
CI in the topology map or View Explorer. In the Information Pane, select the 
Properties tab, click Edit, enter the country, state, and city information in 
the Properties dialog box, and click Apply.
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 3 Select the Display Technology
You can display a geographical map using Virtual Earth, a maps applet, or 
Google Earth. You must select the display technology as follows:

➤ Virtual Earth. If you have an Internet connection, use Virtual Earth to 
display the geographical map. To enable Virtual Earth, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Use Virtual 
Earth entry in the Dashboard Application - Maps Management Properties 
table. Set the property value to true. This is the default.

➤ Maps Applet. If you do not have access to Internet, use the maps applet to 
display the geographical map. To enable maps applet, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Use Virtual 
Earth entry in the Dashboard Application - Maps Management Properties 
table. Set the property value to false.

➤ Google Earth. The Google Earth display technology is available only in 
Dashboard Administration. If you have access to Internet, you can use 
Google Earth to display the geographical map. You must specify that you 
want to display the Export to Google Earth button in the Geographical Map 
tab in Dashboard Administration. To display the Export to Google Earth 
button in the Geographical Map tab in Dashboard Administration, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Enable Export to 
Google Earth button entry in the Dashboard Application - Maps 
Management Properties table. Set the property value to true (false hides the 
Export to Google Earth button).

Note to HP Software-as-a-Service users: The Export to Google Earth button 
is not available when working with HP Software-as-a-Service.
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Note: Google Earth is available only in Dashboard Administration and only 
to users with administrative permissions.

 4 Assign a Geographical Map to a View
Assign a map to a view by selecting a view in the Geographical Map and 
saving the map.

To assign a geographical map to a view, select Admin > Dashboard, click the 
Geographical Map tab to open the Geographical Map Administration page, 
select the appropriate view in the View list in View Explorer, and click Save.

If you assigned geographical location to a view’s CIs, the corresponding 
status indicators are displayed on the map as soon as you assign a map to 
the view. 

Note: To remove CI icons from the map, you must delete their geographical 
location.

Example

The map shows the status of the jpetstore CI in the Cayman Islands.  
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 5 Refine the Geographical Map
As an administrator, you can refine the geographical display depending on 
the type of display you have selected. You can:

➤ Adjust the geographical map using the elements described for each type of 
map. For details, see “Geographical Map Page” on page 212.

➤ Customize the map. For details on Virtual Earth, see “Customize Virtual 
Earth” on page 208. For details on the Map Applet, see “Customize Maps 
Applet” on page 210.

You can save the changes.

 6 View the Geographical Map
To view the resulting geographical Virtual Earth or maps applet map, click 
Application > Dashboard, select the view in View Explorer, and click the 
Geographical Map tab.

 7 Adjust the Displayed Geographical Map
As a user, you can adjust the geographical display in different ways 
depending on the type of display you have selected. The changes are valid 
until you click another tab. For details, see “Geographical Map Page” on 
page 212.
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Display a Geographical Map With Google Earth 

Note to HP Software-as-a-Service users: This feature is not available when 
working with HP Software-as-a-Service.

Note: 

➤ This feature is only available in Dashboard Administration.

➤ The integration of CI locations with your Google Earth installation is at 
the beta stage.

You can view the geographical map information in a three-dimensional map 
using the Google Earth feature. This feature is available only to the 
administrator. This section describes the processes to view status indicators 
in Google Earth.

This task includes the following steps:

➤ “Select the Appropriate Display Technology” on page 205

➤ “Import Location Status into Google Earth” on page 205

➤ “Set the Refresh Rate for the View” on page 206

➤ “View Indicators by Status” on page 206

➤ “View Connecting Lines” on page 207
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 1 Select the Appropriate Display Technology
To use Google Earth you must select the appropriate display technology. For 
details, see “Select the Display Technology” on page 201.

 2 Import Location Status into Google Earth
You can import the location status information shown in the geographical 
map for the current view into a local Google Earth application. After 
importing the information, Google Earth displays all the CI status indicators 
in the appropriate geographical locations.

To list all the views you create in the same folder, create a new folder (for 
example, an HP Business Availability Center folder) in the Places folder in 
Google Earth, and then add to that folder all the views you create. 

You can create a view in Google Earth by creating a network link using the 
view’s URL. This creates a container folder and a sub-folder.

To import location status into Google Earth: 

 a If you have not already installed Google Earth on your local computer, 
open the Google Earth site (http://earth.google.com/) and download the 
application.

 b Click the View in Google Earth button. Follow the instructions in the 
Integration with Google Earth page.

 c Open the Google Earth application.

 d Click the My Places directory in the Places area.

 e If this is the first time you are creating a view in Google Earth, in the 
Create In area, click New Folder and enter HP Business Availability 
Center to create a new folder called HP Business Availability Center.

If the HP Business Availability Center folder already exists in the Create 
In area tree, select the folder.

 f Select Add > Network Link. 

 g The Google Earth - New Network Link dialog box opens.

 h Enter the view name in the Name box.
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 i Paste the URL displayed in the Integration with Google Earth page to the 
Location box.

Note: This URL creates a container folder called by the name you 
specified in the Name box, and a sub-folder called by the name of the 
view.

 j Click OK to close the New Network Link dialog box. 

The Google Earth page displays the HP Business Availability Center folder 
in the Places area. 

 k Open the HP Business Availability Center directory to list the views you 
have added.

 3 Set the Refresh Rate for the View
You can set the refresh rate of the view sub-folder.

To set the refresh rate for the view: 

 a Right-click the view sub-folder.

 b Select Properties.

 c Click the Refresh tab.

 d In the Time-Based Refresh area, select Periodically from the When list 
and select 1 minute in the Time. 

 e Click OK.

 4 View Indicators by Status
You can filter the status indicators that are displayed in Google Earth to 
include specific statuses.

To view the indicators by status:

 a In the Places area, expand the HP Business Availability Center folder.

 b Select the view you want to display. The folder displays the list of statuses 
of the CIs in the view.
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 c Select one or more of statuses. Only the CIs with the selected statuses are 
displayed in Google Earth.

 5 View Connecting Lines
Different locations are connected with a line when you specify different 
geographical locations for monitor CIs and non-monitor CIs they monitor 
in the view. 

For example, in the End User Locations view, the bpm_profile_1 CI is 
located in New York, New York, USA, the tx_10 CI is located in Baden-
Baden, Germany, while the tx_10 from wall_sanity1 is located in Rome, 
Italy.

To view the connecting lines:

 a In Google Earth, select the view you want to display.

 b Select Connecting Lines in your view folder to display the connecting 
lines in Google Earth.

If you select Connecting Lines in more than one view, you can see all the 
lines of all the selected views at the same time.

Create a Geographical Map for an Unavailable Zoom 
Level of a Specific Area

If you need a zoom level of a specific area that is not available in the 
Geographical Map, create a picture of the map and use the Custom Map 
feature instead.
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Customize Virtual Earth

You can customize a Virtual Earth map.

Note: All the steps in this task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Adjust the Virtual Earth Map” on page 208

➤ “Specify the Size of the Indicators” on page 208

➤ “Specify the Statuses to Be Displayed” on page 209

➤ “Specify the Time Delay” on page 209

 1 Adjust the Virtual Earth Map
You can zoom or shift the Virtual Earth map so that it shows the 
information you require. For details, see “Geographical Map Page” on 
page 212.

 2 Specify the Size of the Indicators
You can modify the default size (19 pixels) of the indicators that are 
displayed on the Virtual Earth map.

To modify the size of the indicators, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and enter the indicator size (in pixels) in the Indicator size in 
Virtual Earth entry in the Dashboard Application - Maps Management 
Properties table. 
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 3 Specify the Statuses to Be Displayed
You can select the statuses you want to display in the Virtual Earth map.

To specify the statuses to be displayed, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and locate the Ignore gray statuses entry in the Dashboard 
Application - Maps Management Properties table. Select one of the 
following options:

➤ ALL. Locations with gray statuses (downtime, stopped, no data and 
uninitialized) are not displayed on the map. 

➤ NO. Locations with gray status are displayed on the map.

 4 Specify the Time Delay
You can modify the default time delay between the completion of new 
location download from the server and the display of the information by 
Virtual Earth (in seconds). Use larger values if user has slower connection.

To modify the time delay, select Admin > Platform > Setup and Maintenance 
> Infrastructure Settings, click Applications, select Dashboard Applications, 
and locate the Wait after getting data entry in the Dashboard Application - 
Maps Management Properties table. Enter the delay (in seconds). The 
default is 4. 



Chapter 7 • Geographical Map

210

Customize Maps Applet

You can customize a maps applet.

Note: All the steps in the task are optional and can be performed in any 
order.

This task includes the following steps:

➤ “Adjust the Maps Applet” on page 210

➤ “Specify the Map Refresh Rate” on page 210

➤ “Specify the Maximum Number of CIs Displayed in a Location’s Tooltip” on 
page 211

 1 Adjust the Maps Applet
You can adjust the maps applet so that it shows the required information. 
For details, see “Geographical Map Page” on page 212.

 2 Specify the Map Refresh Rate
You can modify the default of the map refresh rate. The default is 30 
seconds.

To specify the map refresh rate, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and locate the Maps Applet Refresh Rate entry in the 
Dashboard Application - Maps Management Properties table. Enter the 
refresh rate.
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 3 Specify the Maximum Number of CIs Displayed in a Location’s 
Tooltip
You can specify the maximum number of CIs that can be displayed in the 
tooltip for a location in the Geographical Map. The default is 10. 

Keep in mind that the CIs are displayed in the Caused by section in the 
tooltip, so do not specify more than can be accommodated.

To specify the maximum number of CIs displayed in a location’s tooltip, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click Applications, select Dashboard Applications, and locate the Maximum 
CIs in tooltip for location entry in the Dashboard Application - Maps 
Management Properties table. Enter the new maximum.

Reference

Geographical Map User Interface

This section describes:

 ➤  Geographical Map Page on page 212
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Geographical Map Page

Description Enables you to display real-time status indicators on a 
geographical map, with the view's CIs at the 
geographical locations they were assigned. The status 
indicator shows the worst status of the CIs at the 
geographical location. You can also access detailed 
information about the CI’s KPIs. 

To Access: 

➤ Select Admin > Dashboard, and click the 
Geographical Map tab.

➤ Select Applications > Dashboard, and click the 
Geographical Map tab.

Important 
Information

When you magnify the map, the main cities appear for 
the part of the map that is displayed on the screen.

The geographical map display can be rendered using:

➤ Virtual Earth. For details, see “Using Virtual Earth” 
on page 213.

➤ A maps applet. For details, see “Using the Map 
Applet” on page 217.

➤ Google Earth. For details, see “Using Google Earth 
(Admin)” on page 220.

The Geographical Map tab shows a different display, 
depending on the type of setup you have selected. The 
types of setups are: Microsoft MSN Virtual Earth, a flat, 
geopolitical map supplied with Business Availability 
Center, or Google Earth (available only in Dashboard 
Administration). For details, see “Select the Display 
Technology” on page 201.

Included in Tasks “Display and Customize a View in Geographical Map” 
on page 200

Useful Links “Geographical Maps” on page 196

For details on the functionality of View Explorer, see 
“Working with View Explorer” in Model Management.
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Using Virtual Earth

The following is an example of a geographical map using Virtual Earth. 

Description If you have an Internet connection, you can display 
the geographical map using Microsoft MSN Virtual 
Earth (Version 4.0) in Dashboard Geographical Map 
tab. HP Business Availability Center integrates Virtual 
Earth online mapping functionality, available over 
MSN, to enable you to use the geographical map of a 
view. 

Virtual Earth geographical maps are based on Microsoft 
Network (MSN) technology and use dynamic HTML.

The Virtual Earth geographical map presents a flat 
geopolitical view of the planet where you can display 
only the country borders, only the geographical 
features, or both. 

When you magnify the view, the main cities appear for 
the part of the map that is displayed on the screen.

Useful Links “Understanding Virtual Earth” on page 198

For details on the functionality of View Explorer, see 
“Working with View Explorer” in Model Management.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Enable you to zoom in and out in order to enlarge or 
shrink the map. 

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

Click to shift the center of the map to the nearest CI.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

Click to zoom out completely.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

 This icon is only available in Dashboard Application.

Click to open the map on a standalone page. 

Close the page to return to Dashboard.

Click to display the map in two-dimensional format.

Click to display the map in three-dimensional format.

Note: This is available only if you have Windows XP 
installed on your local computer.



Chapter 7 • Geographical Map

215

<Adjustments> ➤ Click the map and drag to move the map in the 
window.

➤ Double-click the map to zoom in.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The color coding is the same as for other icons in 
Dashboard. For more information about color coding, 
see “KPI Status” on page 355. 

The round icon represents the status of a location 
when at least one of the CIs is not a monitor CI.

The square icon represents the status of a location 
where all the CIs are monitor CIs.

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. 

The tooltip includes the following information:

➤ KPI Name. The name of the KPI. The color of the 
header indicates the worst status of the KPI.

➤ Location. The name of the location (country, city, 
and state, if applicable).

➤ Status. The status of the KPI.

➤ Held status since. The time and date when the KPI 
status changed to the current status.

➤ Caused by. The names of the CIs/monitors where 
the problem occurred.

GUI Element (A-Z) Description
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<View> When you select a view in View Explorer, the 
Geographical Map tab displays the selected view bar 
centered in the tree with all its root CIs expanded. 

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

open In a Virtual Earth map, open the map in a standalone 
page by clicking open to explore the map in one 
window and perform other tasks in the main 
Dashboard window.

Road/Aerial/Bird’s 
Eye/Hybrid/Labels

Click:

➤ Road to display the map with the country borders

➤ Aerial to display the map with the topographical 
features

➤ Bird’s Eye for future use.

➤ Hybrid to display the map with both the country 
borders and the topographical features

➤ Labels to display only the real-time status indicators.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

Search Use this feature to perform a search in Microsoft MSN 
Virtual Earth (outside of HP Business Availability 
Center). 

GUI Element (A-Z) Description
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Using the Map Applet 

The following is an example of a geographical map using the Map applet. 

Description If you do not have an Internet connection, the 
Geographical Map page displays a maps applet graphic 
instead of a Virtual Earth map. 

The Geographical tab displays the worst status at each 
geographical location and detailed information about 
the CI’s KPIs. 

The map applet present a flat geopolitical view of the 
planet. 

Useful Links “Understanding the Maps Applet” on page 199

For details on the functionality of View Explorer, see 
“Working with View Explorer” in Model Management.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

 Enable you to zoom in and out to enlarge or shrink the 
map.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

<Adjustments> Click the area that interests you. The map shifts to 
make the location you clicked the new center of the 
map.

Note: 

➤ You can save the adjustments that you make in 
Dashboard Administration. 

➤ You cannot save the adjustments you make in 
Dashboard Application; they are lost when you 
change tab or application.

<Status of a location 
with group CIs or 
with monitor CIs>

The geographical map of the view displays the worst 
status at each geographical location. 

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The color coding is the same as for other icons in 
Dashboard. For more information about color coding, 
see “KPI Status”. 

The round icon represents the status of a location 
when at least one of the CIs is not a monitor CI.

The square icon represents the status of a location 
where all the CIs are monitor CIs.



Chapter 7 • Geographical Map

219

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. 

The tooltip includes the following information:

➤ KPI Name. The name of the KPI. The color of the 
header indicates the worst status of the KPI.

➤ Location. The name of the location (country, city, 
and state, if applicable).

➤ Status. The status of the KPI.

➤ Held status since. The time and date when the KPI 
status changed to the current status.

➤ Caused by. The names of the CIs/monitors where 
the problem occurred.

<View> When you select a view in View Explorer, the 
Geographical Map tab displays the selected view bar 
centered in the tree with all its root CIs expanded. 

GUI Element (A-Z) Description
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Using Google Earth (Admin)

The following is an example of a geographical map using Google Earth. 
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Description Displays the worst status at each geographical location 
and detailed information about the CI’s KPIs. 

Google Earth presents a three-dimensional view of the 
planet. When you magnify the view, the main cities 
appear for the part of the map that is displayed on the 
screen.

Important 
Information

Note to HP Software-as-a-Service: This feature is not 
available when working with HP Software-as-a-Service.

Notes: 

➤ The integration of CI locations with your Google 
Earth installation is at the beta stage.

➤ This feature is only available from Dashboard 
Administration.

Useful Links “Understanding Google Earth” on page 198

“Display a Geographical Map With Google Earth” on 
page 204

For details on the functionality of View Explorer, see 
“Working with View Explorer” in Model Management.



Chapter 7 • Geographical Map

222

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Places area> Select the view and filter the CIs you want to display.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The map presents color-coded status indicators that 
represent the worst status at each geographical 
location. The color coding is the same as for other 
icons in Dashboard. For more information about color 
coding, see “KPI Status” on page 355. 

The round icon represents the status of a location with 
group CIs.

The square icon represents the status of a location with 
monitor CIs.

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. 

The tooltip includes the following information:

➤ KPI Name. The name of the KPI. The color of the 
header indicates the worst status of the KPI.

➤ Location. The name of the location (country, city, 
and state, if applicable).

➤ Status. The status of the KPI.

➤ Held status since. The time and date when the KPI 
status changed to the current status.

➤ Caused by. The names of the CIs/monitors where 
the problem occurred.

<Zoom and direction 
tools>

Enables you to zoom in or out of the current display.
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8
Custom Map

This chapter describes the Dashboard Custom Map.

This chapter includes:

Concepts

 ➤  Custom Maps on page 224

Tasks

 ➤  Display a View in a Custom Map on page 225

Reference

 ➤  Custom Map User Interface on page 230
Concepts
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Custom Maps

The Custom Map feature enables you to associate a view’s CIs represented by 
real-time status indicators with a custom image that describes the real world 
that your view represents. The graphical representation of a view used by 
your organization can be a logical network diagram, business logic, or any 
other graphics. For details on the custom maps user interface, see “Custom 
Map Page” on page 230.

For example, you can associate a graph representing your company’s 
network with real-time data coming from the different parts of the network.

One custom map can be defined for each view. The image shown in the 
Custom Map tab is the one defined for the active view. When you select a 
different view, the corresponding image is automatically displayed in the 
tab. If you do not define a custom map for a view, users accessing the 
Custom Maps tab, when that view is active, see a message stating that there 
is no defined image for the view.

You can create a custom map by adding CI icons from the view and 
associating them with elements of the custom image. The status indicator 
shows the worst status (worst of all KPIs) for that CI.
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When you place the cursor over the status indicator, a tooltip shows the 
name of the associated CI, and KPI details. For details, see “Custom Map 
Page” on page 230.

When you click a status indicator, the corresponding CI in the View 
Explorer is highlighted. If necessary, the View Explorer automatically 
expands to show the selected CI.

When your site does not have an Internet connection, you can upload an 
image or the URL of an image to be used as the background image.

Note: 

➤ The tab displays the image centered in the image pane. If the image is 
larger than the image pane, use the scroll bars. 

➤ When a CI is removed from the IT universe model, the corresponding CI 
icon (in Dashboard Administration) and the corresponding status 
indicators (in Dashboard) are automatically removed from the relevant 
custom maps.

Tasks

Display a View in a Custom Map

This section describes the processes to view real-time status indicators in a 
custom map, and gives examples.

This task includes the following steps:

➤ “Create a Custom Map for a View” on page 226

➤ “Add CIs to the Custom Map” on page 227

➤ “Display a View’s Custom Map” on page 228
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 1 Create a Custom Map for a View
You can create a custom map by selecting a view and attaching the URL of 
the custom image or the image itself to that view. For details, see “Custom 
Map Page” on page 230.

Any type of image supported by the browser can be loaded from any URL 
(including HTTP protocol and HTTP authentication) but then you must 
ensure that the URL is available at all times. 

You can also upload a file system image if you want the image to be 
available at all times. 

The ideal image to select depends on the customer’s environment. The 
custom map feature does not resize the image, so it might look different in 
different resolutions. Additionally, you can view the Custom Map tab with 
or without View Explorer which influences the size of the image you want 
to display.

Example

You want to use a picture of your network to display the status of each 
element in the network:
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 2 Add CIs to the Custom Map
You can add CI icons to the image, to create an association between the 
image and the view. Select the CI in View Explorer, and click Add CI Icon. 
The CI icon is displayed in the left top corner of the diagram with a blue 
outline. Drag the CI to the required location in the diagram. The CI icon is 
set at that position.

For details, see “Custom Map Page” on page 230.

Example

You add the appropriate CI to the custom map:
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 3 Display a View’s Custom Map
After you complete the custom map, display it in Dashboard to view the CI’s 
status in the appropriate location in the diagram.

Example – Add CIs to Custom Map

The custom map displayed for the user is as follows:
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Example – Examples of Custom Maps

Other examples of custom maps can be:

Reference
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Custom Map User Interface

This section describes:

 ➤  Custom Map Page on page 230

Custom Map Page 

Description Enables you to create or display a map for the selected 
view including the view's CIs represented by real-time 
status indicators and a background custom image.

To Access: 

➤ Select Admin > Dashboard, and click the Custom 
Map tab.

➤ Select Applications > Dashboard, and click the 
Custom Map tab.

Important 
Information

➤ You can use, as an image, any diagram or picture, 
provided that the format is supported by the 
browser. Recommended formats: GIF, JPG, or PNG.

➤ Do not overlap CI icons. When icons do overlap, 
only the top status indicator is visible in the custom 
map.

➤ After setting a CI icon on the diagram, you can 
move the cursor over it to display the CI name in a 
tooltip.

➤ You can save the image you want to use as the 
background to the custom map to HP Business 
Availability Center or you can use a URL to access an 
external image.

➤ You can add this report as a portlet in My BSM. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BSM.

Included in Tasks “Display a View in a Custom Map” on page 225

Useful Links “Custom Maps” on page 224

For details on the functionality of View Explorer, see 
“Working with View Explorer” in Model Management.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

This icon appears only in Dashboard Administration.

Marks the location of the status indicator for the CI. 

Use the Refresh button at any time to reload the 
diagram (for example, if changes have been made to 
the source file). Reloading the diagram does not affect 
the position of the indicators.

<Current image 
information>

A string with the image information is displayed above 
the image. The string starts with Linked URL <URL> or 
Saved Image.

<Status indicator> Status indicator icons appears only in Dashboard 
Application.

The status indicator indicates the worst status (worst of 
all KPIs) of the CI. 

For details on the statuses, see “KPI Status” on 
page 355.
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<Tooltip> Move the cursor above the status icon of the CI to 
display additional information about each KPI 
attached to the CI in a separate section. The tooltip 
associated with a CI status indicator displays 
information about each KPI attached to the CI in a 
separate section. The color of each section represents 
the color of the corresponding KPI’s status. For details 
on the colors, see “KPI Status” on page 355.

The tooltip can display any of the following 
information, depending on the KPI:

➤ the header of each section displays Details followed 
by the name of the KPI

➤ CI name. The name of the CI.

➤ Status. The status of the KPI.

➤ Held status since. The date and time when the status 
changed to the current status.

➤ Historical worst. The tooltip of the historical status 
of the CI. For details, see “Trend and History” on 
page 362.

Add CI Icon This button appears only in Dashboard 
Administration.

Click the Add CI Icon button to add the selected icon. 
The CI icon is displayed in the left top corner of the 
diagram with a blue outline . Drag the CI to the 
required location in the diagram. The CI icon is set at 
that position.

GUI Element (A-Z) Description
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Browse This button appears only in Dashboard 
Administration.

Click the Browse button to browse the local file system 
and select the image you want to use as a background 
for the custom map.

Clear CI Icons This button appears only in Dashboard 
Administration.

Click the Clear CI Icons button to clear all the CI icons. 
A confirmation message is issued: You are about to 
clear all nodes from the view. Are you sure?

Delete Image This button appears only in Dashboard 
Administration.

Click the Delete button to delete the image and all the 
CI icons from the custom map associated with the 
current view.

Image URL This field appears only in Dashboard Administration.

The URL of the image must use the format: 
<protocol>://<hostname>/<path_to_image>

The protocol can be HTTP or HTTPS.

To use a local machine as the location of the image, 
enter the URL with the following format: 
file:///<path_to_image> 

This results in an image that cannot be displayed for a 
user working outside the local network.

You can also use a file-sharing path as follows: 
\\server\<path_to_image>

When you enter a URL, the Save and Link to URL 
buttons are enabled.

GUI Element (A-Z) Description
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Link to URL This button appears only in Dashboard 
Administration.

The button is enabled only when the file in the Image 
URL box is not a file system image (shared or URL).

Click the Link to URL button to save the URL of the 
image.

Note: 

➤ Only one URL or one image is saved per view.

➤ If you enter a URL in the Image URL box and click 
the Link to URL button, the URL is saved.

Remove CI Icon This button appears only in Dashboard 
Administration.

Click the Remove CI Icon button to remove the CI 
icons in the custom map. 

Revert This button appears only in Dashboard 
Administration.

Click the Revert button to revert to the last saved 
configuration before you save the changes.

Save This button appears only in Dashboard 
Administration.

Click the Save button to save the image. 

Note: 

➤ Only one URL or one image is saved per view.

➤ If you enter a URL in the Image URL box and click 
the Save button, the image itself is saved like a 
regular image.

GUI Element (A-Z) Description
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9
Introducing Flow Map

This chapter describes the Dashboard Flow Map page. The Flow Map page 
can display flow information for Business Process Insight CIs or transaction 
topology information for TransactionVision CIs. It can also display other 
flow maps.

This chapter includes:

Concepts

 ➤  Flow Map Overview on page 237

 ➤  Mapping of Other CI Types on page 238

Tasks

 ➤  Display a Flow Map on page 239

 ➤  Modify the Flow Map Mapping on page 240

Reference

 ➤  Flow Map User Interface on page 242
Concepts

Flow Map Overview

The Flow Map tab displays a flow map for specific CIs related to Business 
Process Insight or to TransactionVision. 

In the Business Processes view, the flow map displays pre-configured flow 
map information about specific CIs, according to the level of the CI in the 
topology (monitor or group CI). For details, see “Business Process Insight 
Flow Map Overview” on page 245.
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In the Business Transactions views, the flow map displays pre-configured 
transaction topology information about specific CIs, according to the level 
of the CI in the topology (monitor or group CI). For details, see “Transaction 
Topology Flow Map Overview” in Using TransactionVision.

For the relevant CIs, the Flow Map tab displays the URL of other flow map 
resources.

For details on the Flow Map user interface, see “Flow Map Page” on 
page 243.

Mapping of Other CI Types 

The mapping of CIs and their flow map resources is defined in the 
repository-like def.xml file.

You can add other Business Process Insight CIs to the def.xml file and map 
them to Business Process Insight flow maps.

You can also add CIs that are not related to Business Process Insight or 
TransactionVision to the def.xml file and map them to the URLs of other 
flow map resources. 

If you are an advanced user, you can make the following changes in the 
def.xml file:

➤ Add a customized mapping of other CI Types to the URLs of other flow map 
resources.

➤ Specify the context menus, context menu items, tooltips, and refresh rates 
that are used in Flow Map.

➤ Modify the default out-of-the-box mapping between the CI Type and the 
relevant flow map diagram resources using a pre-processor class and a set of 
parameters for the class instance for Business Process Insight--related CIs. 

For details about the def.xml file, see “Modify the Flow Map Mapping” on 
page 240.

Tasks
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Display a Flow Map 

You can display, in the Flow Map tab, the flow map for CIs that have been 
assigned flow map resources.

This task includes the following steps:

➤ “View/Edit the def.xml file – Optional” on page 239

➤ “Reset the Repositories” on page 239

➤ “Display the Relevant CI’s Flow Map” on page 240

 1 View/Edit the def.xml file – Optional
You can add Business Process Insight-related CIs to the out-of-the-box 
def.xml file by mapping CIs to the appropriate flow map resources. 

You can also add other CI types to the mapping definitions in the def.xml 
file and associate them to other flow map resources. 

To review or edit the mapping definitions, access the def.xml file in the 
<HP Business Availability Center home 
directory>\HPBAC\AppServer\webapps\site.war\bam\conf\repositories\
flowmapMapping directory.

For details, see “Modify the Flow Map Mapping” on page 240.

 2 Reset the Repositories
If you have added new CI Types or if you have edited existing CI Types in 
the def.xml file you must save the changes as follows:

 a In the browser, enter, using JMX login credentials:
 http://<HP Business Availability Center server name>
:8080/jmx-console/

 b Double-click service=repositories_manager listed under Topaz.

 c In the JMX MBean View for repositories-manager that opens, click the 
Invoke button corresponding to the cleanDefaultRepositories() 
parameter. 

 d Restart HP Business Availability Center.
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 3 Display the Relevant CI’s Flow Map
To display a CI’s flow map:

 a Select Applications > Dashboard > Console.

 b Select the appropriate view.

 c Select the relevant CI (when the CI is associated with a flow map 
resource, the Flow Map tab is enabled). 

 d Click the Flow Map tab to display the appropriate Flow Map page 
corresponding to the selected CI. 

For details, see “Flow Map Page” on page 243.

Modify the Flow Map Mapping

You can view, edit, or modify the mapping specification used by the flow 
map.

To modify the flow map mapping:

 1 Access the def.xml file located in the <HP Business Availability Center home 
directory>\HPBAC\AppServer\webapps\site.war\bam\conf\repositories\
flowmapMapping directory.

The def.xml file defines the links between the CI types and the relevant flow 
map diagram resources. A link is expressed as a pre-processor class and a set 
of parameters for the class instance. The pre-processor class is used to specify 
the URL of the flow map diagram resource. 
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 2 In the def.xml file, create new links or edit existing links between a CI Type 
and the URL of the corresponding flow map resource using the following 
format:

Use the following parameters to define the links:

➤ ci type is the name of the CI Type. To find the internal name of a CIT, 
select Admin > Universal CMDB > Modeling > CI Type Manager, select 
the appropriate CIT in View Explorer and click the Details tab, and view 
the name of the CIT in the Name box. 

➤ dashboard auto refresh state represents the auto-refresh feature of the 
mapping mechanism. If it is set to:

➤ true. The mapping mechanism uses Dashboard auto-refresh. For 
details, see “Customize Dashboard Display and Refresh Rate” on 
page 69.

➤ false. The Flow Map refresh is done by the hosted application. 

➤ pre-processor class is the name of the class used for the URL pre-
processing mechanism. The DashboardURLPreprocessor and 
DashboardMultiSelectURLPreprocessor classes are used by default. You 
can also use a customized pre-processor class or use the Generic pre-
processor class as a template for the customized pre-processor class. For 
details, see “Dashboard Generic URL” on page 789. 

➤ flowmap url is the URL of the flow map that opens in the Flow Map tab.

➤ constant value represent a constant value used in the URL.

<FlowMapCIMapping id="ci type" enableAutoRefresh="dashboard auto refresh state">
 <PreProcessing __class="pre-processor class">
  <params>
   <param key="URL" value="flowmap url"/>
   <param key="generalParam" value="constant value"/>
   <param key="queryParam" value="dyna parm" convert_to_key="parm name in query"/>
  </params>
</PreProcessing>

</FlowMapCIMapping>



Chapter 9 • Introducing Flow Map

242

➤ dyna parm is the name of the CI attribute that you want to convert into 
the dynamic parameter for the URL that is specified in param name in 
query.

➤ param name in query is the name of the dynamic parameter in the URL 
that corresponds to the CI attribute specified in dyna parm. In the 
resulting URL, the value received from parsing the dynamic parameter is 
named after this parameter: <resulting url>?<param name in 
query>=<dynamic parameter value>

 3 Save the def.xml file and perform the rest of the steps in “Display a Flow 
Map” on page 239. 

Reference

Flow Map User Interface

This section describes:

 ➤  Flow Map Page on page 243
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Flow Map Page

Description Displays the flow map for the selected CI.

Depending on the selected CI you can display a flow 
map for:

➤ Business Process Insight CIs in the Business 
Processes view. For details, see “Flow Map Page” on 
page 255. 

➤ TransactionVision CIs in the Business Transactions 
view. For details, see “Transaction Topology Flow 
Map User Interface” in Using TransactionVision.

➤ Other CIs. For CIs that have been associated with 
flow map resources, select the relevant view in View 
Explorer, click Applications > Dashboard > Console, 
select the relevant CI (when the CI is associated with 
a flow map resource, the Flow Map tab is enabled), 
and click the Flow Map tab to display the 
appropriate Flow Map page corresponding to the 
selected CI. 

Important 
Information

The context menu options and tooltips available in 
Flow Map are configured in Business Process Insight or 
in TransactionVision. 

For customized CIs, the Flow Map framework supplies 
javascript calls for displaying Dashboard tooltips and 
context menus in the user configured pages. If you 
want to use the javascripts, contact HP Software 
Support.
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Business Process Insight Flow Map

This chapter includes the main concepts, tasks, and reference information 
for the Business Process Insight Flow Map.

This chapter includes:

Concepts

 ➤  Business Process Insight Flow Map Overview on page 245

 ➤  Business Process Insight Licensing Options on page 249

Tasks

 ➤  View Data in the Flow Map on page 250

Reference

 ➤  Business Process Insight Flow Map User Interface on page 254

Troubleshooting and Limitations on page 261
Concepts

Business Process Insight Flow Map Overview

The Business Process Insight Flow Map gives you a visual overview of the 
overall status of the health of your Business Process. 

Specifically, the Flow Map provides you with visibility into the health of the 
Business Processes that are running over your IT infrastructure. Using this 
information, you can assess the business impact of delays or blockages in a 
Business Process due to an IT performance problem or other incident such as 
an IT outage.
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Note: Flow Map is referred to as a Process Diagram throughout the Business 
Process Insight Server documentation.

You create a Business Process using the Business Process Insight Modeler and 
you link individual Steps in the Business Process to CIs, which represent 
information held for your business and its IT infrastructure. 

A Business Process is a high-level model that represents a key business 
activity within your business or organization, for example, an order 
processing process, or an insurance claim process. Using the Business 
Process Insight Modeler, you can model your Business Processor Processes, 
and link information held for your business and its IT infrastructure, in the 
form of CIs, to Steps in the process. 

Business Process Insight then checks for changes in the state of the IT 
infrastructure CIs and presents the change in status as a process diagram 
located on the Flow Map. As a result, if there is an IT operational resource 
failure, and a Step in your Business Process relies in this resource, the process 
diagram provides a visualization of the impact of the IT failure on your 
Business Process and thus the impact of this failure to your business activity.

For information about how to construct a Business Process using the 
Modeler, see the Business Process Insight Integration Training Guide - Modeling 
Processes guide. There is also information available within the Modeler from 
the Modeler Help menu option.

This section includes the following topics:

➤ “Business Process Insight Server” on page 247

➤ “Structure of a Business Process Insight Business Process” on page 248
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Business Process Insight Server
If you have installed the Business Process Insight Server, you are able to 
model Business Processes and also individual instances of Business Processes 
(an instance might be a specific customer order with a unique customer 
identifier). As a result, there is additional information available on the 
process diagram. This is information that provides data relating to the 
individual instances of the Business Process; for example, the current value 
of all orders at a particular Step in the process, or how many orders are 
currently being processed at a particular Step. The Business Process Insight 
Server might be maintaining many processes instances, for many customers, 
at any particular time.

Installing the Business Process Insight Server provides additional features 
that enable you to visualize and track the state and business health of 
Business Processes within your organization; this is in addition to 
monitoring the IT infrastructure. For more information, see the Reference 
Information for Business Process Insight guide.
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Structure of a Business Process Insight Business Process
Within Business Process Insight, a Business Process is presented as a series of 
Steps, and connectors that are called Arcs. The Steps represent the business 
activities and the arcs connect the Steps to show the expected direction of 
flow within the Business Process; this is shown in the following diagram.

Business Processes and Business Process Steps are represented as CIs within 
the UCMDB as follows:

There are no CI types for arcs.

CI Type Description

Business Process Stores the Process Name and Process Description as 
entered using the Business Process Insight Modeler.

A Business Process CI is created for each Business 
Process. 

Business Process CIs are logical CIs.

BPI Business Process Step Stores the Step Name and Description as entered 
using the Business Process Insight Modeler.

A BPI Business Process Step CI is created for each 
Step in a Business Process.

BPI Business Process Step CIs are logical CIs. 
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When you install the Business Process Insight Server, additional CI types are 
defined for Business Process Insight, these additional types are listed in 
"Enhancing BAC with Process Instance Monitors" in Using Business Process 
Insight.

Business Process Insight Licensing Options

The detail presented on the Flow Map varies according to whether or not 
you have purchased a suitable license for the Business Process Insight 
application:

➤ You do not have a license for the Business Process Insight application.

In this case, you can model Business Processes, map process Steps to IT 
operational resource CIs and monitor the impacts of the IT operational 
resources using the Flow Map. A Business Process might be the definition of 
an order processing procedures where individual steps in the procedure rely 
on IT systems within your organization, for example, an order processing 
database, or a customer database.

➤ You do have a license for the Business Process Insight application and have 
installed the Business Process Insight Server.

In this case, additional information is presented on the Flow Map; this 
information enables you to monitor business and operational data related to 
individual process instances. As an example, you can monitor and track the 
progress of an individual customer order and view the business data 
associated with this particular order. This business data might be the value 
of the order, or the number of customer orders currently being processed at 
a particular Step in the process.

For more information about the capabilities of the Business Process Insight 
Server, see the Reference Information for Business Process Insight guide.

Tasks
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View Data in the Flow Map

This task describes how to create a Business Process CI using the Business 
Process Insight Modeler, and then view the Flow Map for the CI.

This task includes the following steps:

➤ “Prerequisites” on page 250

➤ “Viewing the Health of Your Business Process” on page 251

 1 Prerequisites
In order to view a Business Process within the Flow Map, you must first 
create and deploy a Business Process using the Business Process Insight 
Modeler. To access the Business Process Insight Modeler, select Admin > 
Business Process Insight > Modeling, click the icon for the Modeler on the 
page, or the Modeler label, and wait for the Modeler to launch as a Java Web 
Start application.

You might be asked to confirm that you want to download the files to open 
the Modeler within your Web page. If required, confirm that you want the 
download to proceed.

For more information about using the Business Process Insight Modeler, 
refer to the following guides: HP Business Process Insight Modeler and 
Integration Training Guide - Modeling Processes.
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Example

The following is an example of a Business Process called Order created 
within the Business Process Insight Modeler. 

 2 Viewing the Health of Your Business Process
To view the health of your Business Process, relative to the IT operational 
resource CIs that you have linked to the process Steps:

 a Select Applications > Dashboard

 b Select the Business Process View

 c Select the specific Business Process CI that you want to view

 d Click the Flow Map tab
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The amount of detail shown on the Flow Map depends on whether you:

➤ have the Business Process Insight Server installed and configured.

➤ are viewing a Business Process that has been created to enable you to 
monitor the status of business events, in addition to the status of the IT 
infrastructure. 

If this is a standard HP Business Availability Center installation and you 
have not installed a Business Process Insight Server, the Flow Map shows 
details of the Business Process and its dependencies on the IT infrastructure 
CIs that you have configured.

Example

The following is an example of the Order process as viewed within the Flow 
Map for a HP Business Availability Center installation where there is no 
Business Process Insight Server installed and configured.
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If you have installed a the Business Process Insight Server and deployed a 
Business Process to additionally enable you to monitor individual instances 
of Business Processes, the Flow Map shows additional information. This 
information shows additional information that relates to the business 
health of your process.

Refer to HP Business Process Insight Modeler and Integration Training Guide - 
Modeling Processes for more information on modeling Business Processes to 
show the business health of the process.

Example

The following is an example of the Order process as viewed within the Flow 
Map when you have the Business Process Insight Server installed and have 
configured the system to monitor and track individual instances of the 
Order process.
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The diagram shows the value of orders at each Step in the process, plus the 
number of instances that are currently being processed at a particular Step. 
This is in addition to the IT infrastructure information, which is always 
available.

Reference

Business Process Insight Flow Map User Interface

This section describes:

 ➤  Flow Map Page on page 255
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Flow Map Page

The following diagram shows the structure of a Flow Map.
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Description Shows the components and structure of a Business 
Process diagram and the health status of the Business 
Process selected from the Business Process View.

To access: 

1  Select Applications > Dashboard

2  Select the Business Processes view from the View 
Explorer

3  Select the Business Process CI type or a Business 
Process Step CI type in the view explorer to view in the 
Flow Map

4  Click the Flow Map tab.

Enables you to visualize the Business Process and 
includes Step annotations, which show information such 
as how many process instances are active at a particular 
Step.

When displayed in the Flow Map, the Business Process 
has the same layout and structure as that when it was 
created using the Business Process Insight Modeler.

Important 
Information

If a Step CI type is selected in the View, the Step is 
highlighted when the Flow Map is displayed.

For more information on the Business Process Insight CI 
types refer to "Enhancing BAC with Process Instance 
Monitors" in Using Business Process Insight.

Included in Tasks “View Data in the Flow Map” on page 250.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

This and the icon that follows enable you to toggle 
between a fit-to-pane view and a normal view.

Click this icon to stretch or shrink the Flow Map such 
that it fits within the available space.

This and the icon above enables you to toggle between a 
fit-to-pane view and a normal view.

Click this icon to revert the Flow Map to the size it was 
when defined within the Modeler

<Business process 
icons>

The following icons are shown on the Flow Map. These 
icons are the same as those used when creating the 
Business Process using the Business Process Insight 
Modeler:

This icon is the Step that represents the normal 
starting point for a process.

This icon is the Step that represents an activity 
within your Business Process, for example, a check 
for account details.

This icon is the Step that represents the normal 
end point for a process.

This icon represents a junction point within your 
Business Process and is a visual Step and is used to 
help define the structure of the Business Process. It 

shows the start and end point of a structural element in 
the process.

Note: A visual representation of the health of the 
Business Process with respect the IT operational resources 
on which it depends. The health of each Step is shown as 
an icon overlay. 

Tooltip: Hold the cursor over the Step to show any 
business KPIs defined for the selected Step. If there are no 
KPIs defined there is no tooltip shown.
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<Normal arc> Process Steps are linked using Arcs, which are dotted lines 
that join Steps. The Arc shows the direction of the flow in 
the Business Process; they do not imply any sequence or 
processing order, but they do imply an expected order. 
Arcs are not enforced; however, they are used when 
determining the status of the process. 

If you want to know when the Steps in your process are 
executed in an unexpected order, use a Sequence Arc.

<Sequence arc> A Sequence Arc is a solid line and is a notification that 
the Steps, which are connected by the arc, are expected 
to be executed in the order implied by the direction of 
the arc. The connect order is determined by the direction 
of the arc between the Steps. If the Steps are executed in a 
different order, an Out of Sequence event is generated by 
the Business Process Insight Server.

<Step name> This is the text below the Step icon. This is the name of 
the BPI Business Process Step CI as entered in the 
Business Process Insight Modeler when the process was 
created; for example: Process Order.

GUI Element (A-Z) Description
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<Step overlay> The Step overlays provide additional information on the 
Flow Map. This information shows the health of the of 
the selected Business Process with respect to the IT 
operational resources on which the process depends.

This is the health of the Business Process in terms of the 
IT infrastructure of the underlying systems to which the 
individual Business Process Steps are linked:

A system health status of OK. All the system KPIs 
fell within their configured settings.

A system health status of Warning. The worst status 
of any system KPI, for a dependent CI, was reported 

as a warning (using the worst-child rule).

A system health status of Minor. The worst status of 
any system KPI, for a dependent CI, was reported as 

minor (using the worst-child rule).

A system health status of Major. The worst status of 
any system KPI, for a dependent CI, was reported as 

major (using the worst-child rule).

A system health status of Critical. The worst status 
of any system KPI, for a dependent CI, was reported 

as critical (using the worst-child rule).

The system health status is No Data. This means 
there is insufficient data to make a decision on the 

system health status.

GUI Element (A-Z) Description



Chapter 10 • Business Process Insight Flow Map

260

<Text in upper left-
hand corner of Step 
icon>

This is a value for the Value property at the Step.

In the case of an Activity Step, this is the total for the 
Value property of the Business Process for all the 
instances that are currently active at that Step.

In the case of an End Step, this represents the total for 
the Value property for all the instances of the Business 
Process that have completed at that Step.

If the locale for the system is set, a currency symbol 
appears with the text for values that are currencies.

Customization: You can customize this text as described 
in "Annotations for Process Diagrams" in Using Business 
Process Insight.

Note: This element appears only if you have installed the 
Business Process Insight Server and have configured the 
system to monitor and track individual instances of the 
selected Business Process. 

<Text in upper right-
hand corner of Step 
icon>

This is the count of the number of instances that are 
currently active at the Step. The End Step shows the total 
of the completed instances for the business; this is the 
total of all instances since the process was deployed in 
the Modeler or the counts were reset. 

If the locale for the system is set correctly, the count is 
displayed in a locale-sensitive format.

Customization: You can customize this text as described 
in Using Business Process Insight.

Note: This element appears only if you have installed the 
Business Process Insight Server and have configured the 
system to monitor and track individual instances of the 
selected Business Process.

GUI Element (A-Z) Description
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Troubleshooting and Limitations

This section includes troubleshooting and limitations for the Business 
Process Flow Map within Dashboard.

Status of Business Process Steps Always Unknown
In order to see the impact of the health of the underlying IT operational 
resources on your Business Process, you must link the Steps in the process to 
the CIs that represent the IT infrastructure; these CIs also need to have 
objectives configured for their KPIs. You link the process Steps to the IT 
infrastructure CIs using the Business Process Insight Modeler; for details, see 
the Business Process Insight Integration Training Guide - Modeling Processes 
guide.
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11
Dashboard Reports 

This chapter describes the Dashboard reports.

This chapter includes:

Concepts

 ➤  Dashboard Reports Overview on page 265

Tasks

 ➤  View KPIs Over Time Information on page 267

Reference

 ➤  Reports User Interface on page 269

Troubleshooting and Limitations on page 298
Concepts

Dashboard Reports Overview

Dashboard reports enable you to view and analyze performance data 
collected by HP Business Availability Center data collectors and stored in the 
HP Business Availability Center database. 

The Dashboard reports are:

➤ KPIs Summary. Displays a summary of KPI status distribution over time for 
each selected KPI. For details, see “KPIs Summary Report” on page 291.

➤ KPIs Trend. Displays the trend for changes in KPI status over time, for 
selected statuses. For details, see “KPIs Trend Report” on page 294.
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➤ KPIs Distribution Over Time. Displays KPI status distribution over time for 
selected statuses. For details, see “KPIs Distribution Over Time Report” on 
page 273.

➤ KPIs Over Time. Displays the status or value, over time, of selected CIs and 
KPIs that are accessible from the Dashboard application. For details, see 
“KPIs Over Time Report” on page 277.

You can print the generated report, send the report by email, open the 
report in different formats, publish the report in different formats, or save 
the report to the report repository. For details, see “Working in Reports - 
Overview” in Reports.

Note: 

➤ Data is displayed in a report starting from the point that data was 
collected for the selected CIs. For example, if you set the report to show 
data every week for the past month, but data was collected only for the 
past two weeks, the report shows data starting from two weeks ago to the 
present date.

➤ The KPI Summary, KPI Trend, and KPI Distribution Over Time reports are 
generated only for CIs of type Application, Business Process, Business 
Service, and Line of Business; in addition, the CIs must be flagged to save 
KPI data over time (historical data). For details, see “Persistent Data and 
Historical Data” on page 366. (Contact HP Software Support if you need 
to change the supported CITs.)

➤ HP Business Availability Center records in a reports log errors that occur 
when generating reports. The reports log can also include the following 
activities: creating a new report, generating a report, modifying the 
report filters, drilling down in reports, and so on. For details on the 
reports log, see “Reports Log” in Reports.

➤ HP Business Availability Center enables you to generate Dashboard 
reports automatically, and to specify a header and a footer for those 
reports. For details, see “Customizing Reports” in Reports.

Tasks
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View KPIs Over Time Information

The steps below describe the process used to set up to view KPIs over time 
information in Dashboard.

This task includes the following steps:

➤ “Save KPI Status Information for the KPIs Over Time Reports” on page 267

➤ “Access KPIs Over Time Reports” on page 267

➤ “Drill Down to HP Diagnostics” on page 268

➤ “Access KPIs Distribution Over Time Report” on page 268

➤ “Access the KPIs Summary Report” on page 268

➤ “Access the KPIs Trend Report” on page 268

 1 Save KPI Status Information for the KPIs Over Time Reports
Persistent data is used to produce KPIs Over Time reports with status 
information, as described in “KPIs Over Time Report” on page 277. Set the 
Save KPI data over time for this CI option to save the calculated 
measurement for each of the CI KPIs, at 15 minute intervals (default value). 
This is done by activating the saveValuesToPersistency global attribute in 
the Business Rule Repository. For details, see “Persistent Data and Historical 
Data” on page 366.

This option is selected, by default, for Business Services, Applications, 
Business Processes and others. This option is not available for Monitor type 
CIs.

 2 Access KPIs Over Time Reports
You can access the KPIs Over Time reports from different locations in 
HP Business Availability Center.

To access KPIs Over Time report, see “KPIs Over Time Report” on page 277.
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Note: The context menu includes the KPIs Over Time Report option for all 
CIs except for monitors. The report displays data only for CIs whose KPIs are 
persistent. For details, see “Persistent Data and Historical Data” on page 366.

 3 Drill Down to HP Diagnostics 
If HP Diagnostics integrates with HP Business Availability Center, you can 
drill down to HP Diagnostics views from the KPIs Over Time report for 
Business Process Step CIs in the End User Monitors views, and for the 
Diagnostics Probe Group, and Diagnostics Probe CIs in the Diagnostics 
View. For details, see “KPIs Over Time Report” on page 277.

 4 Access KPIs Distribution Over Time Report
KPIs Distribution Over Time report enables you to analyze KPI trend by 
viewing KPI status distribution over time for selected statuses. For details, 
see “KPIs Distribution Over Time Report” on page 273.

 5 Access the KPIs Summary Report
KPIs Summary report enables you to view a summary of KPI status 
distribution over time for each selected KPI. For details, see “KPIs Summary 
Report” on page 291.

 6 Access the KPIs Trend Report
KPIs Trend report enables you to analyze the trend for changes in KPI status 
over time, for selected statuses. For details, see “KPIs Trend Report” on 
page 294.

Reference
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Reports User Interface

This section describes:

 ➤  Configuration Items Dialog Box on page 270

 ➤  KPIs Dialog Box on page 272

 ➤  KPIs Distribution Over Time Report on page 273

 ➤  KPIs Over Time Report on page 277

 ➤  KPIs Summary Report on page 291

 ➤  KPIs Trend Report on page 294

 ➤  Statuses Dialog Box on page 298
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Configuration Items Dialog Box

Description Enables you to select the CIs to be included in a 
Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
CIs.

To access: In a Dashboard report, click Configuration 
Items in the reports settings area.

Important 
Information

➤ When selecting CIs for the KPI Summary, KPI Trend, 
and KPI Distribution Over Time reports, only CIs 
that meet the following criteria are available for 
selection in the Configuration Items dialog box:

➤ The CIs with attached KPIs.

➤ The CIs that are flagged to save KPI data over time 
(historical data). For details, see “Persistent Data 
and Historical Data” on page 366.

➤ The CI types that are defined for inclusion in 
these reports; by default, Application, Business 
Process, Business Service, and Line of Business 
CITs are defined for inclusion. (Contact HP 
Software Support if you need to change the 
supported CITs.)

➤ When selecting CIs for the KPIs Over Time report, 
only non-monitor (leaf) CIs are available for 
selection. 

➤ Only CIs are flagged to save KPI data over time 
(historical data) appear in the KPIs Over Time report. 
For details, see “Persistent Data and Historical Data” 
on page 366.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<View tree> Displays the CIs in the selected view. Select the check 
boxes for the required CIs.

Browse The default mode for the Configuration Items dialog 
box, enabling you to select a view and CIs.

Search Click the Search link to move to Search mode, where 
you can search for CIs. For details, see “Working with 
View Explorer” in Model Management.

View Select the relevant view from the dropdown list (start 
typing in the view name to filter the list), or click the 
ellipse button to open the Select View dialog box, 
where you can select a view from the view folders tree.

Note: Only the CIs selected in the currently displayed 
view are saved for the report filter when you click OK. 
If you select another view before clicking OK, all 
previous CI selections are discarded.
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KPIs Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to select the KPIs to be included in a 
Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
KPIs.

To access: In a Dashboard report, click KPIs in the 
reports settings area.

Important 
Information

You must define at least one CI for the report before 
you can select KPIs. After selecting CIs, the Application 
KPI is in some cases selected automatically (if it is 
attached to the selected CIs).

GUI Element (A-Z) Description

KPIs Lists the KPIs that are attached to the selected CIs. 
Availability and Performance are listed first, then all 
other KPIs in alphabetical order.

Select the check boxes for the required KPIs.
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KPIs Distribution Over Time Report

The following is an example of the KPI Distribution Over Time report. 
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Report Settings

Description Displays KPI status distribution over time for selected 
statuses.

To access:

➤ Select Applications > Dashboard > Reports tab > KPIs 
Distribution Over Time.

➤ Access the KPIs Distribution Over Time portlet in 
My BSM.

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 270.

➤ You can add this report as a portlet in My BSM. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BSM.

Useful Links “Configuration Items Dialog Box” on page 270

GUI Element (A-Z) Description

<Common report 
elements>

See “Common Report Elements” in Reports.

Configuration Items Displays the name of the selected CI for the report, and 
if more than one CI is selected, indicates the number of 
CIs that the report is based on. For example, 
Filtered (4) means that four CIs are selected for 
inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.
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KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3). 

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, then this KPI is selected 
automatically.

Statuses Indicates the number of statuses that are included in 
the report and the 7 possible statuses separated by a 
slash; for example, Filtered (5/7).

Click the Statuses link to open the Statuses dialog box 
where you can select statuses.

Default value: All statuses that are defined as 
non-critical are selected, and All Non-Critical Statuses 
is displayed. For details, see “Statuses Dialog Box” on 
page 298.

GUI Element (A-Z) Description
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Bar chart> Each KPI instance for each CI is displayed in a separate 
bar chart (as long as there is relevant data for the KPI 
on that CI). Each chart shows status distribution (in 
percentage) for the KPI over the selected time frame. 

<Bar> Each bar in a chart represents a time interval, 
according to the granularity selected for the report. For 
example, if the selected granularity is every 1 week, 
then each bar represents a week during the overall time 
frame. The legend for the x-axis shows the time 
interval for each bar.

Each bar is divided into colored status sections, 
according to the statuses selected for inclusion in the 
report, so that each section represents the percentage 
of time that the status was held by the KPI during that 
time interval.

Tooltip: Hold the pointer over a bar section to display a 
tooltip containing the following information:

➤ Status. The name of the status represented by the 
section.

➤ Status Duration. Amount of time that the KPI held 
this status during the time interval. This can be 
given in hours, minutes, and seconds (for example, 
01:10:48) or in days and hours (for example, 30 
days, 9 hours).

➤ Status Percentage. Percentage of the time interval 
that the KPI held this status. 



Chapter 11 • Dashboard Reports

277

KPIs Over Time Report

Description Enables you to view the status or the value, over time, 
of selected KPIs and CIs, in table or graph format.

For example, when you encounter a problem with a 
specific CI while viewing the Dashboard, and the 
Performance and Availability KPIs are attached to that 
CI, you can view the KPIs Over Time report of that CI’s 
Performance and Availability. You can also receive a 
daily report showing all CIs statuses in the past day.

To access: 

➤ Select Applications > Dashboard > Reports > KPIs 
Over Time. The report is also available from the 
context menu of CIs in Dashboard.

➤ Access the KPIs Over Time portlet in My BSM.
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Important 
Information

The report displays the status or value of each CI and 
each instance of the attached KPIs. For example, when 
you select one CI with the Availability and 
Performance KPIs, and another CI with the Availability 
KPI the report has only three rows.

➤ You can:

➤ Add this report as a portlet in My BSM. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BSM. 

➤ Add this report to a custom report. For details, see 
“Customizing Reports” in Reports. 

➤ Schedule when to run the report. For details, see 
“Report Schedule Manager Main Page” in Platform 
Administration.

➤ If you select a future date in the To setting in the 
report settings, the report is not generated and an 
error message is issued.

➤ The report is designed to provide information about 
the KPIs of higher level CIs; for example, Business 
Services, Application, Business Processes CIs, and so 
on, but not about the KPIs of monitor CIs. To obtain 
similar information about the KPIs of monitor CIs, 
see “Reports User Interface” in Using End User 
Management, “Alerts and Reports” in Using System 
Availability Management, or “Trend Reports” in 
Reports.

➤ The context menu of all CIs except monitors CIs 
includes the KPIs Over Time Report option. 

➤ The report displays data only for CIs with persistent 
KPIs. For details, see “Persistent Data and Historical 
Data” on page 366.

➤ There is no limit to the number of lines that can be 
displayed in the table. If displaying the table slows 
performance, it is recommended to limit the time 
period or the number of CIs and KPIs you want to 
display.

Included in Tasks “View KPIs Over Time Information” on page 267
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Report Settings

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Common report 
elements>

See “Common Report Elements” in Reports.

Configuration Items Indicates the number of CIs that are included in the 
report. For example, Filtered (4) means that four CIs 
are selected for inclusion in the report.

To select CIs, click the Configuration Items link. For 
details, see “Configuration Items Dialog Box” on 
page 270.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are defined 
for the selected CIs separated by a slash, for example, 
Filtered (1/3). 
All is displayed when all available KPIs are selected.

To select KPIs, click the KPIs link. For details, see “KPIs 
Dialog Box” on page 272.

Default value: When you select one or more CIs and 
the Performance and Availability KPIs are assigned to 
those CIs, the KPIs are automatically selected.



Chapter 11 • Dashboard Reports

280

Report type Select:

➤ Statuses. To display the status information in the 
report. For details, see “KPIs Over Time Report with 
Status Data” on page 281. The KPIs Over Time report 
with status data displays only the status of the 
selected KPIs for the selected CIs. Those KPIs may 
also have values in the HP Universal CMDB but the 
report does not show the values. 

➤ Values. To display the value information in the 
report. For details, see “KPIs Over Time Report with 
Value Data” on page 287. The KPIs Over Time report 
with values data displays only the value of the 
selected KPIs for the selected CIs. Those KPIs may 
also have statuses in the HP Universal CMDB but the 
report does not show the statuses. 

GUI Element (A-Z) Description
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KPIs Over Time Report with Status Data

The following is an example of the KPI Over Time report with status data. 

Important 
Information

The report displays data only for CIs whose KPIs are 
persistent. For details, see “Persistent Data and 
Historical Data” on page 366.

Ensure that the Save historical data for this CI option 
has been selected for the CI. For details, see “KPIs Page” 
on page 409.

Note: The statuses are shown over time, starting with 
the event and ending with the next event. 

The report displays only the status of the relevant KPIs. 
Those KPIs may also have values in the HP Universal 
CMDB but the status report does not show those 
values.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to display status information about the children 
that contribute to the status of the selected CI’s KPI.

Note: Drilling down to the level of the monitor CI is 
unavailable as there is no calculated status for those CIs 
and only raw data is available. To obtain similar 
information about the KPIs of monitor CIs, see “Real 
User Monitor Reports User Interface” in Using End User 
Management, “Alerts and Reports” in Using System 
Availability Management, or “Trend Reports” in Reports.

Example: A view has the following hierarchy: the 
Cust_1_BPM_1 CI, with its tx_10, and tx_15 child CIs. 

The KPIs Over Time report displays information about 
the status of the Performance KPI for the 
Cust_1_BPM_1, tx_10, and tx_15 CIs. 

Click the Drill to influencing children button for the 
Cust_1_BPM_1 CI and the Performance KPI. The drilled 
down report displays the status of the Performance 
KPIs for all of the children of the Cust_1_BPM_1 CI 
that have a Performance KPI, as shown in the graph 
that follows. 

If the selected CI and KPI do not have influencing 
children, then the report displays the message: No 
influencing children found.
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Click to display status information about the parents of 
the CI whose status is influenced by the status of the 
selected CI’s KPI. A CI may have more than one parent 
but the parent CIs that are displayed in the report are 
the parent CIs that are part of the view.

Note: You can drill up to influenced parents only when 
the CIs have persistent data.

Example: A view has the following hierarchy: the tx_10 
CI and its parent the Cust_1_BPM_1 CI.

The KPIs Over Time report displays information about 
the Availability and Performance KPIs of the tx_10 CI. 

Drill up to influenced parents for the Availability KPI, 
the report displays the status of the Availability KPI for 
the Cust_1_BPM_1 CI (parent of tx_10 CI), as shown in 
the graph that follows.  

If the selected CI and KPI do not have influenced 
parents, then the report displays the message: No 
influenced parents found.

GUI Element (A-Z) Description
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<Drill down> This capability is available only in graph format.

Click any time segment in the graph time footer to drill 
down (zoom) on all of the CI and KPI information for 
that period of time. The time segment you zoom on is 
split into four equal parts that can also be zoomed until 
each time segment is one minute long.

The From date and time of the segment you select 
becomes the From date and time of the whole time 
footer and the To date and time of the segment you 
select become the To date and time of the whole time 
footer.

Example: If the time period you selected is from 7/13/05 
8:51 AM till 7/13/05 4:44 PM, the time footer is split 
into four equal segments. If you drill down on the first 
segment of the time footer, the From date and time of 
that segment is 7/13/05 8:51 AM, and its To date and 
time is what is indicated under the second tick of the 
time footer: 7/13/05 11:29 AM. The drilled down report 
time From and To fields display those dates and times, 
and the time footer of the report displays this period of 
time split into four equal parts: (11:29-8:51)/4=39 mn. 
The first part starts at 8:51 AM, and ends at 
8:51+:39=9:30, the second part starts at 9:30 and ends 
at 9:30+:39=10:09, and so on.

GUI Element (A-Z) Description



Chapter 11 • Dashboard Reports

285

<Drill down to 
Diagnostics>

If HP Diagnostics is enabled, you can drill down to 
HP Diagnostics views from the KPIs Over Time report. 

To access the drill down options, click the down arrow 
to the right of a Business Process Step CIs in the 

End User Monitors View, and of the Diagnostics Probe 
Group, and Diagnostics Probe CIs in the Diagnostics 
View and select one of the options. For information 
about the available options, see “Drill Down to 
HP Diagnostics” on page 289.

By default, if HP Diagnostics is enabled, the 
Application KPI is automatically added to all relevant 
CIs in the CMDB. The relevant CIs are the logical CIs. 
For details, see the HP Diagnostics User’s Guide.

The context menu options that are available from the 
KPIs Over Time report are a subset of the Drill to 
Diagnostics options available in Dashboard. For details, 
see “Drill Down to HP Diagnostics” on page 289.

GUI Element (A-Z) Description
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<Tooltip> Move the cursor above the graph to display more 
information about the KPI. The background of the 
tooltip reflects the color of the status calculated by the 
rule attached to the KPI and according to the KPI’s 
objectives. 

The tooltip displays the name of the KPI in the tooltip 
title and the following information:

➤ Configuration Item. The name of the CI to which 
the current KPI is assigned.

➤ Status. The status of the KPI.

➤ Start Time. The time when an event occurred, 
starting the sampling period for that event.

➤ End Time. The time when a new event occurred, 
ending the sampling period of the previous event.

➤ Duration. The duration of the sampling period.

Configuration Item The name of the selected configuration item.

Duration Note: This field appears only when the report is in 
table format.

The duration of the sampling period.

End Time Note: This field appears only when the report is in 
table format.

The time when a new event occurred, ending the 
sampling period of the previous event

KPI The name of the KPI. 

Start Time Note: This field appears only when the report is in 
table format.

The time when an event occurred, starting the 
sampling period for that event.

GUI Element (A-Z) Description
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KPIs Over Time Report with Value Data

Status When the report is in table format, Status displays the 
status of each KPI of each CI, according to the selected 
granularity, during the selected time period.

When the report is in graph format, Status displays the 
status of the KPI as a background color during the 
selected time period. A tooltip is available for each cell 
in the graph (see <Tooltip> for details).

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Graph> Displays the value of the KPI assigned to a specific CI at 
the specified time (indicated by a colored line).

When you select two KPIs and more than one CI, each 
pair of KPIs is displayed in a separate graph. The left y-
axis displays the scale of the first KPI and the right 
y-axis displays the scale of the second KPI.

When you select one KPI, the Y-axis displays the scale 
for the KPI, a line displays the value of the KPI over 
time, and faint colored horizontal lines show the KPI 
objectives (the colors correspond to the objective 
colors of the KPI).

A legend lists the name of the CI, the name of the KPI 
and the color used to represent the KPI value.
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Drill Down to HP Diagnostics 

The following table displays the Diagnostics drill down options for CIs in 
KPIs Over Time reports:

<Time period> This field appears only in table format.

Each column represents a time segment corresponding 
to the selected granularity of the selected time 
period. The table displays the value of the KPI in 
the time segment.

<Tooltip> This field appears only in graph format.

Move the mouse over any dot in the graph to display 
the value of the KPI at this point.

Configuration Item This field appears only in table format.

The name of the selected configuration item.

KPI This field appears only in table format.

The name of the KPI. Each selected KPI is displayed in a 
separate line.

CI Type Diagnostics Drilldown Options

Diagnostics Probe Group ➤ Summary View (Probe Group Summary)

➤ Layers View (Load)

Diagnostics Probe ➤ Summary View (Probe Summary)

➤ Layers View (Load)

Business Process Step ➤ Transactions View

➤ Layers View

GUI Element (A-Z) Description
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The HP Diagnostics views accessed with the context menu options that are 
available from the KPIs Over Time report are as follows:

HP Diagnostics Views Description

Summary View Note: This option is available for all Diagnostics 
Probe CIs. This option is displayed only if you have 
Diagnostics installed. 

Opens the Probe Summary View in the 
HP Diagnostics application, for the probe group and 
for the time frame specified in the View box in the 
KPIs Over Time report. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Layers View Note: This option is available for all Business 
Process Monitor, and Diagnostics Probe CIs. This 
option is displayed only if you have Diagnostics 
installed. 

The Layers (Load) view displays the performance 
metrics for the Diagnostics layers where processing 
has taken place in your application, for the 
transaction that corresponds to the Business Process 
Monitor CI or for the selected Probe CI and for the 
time frame specified in the View box in the KPIs 
Over Time report. 

For more information about Diagnostics, see the 
HP Diagnostics User’s Guide.

Transactions View Note: This option is available for all Business 
Process Step CI. This option is displayed only if you 
have Diagnostics installed. 

The Transactions view displays performance metrics 
for the transactions that are being executed by your 
applications, with the transaction corresponding to 
the Business Process Step CI highlighted, and for 
the time frame specified in the View box in the KPIs 
Over Time report. For more information about 
Diagnostics, see the HP Diagnostics User’s Guide.
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KPIs Summary Report

The following is an example of the KPI Summary report. 

Description Displays a summary of KPI status distribution over 
time for each selected KPI.

To access:

➤ Select Applications > Dashboard > Reports > KPIs 
Summary.

➤ Access the KPIs Summary portlet in My BSM.

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 270.

➤ You can add this report as a portlet in My BSM. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BSM.

Useful Links “Configuration Items Dialog Box” on page 270
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Report Settings

GUI Element (A-Z) Description

<Common report 
elements>

See “Common Report Elements” in Reports.

Configuration Items Displays the name of the selected CI for the report, and 
if more than one CI is selected, the number of CIs that 
the report is based on. For example, Filtered (4) means 
that four CIs are selected for inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3). 

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, this KPI is selected automatically.
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Pie chart> Each pie chart represents a KPI instance (name 
displayed at the top) for a CI (name displayed on the 
left), and summarizes the statuses for the KPI over the 
selected time frame (as long as there is relevant data for 
the KPI on that CI). 

Each pie chart is divided into colored status slices, so 
that each slice represents the percentage of time that a 
particular status was held by the KPI. 

Tooltip: Hold the pointer over a pie slice to display a 
tooltip containing the following information:

➤ Status. The name of the status represented by the 
slice.

➤ Status Duration. The amount of time that the KPI 
held this status during the time frame. This can be 
given in hours, minutes, and seconds (for example, 
01:10:48) or in days and hours (for example, 30 
days, 9 hours).

➤ Status Percentage. The percentage of the time that 
the KPI held this status

Functionality: Right-click a pie for animation 
functionality. For more information, see “Viewing 
Reports with Adobe Flash Player” in Reports.
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KPIs Trend Report

The following is an example of the KPI Trend report. 
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Report Settings

Description Displays the trend for changes in KPI status over time, 
for selected statuses.

To access:

➤ Select Applications > Dashboard > Reports tab > KPIs 
Trend.

➤ Access the KPIs Trend portlet in My BSM.

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 270.

➤ Data is displayed in the report starting from the 
point that data was collected for the selected CIs. For 
example, if you set the report to show data every 
week for the past month, but data was collected 
only for the past two weeks, the report shows data 
from two weeks ago to the present date.

➤ You can add this report as a portlet in My BSM. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BSM.

Useful Links “Configuration Items Dialog Box” on page 270

GUI Element (A-Z) Description

<Common report 
elements>

See “Common Report Elements” in Reports.

Configuration Items Displays the name of the selected CI for the report, and 
if more than one is selected, indicates the number of 
CIs that the report is based on. For example, 
Filtered (4) means that four CIs are selected for 
inclusion in the report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.
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Group by Select a radio button to determine how the data is 
organized:

➤ CIs. A separate chart is displayed for each CI, 
containing trend data for all relevant KPIs.

➤ KPIs. A separate chart is displayed for each KPI, 
containing trend data for all relevant CIs.

KPIs Indicates the number of KPIs that are included in the 
report, and the total number of KPIs that are attached 
to the selected CIs separated by a slash; for example, 
Filtered (1/3).

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, this KPI is selected automatically.

Statuses Indicates the number of statuses that are included in 
the report, and the seven possible statuses separated by 
a slash; for example, Filtered (5/7).

Click the Statuses link to open the Statuses dialog box 
where you can select statuses.

Default value: All statuses that are defined as 
non-critical are selected, and All Non-Critical Statuses 
is displayed. For details, see “Statuses Dialog Box” on 
page 298.

GUI Element (A-Z) Description
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Report Content

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Chart in report> A separate chart is displayed for each included CI, or 
for each included KPI, depending on the Group by 
filter selection. Each chart shows status trend (in 
percentage) over time, within the selected time frame 
(as long as there is relevant data for the KPI on that CI).

<Line on chart> Each line on the chart represents the status trend for a 
specific KPI on a specific CI, based on a compilation of 
all statuses selected in the Statuses filter. A legend is 
given to distinguish each KPI or CI.

The points for the line are plotted at the intervals 
defined by the report granularity (the legend for the 
x-axis shows the time interval for each point), so that 
each point represents a period of time during the 
overall time frame.

Each point shows the percentage of time that the KPI 
held all included statuses during that time interval. For 
example, if the KPI had OK status for 10% of the time 
interval, and Warning status for 20%, and both of these 
statuses are included in the Statuses filter, then both 
periods are included in the total percentage (adding 
30% to the total).

Tooltip: Hold the pointer over a point on the line to 
display a tooltip containing the following information:

➤ Status Duration. The total time that the KPI held the 
included statuses during the time interval. This can 
be given in hours, minutes, and seconds (for 
example, 01:10:48) or in days and hours (for 
example, 30 days, 9 hours).

➤ Status Percentage. Percentage of the time interval 
that the KPI held the included statuses. 

Note: When one line is on top of another, the 
information is the same for both lines.
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Statuses Dialog Box

Troubleshooting and Limitations

HP Business Availability Center records, in a reports log, errors that occur 
when generating reports. The reports log can also include information about 
the following activities: creating a new report, generating a report, 
modifying the report filters, drilling down in reports, and so on. For details 
on the reports log, see “Reports Log” in Reports.

Description Enables you to select the KPI statuses to be included in 
a Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
statuses.

To access: In a Dashboard report, click Statuses in the 
reports settings area.

Important 
Information

➤ You must define at least one CI for the report before 
you can select statuses. 

➤ When you first select the CIs for the report or open 
the report, the default status selection is 
automatically applied. The default selection is for all 
statuses that are defined as non-critical, meaning all 
statuses other than Critical.

You can modify the definition of non-critical 
statuses in the Infrastructure Settings page:
Select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Default 
Non-Critical Statuses entry in the Business Report 
Properties table. Modify the value to include or 
exclude the required statuses.
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12
Dashboard Ticker 

This chapter describes the Dashboard Ticker.

This chapter includes:

Concepts

 ➤  Dashboard Ticker Overview on page 301

Tasks

 ➤  View Data in Dashboard Ticker on page 305

 ➤  Control Dashboard Ticker on page 307

 ➤  Set Ticker Preferences on page 308

Reference

 ➤  Ticker User Interface on page 309
Concepts

Dashboard Ticker Overview

HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center. 

Using HP Dashboard Ticker, you can, without opening HP Business 
Availability Center, select a view, select the server where HP Business 
Availability Center is installed, adjust the rate and the scrolling speed of the 
Ticker Window, and open the Message Window.
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This section includes the following topics:

➤ “Understanding Dashboard Ticker” on page 302

➤ “Ticker Window” on page 303

➤ “Message Window” on page 304

Understanding Dashboard Ticker
After you install HP Dashboard Ticker, one of HP Dashboard Ticker’s icons 
appears in the desktop tray bar. The type of icon displayed indicates 
different situations. A tooltip is available for each icon to describe HP 
Dashboard Ticker’s status.

For details on installing the Ticker, see “Install Dashboard Ticker” on 
page 305.

Status Icon Description Tooltip

Online. The ticker has connected with 
the server and is monitoring status.

Connected with 
<server-url>

where server-url is 
the URL of the 
server.

Message. An incoming message was 
received. A KPI has turned to Critical 
state. 

Incoming message

Offline. The server could not be found 
or the response returned from the 
server is not recognizable.

Offline - <reason>

where reason 
explains why the 
ticker is offline.

Connecting. Dashboard Ticker is 
attempting to connect to the server. 

The indication is an animated icon.

Connecting...



Chapter 12 • Dashboard Ticker

303

HP Dashboard Ticker attempts to connect with the server using the supplied 
server address after the period of time specified in the Update interval 
parameter in the Preferences. If the server cannot be found or a connection 
cannot be established, the tray icon changes to Offline. For details on the 
Update interval parameter, see “Ticker Preferences Dialog Box” on page 312.

The tray icon changes to Connecting if Dashboard Ticker is trying to 
connect to the server. 

The tray icon changes to Online when the server has connected successfully. 

Every KPI in the selected view is checked. Any KPI with an error status is 
checked against the information already in HP Dashboard Ticker. If it is the 
first time this KPI appears in the view, or if the KPI’s status has changed to 
an error status, it is displayed in the Message Window and/or the Ticker 
Window. As soon as a message is put in the queue, the tray icon changes to 
Message, indicating that there is a message to be viewed. HP Dashboard 
Ticker’s internal message queue can contain an unlimited number of 
messages. 

Ticker Window
The Ticker Window displays a scrolling list (from right to left) of the top 
level CIs monitored by Dashboard along with icons that display the status of 
each one of the CI’s KPIs.
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Move the mouse above any icon in the Ticker Window to display a tooltip 
that includes the name of the KPI.

For details, see “Ticker Window” on page 309 in the user interface section.

Message Window
The Message Window is used to inform the user that a KPI’s status has 
changed to error/poor/worst. 

The Message Window displays the following information: 

For details, see “Message Window” on page 310 in the user interface section.

Tasks
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View Data in Dashboard Ticker

HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center. For details, see 
“Dashboard Ticker Overview” on page 301. 

This task includes the following steps:

➤ “Install Dashboard Ticker” on page 305

➤ “Launch Dashboard Ticker” on page 305

➤ “Meet the Requirements” on page 306

➤ “Control Ticker Behavior” on page 306

➤ “Set the Ticker Preferences” on page 306

➤ “View Dashboard Information in Dashboard Ticker” on page 307

 1 Install Dashboard Ticker
Install HP Dashboard Ticker as explained in this section.

To install HP Dashboard Ticker, select Admin > Platform > Setup and 
Maintenance to open the Downloads page, click HP Dashboard Ticker and 
follow the on-screen instructions.

Note: HP Dashboard Ticker 7.5 is compatible with HP Business Availability 
Center 8.0.

 2 Launch Dashboard Ticker
After HP Dashboard Ticker is installed, you must launch it to configure its 
behavior.

To launch HP Dashboard Ticker, select Start > Programs > HP Dashboard 
Ticker > HP Dashboard Ticker to launch the application and open the 
Preferences page. For details, see “Ticker Preferences Dialog Box” on 
page 312.
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 3 Meet the Requirements
To use the HP Dashboard Ticker you must have the following software 
installed on your computer: 

➤ Win2000 or Windows XP 

➤ Microsoft Internet Explorer 6.0 Service Pack 1 or later

Note: The requirements listed above are for the desktop version of HP 
Dashboard Ticker. To log on to HP Business Availability Center from the 
Message Window, you must fulfill the requirements detailed in the 
HP Business Availability Center Database Guide PDF.

 4 Control Ticker Behavior
You can control the behavior of HP Dashboard Ticker using the options that 
are displayed by right-clicking the icon in the tray bar. Depending on the 
icon, a subset of the capabilities described in this section is displayed. 

For details, see “Control Dashboard Ticker” on page 307.

 5 Set the Ticker Preferences
You can set the Ticker preferences so that you can view messages 
automatically or you can click the Message icon to display the Message 
Window. The Message Window fades out after 5 seconds. 

If you click the icon in the Message Window, the message that is currently 
displayed is removed from the queue as soon as you close the window. 

If you select to display the Message Window automatically and you do not 
click that window, the Message Window fades out after 5 seconds, and the 
message is considered unread. It is not removed from the queue.

For details, see “Set Ticker Preferences” on page 308.



Chapter 12 • Dashboard Ticker

307

 6 View Dashboard Information in Dashboard Ticker
HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center.

For details on the Ticker Window, see “Ticker Window” on page 303.

For details on the Message Window, see “Message Window” on page 304.

Control Dashboard Ticker

You can view an event in the Message Window or in the Ticker Window. 
You can open the Web browser, connect to the HP Business Availability 
Center server, and display the view in Dashboard. You can select what 
information is displayed in HP Dashboard Ticker, and how it is displayed.

You can control the behavior of HP Dashboard Ticker using the options that 
are displayed by right-clicking the icon in the tray bar. For details, see 
“Understanding Dashboard Ticker” on page 302. 

Depending on the icon, a subset of the following options is displayed:

➤ Show Current Event. To display the event if an event is waiting in the 
queue. For details, see “Message Window” on page 304.

➤ Show Ticker. To display the Ticker Window. For details, see “Ticker Window” 
on page 309.

➤ Log On. Opens the default Web browser, connects to the HP Business 
Availability Center server, and displays the view in Dashboard. For details, 
see “Dashboard Administration and Application” on page 22.

➤ Preferences. To modify the information that is displayed in HP Dashboard 
Ticker, and how it is displayed. For details, see “Ticker Preferences Dialog 
Box” on page 312.

➤ About. To display the About window.

➤ Exit. To exit HP Dashboard Ticker.
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Set Ticker Preferences

You can view messages automatically (defined in Preferences) or you can 
click the Message icon to display the Message Window. The Message 
Window fades out after 5 seconds. 

If you click the icon in the Message Window, the message that is currently 
displayed is removed from the queue as soon as you close the window. 

If you select to display the Message Window automatically and you do not 
click that window, the Message Window fades out after 5 seconds and the 
message is considered unread. It is not removed from the queue.

You can:

➤ reload a View to Display in the Ticker Window or in the Message Window

➤ select the View to Display in the Ticker Window or in the Message Window

➤ change the Server You are Accessing

➤ modify the Refresh Rate of the Ticker Window

➤ change the Scrolling Speed of the Ticker Window

➤ select the Dock Orientation of the Ticker Window on Your Desktop

➤ display a Popup Message Window When a New Message Arrives

➤ sound an Alert When a New Message Arrives

➤ automatically Load HP Dashboard Ticker When You Start Your Computer

For details on the steps to follow to view data in Dashboard Ticker, see 
“View Data in Dashboard Ticker” on page 305.

For details on setting the Ticker preferences, see “Ticker Preferences Dialog 
Box” on page 312.

Reference
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Ticker User Interface

This section describes:

 ➤  Ticker Window on page 309

 ➤  Message Window on page 310

 ➤  Ticker Preferences Dialog Box on page 312

Ticker Window

Description Enables you to view a scrolling list (from right to left) 
of the top level CIs monitored by Dashboard along 
with icons that display the status of each one of the 
CI’s KPIs. The icons correspond to the icons displayed 
in the Top View tab in Dashboard. 

To Access: Set up Dashboard Ticker. 

Important 
Information

➤ You set the scrolling speed of HP Dashboard Ticker 
in the Scrolling speed parameter in the Preferences 
page. For details, see “Ticker Preferences Dialog Box” 
on page 312.

➤ When you have moved the Ticker Window to a 
specific location on your desktop, the window is 
displayed in the same location the next time you 
select Show Ticker in the Preferences page or when 
you restart your computer.

➤ If you move the mouse to the Ticker Window, 
scrolling stops; it resumes when you move the 
mouse out of the Ticker Window.

➤ If you change any parameter in the Preferences page, 
scrolling restarts from the beginning.

➤ Modify the number of CI levels you want to display 
by changing the value of the Number of levels 
parameter in the Preferences. For details, see “Ticker 
Preferences Dialog Box” on page 312.

Included in Tasks “View Data in Dashboard Ticker” on page 305
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Message Window

GUI Element (A-Z) Description

<icons> The icons correspond to the icons displayed in the Top 
View tab in Dashboard. For details, see “KPI Icons in 
Top View” on page 140.

<tooltip> Move the mouse above any icon in the Ticker Window 
to display a tooltip that includes the name of the KPI. 
For details, see “Ticker Window” on page 303.

Description Conveys that a KPI’s status has changed to 
error/poor/worst. 

To Access: Setting up Dashboard Ticker. 

Important 
Information

➤ The window is displayed either automatically or 
manually. For details on how to set this option, see 
“Ticker Preferences Dialog Box” on page 312. 

➤ When you close the message window, the entry that 
was displayed is removed from the queue. You 
cannot re-display that information. When you 
reopen the window, the next message in the queue 
is displayed.

➤ If you specified in the Preferences that an alarm 
should be sounded when a KPI’s status changes to 
error/poor/worst, an alarm sounds when the 
message is displayed. For details on the Preferences 
dialog box, see “Ticker Preferences Dialog Box” on 
page 312.

Included in Tasks “View Data in Dashboard Ticker” on page 305
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

The status icon of the KPI.

<first line> The name of the CI.

<second line> The name of the KPI.

<third line> The date and time when the status change was received 
by Dashboard Ticker.

Log-on Click the Log-on link to automatically open the view 
you specified in the Preferences, in the Console tab in 
Dashboard.
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Ticker Preferences Dialog Box

Connection Settings Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the current preferences for running the 
Dashboard Ticker. 

To Access: Right-clicking the Dashboard Ticker icon in 
the desktop tray bar and selecting Preferences.

Included in Tasks “View Data in Dashboard Ticker” on page 305

GUI Element (A-Z) Description

BAC server URL In the BAC server URL box, enter the URL or the IP 
address of the server you want to access. The URL 
format must be: http://<HP Business Availability 
Center server>/<virtual_Web_URL>
where virtual_Web_URL may be, for example: HPAM.

MMS customer Select if you are an HP Software-as-a-Service customer. 
In the ID box that is displayed, enter the customer ID 
number.

Update interval box The update interval timeout (in seconds). The 
minimum interval is 5 seconds.

Default value: 15 seconds.
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Login Information Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Selection Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Password Enter your password.

User name Enter your user name.

GUI Element (A-Z) Description

Number of levels Enter the number of levels you want to display in the 
Ticker. When displayed in the Ticker, all levels are 
flattened out.

Reload Click the Reload button to reload the views from the 
HP Business Availability Center server you are 
accessing.

View name Select the name of the view you want to display in the 
ticker. 
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Ticker Window Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Dock orientation Select the location of the Ticker on your desktop: 

➤ Top. The Ticker is docked at the top of the desktop.

➤ Bottom. The Ticker is docked at the bottom of the 
desktop.

➤ None. The Ticker is not docked. You can move it 
around on of the desktop. The default is None. 

Scroll speed Select a scrolling speed: Low, Mid, or High. The default 
is Mid.
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Options Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Load Dashboard 
Ticker when my 
computer starts

Select to automatically load Dashboard Ticker when 
you start your computer. For details on the Ticker 
Window, see “Ticker Window” on page 309.

Play incoming 
message sound alert

To automatically sound an alert when a new message 
arrives.

When the sound is switched on, a sound alert is played 
when the Ticker Window is currently displayed and a 
CI’s KPI changes status to Critical (red). The Critical 
status icon is also shown flashing until the next screen 
refresh. The alert sound is a WAV file downloaded by 
the browser. 

Note:

➤ The sound is played only if the status of a CI’s KPI in 
the currently displayed tree branches has changed to 
Critical. If a CI in a hidden part of the view has 
changed to Critical but does not change the status of 
any of the CIs in the currently displayed branches, 
no sound is heard.

➤ If the view is being loaded for the first time, no 
sound is played for the CI’s KPIs that are loaded at 
Critical status.

➤ If you are using Mozilla, you must download a plug-
in for playing WAV files, otherwise no sound is 
played.

To use another alert sound, access (if you are a user 
with administrative permissions) < Gateway server 
root directory>\AppServer\ 
webapps\site.war\bam\pages\sounds and replace the 
ding.wav file with your own WAV file (you must 
rename your file ding.wav). The change takes effect 
immediately.
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Show incoming 
message desktop 
alert

To automatically display the Message Window when a 
new message arrives. If you do not select this option, 
you have to click the message icon to display the 
Message Window.

Show Ticker Window 
when my computer 
starts

To automatically load Dashboard Ticker Message 
Window when you start your computer. For details on 
the Message Window, see “Message Window” on 
page 304.

GUI Element (A-Z) Description
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13
Dashboard on a Mobile Device

This chapter describes how to view Dashboard data on a mobile device.

This chapter includes:

Concepts

 ➤  Dashboard on a Mobile Device Overview on page 317

Tasks

 ➤  View Data on a Mobile Device on page 318

Reference

 ➤  Mobile Device User Interface on page 319
Concepts

Dashboard on a Mobile Device Overview

You can display the operational status of components of your business using 
mobile devices with a browser that supports standard HTML. 
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The configuration items (CIs) are shown in layers where each parent CI is a 
link to the layer of its children CIs. The status of the CI’s Key Performance 
Indicators (KPIs) is displayed on the right of the screen.

For details on what to do to display Dashboard data on a mobile device, see 
“View Data on a Mobile Device” on page 318.

For details on Dashboard data displayed on a mobile device, see “Mobile 
Device Page” on page 320.

Tasks

View Data on a Mobile Device

You can display a view’s data on a mobile device using the steps described in 
this section. 

This task includes the following steps:

➤ “Prerequisites” on page 318

➤ “Access the Server URL” on page 318

➤ “Change Display Characteristics – Optional” on page 319

➤ “Navigate to the View and Display the Data” on page 319

 1 Prerequisites

➤ Ensure that the server you want to access is open to Internet.

➤ Ensure that the browser of the mobile device you want to use supports 
standard HTML.

 2 Access the Server URL
Enter the following URL in your mobile device: 
http://<HP Business Availability Center 
server>/<HP_BAC_web_application_context_name (usually 
topaz)>/mobileConsole.do
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Tip: 

➤ In the mobile device, you can add the URL to your Favorites at any stage 
(login, view, or drill down). Depending on the stage, clicking the Back 
button might not access higher hierarchy levels or the view selection 
page.

➤ You must click Refresh to refresh the display as the refresh feature is not 
automatic and the data becomes obsolete.

 3 Change Display Characteristics – Optional
The display characteristics of the mobile console are controlled by an XSL 
file. To modify any aspect of the display using non-Latin characters (for 
example, displaying the view and button names: Back and Refresh), contact 
HP Software Support for help in writing an XSL to support this feature.

Note: The characters used for KPI names depend on the user’s locale and not 
on the browser’s locale.

 4 Navigate to the View and Display the Data
Enter the appropriate information in the login screen, and select a view. For 
details, see “Mobile Device Page” on page 320.

Reference

Mobile Device User Interface

This section describes:

 ➤  Mobile Device Page on page 320
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Mobile Device Page

The following is an example of the Mobile Device page. 

Description Enables you to display a view on a mobile device. 

To Access: Enter the appropriate information in the 
login screen, and select a view. 

Important 
Information

➤ When more than a few KPIs are attached to the CI 
(depending on the device's screen resolution), the 
display becomes scrollable.

➤ Long CI names are wrapped. 

Note: Only the first four letters of the KPI names are 
displayed in the view. You might have to clone or 
rename some of the KPIs if their first four letters are the 
same; for example SAP and SAP Alert KPIs. All the 
feature’s visual aspects are controlled by the following 
XSL file:
\AppServer\webapps\site.war\mobile\dash\
console.xsl

You can modify the XSL file so the mobile device can 
display longer labels. Contact HP Software Support for 
help in writing an XSL to support that feature.

This XSL file transforms the XML returned from 
HP Business Availability Center server to the mobile-
like HTML file that is displayed on the mobile device.

Included in Tasks “View Data on a Mobile Device” on page 318
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<KPI> The status of the KPIs attached to the CIs. For details 
on the displayed status, see “KPI Status” on page 355.

Note: Only the first four letters of the KPI names are 
displayed on the mobile device. You may want to 
rename the KPIs if their first four letters are the same; 
for example SAP and SAP Alert KPIs.

You can rename KPIs in the KPIs Repository (BAC > 
Admin > Dashboard > Repositories > KPIs).

Tooltip: Click an icon to display the relevant tooltip. To 
hide the tooltip, click anywhere else in the page or wait 
5 seconds. 

The tooltip displays the name of the CI, the status of 
the KPI, the rule used to calculate the status, and the 
date when the status changed, and additional 
information depending on the type of KPI. For 
example, Avg. response time displays the value for the 
Performance KPI, Average for displays over how long 
the average was calculated, Minor and OK are the 
objectives of the Performance KPI (the objective). 

Back Click Back to go back to the login page.
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Name The name of the CIs in the view.

Note: To drill down to a child CI, move the cursor to 
the CI, and click.

Refresh Click Refresh to refresh the view.

View The name of the view you selected in the login page.

GUI Element (A-Z) Description
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14
HP BAC Dashboard Widget

This chapter includes the main concepts, tasks, and reference information 
for using the HP BAC Dashboard Widget to display Dashboard view data.

This chapter includes:

Concepts

 ➤  Dashboard Widget Overview on page 323

Tasks

 ➤  View Data in Dashboard Widget on page 325

Reference

 ➤  Dashboard Widget User Interface on page 329
Concepts

Dashboard Widget Overview

HP BAC Dashboard Widget enables you to continuously monitor the 
operational status of your business, without having Business Availability 
Center Dashboard open on your screen. The Dashboard Widget runs on the 
Yahoo! Widgets application, and displays CI status for a selected Dashboard 
view.

The Dashboard Widget is a small window that can be positioned anywhere 
on your screen, enabling you to display it in a non-intrusive manner while 
working in other applications. You do not need to have Business Availability 
Center open to display view information in the Dashboard Widget.
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The Dashboard Widget presents a flat list of the CIs in a selected view, 
together with KPI status for the CIs. This is the same status information that 
you see in the Applications > Dashboard > Console > Hierarchy tab. You can 
drill down from a parent CI to see its child CIs. 

To install and display the Dashboard Widget, see “View Data in Dashboard 
Widget” on page 325.

For details on working with the Dashboard Widget, see “Dashboard Widget 
User Interface” on page 329.

Tasks
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View Data in Dashboard Widget

This task describes how to install and configure the Dashboard Widget to 
display Dashboard views.

This task includes the following steps:

➤ “Prerequisites” on page 325

➤ “Install Dashboard Widget” on page 325

➤ “Configure Dashboard Widget” on page 326

➤ “Log in to Dashboard Widget” on page 328

➤ “Select a Dashboard View” on page 329

 1 Prerequisites
The Dashboard Widget runs on the Yahoo! Widgets application. If you do 
not have it installed, download the Yahoo! Widgets application from the 
Yahoo! Widget page: http://widgets.yahoo.com/download.

After installing, you can click the Yahoo! Widgets icon in your toolbar to 
view the Widgets Dock at the right edge of the screen.

 2 Install Dashboard Widget
In Business Availability Center, open Admin > Platform > Setup and 
Maintenance > Downloads. Click the HPDashWidget_v1.0_win.zip link and 
extract the contained file (HPDashWidget_v1.0_win.widget) to your local 
machine.

To start the Dashboard Widget, double-click the 
HPDashWidget_v1.0_win.widget file. The file is automatically moved to the 
My Documents\My Widgets folder, created by Yahoo! Widgets on your 
primary local drive.
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Note: The HPDashWidget_v1.0_win.widget file must be located in the My 
Documents\My Widgets folder, so that it is displayed by the Show All 
Widgets button on the Widgets Dock (top right corner). This button opens 
all widgets in the My Widgets folder.

 3 Configure Dashboard Widget
After installing the Dashboard Widget, it is automatically added to the list of 
widgets available from the Widgets Dock on your machine, and Yahoo! 
Widgets displays the Dashboard Widget introductory window.

Note: If the Dashboard Widget introductory window is not displayed, either 
double-click the installed HPDashWidget_v1.0_win.widget file, or perform 
the following steps:

➤ Open Yahoo! Widgets from the Start > Programs menu.

➤ In the Widgets Dock, click the Options Menu icon.

➤ In the Options menu, select Open Widget.

➤ In the Open dialog box, open the HPDashWidget_v1.0_win.widget file.
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Configure the Dashboard Widget to access data from the relevant Business 
Availability Center application as follows: 

 a In the introductory window, click Use Widget. A message is displayed 
warning you that a host must be defined. Click OK to open the HP BAC 
Dashboard preferences window for the Dashboard Widget.

 b In the BAC Settings tab, modify the parameters as required.

➤ BAC protocol. Enter the protocol that your Business Availability Center 
application is using. For example, http.

➤ BAC host. Enter the host name for the Business Availability Gateway 
server, including the DNS domain.

➤ BAC port. Enter the port number used by the Business Availability 
Gateway server. Default is 80.
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➤ Return to last page on startup. Select the check box to have the 
Dashboard Widget remember your user name and password after 
login, and the last view you selected. When you next access the 
widget, it opens directly to the last view.

➤ Refresh interval. Select the refresh interval from the dropdown list. 
Default is 60 seconds.

Note: You can modify the settings at any time by right-clicking in the 
Dashboard Widget window, and selecting Widget Preferences > BAC 
Settings tab.

 4 Log in to Dashboard Widget
After configuring parameters for the Dashboard Widget, the login window is 
automatically displayed. (If the login window is not displayed, open the 
HP BAC Dashboard Widget from the Widgets Dock.)

Enter your Business Availability Center login information and click Submit. 
The Select View window is displayed.
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 5 Select a Dashboard View
In the Select View window, click the arrows to the right of the displayed 
view name to open an alphabetical list of the available Dashboard views in 
Business Availability Center.

Select the required view and click Submit. The selected view is displayed in 
the Dashboard Widget.

Reference

Dashboard Widget User Interface

This section describes:

 ➤  Dashboard Widget Window on page 330
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Dashboard Widget Window

Description Displays Dashboard view data within a Yahoo! Widget. 

To access: Open from the Widgets Dock, or right-click 
the Yahoo! Widgets  icon on your toolbar and select 
Open Widget. Navigate to the 
HPDashWidget_v1.0_win.widget file and open it.

Important 
Information

➤ To move the Dashboard Widget on your screen, 
hold down CTRL while dragging the window.

➤ You can modify some display aspects of the 
Dashboard Widget, for example, you can set the size 
and opacity of the window, or set the Dashboard 
Widget to stay on top of other windows.
Right-click in the Dashboard Widget window and 
select Widget Preferences, then select either the 
Display or Window tab. 

Included in Tasks “View Data in Dashboard Widget” on page 325
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<KPI> Each KPI column displays the KPI status of each CI. For 
details on the displayed status, see “KPI Status” on 
page 355.

Note: Only the first four letters of the KPI names are 
displayed in the Dashboard Widget. You may want to 
rename the KPIs if their first four letters are the same; 
for example SAP and SAP Alert KPIs.

You can rename KPIs in the KPIs Repository (BAC > 
Admin > Dashboard > Repositories > KPIs).

Tooltip: Click a status icon to display the relevant 
tooltip. 

The tooltip displays the name of the CI, the status of 
the KPI, the business rule used to calculate the status, 
and the date when the status changed. It may also 
display additional information, depending on the type 
of KPI. 

Back (Located at the bottom of the Dashboard Widget 
window. Scroll down to display the Back link.)

Click to return to the previous page.

Close (Located at the bottom right of the Dashboard Widget 
window)

Click to close the Dashboard Widget.
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Last update (Displayed at the bottom left of the Dashboard Widget 
window)

Displays the date and time that the data was last 
updated.

Note: While a page is loading, Retrieving data is 
displayed instead.

Name Alphabetically lists the CIs at the currently displayed 
level of the selected Dashboard view.

Note: Click a CI to drill down to its child CIs.

Refresh (Located at the bottom of the Dashboard Widget 
window. Scroll down to display the Refresh link.)

Click to refresh the view data displayed in the 
Dashboard Widget.

Default value: 60 seconds. To change the refresh 
interval, see “Configure Dashboard Widget” on 
page 326.

Note: Displayed information is not automatically 
refreshed. The time of the last update is displayed at 
the bottom of the Dashboard Widget.

Retrieving data (Displayed at the bottom left of the Dashboard Widget 
window)

Displayed while a page is loading.

Note: After load completion, Last update is displayed 
instead.

View Name of the active Dashboard view. Click the view 
name to select another view.

GUI Element (A-Z) Description
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15
Working With KPIs 

This chapter describes how to configure KPIs.

This chapter includes:

Concepts

 ➤  KPI Configuration Overview on page 336

 ➤  How Dashboard KPIs Work on page 338

 ➤  About Business Rules on page 341

 ➤  No Data Timeout for Transaction CIs on page 342

 ➤  KPI Objectives on page 343

 ➤  Selectors for KPIs on page 352

 ➤  KPIs for User Modes on page 355

 ➤  KPI Status on page 355

 ➤  Trend and History on page 362

 ➤  Persistent Data and Historical Data on page 366

Tasks

 ➤  Configure a KPI – Workflow on page 367

 ➤  Attach a PNR KPI to a CI – Scenario on page 372

 ➤  Attach KPIs to CIs and Configure the KPIs on page 374

 ➤  Edit KPI Properties on page 375

 ➤  Define Selectors on page 380

 ➤  Set Up User Mode Functionality on page 386
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 ➤  Change the KPI Status Icons on page 394

Reference

 ➤  KPIs User Interface on page 396
Concepts

KPI Configuration Overview

The Dashboard KPIs (Key Performance Indicators) provide quantifiable 
measurements that help you monitor in real-time how well your business is 
achieving its objectives. The KPIs provide real-time status for the CIs 
representing your business and processes, enabling you to assess the 
business impact of problems in the system.

Each KPI works with a predefined set of values, against which the incoming 
metrics are measured. The resulting measurement for the KPI is translated 
into a color-coded status indicator, displayed in the Dashboard Console, 
where the color represents a more desirable or less desirable condition for 
the KPI. You can learn more about KPI functionality in “How Dashboard 
KPIs Work” on page 338.
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CIs can have multiple KPIs attached. KPIs can be attached to a CI as follows: 

➤ KPIs may be attached to the CI as part of the CI creation.

➤ For CIs created in the Universal CMDB using the source adapters in 
Source Manager all CIs are automatically assigned default KPIs, according 
to the nature of the CI. For example, a CI for a Business Process Monitor 
profile has default KPIs for availability and performance. You can edit a 
source adapter to define additional KPIs that you want added to the 
created CIs.

For more information on the source adapters and how they define the 
default KPIs, see “Source Manager Overview” in Model Management.

➤ For CIs created in the Universal CMDB directly from the monitors, all CIs 
are automatically assigned default KPIs, according to the nature of the CI 
using the KPI Assignment mechanism or the KPI Propagation 
mechanism. You can edit a KPI assignment to define additional KPIs that 
you want added to the CIs.

For more information on the KPI assignments and how they define the 
default KPIs, see “Assignments” on page 421.

➤ CIs that are added manually or by Discovery and Dependency Mapping 
do not have automatically assigned KPIs. For information on how 
Discovery and Dependency Mapping creates CIs, see “Discovery and 
Dependency Mapping – Overview” in Discovery and Dependency Mapping 
Guide.

➤ KPIs may be attached to a CI as a result of propagation from child CIs. Most 
KPIs propagate up through the hierarchy, so that parent CIs have the same 
KPIs as all their child CIs.

➤ KPIs may be manually attached to a CI in the Dashboard Administration 
KPIs tab. You may want to attach new KPIs to a CI, in addition to the 
default/propagated KPIs, to broaden the information derived from the 
monitoring measurements. For example, you can add an OT Impact KPI to 
assess the ongoing cost of an application that is not available.

In the KPIs tab, as well as attaching new KPIs to a CI, you can edit existing 
KPIs and delete attached KPIs. For details, see “KPIs Page” on page 409.
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How Dashboard KPIs Work

HP Business Availability Center provides a selection of predefined KPIs to 
work with Dashboard. The definitions for the KPIs are contained in an XML 
file, which contains the default parameters for creating each KPI instance.

Note: You can edit the KPI definitions, or create customized KPIs, in the KPI 
Repository, as described in “KPI Repository Overview” on page 509.

Each CI has its own attached KPIs (that define what is being monitored for 
that specific CI). Each attached KPI generally defines:

➤ The business rule (for example, Performance rule) to be used with the 
collected metrics, to calculate a measurement for the KPI.

➤ The source for the metrics to be used for the KPI: either from data samples 
(for monitoring CIs), or from other KPIs. In the latter case, the KPI metrics 
may be taken from the child CIs (when using, for example, the Summary of 
Values rule), or from another KPI attached to the same CI (when using, for 
example, the Impact Over Time rule).

➤ The thresholds (objective values) that the KPI measurement is compared 
against; and the status (color) allocated to the KPI, based on the defined 
thresholds.

➤ Where and how to display the status indicator for the KPI in Dashboard, and 
where to store the KPI measurement.

For most KPI types, the KPIs propagate up to all parent CIs (there are 
exceptions to this, for example, the PNR (Service Level Management) KPI). 
This means that if you attach a KPI, for example, Volume, to a child CI, then 
a Volume KPI is also added to each parent CI for that child, up to the top of 
the subtree.

Each KPI added by propagation has its own KPI instance definition, with its 
own business rule and properties. For example, the Volume KPI for a child 
CI may use the RUM Page Monitor Volume Rule, while the Volume KPI for 
the parent CI (added by propagation from the child CI) may use the Worst 
Child Rule.
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The calculations required by the KPI business rule are made by the Business 
Logic Engine. When a data sample arrives on the bus and is identified (by 
means of the KPI selector) as relevant for a specific monitoring CI, the 
required metrics are passed to the relevant KPI instance for that CI, for 
example, an Availability KPI. At regular intervals (default 15 seconds) the 
Business Logic Engine recalculates the measurement for the KPI using the 
metrics received for the KPI since the last calculation.

If the new measurement causes a change in the status of the KPI, the new 
status is passed to the parent CIs. The Business Logic Engine then 
recalculates the measurement for the corresponding KPI of each parent CI, 
using the new received status information. If the new measurement causes a 
change in the status for that KPI, the new status is again passed up the 
hierarchy to the corresponding KPI instances for the parent CIs, and so on. 

You can change the default Business Logic Engine calculation time interval 
in the Infrastructure Settings page. For details, see “Change the Default 
Business Logic Engine Calculation Time Interval – Optional” on page 368.

Notes and Limitations for KPIs and CIs

➤ Any change you make to the KPIs for a CI—adding new KPIs, deleting KPIs, 
or editing KPI properties—changes the CI in the HP Universal CMDB, 
meaning that the changes are seen in any view that includes the CI.

➤ You must create at least one HP Business Availability Center profile database 
for Dashboard to receive data samples. For details, see “Profile Database 
Properties - MS SQL Server Page” in Platform Administration.

➤ There are no restrictions on the type of KPI that can be attached to a CI, or 
on the type of business rule that you can select from the allowed rules list 
for a KPI. You must ensure that you select KPIs and business rules that are 
appropriate for the CI type.

➤ The Application KPI is only applicable for CIs corresponding to 
HP Diagnostics (and is attached automatically to HP Diagnostics CIs when 
HP Diagnostics is supported in HP Business Availability Center). For more 
information, see the HP Diagnostics User’s Guide.
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➤ KPIs added to a CI as part of a SLA definition in Service Level Management 
Administration have no relevance to the Dashboard KPIs and do not appear 
in the KPIs tab. Conversely, KPIs added to a CI in the KPIs tab have no 
relevance for the CI when it is included in an SLA, and do not appear for the 
CI in Service Level Management.

➤ Deleting a KPI may impact on other KPIs that are dependent on the first KPI. 
For example, OT Impact is calculated based on the status of another KPI, 
such as Availability; in this case, deleting the Availability KPI would prevent 
calculation of OT Impact. 

➤ KPIs created for CIs by the source adapter templates frequently have 
objective values that differ from the default ones used by the business rule. 
However, when editing one of these KPIs, if you select a different rule and 
then revert to the original rule, then the original objective values are 
replaced with the rule default values.

➤ The Edit KPI for child transactions button is enabled for all KPIs, but:

➤ It is relevant Transaction and Availability KPIs (an error message is 
displayed for other KPIs).

➤ It is valid only when there are Business Process Monitor transaction CIs 
contained in the subtree. 

Changes made in the Edit KPIs for Child Transaction window have no effect 
on KPIs other than Transaction and Availability, or on CIs for which the 
option does not apply.

➤ After applying the Edit KPI for child transactions option, a KPI was saved 
successfully message is displayed in the top-right corner of the page, even if 
no changes were made to any CIs.

➤ If a transaction CI in the subtree is using a business rule other than the 
default monitor rule for the KPI (Transaction Availability rule or Transaction 
Performance rule), then when you apply the Edit KPI for child transactions 
option, the existing rule is replaced with the default rule.

➤ The Objectives area in the Edit KPIs for Child Transaction window displays 
the default Operator for the rule. When you apply your changes, the 
displayed default operator is updated to all transaction CIs (regardless of 
which operator they were using previously).
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About Business Rules

A KPI must always have an associated business rule that defines the logic to 
be performed (by the Business Logic Engine) to calculate the measurement 
for the KPI. The properties and objectives that are assigned to the KPI 
depend on the selected rule. 

HP Business Availability Center provides predefined rules for use with the 
KPIs. The rules are defined in the Business Rule Repository, where you can 
edit the rules, or create customized rules. For information on the business 
rules available in Dashboard, the roles they play, and how to edit them, see 
“List of Dashboard Business Rules” on page 581.

Some business rules are specific to a particular KPI, while others can be used 
for a variety of KPIs. In the KPI Repository, each KPI has a defined default 
rule, and a list of rules that can be used with that KPI. (If required, the 
default rule and the allowed rule list can be modified.) In addition, if the 
KPI’s CI is a monitor CI, the rule assigned to the KPI is a monitor rule and if 
the KPI’s CI is a group CI, the rule assigned to the KPI is a group rule. For 
details on the types of rules, see “Monitor Rules and Group Rules” on 
page 559.

When a KPI is added manually to a CI in the KPIs tab, it is assigned the 
default business rule defined for the KPI (the default rule is usually a rule for 
groups). For example, for the RT Impact KPI, there are two applicable rules: 
Real Time Impact Rule and Sum of Values Rule. When you add a new RT 
Impact KPI to a CI, the default rule for the KPI, Sum of Values Rule, is 
automatically assigned. You can change the assigned rule when adding or 
editing the KPI in the KPIs tab, by selecting a new rule from the list of 
allowed rules for the KPI. 
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No Data Timeout for Transaction CIs

When a KPI is using a monitor rule (for example, the Transaction 
Availability Rule), the Business Rule Parameters area includes the No data 
timeout property. This property defines the number of seconds from the 
time the last sample was received for the KPI, until the KPI is timed out—at 
which point the KPI changes to decay status (gray). 

The default value for the No data timeout property is generally taken from 
the monitor rule definitions (as defined in the Business Rule Repository). 
However, for Business Process Monitor transaction CIs, Dashboard calculates 
a new No data timeout value, based on the schedule for running the 
transaction. The calculation takes the schedule interval (defined in End User 
Management Administration) for the business process profile that contains 
the transaction (default value = 15 minutes) and adds an additional 90 
seconds. For example, for a transaction with a schedule interval of 15 
minutes, the No data timeout value is 990 seconds. (For details on defining 
the profile schedule, see “Data Collectors Page” in Using End User 
Management.) 

This calculation method means that the timeout value is automatically 
adjusted to align with changes made to the profile schedule interval in End 
User Management Administration, so that the KPI is not incorrectly timed 
out. If there is more than one scheduling scheme in effect, the following 
rules are used for the calculation:

➤ If multiple schedules are defined for a profile running on a Business Process 
Monitor instance, the largest schedule interval is used (all schedules are 
treated equally, whether they apply to the whole week or part of the week).

➤ If the profile is assigned to several locations, each with a different schedule, 
then smallest interval from amongst the locations is used (after first 
applying the rule above).
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KPI Objectives

The KPI objectives define the standards for allocating business status to the 
KPI.

The following sections describe objectives and how to define them for a KPI.

➤ “About Status and Objectives” on page 343

➤ “Defining Logical Objectives” on page 346

➤ “Excluding Statuses” on page 347

➤ “Units of Measurement for Objectives” on page 350

➤ “Example of Defining Objectives” on page 351

About Status and Objectives
The status displayed for a KPI in Dashboard provides an indication of how 
well a business process or system is meeting your business objectives. Based 
on traffic light colors (with additions), the Dashboard shows you if the KPI 
measurement is meeting the objective requirements (green), or is critically 
failing (red), or is at some business risk level between the two. 

Five statuses are available in Dashboard (for active status), each representing 
a different level of business performance:

➤ OK (green)

➤ Warning (teal)

➤ Minor (yellow)

➤ Major (orange)

➤ Critical (red)

Depending on the CI and KPI types, active status may be represented in 
Dashboard using from two to all five of these status levels. In most cases 
(not for SiteScope measurements), the KPI is assigned a status as follows:

➤ The business rule calculates a measurement for the KPI.

➤ The calculated measurement is compared with defined objective values. 
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➤ The KPI is assigned a status according to where the measurement falls 
within the objectives. For example, a KPI measurement of 50% may fall 
within the definition for the Minor objective, so the KPI is assigned Minor 
status (yellow).

The objective values used for each KPI can originate from various sources:

➤ The business rule definitions in the Business Rule Repository provide default 
objective values for every rule that uses objectives. The business rules 
generally define different objective values for each of the five statuses used 
in Dashboard. You can define new default objective values for a business 
rule, as described in “Rule Details Dialog Box” on page 657.

➤ The source adapter may specify specific objective values to be used with the 
business rule for a KPI. These values override the values from the Business 
Rule Repository. You can modify the template for a source adapter to define 
custom objective values, as described in “Modify an Adapter Template” in 
Model Management.

➤ The source adapter may specify reference values for the objective 
parameters, so that the objective values are taken from the threshold values 
defined in End User Management Administration. These values override the 
values from the Business Rule Repository.

➤ You can modify the objective values for an individual KPI in the Dashboard 
Administration KPIs tab, while adding or editing a KPI. The new values 
override values from the source adapter or from the business rule. For 
details, see “No Data Timeout for Transaction CIs” on page 342. 

SiteScope Monitoring CIs

For SiteScope monitoring CIs, KPI status is based on the status received from 
SiteScope (calculated according to the thresholds defined in SiteScope). 
Three status levels are used in Dashboard: 

➤ OK (green) in Dashboard corresponds to Good or OK status in SiteScope

➤ Minor (yellow) in Dashboard corresponds to Warning status in SiteScope

➤ Critical (red) in Dashboard corresponds to Error status in SiteScope

The SiteScope status definitions cannot be changed in Dashboard, so the 
business rules for SiteScope KPIs do not include objective values.
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End User Monitoring CIs 

For end user monitoring CIs (from Business Process Monitor, Real User 
Monitor), KPI status is calculated by comparing the KPI measurement with 
objective values.

➤ For Business Process Monitor transaction CIs, the KPI objective values are 
either taken from End User Management Administration or the rule 
definition: 

➤ For CIs using the Transaction Performance Rule (ID# 13), the Business 
Process Monitoring source adapter references the transaction thresholds 
defined for the corresponding monitoring object in End User 
Management Administration. The threshold values map to KPI objective 
values for three status levels in Dashboard: OK, Minor, and Critical.

➤ For CIs using the Transaction Availability Rule (ID# 5), KPI objectives are 
taken from the default values for the rule in the Business Rule Repository. 
The rule defines objective values for all five status levels in Dashboard.

➤ For Real User Monitor monitoring CIs, depending on the rule used, the KPI 
objective values are taken from the Real User Monitor source adapter, End 
User Management Administration, or the rule definition. For example:

➤ For RUM Application Error Monitor CIs using the RUM Event Monitor 
Volume Rule (ID# 73), the objective values are defined directly in the 
source adapter. The objective values defined for this rule use four of the 
Dashboard status levels: OK, Warning, Minor, and Critical.

➤ For RUM Page Monitor CIs using the RUM Page Monitor Availability Rule 
(ID# 49), the source adapter references the Availability threshold defined 
in End User Management Administration for the page. This is a single 
value, so two status levels are used in Dashboard: OK and Critical.

➤ For RUM Sessions Monitor CIs using the RUM Session Monitor 
Availability Rule (ID# 52), the source adapter does not define objective 
values, so KPI objectives are taken from the default values for the rule in 
the Business Rule Repository. The rule defines objective values for three 
Dashboard status levels: OK, Minor, and Critical.
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For all end user monitoring CIs, you can edit the objective values in the KPIs 
tab to use as many of the status levels as you require, as described in 
“Defining Logical Objectives” on page 346.

Warning: KPIs created for CIs by the source adapter templates, frequently 
have objective values that differ from the default ones used by the business 
rule. However, when editing one of these KPIs in the KPIs tab, if you select a 
different rule and then revert to the original rule, the original objective 
values are replaced with the rule default values.

Defining Logical Objectives
The objectives values for a KPI should cover the whole spectrum of possible 
active measurements for that KPI, which correspond to the OK, Critical, 
Major, Minor, and Warning statuses. The objectives do not include the KPI 
values corresponding to the No Data, Downtime, and Info statuses. 

The KPI measurement is evaluated against each objective level, starting from 
OK (green), and continuing (in order) to Critical (red). This process stops at 
the first objective level into which the KPI measurement fits. 

To define where the boundaries of each objective level falls, each objective 
from OK to Major is associated with an Operator. (The Critical objective 
definition is always Otherwise, meaning that this status is applied to all 
measurements that fall beyond the Major objective limit.) You can select the 
operator that matches your requirements; the same operator is applied to all 
objective levels.

The available operators are:

> 
>=
<
<=
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You must ensure that the objectives contain logical values (according to the 
data type) and are correctly ordered, and that the operator is logical for the 
order. For example:

➤ If you enter descending objective values, such as 70, 55, 40, 20, you must use 
operator > or >=, so that the OK objective covers all measurements greater 
than 70. 
For a KPI measurement of 88: 88 >= 70 is true, so assigned status is OK.
For a KPI measurement of 18: evaluation of the KPI measurement against 
every objective is false, so status falls into the Otherwise category and be 
assigned status Critical.

➤ If you enter ascending objective values, such as 10, 25, 35, 40, you must use 
operator < or <=, so that the OK objective covers all measurements less 
than 10.
For a KPI measurement of 7: 7 <= 10 is true, so assigned status is OK.
For a KPI measurement of 50: evaluation of the KPI measurement against 
every objective is false, so status falls into the Otherwise category and be 
assigned status Critical.

Excluding Statuses
Not all the statuses need be used for a KPI; for example, the OT Impact KPI 
by default uses only OK (green) and Critical (red) status. There are two 
methods used in Dashboard to exclude statuses, as described in the 
following sections.
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Blank Objective Value

When the objective value for a status is left blank, Dashboard ignores that 
status during KPI status calculation. For example, the Performance KPI for a 
transaction may have the following objectives defined (taken from the 
threshold settings for the transaction in End User Management 
Administration):

In this case, if the measurement for the KPI does not fall into the OK 
objective level, then Warning is skipped and the measurement is evaluated 
against the Minor objective level. If it does not fall into that level, Major is 
also skipped, and the KPI is assigned Critical status.

If you want to exclude statuses when editing the objective values for a KPI, it 
is recommended that you use this method.

Repeated Objective Value

Dashboard allocates status by starting at OK status, and evaluating the KPI 
measurement against each objective level until the right level is found. 
When an objective value is repeated for two or more statuses, the repeat 
occurrences are passed over and those statuses are not used. 
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For example, the Availability KPI for a RUM page monitor may have the 
following objectives defined (by using the Availability threshold setting in 
End User Management Administration for all four defined objective values):

In this case, if the measurement for the KPI is greater or equal to 98%, then 
it is given OK status. If it is less than 98%, then evaluation against the 
Warning, Minor, and Major statuses also does not give any result and these 
statuses are not used; the KPI is then assigned Critical status.

Example of Defining Objectives

A specific transaction monitor CI is using the Transaction Performance Rule. 
For this transaction, the required objectives are as follows:

➤ The objective for acceptable performance time is under 6000 milliseconds. 
An average performance time that reaches 6000 milliseconds is already of 
concern.

➤ Performance time of 8000 milliseconds is considered seriously problematic.

➤ Performance time of 10000 milliseconds is considered critical.

In addition, Warning status is not required for this KPI.
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In the Edit KPI window for the transaction’s Performance KPI, the objective 
levels and operator are modified as follows:

When a measurement is calculated for the KPI from the incoming 
performance data, the measurement is compared with the objectives 
assigned to the KPI as follows:

➤ For a measurement under 6000 milliseconds, status = OK

➤ For a measurement of 6000 milliseconds or more, but under 8000 
milliseconds, status = Minor

➤ For a measurement of 8000 milliseconds or more, but under 10000 
milliseconds, status = Major

➤ For a measurement of 10000 milliseconds or more, status = Critical

Units of Measurement for Objectives
The objectives use a unit of measurement, shown after the objective value 
box in the KPI Objectives area:
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The unit is part of the business rule definition, and indicates the format of 
the calculated measurement. This format may reflect the units used by the 
incoming data (for example, milliseconds for performance time data), or it 
may be a new format applied as a result of the business rule calculations (for 
example, dollars for a financial loss calculation). If required, the default unit 
for a rule can be changed in the rule definition (as described in “Rule Details 
Dialog Box” on page 657).

For details about the available default units, see “Units of Measurement for 
Objectives” on page 544.

Example of Defining Objectives
A specific transaction monitor CI is using the Transaction Performance Rule. 
For this transaction, the required objectives are as follows:

➤ The objective for acceptable performance time is under 6000 milliseconds. 
An average performance time that reaches 6000 milliseconds is already of 
concern.

➤ Performance time of 8000 milliseconds is considered seriously problematic.

➤ Performance time of 10000 milliseconds is considered critical.

In addition, Warning status is not required for this KPI.

In the Edit KPI window for the transaction’s Performance KPI, the objective 
levels and operator are modified as follows:
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When a measurement is calculated for the KPI from the incoming 
performance data, the measurement is compared with the objectives 
assigned to the KPI as follows:

➤ For a measurement under 6000 milliseconds, status = OK

➤ For a measurement of 6000 milliseconds or more, but under 8000 
milliseconds, status = Minor

➤ For a measurement of 8000 milliseconds or more, but under 10000 
milliseconds, status = Major

➤ For a measurement of 10000 milliseconds or more, status = Critical

Selectors for KPIs

Monitoring CIs are CIs that are intended to receive real-time data from the 
data samples sent by the external system (purely logical CIs do not receive 
data samples). The data samples, containing information collected by a 
monitoring system (either HP or third-party), are supplied to HP Business 
Availability Center over the bus.

When a monitoring (leaf) CI has a KPI and associated business rule that are 
intended to be applied to actual data samples, the KPI properties include a 
selector. A selector is a filter definition that defines which samples are 
relevant for the KPI.

The Business Logic Engine filters the data samples arriving on the bus using 
selectors, which are set using Dashboard Administration. A selector is 
defined as part of the monitor rule for a KPI attached to a monitoring CI. 
The selector identifies and catches the data that is relevant for the CI and 
the KPI.

A different selector can be used by each KPI with an associated monitor rule, 
enabling (when required) the use of different samples for each KPI. 

You can define selectors as explained in the following sections:

➤ “Monitoring CI in HP Universal CMDB” on page 353

➤ “Dynamic Node Factory CIs” on page 353
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➤ “KPI Assignments” on page 353

➤ “EMS” on page 354

➤ “Source Adapters” on page 354

➤ “KPI Definition in Dashboard” on page 354

Monitoring CI in HP Universal CMDB
When a monitoring CI is added to the HP Universal CMDB by a monitoring 
adapter, a selector is automatically defined for each of the default KPIs for 
the CI. For details, see “Predefined Monitoring Views” in Model Management.

Dynamic Node Factory CIs
The selector is defined directly as part of the CI definition, not in a KPI. The 
selector used by a Dynamic Node Factory can be defined and/or edited in 
the IT Universe Manager tab of CMDB Administration, as described in 
“Working with Dynamic Node Factory Overview” in Model Management. The 
functionality and definitions for a Dynamic Node Factory selector are the 
same as for a KPI selector, as described in this section.

KPI Assignments
You can create or customize a KPI assignment rule for each CI type. An 
assignment rule includes a condition and a task. The condition describes 
specific characteristics of a CI. The task describes the context menus, KPIs, 
rules, rule parameters, and selectors that are to be assigned automatically to 
the CI when the condition occurs, if the assignment is running. For details, 
see “Define Assignment Configuration Dialog Box” on page 452.
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EMS
The mechanism used to integrate EMS (Enterprise Management Systems) 
software into HP Business Availability Center, includes an assignment rule 
mechanism. The assignment rule mechanism is triggered when a specific 
monitor CI attribute is updated. An assignment rule includes a condition 
and a task. The condition describes specific characteristics of a CI. The task 
describes the context menus, KPIs, rules, rule parameters, and selectors that 
are to be assigned automatically to the CI when the condition occurs, if the 
assignment is running. The task description includes a selector. For details, 
see “Define Assignment Configuration Dialog Box” in Solutions and 
Integrations.

Source Adapters
For information on editing selector definitions in the source adapters, see 
“Define Selectors” in Model Management.

KPI Definition in Dashboard
If required, you can edit the default KPI selectors in the KPIs tab. You can 
also attach new KPIs to a monitoring CI, assign a monitor rule and manually 
define the selector. For more information about defining selectors, see 
“Define Selectors” on page 380, “Set Up User Mode Functionality” on 
page 386, or “Set Up User Mode Functionality” on page 386.
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KPIs for User Modes

HP Business Availability Center provides the option to define Dashboard 
KPIs for two different user types (modes): operations and business. This 
option enables the creation of two versions of a single KPI, where each KPI 
version is geared towards the particular viewing requirements of one of the 
user types. Each user type sees the appropriate version of the KPI in the 
Dashboard views.

For example: You might want to create two versions of the Availability KPI, 
so that the Availability KPI for an operations user shows Critical status (red) 
when transaction availability is below 30%, and the Availability KPI for a 
business user shows Critical status when transaction availability is below 
20%.

KPI Status

For each CI, Dashboard displays real-time status in one or more KPI columns 
in the view. 

Each KPI can include three icons: Status, Trend, and History.

A color-coded icon is displayed for each KPI in a view, representing the 
status assigned to that component for its current performance level. In 
addition to the main status icon for a KPI, the KPI column can contain 
additional icons showing trend and history for the CI under that KPI. 
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The status of a KPI in Dashboard provides an indication of how well a 
business process or system is meeting your business objectives. Based on 
traffic light colors (with additions), the Dashboard shows you whether the 
KPI measurement is meeting the objective requirements (green), is critically 
failing (red), or is at some business risk level between the two (teal, yellow, 
orange). For more details on objectives, see “KPI Objectives” on page 343. 

The status of each KPI is calculated using a business rule. A different 
business rule may be used for a parent CI and a child CI with the same KPI 
attached. The business rules are defined for the KPI in Dashboard 
Administration. For details on the rules, see “List of Dashboard Business 
Rules” on page 581.

This section includes the following topics:

➤ “Types of CIs” on page 356

➤ “Colors of KPI Statuses Used in Dashboard” on page 357

➤ “Status Scores” on page 360

➤ “Statuses and Group Rules” on page 360

➤ “Influence of Must and Weight on Status” on page 361

Types of CIs
There are two types of CIs whose status is calculated differently:

➤ Monitor CI

Monitor CIs receive real data from data samples. These data samples are 
used to calculate the status of the KPIs attached to the monitor CIs.

The foundation of status definition for all monitor CIs is a comparison of 
performance metrics with objective values. 

➤ Group CI

For group CIs (all CIs except monitor CIs), Dashboard displays a status icon 
that represents a "summary" of the status for the child components (that is, 
the CIs that belong to the lower level in the hierarchical structure). 
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The Details tooltip for each status icon provides additional information 
regarding the calculation method in use for the KPI: the KPI name, the CI 
name and the KPI status, the time and date when the status was changed to 
its current value, and a warning that states that no update was received.

Note: The color displayed for a CI icon in Dashboard represents a summary 
of interim status values for a predefined duration (the default duration value 
is generally 300 seconds). The calculation of status values is an ongoing 
process, using samples collected every 60 seconds (default granularity 
value), thus the interim status may actually change several times over the 
duration without causing any change in the color of the icon. For example, 
if the icon for a transaction is red at the beginning of a duration, and during 
the duration the interim status changes from red to green and back to red, at 
the end of the duration the icon is still red.

Colors of KPI Statuses Used in Dashboard
The following shows the main status levels that are used to show status for 
KPIs in Dashboard (note that some of the Dashboard KPIs use text in place 
of icons, but use the same color coding to indicate status as shown here):

Icon Description Status Name
Numerical 
Code

Definition

Red circle with 
"X"

Critical 0 The measurement calculated for 
the KPI fell within the value 
range for the Critical objective.

Orange triangle 
with exclamation 
mark

Major 5 The measurement calculated for 
the KPI fell within the value 
range for the Major objective.
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Yellow triangle 
with exclamation 
mark

Minor 10 The measurement calculated for 
the KPI fell within the value 
range for the Minor objective.

Teal circle with 
exclamation 
mark

Warning 15 The measurement calculated for 
the KPI fell within the value 
range for the Warning objective.

Green circle with 
check mark

OK 20 The measurement calculated for 
the KPI fell within the value 
range for the OK objective.

Dark blue circle 
with lowercase i

Info -1 The KPI has a value and no 
status. The reason is that the 
KPI’s objectives have not yet 
been specified. For details on 
setting the objectives, see 
“Objectives Area” on page 402.

Light blue circle 
with question 
mark

Not up to 
date (Decay)

-2 The following cases might be the 
cause of the KPI’s status:

➤ The KPI has passed a timeout 
period during which no new 
information has been 
received.

The default timeout period is 
15 minutes, and the default 
decay status color is light blue.

➤ No performance measurement 
data has yet been received for 
this KPI. This may be the case 
if no measurements have been 
taken for the CI in the period 
since starting Dashboard or 
Business Process Monitor.

Icon Description Status Name
Numerical 
Code

Definition
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Note: 

➤ The numerical code is used in HP Business Availability Center files to 
perform calculation instead of the corresponding status.

➤ To change the color of the icons used at each status level, you can 
customize some of the icons, or complete sets of icons. For details, see 
“Change the KPI Status Icons” on page 394.

➤ Change icons indicate when a change was made to a specific static 
attribute of a specific CI in the HP Universal CMDB. For details, see 
“Monitoring Changes in Dashboard Overview” on page 111.

For Trend and History status, see “Trend and History” on page 362.

Gray with white 
slash

Stopped -3 
(Stopped)

The corresponding 
profile/group/monitor for the CI 
is currently disabled. 

When the stopped period 
finishes, the status icon changes 
to Not up to Date until data is 
received for the CI.

White circle with 
gray outline and 
grey back slash

Downtime -4 
(Downtim
e)

The corresponding 
profile/group/monitor for the CI 
is currently disabled. 

When the downtime period 
finishes, the status icon changes 
to Not up to Date until data is 
received for the CI.

Gray with white 
center

Not 
applicable 
for this CI

N/A This KPI is not applicable for the 
CI.

Icon Description Status Name
Numerical 
Code

Definition
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Status Scores
This section describes how statuses are assigned to KPIs when only three 
main statuses (0, 10, and 20) are used instead of five statuses.

The five real-time statuses and their values are listed in the Value and Real-
time status columns of the table. 

In most rules, only the main three statuses (0, 10 and 20) are used to 
calculate the status. The calculations are assigned statuses according to the 
values listed in the When using only three values column. The colors 
assigned to the values and statuses are listed in the Colors column.

Note: Only relevant statuses (0-20) are taking into consideration ("gray " 
statuses are ignored).

Statuses and Group Rules
Some group rules select the worst or best status for child CIs according to 
the following groups:

Value Real-time status
When using only 
three values

Colors

0 worst 0 red

5 bad 0 < score < 7.5 orange

10 middle 7.5 to 12.5 (inclusive) yellow

15 good 12.5 < score < 20 teal

20 best 20 green

Groups Statuses

first group OK, Warning, Minor, Major, Critical
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There is a priority between the groups. The first group of statuses has the 
highest priority, the second group the second priority and the third one the 
last priority. 

The child CIs of a specific CI may have statuses in different status groups. 
The status of the parent CI is taken from the group with the highest priority. 
The statuses of the child CIs in the other groups are not taken into 
consideration. 

For example:

➤ The child CIs of a specific CI have the Critical, Info statuses; the status for 
the parent CI, when calculated using the Worst Child rule is: Critical. 

➤ The child CIs of a specific CI have the Critical, Warning, and No Data 
statuses; the status for the parent CI, calculated using the Worst Child rule 
is: Critical. 

Influence of Must and Weight on Status
When Must and Weight properties have been defined for the relationship 
between a parent CI and a child CI, these properties have an impact on the 
status calculations for the KPIs of the parent CI.

Must and Weight can be used to qualify a relationship. Weight is used for 
weighted percentage status calculations. Must is used for dominant child 
status calculations.

The dominant and/or weight information affects only the status of the 
group to which this CI belongs, and does not affect the status of the CI 
itself. The status of a group CI is based on its child CIs, and the status of a 
monitor CI is based on the information received from the monitoring 
source. 

For more details on Weight and Must, see “Understanding the Percentage 
Rule” on page 562.

second group Info

third group No Data, Downtime, Stopped

Groups Statuses
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Trend and History

The following status levels are used to show historical and trend status for 
monitor CIs in Dashboard:

➤ Trend Status

The trend status has three positions: up, down, and no change. It shows the 
trend of the real-time status.

➤ History Status

The history status can display the worst status or the average status over a 
time period. 

Icon Description Status Status Definition

Small gray 
downward 
arrow

Downward 
trend

Real-time status shows a downward 
trend.

Small gray 
double-sided 
arrow

Stable trend Real-time status shows a stable trend. 

Small gray 
upward 
arrow

Upward trend Real-time status shows an upward 
trend. 

Icon Description Status Status Definition

Small green 
circle with 
checkmark

Historical OK All performance measurements fell 
within the OK objective level over a 
time period up to the present.

Small yellow 
triangle with 
exclamation 
mark

Historical Minor At least one performance 
measurement fell within the Minor 
objective level, but no measurements 
fell within the Major objective level, 
over a time period up to the present.
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Note: 

➤ When a CI has no history or trend data (for example, the CI status is 
uninitialized or stopped) or when history or trend data is not relevant for 
the CI’s KPI, the history or trend icons are not displayed

➤ If a transaction in an HP Virtual User Generator script is renamed, 
Business Availability Center considers it as a new transaction. A new BPM 
Transaction from Location CI is created in the CMDB using the new 
name, and the CI with the old transaction name is removed after it stops 
receiving samples. In Dashboard, the new CI does not display trend and 
history status data from before the transaction name change.

Small orange 
triangle with 
exclamation 
mark

Historical Major At least one performance 
measurement fell within the Major 
objective level, but no measurements 
fell within the Warning objective 
level, over a time period up to the 
present.

Small teal 
triangle with 
exclamation 
mark

Historical 
Warning

At least one performance 
measurement fell within the 
Warning objective level, but no 
measurements fell within the Critical 
objective level, over a time period up 
to the present.

Small red 
with "X"

Historical 
Critical

At least one performance 
measurement fell within the Critical 
objective level, over a time period up 
to the present.

Icon Description Status Status Definition
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The way the trend and history status is determined is described in the 
following sections:

➤ “History Calculation” on page 364

➤ “Trend Calculation” on page 365

➤ “Modifying the Trend and History Status Calculations” on page 365

History Calculation
The history status icon displays either the worst status or the average status 
for the CI’s KPI during a specified time period. 

The calculation method for history status is determined by the value set for 
the HistoryType parameter (one of the global parameters in the Business 
Rule Repository, described in “List of Dashboard Business Rules” on 
page 581). The possible calculation methods are Worst (default value) or 
Average. Whichever calculation method is used, only status scores that have 
meaning (scores 0 to 20—the non-gray icons) are taken into consideration.

➤ Worst. Takes the worst status over the period of time specified in the 
HistorySize parameter (also one of the global parameters).

For example: if HistorySize is 60 minutes (default value) and the KPI’s values 
for the last 60 minutes are: 10, 10, 5, 0, -2, 20, the worst status is 0, so the 
history icon is red.

➤ Average. Takes the average status over the period of time specified in the 
HistorySize parameter (Simple Moving Average). The calculation result is 
rounded to the nearest of the following values: 0, 5, 10, 15, or 20. 

For example: if HistorySize is 60 minutes and the KPI’s values for the last 60 
minutes are: 10, 10, 5, 0, -2, 20, the Average status is 10 (rounded from 
(10+10+5+0+20)/5=9), so the history icon is yellow.
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Trend Calculation
The trend status icon shows the trend in real-time status for the CI KPI, 
using three directions: up, down, and no change.

Trend analysis is performed by comparing the Simple Moving Average 
(SMA) value for a long window with the SMA for a short window. If the 
short window SMA is higher than the long window SMA, the trend is 
considered to be up. If the long window SMA is higher, the trend is 
considered to be down. The SMA is calculated only on status scores that 
have meaning (scores 0 to 20—the non-gray icons).

➤ Long window SMA. Based on the mean status of a KPI over the period of 
time specified in the HistorySize parameter (default = 60 minutes), one of 
the global parameters in the Business Rule Repository, described in “List of 
Dashboard Business Rules” on page 581.

➤ Short window SMA. Based on the mean status of a KPI over the period of 
time defined by (TrendRate * HistorySize). The TrendRate parameter 
(default = 0.3) represents the time rate between the long and short window, 
and is defined in the hidden parameters described in “Modifying the Trend 
and History Status Calculations” on page 365.

Modifying the Trend and History Status Calculations
You can modify the way the trend and history statuses are calculated and 
displayed, by editing certain rule parameters. A rule parameter can be set in 
three places: 

➤ As part of the global rule parameters that apply to all rules and affect all CIs. 
For details on editing global parameters, see “Global Attributes Dialog Box” 
on page 651.

➤ Directly for a rule, so that it affects all CIs that use this rule. For details on 
editing rule parameters, see “Rule Details Dialog Box” on page 657.

Some parameters for trend and history statuses are predefined and can be 
viewed and edited in the Business Rule Repository page; others are hidden, 
but can be manually added on the Repositories tab if you want to override 
the parameter default value. 
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Persistent Data and Historical Data

A KPI whose data is persistent is attached to a CI whose Save KPI data over 
time for this CI option has been selected. For details, see “KPIs Page” on 
page 409. This option is selected by default for Business Process, Line of 
Business, and Monitor Application CIs. This option is not available for 
Monitor type CIs.

For each CI with the Save historical data for this CI option, the following 
information is stored in the database:

➤ Every status change for each KPI

➤ The current calculated value for each KPI, read at regular time intervals (the 
default time interval is 15 minutes)

When the option is first selected, the current status for all of the CI KPIs is 
written to the database. As long as the settings remain the same, each time 
there is a change in status for one of the CI’s KPIs (for example, from Critical 
to OK), the status change is written to the database.

Note: Saving historical data for long periods of time or for many CIs and 
KPIs can require a lot of database memory, so this option should be used 
with care. When you no longer require data to be saved for a CI, clear the 
Save historical data for this CI check box for that CI.

This capability is used in the Dashboard reports. For details, see “Dashboard 
Reports” on page 265.

Tasks
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Configure a KPI – Workflow

This section describes the processes for the main task flow used to configure 
KPIs, and gives examples.

Configure a KPI using the steps described in this section.

This task includes the following steps:

➤ “Define or Edit KPIs” on page 367

➤ “Set Up the User Mode for the KPI – Optional” on page 368

➤ “Attach KPIs to CIs” on page 368

➤ “Change the Default Business Logic Engine Calculation Time Interval – 
Optional” on page 368

➤ “Change the No Data Timeout Value for Transaction CIs – Optional” on 
page 369

➤ “Modify the Number of CIs Monitored for Change in Real-Time” on 
page 369

➤ “Monitor CI Property Changes in Real-Time” on page 370

➤ “Customize Trend and History Statuses and Icons – Optional” on page 370

➤ “Modify the Trend and History Status Calculations” on page 371

➤ “View the Result in Dashboard” on page 371

 1 Define or Edit KPIs
You can globally define or edit a KPI. For details, see “KPI Repository page” 
on page 537.

You can edit a specific KPI. For details, see “KPI Details Dialog Box” on 
page 539.
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 2 Set Up the User Mode for the KPI – Optional
HP Business Availability Center provides the option to define Dashboard 
KPIs for two different user types (modes): operations and business. This 
option enables the creation of two versions of a single KPI, where each KPI 
version is geared towards the particular viewing requirements of one of the 
user types. For details, see “KPIs for User Modes” on page 355.

For details on the User Mode functionality, see “Set Up User Mode 
Functionality” on page 386.

For a detailed example, see “Example – Scenario of KPI Versions for User 
Modes” on page 389.

 3 Attach KPIs to CIs
You can attach additional KPIs to any CI. You can attach one of the default 
KPIs provided with HP Business Availability Center, or attach a KPI that you 
defined in the KPI Repository. 

For details on attaching a KPI to a CI, see “Attach KPIs to CIs and Configure 
the KPIs” on page 374.

If you have set a version for a KPI, manually attach the KPI versions to the 
CIs to which you want them to apply. For details, see “Attach KPI Versions 
to CIs” on page 388.

 4 Change the Default Business Logic Engine Calculation Time 
Interval – Optional
You can change the default Business Logic Engine calculation time interval 
in the Infrastructure Settings page. 

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click Foundations, select Online Business Logic Engine, and locate the 
Model calculation interval entry in the Calculation Related Settings table. 
Edit the value as required.
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 5 Change the No Data Timeout Value for Transaction CIs – 
Optional
When a KPI is using a monitor rule (for example, the Transaction 
Availability Rule), the Business Rule Parameters area includes the No data 
timeout property. This property defines the number of seconds from the 
time the last sample was received for the KPI, until the KPI is timed out—at 
which point the KPI changes to decay status (gray). For details, see “No Data 
Timeout for Transaction CIs” on page 342.

 6 Modify the Number of CIs Monitored for Change in Real-Time
For a limited number of CIs, Dashboard can monitor for changes to the CI 
properties (or changes to the properties of the CI’s child CIs) in real-time. 

This information is in addition to the Dashboard Change Report, which 
shows a historical report on changes to properties for CIs over a period of 
time. (For details on the Change Report, see “Change Report Page” in Model 
Management.)

For details on where to set the Monitor changes check box see “KPIs Page” 
on page 409. 

You can set the monitor changes option for up to 20 CIs. Once 20 CIs have 
been configured, a message is displayed when you try to set the option for 
another CI, stating that the limit has been reached.

If you then clear the option for one or more of the configured CIs, the 
option becomes available again for all CIs, until the 20 CIs limit is again 
reached.

Note: To change the 20 limit, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Application, and locate the Maximum monitored CIs entry in the Change 
Impact Properties table. Modify the value as required. However, change this 
value with caution to avoid too much load on the system.
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When the monitor changes option has been set for a CI, Dashboard 
continuously monitors that CI and all its child CIs, to see if a change occurs 
in one of the significant properties defined for the CIs.

The significant properties vary for each CIT, according to the CIT definition 
in Admin > CMDB > CI Type Manager. In CI Type Manager, in the Attributes 
tab for the CIT, the Change Monitored column must be selected for a 
property, in order for that property to be significant and therefore 
monitored. For more information on CIT definitions, see “CI Type 
Manager” in Model Management.

If a change occurs in one of the significant properties for the CI or the CI 
children, an icon is displayed in Dashboard beside the CI name. For more 
information, see “Monitoring Changes in Dashboard Overview” on 
page 111.

After a change occurs, the change icon is displayed for 24 hours (default 
value). You can change the default value, as described in “Customize the 
Change Period” on page 113.

 7 Monitor CI Property Changes in Real-Time
For a limited number of CIs, Dashboard can monitor for changes to the CI 
properties (or changes to the properties of the CI’s child CIs) in real-time. 
For details, see “Attach KPI Versions to CIs” on page 388.

This information is in addition to the Dashboard Change Report, which 
shows a historical report on changes to properties for CIs over a period of 
time. For details, see “Change Report Page” in Model Management.

 8 Customize Trend and History Statuses and Icons – Optional
You can:

➤ Customize the Trend or History Statuses. For more information on how to 
customize your trend and history statuses and explanations about how 
those statuses are calculated, see “KPI Status” on page 355.

➤ Customize the set of Trend or History Icons. You can customize the set of 
Trend and History icons. For details, see “Change the KPI Status Icons” on 
page 394.
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 9 Modify the Trend and History Status Calculations
You can modify the way the trend and history statuses are calculated and 
displayed, by editing the hidden rule parameters. For details on the 
parameters, see “Hidden Parameters” on page 653. 

A rule parameter can be set in three places: 

➤ As part of the global rule parameters that apply to all rules and affect all CIs. 
For details on editing global parameters, see “Global Attributes Dialog Box” 
on page 651.

➤ Directly for a rule, so that it affects all CIs that use this rule. For details on 
editing rule parameters, see “Rule Details Dialog Box” on page 657.

 10 View the Result in Dashboard
If you have defined user modes for a KPI, each user type sees in Dashboard 
the appropriate KPI version for their assigned user mode (operations or 
business user), for all KPIs that are defined as specific to a user mode. Users 
who are not assigned a user mode (undefined) see KPIs for both modes, as 
do system administrators:
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In the Geographical Map and Custom Map tabs, status at a location is based 
on whichever KPI versions the user sees in Dashboard:

Attach a PNR KPI to a CI – Scenario

The PNR (Point of No Return) KPI enables you to view how well agreement 
objectives are being met. When the PNR KPI is defined for a CI, a bar is 
displayed in Dashboard indicating how much more time (in percentages) 
the CI can be unavailable before the agreement is in breach of contract. For 
an explanation of unavailability, see “Dashboard PNR Rule” on page 601.

Perform the following procedure to view Service Level Management data in 
an information bar in Dashboard.

To set up Dashboard to display Service Level Management data:

 1 Create an agreement. For details, see “Agreement Wizard” in Using Service 
Level Management.

The agreement must include a CI with an attached Availability KPI and/or a 
System Availability KPI, for the Dashboard PNR KPI to show data in reports. 
If both KPIs are attached to the CI, the PNR KPI is calculated by using only 
the Availability KPI. If only the System Availability KPI is attached to the CI, 
the PNK KPI is calculated using the System Availability KPI.
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 2 In Dashboard Administration, attach a PNR KPI to the same CI. For details 
on attaching a KPI, see “No Data Timeout for Transaction CIs” on page 342. 
During KPI creation: 

 a Choose the PNR KPI.

 b Select the agreement whose data is to be displayed in Dashboard.

 c Select the calendar and tracking period. These parameters are defined 
when creating the agreement. For details, see “Define Agreement 
Properties Page” in Using Service Level Management.

 d Add the objective’s ranges that Dashboard uses to calculate when 
unavailability time approaches breach of contract levels.
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 3 View the results in Dashboard: Applications > Dashboard > Console. Choose 
the view and select the CI.

For details on the information that Dashboard displays in the Console page, 
see “Console Overview” on page 143.

Attach KPIs to CIs and Configure the KPIs

You can attach additional KPIs to any CI. You can attach one of the default 
KPIs provided with HP Business Availability Center, or attach a KPI that you 
defined in the KPI Repository. For details on the KPI repository, see “KPI 
Repository Overview” on page 509.

This task includes the following steps:

➤ “Attach a KPI to One or More CIs” on page 374

➤ “Define the KPI Objectives” on page 375

➤ “Define the KPI Selector” on page 375

 1 Attach a KPI to One or More CIs
There can be only one instance of each KPI for a CI. Dashboard 
Administration also gives you the option of attaching a KPI to multiple CIs. 
The KPI is added to all CIs that do not already have that KPI attached. All 
instances of the KPI have the same defined business rule and properties. 

For information on KPI functionality, see “How Dashboard KPIs Work” on 
page 338.
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For details on attaching a new KPI to a single CI or to multiple CIs, see “How 
Dashboard KPIs Work” on page 338.

For each new KPI, define the KPI type and business rule. Where relevant, 
also define additional information required by the rule. Attaching a new KPI 
to a CI, and defining the KPI properties, must be undertaken with care; these 
actions can result in KPIs that give an inaccurate performance assessment in 
Dashboard. Please read the notes and limitations before proceeding. For 
details, see “Notes and Limitations for KPIs and CIs” on page 339.

 2 Define the KPI Objectives
Dashboard uses objectives to calculate the status of a KPI. You can modify 
the objectives of a specific KPI. For details, see the Objectives area in “Add 
KPI to Multiple CIs/Edit KPI/Edit KPI for Child Transaction Dialog Box” on 
page 397.

 3 Define the KPI Selector
Use selectors to filter the samples relevant for the KPI. For details, see 
“Define Selectors” on page 380.

Edit KPI Properties

You can edit KPI properties for individual KPIs in the Edit KPI window. You 
can also perform a multiple edit on certain KPI properties for transaction 
CIs.

Editing KPI properties must be undertaken with care; the changes can result 
in KPIs that give an inaccurate performance assessment in Dashboard. Read 
notes and limitations before proceeding. For details, see “Notes and 
Limitations for KPIs and CIs” on page 339.

This task includes the following steps:

➤ “Edit a KPI Properties” on page 376

➤ “Edit the KPI Properties for Multiple Transaction CIs” on page 376
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 1 Edit a KPI Properties
You can modify all properties for a defined KPI (apart from the KPI type), 
whether it is a default KPI for the CI, or a KPI attached by a user.

For details, see “Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child 
Transaction Dialog Box” on page 397.

 2 Edit the KPI Properties for Multiple Transaction CIs
The KPIs tab has a multiple edit function, enabling you to modify the 
Availability or Performance KPIs for all BPM Transaction from Location CIs 
in a group. This function enables you to define new business rule parameter 
values and/or objective values for all child transactions CIs that appear in a 
subtree of a view, in one operation.

You can define the new values in the Edit KPI for Child Transactions 
window. Every new value you define replaces the previous value for that 
property, for each transaction CI in the subtree. Property boxes left blank in 
the Edit KPI for Child Transactions window do not affect the CIs. For details, 
see “How Dashboard KPIs Work” on page 338.

Before using the Edit KPIs for Child Transactions function, you should 
ensure that the planned new values are logical for all transaction CIs in the 
subtree. You should also review the Notes and Limitations section; for 
details, see “Notes and Limitations for KPIs and CIs” on page 339.
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Example

The following example describes editing the objective values for transaction 
CIs in a subtree.

 a In the KPIs tab, the Performance KPI objective values for every 
transaction CI in the myapp subtree appear as in the following figure. 
They are displayed by clicking the Edit KPI button for any of the 
transaction CIs.

For this example, two additional objective values are added, to include 
Warning and Major status levels for each transaction CI, and the Minor 
objective value is modified.
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 b In View Explorer, select the parent CI for the subtree—in this case, the 
Application CI myapp:

 c In the right pane, click the Edit KPIs for child transactions button for the 
required KPI—in this case, the Performance KPI.
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 d In the Edit KPI for Child Transactions window, enter the required 
values—in this case, 10000 for Warning objective, 11000 for Minor 
objective, and 12000 for Major objective.

 e After applying the changes, all transaction CIs in the myapp subtree have 
the following objective values defined:
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Define Selectors

In the selector Filter area, you define selector expressions to filter the data 
samples, to target only those samples that are relevant for the KPI. A selector 
expression requires a Field, an Operator, and a Value, defined in that order. 
For more information, see “Selector Area” on page 403.

You can define selectors using predefined sample parameters, or create 
custom selectors. You can then combine those selectors to create complex 
filters with several selector expressions.

This task includes the following steps:

➤ “Define a Selector Expression Using Predefined Sample Parameters” on 
page 380

➤ “Define a Custom Selector” on page 383

➤ “Build Complex Filters” on page 384

 1 Define a Selector Expression Using Predefined Sample 
Parameters
Define the selector expressions by selecting from metadata—predefined 
sample types and sample parameters in the database. 

Note: You can also build a custom selector as explained below.

When defining or editing a selector using predefined sample data, you can 
select Field and Operator values from predefined lists. This definition 
method validates the field names and operators, and prevents errors that 
might occur when manually entering field names. It also simplifies the 
process of defining a selector. 

The predefined fields use metadata, information on sample types collected 
from data samples arriving from various data sources (including HP data 
collectors and third-party data sources) and stored in the database. For 
explanations of the data samples and their fields, see “Data Samples” in 
Reference Information.
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Example

 a Define the sample type that applies for this KPI. Select the sample type 
from the list at the top of the Selector area in the New KPI or Edit KPI 
window. The list is based on the sample types currently in the database.

For example, for a KPI that relates to transaction measurements, select 
sample type Transactions from the list.

When you select a sample type from the list, all previously defined 
expressions for the selector are overridden, so the contents of the Filter 
box are automatically deleted. 
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The Field box in the first selector expression converts to a dropdown list, 
containing all valid options for the selected sample type. The Field box 
defines the required reference property in the data samples.

 

 b Select an option from the Field list. 

The Operator list is automatically updated so that it contains only those 
operators that are valid for the selected field. For example, if the selected 
field always contains a text string, then only the operators that are used 
with text are included in the list, such as like, notIn, ==, in.

 c Enter a value for the selected field in the Value box.

Note: The Value property is case sensitive and must be entered precisely 
as used in the data samples from the data source, or the selector fails. The 
recommended method is to take the values from the samples published 
on the bus. 
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 2 Define a Custom Selector
Define the selector expressions by manually defining the sample type and 
sample parameters. You can build a custom selector using any field name, 
and, if required, can combine fields from two or more data types. 

Note: You can have HP Business Availability Center automatically assign the 
default selector for the monitoring CI, by leaving the selector expressions 
blank in the New KPI/Edit KPI window. After clicking OK to close the 
window, HP Business Availability Center assigns the KPI the default selector 
for the CI, as used by the default KPIs attached to the CI.

When defining or editing a selector, you can build a custom selector by 
manually defining all information for the selector. Ensure that no sample 
type is defined in the list at the top of the Selector area in the New KPI or 
Edit KPI window (the box should display Custom).

If a sample type was previously selected in the list, and you then select 
Custom, all previously defined expressions for the selector are overridden 
and the contents of the Filter box are automatically deleted.

Every selector must include the definition of the sample type required for 
the KPI, so when manually defining a selector, at least one selector 
expression must contain this information. For example, for a KPI that relates 
to transaction measurements, the selector must catch transaction samples, 
which are defined by the sample type trans_t in the selector.
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Note: The Field and Value properties are case sensitive and must be entered 
precisely as used in the data samples from the data source, or the selector 
fails. The recommended method is to take the values from the samples 
published on the bus. For details, see “Data Samples” in Reference 
Information.

To define a custom selector expression, enter the required reference property 
in the Field box, select an operator from the Operator list. You can select 
from any of the operators used in Dashboard, and enter the required value 
for the property directly in the Value box.

For details on samples, see “Sample: Transactions (trans_t)” in Reference 
Information.

 3 Build Complex Filters
You can use metadata to build a complex filter, by defining blocks of selector 
expressions that together form a complex logical expression: 

➤ Narrow the filter by using a logical And operator to attach additional 
selector expressions to an expression block. 

➤ Widen the filter by using a logical Or operator to add alternative expression 
blocks (each containing one or more selector expressions).

You can define as many selector expressions and blocks of selector 
expressions as required:

➤ To define an additional selector expression within a block, click the And 
button for that block. An additional empty selector expression row is 
displayed in the block.
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For example, you can define a filter that looks for transaction samples that 
contain both profile name X and transaction name Y. 

➤ To define an alternative expression block, click the Add ’OR’ Expression 
button. A new block is created, with an empty selector expression row.

Example

You can define a filter that looks for transaction samples that contain either 
transaction name X or transaction name Y. 

You can add additional selector expressions to the new block using the And 
button for the block. 

A data sample qualifies for the selector if all the selector expressions in a 
single expression block are TRUE for the data sample. For example, either 
selector expressions a and b and c in block 1 are all TRUE, or selector 
expressions d and e and f in block 2 are all TRUE. 

Example of selector with two expression blocks.
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Set Up User Mode Functionality

You can set up user mode functionality in HP Business Availability Center 
by defining the mode for users, defining the KPI versions for each mode, 
and attaching the KPI versions to the CIs.

This task includes the following steps:

➤ “Assign a User Mode” on page 386

➤ “Define KPI Versions for the User Modes” on page 386

➤ “Attach KPI Versions to CIs” on page 388

 1 Assign a User Mode
There are two ways to assign a user mode to a user:

➤ The system administrator, when defining new users in the Admin > Platform 
> Users and Permissions > User Management page, can set User Mode to 
Undefined, Operations User, or Business User. By default, all new/existing 
users are set as Unspecified (meaning that they see KPIs for both modes in 
Dashboard).

➤ Users can change their own user mode in the Admin > Personal Settings > 
General Settings page. In the User Mode area, select the required mode 
from the Select user mode list.

After changing the mode in the General Settings page, you must log out of 
HP Business Availability Center and log in again to see the mode filtering 
work.

 2 Define KPI Versions for the User Modes
The following steps describe how to define different versions of a KPI to use 
with each user mode. You can assign user modes to a new KPI that you 
define, or to an existing KPI by cloning or overriding the KPI. For more 
information, see “KPI Repository page” on page 537.

If you want one of the KPI versions for a user mode to automatically replace 
an existing KPI, then you must override the existing KPI and edit the new 
version.
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It is recommended that you give a name to each KPI that is assigned a user 
mode that easily identifies the KPI with the appropriate user version. For 
example, you can add an appropriate suffix.

Example – Define KPI Versions For User Modes

 a Access the Admin > Dashboard > Repositories > KPIs page.

 b Define the business user version of the KPI:

➤ Add the required KPI to the Custom KPIs area by cloning or overriding 
a KPI, or creating a new KPI. Open the KPI for editing.

➤ In the displayed KPI Details window, give the new KPI/copied KPI an 
appropriate name. For example, add the suffix _biz (as in 
Availability_biz).

➤ Select Business in the Applicable for User Mode list.

 c Define the operations user version of the KPI:

➤ Add the required KPI to the Custom KPIs area by cloning or overriding 
a KPI, or creating a new KPI. Open the KPI for editing.

➤ In the displayed KPI Details window, give the new KPI/copied KPI an 
appropriate name. For example, add the suffix _ops (as in 
Availability_ops).

➤ Select Operations in the Applicable for User Mode list.

Note: If you override a KPI, the overridden version of the KPI replaces the 
original KPI throughout Dashboard, so all CIs that are assigned the 
original CI (for example, Availability) are automatically updated to the 
new version (for example, Availability_ops).

 d Edit the details for each KPI version, according to your requirements. For 
example, you might want different business rules to apply to each 
version. For more information, see “KPI Details Dialog Box” on page 539.
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 e To use a different version of a business rule with each KPI version, you 
must define the rule versions in the Business Rule Repository. For 
example, for two versions of the Availability KPI, you may require two 
versions of the Transaction Availability Rule, each with different default 
objective values.

For details on defining business rules, see “Customize a Business Rule” on 
page 568.

 3 Attach KPI Versions to CIs
You can manually attach the KPI versions to the CIs to which you want 
them to apply. 

➤ If the original KPI is already attached to CIs (for example, the Availability 
KPI is automatically attached to transaction CIs), then the KPI version that 
overrode the original (for example, Availability_ops) is automatically 
attached to the CIs instead. You can manually attach the second KPI version 
(for example, Availability_biz).

➤ If there are two new KPI versions, one for business and one for operations 
then for every applicable CI you manually attach the two versions (and 
delete the original KPI if it is not required).

To attach the KPI versions to CIs, select Admin > Dashboard > KPIs page, add 
the KPI versions to each CI where they are required, so that the CIs have 
both versions of the KPI. You can add the KPI to multiple CIs in one 
operation. For example, you might want to define different objective values 
for the KPI. For KPIs that require selectors: Do not define anything in the 
Selector area, leave the selector expressions empty. Click OK to save the KPI 
details. The KPI version is added to each selected CI, and propagates up the 
hierarchy to the parent CIs. After you click OK to add the KPI to the CIs, 
HP Business Availability Center automatically replaces each blank selector 
with the default selector defined for the other KPIs attached to each CI. For 
details, see “How Dashboard KPIs Work” on page 338.
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Example – Scenario of KPI Versions for User Modes

In the following example scenario, two versions of the Availability KPI are 
set up, one for each user mode. The Availability_ops version uses the default 
objective values; however, when the Availability_biz version is attached to 
CIs, different objective values are defined.

Proceed as follows to set up and use Availability KPI versions for user modes:

 a Access the Admin > Dashboard > Repositories > KPIs page.

 b In the Factory KPIs area, select the check box for the Availability KPI and 
click Clone. The cloned KPI is displayed in the Custom KPIs area.

 

 c Click the Edit button for the cloned KPI. In the displayed KPI Details 
window, edit the KPI properties as follows:

➤ In the Display Label box, add the suffix _biz to the Availability label.

➤ Select Business in the Applicable for User Mode list.
 

➤ Click OK.

 d In the Factory KPIs area, select the check box for the Availability KPI and 
click Override. The old Availability KPI is shown as overridden, and the 
new version of the KPI is displayed in the Custom KPIs area. 
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 e Click the Edit button for the new KPI. In the displayed KPI Details 
window, edit the KPI properties as follows:

➤ In the Display Label box, add the suffix _ops to the Availability label.

➤ Select Operations in the Applicable for User Mode list.
 

➤ Click OK.

The KPI names are displayed in the Custom KPIs area.
 

 f Access the Admin > Dashboard > KPIs page and open the End User 
Monitors View. For all BPM Transaction from Location CIs, the 
Availability KPI has been replaced with the Availability_ops KPI.
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 g Add the Availability_biz KPI to all BPM Transaction from Location CIs. 
Use the keyboard CTRL key to select all the CIs, then right-click one of the 
selected CIs and select Add KPI.

The Add KPI to Multiple CIs window opens.

 h Edit the properties in the Add KPI to Multiple CIs Window as follows:

➤ Select Availability_biz in the KPI list.

➤ Select Transaction Availability Rule in the Business rule list.
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➤ In the Objectives area, enter the objective values required for 
Availability KPI in business user mode: 80, 60, 40, 20.

➤ Leave the selector expressions empty.
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➤ Click OK. The Availability_biz KPI is added to the KPIs list for each 
selected CI.

The appropriate selector is automatically defined for each new KPI, by 
copying the selector definitions for the other KPIs attached to the BPM 
Transaction from Location CI. (You can click the Edit button for the 
Availability_biz KPI to view the selector.)

The Availability_biz KPI also propagates up to the CI parents, using the 
default group rule for the KPI.

 i In the Applications > Dashboard > Console page, you can see the 
Availability KPI versions as follows:

➤ For users assigned Operations mode:
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➤ For users assigned Business mode:

A CI can display different status for each Availability KPI version 
(although each KPI has the same Availability score), because of the 
different objective levels defined for each version.

Change the KPI Status Icons

Different icons are used for the KPI status for each range specified in the 
From/To fields in the Parameter Details dialog box. For details, see 
“Parameter Details Dialog Box (KPIs)” on page 552.

If you want to customize the KPI status icons, create a new set of icons and, 
where applicable, add your icons to the appropriate directories and redirect 
the KPI’s status parameters to those icons or replace the default icons with 
your customized icons using the same names.

Note: The recommended size for an icon should be 16x16 pixels.

For details on the default icons, see “Colors of KPI Statuses Used in 
Dashboard” on page 357.
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To change the Dashboard KPI status icons:

You can do one of the following:

➤ Add your icons to the appropriate directory and specify their names in each 
one of the status parameters for the KPIs. For details on the user interface, 
see “KPI Details Dialog Box” on page 539.

➤ Replace the icon or icon set with the customized icons and give them the 
names of the default icons.

To find the location of the icon you want to replace, right-click the icon in 
the appropriate tab in Dashboard, select Properties, and view the icon’s 
location in the Address (URL) field.

Make sure that you replace the icons set in the following directories:

➤ <Gateway root directory>
\AppServer\webapps\site.war\bam\pages\images\gui\indicator

➤ <Gateway root directory>
\AppServer\webapps\site.war\images\gui\indicator

To change the Dashboard Trend and History status icons:

You cannot change the names of the trend and history icons that appear in 
the Top View tab. To customize those icons, you can only replace the default 
images with your customized images.

The directory where the Trend and History Status icons are located is:
<Gateway root directory>\
AppServer\webapps\site.war\static\dash\images\indicator

For details on the Trend and History icons, see “Trend and History” on 
page 362.
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To change the Dashboard Top View status icons:

You cannot change the names of the Top View icons. To customize those 
icons, you can only replace the images with your customized images.

The directory where the icons are located is:
<Gateway root directory>\AppServer\webapps\site.war\
bam\pages\images\icons\dimensionIcons

The location of a specific icon uses the following naming scheme:
dimensionIcons/<kpi_id>/<status_id>.gif where <status_id> is the value 
specified in the From field of the status parameter defined for the KPI. For 
example: the value of the From field of the OK (green) status is 20 therefore 
the icon for the Availability KPI is located at: dimensionIcons/7/20.gif. For 
details on the user interface, see “Parameter Details Dialog Box (KPIs)” on 
page 552.

For details on the Top View icons, see “KPI Icons in Top View” on page 140.

Reference

KPIs User Interface

This section describes:

 ➤  Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child Transaction Dialog Box 
on page 397

 ➤  Context Menus List Editor Dialog Box on page 406

 ➤  Event Details Page on page 407

 ➤  KPIs Page on page 409
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Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child 
Transaction Dialog Box

Description Enables you to attach additional KPIs to any CI or to 
edit the properties of a CI’s KPIs. 

To Access: Click the KPIs tab and select:

➤ (Single CI) the required CI in View Explorer, and 
either click the Add KPI/Edit KPI  button in the 
right pane, or right-click the CI in View Explorer and 
select Add KPI/Edit KPI. 

➤ (Multiple CIs) the required CIs in View Explorer 
using the keyboard Ctrl key, right-click one of the 
selected CIs in View Explorer, and select Add 
KPI/Edit KPI.

➤ (multiple transactions) the required group-level CI 
in View Explorer, and either click the Edit KPI for 
child transactions  button corresponding to the 
KPI (Performance or Availability) that you want to 
edit. 
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Important 
Information

There can be only one instance of each KPI for a CI. For 
each new KPI, you define the KPI type and business 
rule. Where relevant, you also define additional 
information required by the rule.

You can attach one of the default KPIs provided with 
HP Business Availability Center, or attach a KPI that 
you defined in the KPI Repository (as described in 
“Customize a KPI” on page 510). When you attach a 
KPI to multiple CIs, the KPI is added to all CIs that do 
not already have that KPI attached. All instances of the 
KPI have the same defined business rule and properties. 
Attaching a new KPI to a CI, and defining the KPI 
properties, must be undertaken with care; these actions 
can result in KPIs that give an inaccurate performance 
assessment in Dashboard. Read the “Notes and 
Limitations for KPIs and CIs” on page 339 before 
proceeding.

For information on KPI functionality, see “How 
Dashboard KPIs Work” on page 338.

Note: Changes made in the Edit KPIs for Child 
Transaction window have no effect on KPIs other than 
Transaction and Availability, or on CIs for which the 
option does not apply.

Included in Tasks “Configure a KPI – Workflow” on page 367
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KPI Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Hold the pointer over the question mark icon to 
display additional information for the rule.

Business Rule After selecting a KPI, the Business rule list is 
automatically updated to display all business rules that 
are relevant for the selected KPI. Select the required 
rule from the list. The rule is used to calculate the 
measurement and status for the KPI. For an 
explanation of the role of the rules, see “About 
Business Rules” on page 341. For information on each 
individual rule, see “List of Dashboard Business Rules” 
on page 581.

Important: After selecting a rule, the New KPI dialog 
box is automatically updated to display the areas 
(Business Rule Parameters, API Rule Definitions, 
Objectives, Selector, and so on) that are relevant for 
the selected rule.

Note: You should only select a monitor rule if the KPI 
is attached to a monitoring CI. For more information, 
see “Monitor Rules and Group Rules” on page 559.

KPI Select a KPI from the KPI list. The list contains the 
names of all available KPIs (KPIs that are already 
attached to the CI are not included in the list). For an 
explanation of each individual KPI, see “List of 
Dashboard KPIs” on page 512.

Note: When defining a KPI for multiple CIs, the KPI list 
contains all KPI types.

OK If you do not define a selector for the KPI, then after 
clicking OK to close the New KPI dialog box, 
HP Business Availability Center automatically assigns 
to the KPI the default selector (generally defined for the 
other KPIs attached to the monitoring CI).
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Business Rule Parameters Area

SLA If you are defining a PNR KPI, select the required values 
from the SLA list.

For information on defining the PNR KPI, see “Event 
Details Page” on page 407.

Time Interval If you are defining a PNR KPI, select the required values 
from the Time interval lists.

For information on defining the PNR KPI, see “Event 
Details Page” on page 407.

Tracking Period If you are defining a PNR KPI, select the required values 
from the Tracking period lists.

For information on defining the PNR KPI, see “Event 
Details Page” on page 407.

Description Enables you to view and modify the parameters 
relevant for the selected rule. All parameters have 
default values.

Important 
Information

If required, modify the parameter values by entering a 
new value in the appropriate boxes. The information 
after each box directs you as to the type of value that 
can be entered, for example, Any Number, Text, or 
Boolean.

Multiple KPI selection. In the Business Rule Parameters 
area, the value box is empty. Enter the required value 
in the boxes. Make sure you enter values that apply 
logically to all transactions in the group. 

For information on rule parameters and possible 
values, see the section for the relevant rule, as 
described in “List of Dashboard Business Rules” on 
page 581.

GUI Element (A-Z) Description
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API Rule Definitions Area

This area is displayed when you select an API rule in the Business rule list. 
The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

KPI Calculation Script Enter the KPI calculation script for the rule you are 
creating using the Rules API. The contents of the script 
depends on the rule type, as follows:

➤ API Group and Sibling Rule. See “API Group and 
Sibling Rule” on page 663.

➤ API Sample Rule. See “API Sample Rule” on 
page 667.

➤ API Duration-Based Rule. See “API Duration-Based 
Sample Rule” on page 669.

Sample Fields Enter the names of the sample fields you want to use in 
the script. Separate between the sample names with a 
comma.

Note: Displayed only when you select the API Sample 
rule or the API Duration-Based rule in the Business rule 
list.



Chapter 15 • Working With KPIs

402

Objectives Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to define value ranges that are used to 
determine status for the KPI. The measurement for the 
KPI (calculated by the business rule) is compared with 
the objectives, and a color status assigned accordingly. 

The objectives are defined in a unit of measurement 
appropriate to the type of data dealt with by the rule. 
The unit is indicated after the objective value box.

Important 
Information

This area is displayed when necessary.

If required, you can modify the default values for the 
objectives.

Multiple KPI selection. In the Objectives area, the value 
box is empty. Enter the required value, or select a 
different operator for the objectives. Make sure you 
enter values that apply logically to all transactions in 
the group. 

For information on defining objectives, see “KPI 
Objectives” on page 343.

GUI Element (A-Z) Description

OK, Warning, Minor, 
Major, Critical

Enter the required objective value for each status in the 
appropriate box. Ensure that the numbers you enter are 
logically ordered.

For more information on objectives functionality and 
defining objectives, see “KPI Objectives” on page 343.

Operator Select the required operator. This operator is applied for 
all objectives.

Note: The Objectives area in the Edit KPIs for Child 
Transaction window displays the default Operator for 
the rule. When you apply your changes, the displayed 
default operator is updated to all transaction CIs 
(regardless of which operator they were using 
previously).
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Selector Area

Description Enables you to define the filter criteria for the KPI. The 
selector catches data samples from the incoming data 
that meet the filter criteria. A selector is required for all 
KPIs (attached to monitoring/leaf CIs) that are 
intended to calculate a measurement based on original 
sample data; otherwise no data is mapped to the KPI 
and it remains gray in Dashboard.

Important 
Information

The Selector area is displayed when necessary.

If relevant for the rule, the Selector area is displayed in 
the window. This area is displayed only for certain 
monitor rules and for Dynamic Node Factory CIs.

For a detailed explanation of selector functionality and 
defining selectors, see “Selectors for KPIs” on page 352.

In the Filter area, define selector expressions to create a 
filter for the selector. Each selector expression defines a 
required criteria for the new KPI. 

Note: If you do not define a selector for the KPI, then 
after clicking OK to close the dialog box, HP Business 
Availability Center automatically assigns to the KPI the 
default selector (generally defined for the other KPIs 
attached to the monitoring CI). For details, see “Define 
Selectors” on page 380.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<box> Selector filters can be manually defined to create a 
custom filter, or defined using metadata (predefined 
sample types). To use metadata for the filter, select a 
sample type from the list at the top of the Selector 
area.

When the list displays Custom, the filter is defined 
manually. 

For more information, see “Set Up User Mode 
Functionality” on page 386.

Add 'OR' Expression Click the Add OR Expression button to widen the filter 
by adding additional expression blocks (each 
containing one or more selector expressions).

For more details, see “Build Complex Filters” on 
page 384.

And Click the Add button to define additional selector 
expressions to build a more complex filter. You can 
attach additional selector expressions to the first 
selector expression using the And button, to create an 
expression block that narrows the filter. 

For more details, see “Build Complex Filters” on 
page 384.

Field Enter the name of a reference property that the selector 
expression searches for in the incoming data samples 
sent from the data source. For details on the samples, 
see “Data Samples” in Reference Information.
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Operator The relational operator that the selector expression 
uses when comparing the actual value for the property 
against the value defined in the selector. The 
expression gives a result of TRUE or FALSE for each 
data sample.

Select an option from the list. The option can be:

➤ = = or != =. Filters the samples where the value of the 
sample field specified in the Field box equals or is 
not equal to the value specified in the Value box.

➤ > or <. Filters the samples where the value of the 
sample field specified in the Field box is less or more 
than the value specified in the Value box.

➤ in or notIn. Use the |!| separator Value box. The value 
specified in the Value box can only be 100 characters 
long.

➤ >= or <=. Filters the samples where the value of the 
sample field specified in the Field box is more or 
equal to or less or equal to the value specified in the 
Value box.

➤ prefix or notPrefix. Filters in the samples where the 
sample field value starts with the string entered in 
the Value box.

➤ suffix or notSuffix. Filters in the samples where the 
sample field value ends with the string entered in 
the Value box.

➤ like or notLike. The expression you enter in the 
Value box should follow the Java standard for 
regular expression. 

Note: It is recommended to use the suffix or notSuffix 
operators instead of the like and notLike operators that 
are performance intensive.

GUI Element (A-Z) Description
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Context Menus List Editor Dialog Box

Value Enter the required value for the property. 

This is the property value that the expression compares 
with the value in the data sample. The value must be in 
numeric format if a numeric operator is selected, or it 
must be entered between quotation marks if a text 
string operator is selected.

For more information, see “Define Selectors” on 
page 380.

Description Enables you to select the context menus you want to 
assign to the CI.

To Access: Click Edit in the KPIs page.

Important 
Information

Move the context menus from the Available Context 
Menus box to the Active Context Menus box, and the 
other way around, using the arrows.

GUI Element (A-Z) Description
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Event Details Page

The following is an example of the Event Details page. 



Chapter 15 • Working With KPIs

408

Description Enables you to display data from the last sample that 
arrived for a monitor CI; this includes all of the 
parameters for the CI, and the parameter values at the 
last update.

To Access: From the Console or Filters tabs in 
Dashboard, click the status icon for a monitor CI. (If 
there is an associated Event Details dialog box for a CI, 
then the cursor changes to a hand when you hold the 
cursor over the status icon for the CI.)

Important 
Information

To view the Event Details dialog box for CIs, you must 
configure Dashboard to save the last sample for the CI. 
You can configure this per KPI rule (so that you only 
see sample details for a monitor CI under that KPI), or 
for all rules. For details on how to do this, see “View 
Sample Details” in Using Dashboard.

Note: Storing last sample details may require use of a 
large amount of memory, slowing down Dashboard 
performance.

Note: You can open as many Event Details dialog boxes 
as required; if you move to another application or 
administration page in HP Business Availability Center, 
any open Event Details dialog boxes are closed.

Included in Tasks “View Sample Details” on page 57
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

KPIs Page

GUI Element (A-Z) Description

Event Message area Displays the details for the CI (according to the KPI) at 
the last update. 

Note: The Event Details dialog box is not automatically 
refreshed when there is a new update for the CI. You 
can refresh by right-clicking in the dialog box (outside 
of the Event Message panel) and selecting Refresh, or 
by closing and reopening the dialog box.

Event Source area Contains parameters providing information on the KPI 
(in the Dimension name field) for which the event 
details are relevant, the date and time of the last update 
to the CI, and the CI status at that update.

Description Displays, depending on the selected CI, information 
about the CI’s assigned KPIs, the view’s KPIs, the 
associated business rules, context menu, the KPI’s user 
mode, and/or additional information.

To Access: Select Admin > Dashboard, click the KPIs 
tab, select the required view and the required CI in the 
View Explorer in the left pane. (For information on 
using View Explorer, see “Working with View Explorer” 
in Model Management.)

Included in Tasks “Configure a KPI – Workflow” on page 367
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KPI Selection Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the view’s KPIs, the KPI’s user mode (Business 
or Operation), and whether the KPI is included in the 
CI status, in the view, or both.

Important 
Information

The KPI Selection area is displayed when you select the 
root CI in the view.

You can sort the information displayed in the KPIs 
table by clicking on the column header. 

GUI Element (A-Z) Description

Business Appears only when you select the root CI in View 
Explorer.

An asterisk indicates that the KPI is defined for the 
Business user mode. For details on user mode, see “KPIs 
for User Modes” on page 355.

Include in CI Status Clear the option to ensure that:

➤ The KPI is displayed in the Dashboard views and in 
the tooltips.

➤ The KPI is not included in the CIs generic status 
when the CI status is calculated by including all the 
CI’s KPIs (like in Top View, Custom Map, 
Geographical Map, and Topology Map).

Default value: The option is selected.

Note: 

➤ The selection has a similar impact on the relevant 
My BSM portlets. For details, see “Edit Preferences 
<portlet_name> Dialog Box” in Using My BSM.

➤ The Include in CI Status option is automatically 
cleared when the Include in View option is cleared.
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Include in View Clear the option to ensure that:

➤ The KPI is not displayed in the Dashboard views and 
in the tooltips.

➤ The KPI is not included in the CIs generic status 
when the CI status is calculated by including all the 
CI’s KPIs (like in Top View, Custom Map, 
Geographical Map, and Topology Map). 

Default value: The option is selected.

Note: The selection has a similar impact on the 
relevant My BSM portlets. For details, see “Edit 
Preferences <portlet_name> Dialog Box” in Using My 
BSM.

Note: The Include in CI Status option is automatically 
cleared when the Include in View option is cleared.

KPI The name of the KPI.

Operations Appears only when you select the root CI in View 
Explorer.

An asterisk indicates that the KPI is defined for the 
Operations user mode. For details on user mode, see 
“KPIs for User Modes” on page 355.

GUI Element (A-Z) Description
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KPIs area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays, depending on the selected CI, the CI’s 
assigned KPIs, associated business rules, and context 
menu, or the view’s KPIs, whether the KPI is defined in 
Business or Operation user mode, and whether to 
include the KPI in the CI status or the view’s 
calculations

If you select a CI in View Explorer (not the root CI), the 
KPIs page displays the KPIs and associated business 
rules defined for the selected CI.

If you select the root CI in View Explorer, the KPIs page 
display all the view's KPIs when you expand the KPI 
Selection area. 

To Access: Select Admin > Dashboard, click the KPIs 
tab, and select the required view and then the required 
CI in the View Explorer in the left pane. (For 
information on using View Explorer, see “Working 
with View Explorer” in Model Management.)

Important 
Information

You can sort the information displayed in the KPIs 
table by clicking on the column header. You can switch 
the column between ascending and descending order 
by clicking the header again.

GUI Element (A-Z) Description

Click to edit an existing KPI for a CI (or for multiple 
transaction CIs), as described in “How Dashboard KPIs 
Work” on page 338.
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Click to edit the KPIs for the child transactions. For 
details, see “How Dashboard KPIs Work” on page 338.

The Edit KPI for child transactions button is enabled for 
all KPIs, however:

➤ The option is only relevant for Performance and 
Availability KPIs (an error message is displayed for 
other KPIs).

➤ The option has validity only when there are 
Business Process Monitor transaction CIs contained 
in the subtree. 

Note: 

➤ Changes made in the Edit KPIs for Child Transaction 
window have no effect on KPIs other than 
Performance and Availability, or on CIs for which 
the option does not apply.

➤ After applying the Edit KPI for child transactions 
option, a KPI was saved successfully message is 
displayed in the top-right corner of the page, even if 
no changes were made to any CIs.

➤ If a transaction CI in the subtree is using a business 
rule other than the default monitor rule for the KPI 
(Transaction Availability Rule or Transaction 
Performance Rule), then when you apply the Edit 
KPI for child transactions option, the existing rule is 
replaced with the default rule.

Click to delete a KPI attached to a CI.

Business Rule The name of the business rule attached to the KPI.

KPI The name of the KPI.

GUI Element (A-Z) Description
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Monitor changes Set Dashboard to monitor (in real-time) changes made 
to the properties for a selected CI, or to the child CIs 
for the selected CI, as described in “Change the No 
Data Timeout Value for Transaction CIs – Optional” on 
page 369.

The icons that mark the changed CIs appear in the 
Console and Filter pages.

For a limited number of CIs (20 by default), Dashboard 
can monitor for changes to the CI properties (or 
changes to the properties of the CI’s child CIs) in 
real-time. To change the default, see “Analyze Real-
Time Change Information” on page 112

This information is in addition to the Dashboard 
Change Report, which shows a historical report on 
changes to properties for CIs over a period of time. (For 
details on the Change Report, see “Change Report 
Page” in Model Management.)

Note: The Monitor changes option is only enabled if:

➤ You are working in a shared CMDB environment.

➤ You enable change impact monitoring by selecting 
Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications, select 
Dashboard Application, and locate the Host name 
for MAM GUI Web server entry in the Change 
Impact Properties table. Define the Web server name 
and restart HP Business Availability Center.

Add KPI Click the Add KPI button to attach a new KPI to the CI. 
For details, see “How Dashboard KPIs Work” on 
page 338.

GUI Element (A-Z) Description
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Save KPI data over 
time for a CI

Select the option to set HP Business Availability Center 
to save KPI data for CIs, as described in “KPIs Over 
Time Report” on page 277.

You can enable/disable this option for multiple CIs by 
selecting the required CIs in View Explorer (using the 
keyboard CTRL key) and right-clicking one of the 
selected CIs. 

The option is selected by default for CIs of the 
following types: Business Process, Business Process 
Group, Line of Business, Application (logical 
application), and End User Management Application 
Related Group. The option is not available (disabled) 
for monitoring CIs. 

(If you also want to save data on the actual 
measurements for the KPIs, you must change the 
default settings for Dashboard in the Repositories, as 
described in “Change the No Data Timeout Value for 
Transaction CIs – Optional” on page 369.)

Saving status (and measurements) data for long periods 
or for many CIs can occupy a lot of database memory, 
so this option should be used with care. When you no 
longer require data to be saved for a CI, clear the check 
box.

GUI Element (A-Z) Description
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Context Menu area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays, depending on the selected CI, the CI’s 
assigned KPIs, associated business rules, and context 
menu, or the view’s KPIs, whether the KPI is defined in 
Business or Operation user mode, and whether to 
include the KPI in the CI status or the view’s 
calculations

If you select a CI in View Explorer (not the root CI), the 
KPIs page displays the KPIs and associated business 
rules defined for the selected CI.

If you select the root CI in View Explorer, the KPIs page 
display all the view's KPIs when you expand the KPI 
Selection area. 

To Access: Select Admin > Dashboard, click the KPIs 
tab, and select the required view and then the required 
CI in the View Explorer in the left pane. (For 
information on using View Explorer, see “Working 
with View Explorer” in Model Management.)

Important 
Information

You can sort the information displayed in the KPIs 
table by clicking on the column header. You can switch 
the column between ascending and descending order 
by clicking the header again.

GUI Element (A-Z) Description

<Context menu> The name of the context menus that you assigned to 
the CI.

Default Menu The default menu is, by default, assigned to the CI.

Edit Click the Edit button to open the Context Menus List 
Editor dialog box where you select the context menus 
you want to assign to the CI.
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16
Working With KPI Assignments and 
Propagations in Dashboard

This chapter describes how to manage KPI Assignments and KPI 
Propagations.

This chapter includes:

Concepts

 ➤  KPI Assignment Management Overview on page 420

 ➤  Assignments on page 421

 ➤  Propagations on page 423

 ➤  Validation on page 436

 ➤  SiteScope KPI Assignment Group Overview on page 437

Tasks

 ➤  Manage KPI Assignment Groups on page 442

 ➤  Manage KPI Assignment Groups – Scenario on page 444

 ➤  Work with the SiteScope Assignment Group on page 446

Reference

 ➤  Factory KPI Assignment Groups on page 448

 ➤  KPI Assignments User Interface on page 450
Concepts
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KPI Assignment Management Overview 

When a new CI is added to the CMDB, the assignment mechanism assigns 
the appropriate KPIs to the CI. When you assign a KPI to a CI or when you 
attach a CI to another CI, the propagation mechanism propagates the 
appropriate KPIs to the parent CIs.

The assignment mechanism assigns KPIs and context menus to CIs at the 
monitor CI level. Then the propagation mechanism starts running, 
propagating by default the KPIs assigned at the monitor level to the higher 
levels in the hierarchy of the view or attaching other KPIs to the CIs in the 
higher levels of the hierarchy. The propagation is performed for each KPI 
separately. 

An assignment assigns KPIs according to the cmdb_class attribute of the CI 
type. A propagation assigns KPIs to the parent CI, according to the triplet 
defined by the parent CI Type (using the parentCIClassName attribute), 
child CI Type (using the childCIClassName attribute), and KPI of the child 
CI.

KPIs and business rules are assigned to CIs using the assignment mechanism 
at the monitor CI level. For details about the assignment mechanism, see 
“Assignments” on page 421.

KPIs and business rules are assigned to CIs using the propagation 
mechanism at non-monitor CI level. For details about the propagation 
mechanism, see “Propagations” on page 423.

For a scenario which includes assignment and propagation, see “Define 
Repository Elements and KPI Assignments to Monitor Mobile Terminals – 
Scenario” on page 484.

Note: If you are using HP Operations Manager i with HP Business 
Availability Center, then the KPI Assignment tab contains OMi-related 
assignment groups. For more information, see Using HP Operations Manager i. 
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Assignments

KPI assignment are mechanisms that are activated under certain conditions 
to incorporate specific data into Dashboard, at the monitoring level. 

An assignment includes a condition and a task. The condition describes a CI 
or sets conditions on the attributes of a CI. The task describes the context 
menus, KPIs, and business rules that are automatically assigned to the CI, in 
the CMDB, when the condition occurs, and the assignment is running. An 
assignment is a rule that is saved using the Dashboard Repositories 
mechanism. You can view the assignments only in the KPI Assignment user 
interface. For details, see “Assignment Groups Page” on page 451.

Factory KPI assignment groups are pre-defined sets of assignments. They 
work together to cover all the sets of conditions for monitoring level CIs 
needed to incorporate data from the corresponding monitored system into 
Dashboard. For details on groups, see “Groups” on page 422.

This section includes the following topics:

➤ “Assignment Mechanism” on page 421

➤ “Groups” on page 422

Assignment Mechanism
The assignment mechanism receives notification from the Universal CMDB 
about the creation of monitor CIs. The KPI assignment mechanism is 
activated when a specific attribute of the monitor CI is updated and the KPI 
assignment conditions for that CI are based on the updated attribute. The 
KPI assignment mechanism performs the following actions in the Universal 
CMDB:

➤ Creates the KPIs attached to the monitor CI.

➤ Assigns the business rule to the KPI with parameters that can be based on 
attributes of the monitor CI.

➤ Assigns thresholds that can be based on attributes of the monitor CI.

➤ Assigns selectors that can be based on attributes of the monitor CI.

➤ Adds the context menus.
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The KPI assignment mechanism is a HP Business Availability Center service 
that can be managed by HP Service Manager. For details, see “System Health 
Setup Wizard” in Platform Administration.

A service completes the missed KPI assignments as soon as HP Business 
Availability Center is restarted, after it has been stopped.

The KPI assignment mechanism is deployed on the Data Processing server.

For details on creating assignments, see “Define Assignment Configuration 
Dialog Box” on page 545.

For general information on KPI functionality, see “KPI Configuration 
Overview” on page 336. For details on Dashboard KPIs, see “List of 
Dashboard KPIs” on page 512.

Groups
A group is a logical feature that enables you to group KPI assignments 
(assignments and propagations).

Some assignments are grouped together to cover all the conditions that can 
be applied to a specific CI. The conditions are set on the sample’s field 
values.

For example, a group can assign different KPIs to a CI when the value of a CI 
attribute equals or is different from a certain value.

➤ An assignment that deals with the KPIs and business rules to be applied if 
the sample’s field, corresponding to the CI, has a specific value:

➤ An assignment that deals with the KPIs and business rules to be applied if 
the sample’s field does not have that specific value:
 

Some groups also include assignments that are applied to different CIs.

<condition cmdb-class="ems_monitor">
    <property-condition name="data_source" operator="EQ" value="ticketing"/>
</condition>

<condition cmdb-class="ems_monitor">
    <property-condition name="data_source" operator="NOT_EQ" value="ticketing"/>
</condition>
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For details about the assignments user interface, see “Assignment Groups 
Page” on page 451.

Propagations 

Propagations are mechanisms that are activated under certain conditions to 
incorporate specific data into Dashboard, at all CI levels except for the 
monitoring level.

A propagation is defined per triplet (parent CI type, child CI type, and KPI 
attached to the child CI type), and specifies the business rules, KPIs, and 
thresholds propagated to the parent CI type from the child CI type.

A propagation includes a condition and a task. The condition describes the 
KPIs to be propagated, the child CIs, the parent CIs, and the type of 
propagation (explicit or samekpi). The task describes the KPIs, and business 
rules that are automatically propagated to the parent CI. The task may 
include thresholds to be used to set the status of the KPI. For details, see 
“Thresholds” on page 425.

A propagation definition is a rule that is saved using the Dashboard 
Repositories mechanism. You can view propagation information only in the 
Propagation user interface. For details, see “Define Propagation 
Configuration Dialog Box” on page 464.

If a parent CI is already assigned a specific KPI, and the propagation is 
defined as propagating the same KPI from the child CI, the KPI is not 
propagated from the child CI.

Some limitations apply when the same KPIs are propagated to the parent CI 
from multiple child CIs. For details, see “Propagation Limitations” on 
page 435.

The parent CI must be a logical group CI and the business rules that are 
propagated must be non-leaf rules.
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Factory propagations are pre-defined sets of propagations. They work 
together to cover all the possible configurations of child CIs and parent CIs 
needed to propagate data from the relevant monitoring level CIs to the 
non-monitoring level CIs. For details about groups, see “Groups” on 
page 422.

This section includes the following topics:

➤ “Default Propagation” on page 424

➤ “When is the Propagation Mechanism Activated” on page 425

➤ “Thresholds” on page 425

➤ “Types of Propagation” on page 427

➤ “Recommended Procedure” on page 430

➤ “Selecting the Appropriate Propagation” on page 431

➤ “De-propagation” on page 434

➤ “Propagation Limitations” on page 435

Default Propagation
The default propagation means that:

➤ Each KPI attached to any child CI of any parent CI is automatically 
propagated to the parent CI.

➤ The KPI is assigned the KPI’s default group business rule as defined in the 
KPI definition in the KPI repository. For details, see Default Group Rule in 
“KPI Details Dialog Box” on page 388.

➤ The thresholds are defined in the business rule repository, if they exist.

➤ The default propagation is not visible in the user interface. You cannot 
modify it.

The default propagation rule is used for a triplet only if no other factory or 
custom propagation rule matches the triplet.
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When is the Propagation Mechanism Activated
The propagation mechanism is triggered when:

➤ A link between two CIs is added or removed, in the CMDB.

➤ You assign a KPI to a CI or you detach a KPI from a CI in Dashboard 
administration.

Thresholds
Each child CI can have a different KPI propagation definition that includes 
the KPIs and the business rules to attach to the parent CI as well as the 
thresholds that determine the KPI status. For details about the KPI 
propagation, see “Define Propagation Configuration Dialog Box” on 
page 464. 

This section describes the different ways you can use to specify the 
propagated business rule objectives.

This section includes the following topics:

➤ “Default Thresholds” on page 426

➤ “Non-Default Thresholds” on page 426
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Default Thresholds

Default thresholds are defined in the repository business rules. If you do not 
enter an <objective> section in the task, the thresholds defined in the 
business rules are used. If thresholds are not defined in the business rules, 
then empty thresholds are assigned to the KPI.

Non-Default Thresholds

To use non-default thresholds for the business rule, you can specify the 
thresholds in the task (after specifying the KPI and the rule):

<objective>
                <operator type="GREATER_THAN"/>
                <threshold type="OK" value="RefProp:normal_limit"/>
                <threshold type="WARNING" value="RefProp:warning_limit"/>
                <threshold type="MINOR" value="RefProp:minor_limit"/>
                <threshold type="MAJOR" value="RefProp:major_limit"/>
</objective>



Chapter 16 • Working With KPI Assignments and Propagations in Dashboard

427

Types of Propagation
The propagation mechanism supports different types of propagation.

The table lists the different type of propagation and provides typical 
examples of conditions and tasks for each type of propagation:

Type of propagation Condition/task details

Type 1: Any KPI of any child CI 
of the specific parent CI is 
propagated to the parent CI.

Condition:

<condition childCIClassName="it_world" kpiType="all" 
parentCIClassName="customer" propagate="sameKpi"/>

When you have any KPI attached to any child CI of a 
Customer parent CI, the KPI and rule specified in the task are 
assigned to the Customer parent CI.

Task:

<task-config>
    <kpis-config globalRule="default"/>
</task-config>

The task assigns any KPI assigned to any child CI of the 
Customer parent CI and the default rule to the Customer 
parent CI. For additional details, see “Define Propagation 
Configuration Dialog Box” on page 464.
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Type 2: A specific KPI of any 
child CI of the specific 
parent CI is propagated to 
the parent CI.

Condition:

<condition childCIClassName="it_world" kpiType="612" 
parentCIClassName="bpi_step" propagate="explicit"/>

When you have KPI 612 attached to any child CI of a BPI Step 
parent CI, the KPI and rule specified in the task are assigned to 
the BPI Step parent CI.

Task:

<task-config>
  <kpis-config>
    <kpi-config type="612">
       <rule type="290"/>
            <objective>
               <operator type="GREATER_THAN"/>
                <threshold type="OK" value="ignore"/>
                <threshold type="WARNING" value="ignore"/>
                <threshold type="MINOR" value="ignore"/>
                <threshold type="MAJOR" value="ignore"/>

                  </objective>
        </kpi-config>
    </kpis-config>
</task-config>

The task assigns KPI 612 and the rule 290 to the parent 
CI. The objectives are not used (value="ignore"). For 
additional details, see “Define Propagation Configuration 
Dialog Box” on page 464.

Type of propagation Condition/task details
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Type 3: A specific KPI 
attached to a specific child 
CI of the specific parent CI is 
propagated to the parent CI.

Condition:

<condition childCIClassName="bpm_tx_from_location" 
kpiType="103" parentCIClassName="bp_step" 
propagate="explicit"/>

When you have KPI 103 attached to the BPM Transaction 
From Location child CI of a BP Step parent CI, the KPI and rule 
specified in the task are assigned to the BP Step parent CI.

Task:

<task-config>
        <kpi-config type="101">
            <rule type="201"/>
            <objective>
              <operator type="GREATER_THAN"/>
                <threshold type="OK" value="ignore"/>
                <threshold type="WARNING" value="ignore"/>
                <threshold type="MINOR" value="ignore"/>
                <threshold type="MAJOR" value="ignore"/>

                  </objective>
        </kpi-config>

The task assigns KPI 101 and rule 201 to the BP Step parent CI. 
The thresholds are specified in the code. For additional details, 
see “Define Propagation Configuration Dialog Box” on 
page 464.

Type of propagation Condition/task details
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Recommended Procedure
You create a set of propagations for a topology, meaning that for each level 
of parent CI in the hierarchy, you must create a set of propagations. A lot of 
the propagations are repetitive so the correct procedure is to:

 1 Create a set of general propagations of Type 1 for a specific parent CI. 

 2 Create a set of more specific propagations of Type 2 for a specific KPI and a 
specific parent CI.

 3 Create a set of more specific propagations of Type 3 for a specific KPI, a 
specific child CI, and a specific parent CI.

 4 Create a set of non-propagations of Type 4 for a specific KPI, a specific child 
CI, and a specific parent CI.

The propagations are then sorted and applied to each parent CI. For details, 
see “Selecting the Appropriate Propagation” on page 431.

Type 4: A specific KPI 
attached to a specific child 
CI of a specific parent is not 
propagated to the parent CI.

Condition:

<condition childCIClassName="it_world" kpiType="103" 
parentCIClassName="bp_group" propagate="explicit"/>

When you have KPI 103 attached to any child CI of a BP 
Group parent CI, the KPI and rule specified in the task are 
assigned to the BP Group parent CI.

Task:

<task-config>
    <kpis-config/>
</task-config>

The task does not provide a default rule, a rule or a KPI. This 
indicates that the KPI is not propagated to the parent CI. For 
additional details, see “Define Propagation Configuration 
Dialog Box” on page 464.

Note: All the types of propagations listed in the table can be 
defined as non-propagations using the features provided in 
Type 4.

Type of propagation Condition/task details
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Selecting the Appropriate Propagation
The matcher of the propagation mechanism considers all the propagation 
definitions and sorts them before applying them to the different triplets.

All the customized propagations that you define are added to a list of 
existing propagations that is already sorted.

The matcher sorts the complete list of propagations according to the 
algorithm described below.

 1 Parent sorting:

➤ A comparison triplet parent CI that is equal to the propagation parent CI 
(the number of hierarchy levels is 0 in the model hierarchy) is better than 
a comparison triplet parent CI that is derived – with a larger number of 
hierarchy levels – from the propagation parent CI.

➤ A comparison triplet parent CI that is derived, in the class model, from 
the propagation parent CI with a smaller number of hierarchy levels is 
better than a comparison triplet parent CI that is derived from the 
propagation parent CI, with a larger number of hierarchy levels.

 2 Child sorting:

The mechanism performs the same type of sorting as the parent CI sorting 
on the child CI. 

 3 KPI sorting:

The sorting is performed on the KPI where the KPI corresponding to the 
triplet KPI is better than kpiType=all. 
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For each KPI that is propagated from a child CI type to a parent CI type 
(comparison triplet), the matcher scans the list of sorted propagations to 
find the propagation that most closely matches the triplet. A propagation is 
considered a match when:

➤ The parent CI type and the child CI type in the propagation correspond 
exactly to the comparison triplet parent CI or child CI, OR the child CI 
class in the comparison triplet is derived (in the class model hierarchy) 
from the child CI type in the propagation and the same for the parent CI 
type.

AND

➤ The propagation KPI has the same ID number as the comparison triplet 
KPI OR the propagation condition specifies kpiType=all.

The first propagation in the sorted list is used. 

Example

The factory and customized propagations defined are as follows:

No

Propagation Condition
How does the propagation match the triplet (parent CI=B, 
child CI=A, and KPI=K)?Parent 

CI
Child CI KPI

1 it_world it_world All The propagation includes the triplet.

2 J it_world All The propagation does not include the triplet.

3 D C All CI B is derived from CI E, CI D and CI A is derived from CI C 
in the class model, and the propagation is for all KPIs, so the 
propagation includes the triplet.

4 E it_world K CI B is derived from CI E and CI A is included in it_world in 
the class model, and the propagation is for the K KPI, so the 
propagation includes the triplet.
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The class model is provided in the picture below. 

The result of the sorting procedure is as follows:

 1 Propagation 6 is at the top of the list as its parent CI type is E (most specific), 
child CI type C (most specific) and KPI type is K (explicit type).

 2 Propagation 5 comes after propagation 6 as its only difference with 6 is its 
generic KPI type.

 3 Propagation 4 comes after as its child CI type (it_world) is more generic than 
propagation 5's child CI type (C).

5 E C All CI B is derived from CI E and CI A is derived from CI C in 
the class model, and the propagation is for all KPIs, so the 
propagation includes the triplet.

6 E C K CI B is derived from CI E and CI A is derived from CI C in 
the class model, and the propagation is for the K KPI, so the 
propagation includes the triplet.

No

Propagation Condition
How does the propagation match the triplet (parent CI=B, 
child CI=A, and KPI=K)?Parent 

CI
Child CI KPI
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 4 Propagations 3, 2, and 1 are listed afterwards (in this order), as their parent 
type is less specific (higher in the hierarchy) than type E.

 5 Propagation 1 goes to the bottom of the list as it is the most generic 
propagation.

When the propagation mechanism tries to find the closest matching 
propagation definition to the triplet (parent=CI B, child=CI A and KPI=KPI 
K) propagation 6 is at the top of the list and is therefore selected. 

De-propagation
The de-propagation mechanism is activated:

 1 When a CI is deleted from the impact model.

 2 When a link between two CIs is deleted from the impact model.

 3 When a KPI is deleted from a CI of the impact model.

For details on the impact model, see “Impact Modeling Overview” in Model 
Management.

There are two cases of de-propagation:

➤ Case A: KPI is deleted.

➤ Case B: CI is deleted OR the link between two CIs is deleted.

In case A, the de-propagation mechanism performs the following steps:

 1 Finds the matching propagation for the deleted KPI according to its triplet 
(child CI, parent CI, and KPI type). For details, see “Selecting the 
Appropriate Propagation” on page 431.

The selected propagation includes the set of KPIs that might have been 
previously propagated by the deleted KPI.

 2 Retains from the potential KPIs only the KPIs that are currently attached to 
the parent CI.

 3 Finds the propagations that match the KPIs attached to the child CI and its 
siblings.

 4 Builds a set of the KPIs that might have been previously propagated by the 
matching propagations from step 3.
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 5 Removes the KPIs of step 4 from the set of KPIs of step 2.

 6 The remaining KPIs are deleted from the parent CI.

 7 The de-propagation mechanism is then applied to the next level of the 
impact model topology for each one of the KPIs deleted in step 6.

In case B, the de-propagation mechanism performs the following steps:

 1 Finds all the matching propagations for all of the KPIs attached to all of the 
siblings of the deleted (or detached) CI.

 2 Builds a set of KPIs attached to the parent CI that were not propagated by 
any of the propagations from step 1.

 3 Deletes from the parent CI all of the KPIs from step 2.

 4 Activates the de-propagation mechanism described in case A starting with 
the parent CI and the set of KPIs deleted from it in step 3.

Propagation Limitations

➤ If you propagate the same KPI A from different child CIs (CI1 and CI2) with 
a different propagation, the propagation that affects the parent CI (CI4) 
regarding KPI A can be either one of the propagations (from CI1 or CI2). 
Because of this uncertainty, it is recommended to avoid specifying different 
propagations that propagate the same KPI with different rules and/or 
thresholds.
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➤ According to the previous limitation, if you propagate the same KPI A from 
different child CIs (CI1, CI2, or CI3), the propagation that affects the parent 
CI (CI4) regarding KPI A can be either one of the propagations. If you delete 
one of the CIs (CI2) or one of its KPIs, the configuration of KPI A (rule and 
thresholds) is updated and propagated from either CI1 or CI3. The update is 
not performed if the KPI was customized by the user.

Validation

The validation mechanism for assignments and propagations checks that 
for:

➤ KPI assignments:

➤ The CMDB class used in the condition of a Dashboard KPI assignment 
should be of monitor type.

➤ The task of a Dashboard KPI assignment should contain at least one KPI 
that specifies a selector.

➤ The task of a Dashboard KPI assignment should contain at least one KPI 
configuration.
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➤ KPI propagations:

➤ The business rule assigned to a KPI is applicable to the KPI and is a 
non-leaf rule

➤ When you use the same-kpi propagation in a Dashboard KPI 
propagation, you must specify a global rule (it can be the default rule); 
and you should not specify KPI configuration elements.

SiteScope KPI Assignment Group Overview

Note: The feature described in this section is available to users working with 
SiteScope 9.50 and later. If you are working with SiteScope 9.0 and earlier, 
see “SiteScope Source Adapter Details” in Model Management. 

The SiteScope Assignment group is a logical group of KPI assignments. The 
KPI assignments assign specific KPIs, business rules, and context menus to 
the appropriate CIs in the Universal CMDB, under specified conditions 
usually related to the samples sent by SiteScope to HP Business Availability 
Center. 

SiteScope sends the topology information and builds the hierarchy, 
including the hosts, SiteScope groups, monitors, and additional topologies 
corresponding to specific SiteScope monitors, needed to incorporate data 
(collected by SiteScope data collectors, or supplied by other external 
resources) directly to HP Business Availability Center. The KPI assignments 
mechanism, analyzes the samples, and adds the KPIs, business rules, and 
context menus at the monitoring level of the topology. 
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Siebel, SAP, and SOA topology and their measurements also use the KPI 
assignments mechanism to add the KPIs, business rules, and context menus 
needed to incorporate data (collected by the appropriate SiteScope data 
collectors) into HP Business Availability Center, at the monitoring level.

The information is then used to build views for the HP Business Availability 
Center applications. Those views present the real-time monitoring data 
received from the data sources in Dashboard. 

The SiteScope Assignment group is preconfigured to work immediately with 
the data collected by the SiteScope data collectors.

Note: All topologies created by SiteScope and stored in the Universal CMDB 
are subjected to the aging process. To prevent aging, see “Aging of CIs in 
CMDB” in Using System Availability Management. 

This section includes the following topics:

➤ “Predefined Monitoring Views” on page 438

➤ “Hierarchies” on page 439

Predefined Monitoring Views
Predefined views display the created CI hierarchies for the SiteScope 
monitors. When data is received over the bus for a defined source, you can 
open the relevant view in Dashboard and view status information for the 
CIs. You can use the CI hierarchies created in the predefined monitoring 
views as the building blocks for defining your own customized views.
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Hierarchies
The default topology corresponding to the SiteScope monitors is included in 
the following views:

➤ System Monitors view:

The curved arrow indicates that the hierarchy element is recursive; the CI 
type is the child of the level above in the hierarchy, but it can also be a child 
of the CI type itself. For example, a SiteScope Group CI type is the child of a 
SiteScope Profile CI type, but can also be the child of a SiteScope group CI 
type. The view also supports the legacy hierarchies (Depends on and 
Monitored by relationships and Include Measurements and Include 
Machines options). The legacy hierarchy is not shown in the picture of the 
view displayed above.

➤ Monitored Hosts view:

Additional topologies are related to the HP Business Availability Center for 
SAP Applications, HP Business Availability Center for Siebel Applications, 
and HP Business Availability Center for SOA solutions within HP Business 
Availability Center:
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➤ Siebel Application Server topology:

SiteScope creates the topology for the SiteScope Siebel Application Server 
monitor. For details, see “Siebel Views” in Solutions and Integrations.

Note: The topology is created only if you have the Business Availability 
Center for Siebel license installed.

➤ Siebel Web Server topology:

SiteScope creates the topology for the SiteScope Siebel Web Server monitor. 
For details, see “Siebel Views” in Solutions and Integrations.

Note: The topology is created only if you have the Business Availability 
Center for Siebel license installed.

➤ SAP CCMS topology:

SiteScope creates the topology for the SiteScope SAP CCMS monitor. For 
details, see “SAP Systems View” in Solutions and Integrations.

Note: The topology is created only if you have the Business Availability 
Center for SAP license installed.

➤ SAP Work Processes topology:

SiteScope creates the topology for the SiteScope SAP Work Processes 
monitor. For details, see “SAP Systems View” in Solutions and Integrations.

Note: The topology is created only if you have the Business Availability 
Center for SAP license installed.
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➤ SOA topology:

SiteScope creates the topology for the SiteScope Web Service monitor. For 
details, see “SOA Views and Their Components” in Solutions and Integrations.

Note: The topology is created only if you have the Business Availability 
Center for SOA license installed.

➤ Additional topologies

SiteScope creates other topologies. For details, see “Reporting Discovered 
Topologies to HP Business Availability Center” in Using System Availability 
Management.

Tasks



Chapter 16 • Working With KPI Assignments and Propagations in Dashboard

442

Manage KPI Assignment Groups

Note: You can partially edit factory groups:

➤ You can modify only the task of factory group’s KPI assignments.

➤ You cannot add new KPI assignments to a factory group.

➤ You cannot delete existing KPI assignments within a factory group.

You can add, edit, or delete custom groups.

To manage KPI assignment groups, use the steps listed in this task.

This task includes the following steps:

➤ “Manage the Groups” on page 442

➤ “View or Configure KPI Assignment Conditions and Tasks” on page 443

➤ “View or Configure KPI Propagation Definition Conditions and Tasks” on 
page 443

 1 Manage the Groups
You can create custom KPI Assignment groups, or edit factory or custom KPI 
Assignment groups. For details, see “Assignment Groups Page” on page 451.

After you create a new KPI Assignment group, you add individual 
assignments and propagations to the group. For details, see “Edit Group 
Page” on page 469.
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 2 View or Configure KPI Assignment Conditions and Tasks
You can view the factory KPI assignments or you can create or edit a KPI 
assignment for each CI type. 

An assignment definition includes a condition and a task. The condition 
describes specific characteristics of a CI. The task describes the KPIs and 
business rules that are to be assigned automatically to the CI when the 
condition occurs. For details, see “Assignments” on page 421.

To create or edit a KPI assignment, you specify the condition, the task, the 
thresholds, and the operator. For details, see “Define Assignment 
Configuration Dialog Box” on page 452.

 3 View or Configure KPI Propagation Definition Conditions and 
Tasks
You can view the factory KPI propagations or create or edit a KPI 
propagation definition for each non-monitor CI type. 

A propagation definition includes a condition and a task. The condition 
describes specific characteristics of a triplet (parent CI type, child CI type, 
and KPI). The task describes the KPIs and business rules that are to be 
assigned automatically to the non-monitor CI when the condition occurs. 
For details, see “Propagations” on page 423.

The parent CI must be a group CI and the business rules that are propagated 
must be non-leaf rules.

To create or edit a KPI propagation definition, you specify the condition, the 
task, the objectives, and the operator. For details, see “Define Propagation 
Configuration Dialog Box” on page 464.
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Manage KPI Assignment Groups – Scenario

In the HP Business Process Insight KPI assignment group, you want to 
modify the BPI Process Monitor CIs assignment so that the Backlog KPI 
(600) is assigned the BPI Monitor Backlog Count Rule (604) instead of the 
BPI Monitor Backlog Value Rule (605).

By default, all the KPIs of the BPI Duration Monitor CI (child CI) are 
propagated with their default group rules to the Business Process CI (parent 
CI). You want to prevent the propagation of the Duration (601) KPI from BPI 
Duration Monitor CI to the Business Process CI.

The scenario includes the following steps:

➤ “Modify the HP Business Process Insight KPI Assignment Group” on 
page 444

➤ “Add the Duration KPI Assignment Group” on page 445

 1 Modify the HP Business Process Insight KPI Assignment Group
Open the HP Business Process Insight KPI Assignment group and then open 
the BPI Process Monitor CIs assignment and modify it.

 a Click Admin > Dashboard > KPI Assignments, select the HP Business 
Process Insight KPI Assignment group and click the Edit  button. 

 b In the Edit Group dialog box, select the BPI Process Monitor CIs 
assignment and click the Edit  button. 
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 c In the Define Assignment Configuration dialog box, replace 605 with 
604, and modify the threshold definitions if needed:

 d Click OK. 

For details, see “Assignment Groups Page” on page 451.

 2 Add the Duration KPI Assignment Group
As you cannot add a propagation to an existing factory KPI assignment 
group, you must create a new KPI assignment group and specify the 
non-propagation configuration in the new KPI assignment group.

You want to prevent the propagation of the Duration (601) KPI from the BPI 
Duration Monitor CI to the Business Process CI.

 a Click Admin > Dashboard > KPI Assignments, click the New button, and 
create the Duration KPI Assignment group. 

 b In the Edit Group dialog box, click the New button in the Propagations 
area. 

 c In the Define Propagation Configuration dialog box, specify the name of 
the propagation and enter a description.

<task-config>
    <contextmenu id="BPIBPMenu"/>
    <kpis-config>
       <kpi-config type="600">
           <rule type="604"/>
           <trinity-selector>
               <CompositeSelector logicalOp="AND">
                  <Selector key="sampleType" op="EQ" type="String" value="bpi_process_t"/>
                 <Selector key="bp_cmdb_id" op="EQ" type="Binary" 
value="RefProp:bp_cmdb_id"/>
               </CompositeSelector>
           </trinity-selector>
       </kpi-config>
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 d Enter the following text in the Condition box. This condition specifies 
the KPI, the child CI and the parent CI and states that the task is explicit. 
It details the KPIs and rules.

 e Enter the following text in the Task box. The task specifies that the KPI 
should not be propagated.

 f Click OK.

Work with the SiteScope Assignment Group

Note: If you are working with SiteScope 9.0 and earlier, see “Work with the 
SiteScope Source Adapter – Workflow” in Model Management. If you are 
working with SiteScope 9.50, use the following task.

This task describes how to work with the SiteScope assignment group.

This task includes the following steps:

➤ “Set Up the Permissions” on page 447

➤ “Set the SiteScope Monitors to Report to HP Business Availability Center” on 
page 447

➤ “Results” on page 448

<condition childCIClassName="bpi_duration_monitor" kpiType="601"
    parentCIClassName="business_process" propagate="explicit"/>

<task-config>
    <kpis-config/>
</task-config>
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 1 Set Up the Permissions
You must have at least the Superuser or Administrator role to have access to 
Dashboard Administration. If you have the Superuser role, you have full 
viewing and editing rights for all of the Dashboard Administration, 
including the KPI Assignments. If you have the Administrator role, you can 
only view/edit views for which you have permission and you cannot edit, 
add, or view KPI Assignments. To access the Permissions page, select Admin 
> Platform > Users and Permissions. For details, see “User Management” in 
Platform Administration.

Note to HP Software-as-a-Service customers: You must have at least the 
Superuser, Operator, Customer Super User, or Customer Administrator role 
to have access to the Dashboard Administration. If you have the Customer 
Administrator role, you can only view/edit views for which you have 
permission, and you cannot edit the KPI Assignments. 

 2 Set the SiteScope Monitors to Report to HP Business 
Availability Center
To display data from SiteScope monitors in HP Business Availability Center 
you must set the appropriate SiteScope monitors logging options. For details 
on these options, see “HP BAC Integration Settings” in Using System 
Availability Management.

Depending on when you set SiteScope to report to HP Business Availability 
Center, the default logging options are set as follows:

➤ If you defined monitors in SiteScope before SiteScope was set to report to 
HP Business Availability Center, the logging option of each SiteScope 
monitor is automatically changed to Disable reporting to BAC when you set 
SiteScope to report to HP Business Availability Center. 

You must select another logging option for the monitors whose information 
you want to display in HP Business Availability Center. Use the Global 
Search and Replace mechanism to modify the logging option of the selected 
monitors. For details, see “Global Search and Replace” in Using System 
Availability Management.
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Use the Disable reporting to BAC option when you do not want the 
SiteScope monitors and measurements for the subject monitor to be 
transferred to HP Business Availability Center.

➤ If you define monitors after you have set SiteScope to report to HP Business 
Availability Center, the monitors have, by default, the Report everything 
option selected.

For additional information about the integration of SiteScope and 
HP Business Availability Center, see “Integrating SiteScope Data with 
HP Business Availability Center’s Configuration Items” in Using System 
Availability Management.

 3 Results
You can view the topology created by SiteScope KPI Assignments in the 
“Hierarchies” on page 439.

Reference

Factory KPI Assignment Groups

The following factory KPI assignment groups are available:

Factory KPI Assignment 
Group

Description

General The General assignment group deals with the 
propagation of the PNR KPI – it does not include KPI 
assignments.

HP Business Process 
Insight

Includes assignments and propagations for Business 
Process Insight-related CIs.

HP TransactionVision Includes assignments and propagations for 
TransactionVision-related CIs.
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SiteScope Includes assignments and propagations for 
SiteScope-related CIs.

The SiteScope Siebel Measurements assignment is 
activated when the measurement’s names do not 
include the No. of tasks in error or No. of Running 
Sessions strings.

The SiteScope Siebel Sessions Measurements 
assignment is activated when a measurement’s name 
includes the No. of Running Sessions string.

SOA Includes assignments for SOA-related CIs.

Non-monitor SOA-related CIs use the default 
propagation rules. For details, see “Default 
Propagation” on page 424.

Factory KPI Assignment 
Group

Description
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KPI Assignments User Interface

This section describes:

 ➤  Add Group Dialog Box on page 450

 ➤  Assignment Groups Page on page 451

 ➤  Define Assignment Configuration Dialog Box on page 452

 ➤  Define Propagation Configuration Dialog Box on page 464

 ➤  Edit Group Page on page 469

Add Group Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to add a group.

To access: Click  in the KPI Assignments tab.

Included in Tasks “Manage KPI Assignment Groups” on page 442

GUI Element (A-Z) Description

Name The name of the group.

This field is mandatory.

Description The description of the group. 

This is the description displayed in the Assignment 
Groups page.
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Assignment Groups Page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the Factory and Custom assignment groups.

To access: Select Admin > Dashboard > KPI Assignments

Important 
Information

You can create, edit, and delete custom groups.

You can partially edit factory groups, that is:

➤ You can modify a factory group’s assignments.

➤ You cannot add new assignments to a factory group.

➤ You cannot delete existing assignments within a 
factory group.

Note: To change the way out-of-the-box KPIs are assigned 
to CIs or the rules that are attached to the KPIs for Real 
User Monitor or the Business Process Monitor CIs, do not 
create KPI assignments but modify the XML files for each 
source adapter. For details, see “Business Process 
Monitoring Source Adapter Details” or “Real User 
Monitor Source Adapter Details” in Model Management.

Included in Tasks “Manage KPI Assignment Groups” on page 442

GUI Element (A–Z) Description

Click the New Group button to open the Add Group 
dialog box.

Select a group and click the Edit button to open the Edit 
Group page where you can edit the group. For details, see 
“Edit Group Page” on page 469.

Select a group and click the button to delete the group.

Note: If you select a Factory group and click the Delete 
button, the following message is displayed: Deleting a 
factory group is prohibited.

Click the Reset Column Width button to enable you to 
modify the width of the table columns or restore the 
table columns to their original width.
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Define Assignment Configuration Dialog Box

Description The description of the assignment group.

Name The name of the assignment group.

Factory assignment groups are available. For details, see 
“Factory KPI Assignment Groups” on page 448.

Type The type of the assignment group: Custom or Factory.

Description Enables you to configure a KPI assignment.

To Access: Click the New Assignment button   in 
the Edit Group page in the Assignments area.

Note: The button is not available for factory 
assignment groups.

Important 
Information

After you have created a KPI assignment you cannot 
modify the condition. A workaround is to delete the 
KPI assignment and to recreate it with a new condition.

Note: To change the way out-of-the-box KPIs are 
assigned to CIs or the rules that are attached to the 
KPIs for Real User Monitor or the Business Process 
Monitor CIs, do not create KPI assignments but modify 
the XML files for each source adapter. For details, see 
“Business Process Monitoring Source Adapter Details” 
or “Real User Monitor Source Adapter Details” in Model 
Management.

Included in Tasks “Manage KPI Assignment Groups” on page 442

GUI Element (A–Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Condition The condition is written in XML. It uses parameters to 
specify the criteria used to trigger the Task. For details 
on the parameters, see “Assignment – Condition” on 
page 454.

Description The description of the KPI assignment. 

Name The name of the assignment.

This field is mandatory.

Run on existing CIs Set to retroactively run the KPI assignment on existing 
CIs. 

When you select this option, and click OK, the KPI 
assignment is run retroactively on the appropriate CIs 
with the appropriate conditions. 

Note: Selecting this option does not change the status 
of the KPI assignment itself.

Status Status can display:

➤ Assignment Configuration will be stopped after 
creation when you are creating a new KPI 
assignment. After you configure the KPI assignment 
the status of the KPI assignment is automatically set 
in Stopped status in the Edit Group page if you are 
using KPI Assignments in Dashboard or in the Add 
Integration page if you are using EMS Integration.

➤ Stopped or Running depending on the status of the 
KPI assignment you are editing.

Task The task is written in XML. It uses parameters to define 
the tasks used to assign the KPIs, business rules, and 
context menus to the selected CI. The task is performed 
after the KPI assignment is triggered. For details, see 
“Assignment – Task” on page 457.
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Assignment – Condition
The assignment condition uses the following format:

The parameters used to define assignment conditions are as follows:

Validate Click the Validate button to validate the XML code in 
both the Condition and Task areas and to perform the 
indentation of the code. For details, see “Validation” 
on page 436.

<condition cmdb_class="class_name">
<property-condition name="name" operator="operator" value="value"/>

</condition> 

Element Description

condition A collection used to define the condition. 

The element’s attribute is cmdb-class, which represents the 
name of the CMDB class (not the display name) that 
corresponds to the CI for which you are creating the KPI 
assignment. For details on the CMDB classes, select Admin > 
Modeling > CIT Manager, select the CI type, and click the 
Details tab.

Note: This element is mandatory. It can contain one or more 
property-condition elements.

Note: The name you specify in cmdb_class must be the name 
of a monitor CI. If not, the validation issues an error message.

GUI Element (A-Z) Description
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Property_Condition Operator

Use one of the following values:

property-
condition

An element that creates a restriction on the condition. You can 
use more than one property-condition. The element’s 
attributes are:

➤ name. This attribute is mandatory. The name of one of the 
attributes of the CMDB class. For details on the CMDB 
classes, select Admin > Modeling > CIT Manager, select the 
CI type, and click the Details tab.

➤ operator. This attribute is mandatory. The operator. For 
details on the possible operators, see “Property_Condition 
Operator” on page 455. 

➤ value. This attribute is mandatory. A string that is compared 
to the value of the attribute of the CMDB class specified in 
class_attribute_name. This attribute is not mandatory when 
using IS_NULL and NOT_NULL.

Value Description

EQ Returns true when the value of the CMDB class attribute 
equals the value specified in the value attribute of the 
property-condition. See the example below.

IN Returns true when the value of the CMDB class attribute 
equals one of the elements that is listed in the value attribute 
of the property-condition. The elements in the list should be 
separated with a comma. 

IN_LIST Returns true when the value attribute of the 
property-condition equals one of the elements listed in the 
value of the CMDB class attribute, when the CMDB attribute 
type is string_list.

IS_NULL Checks where the CI attribute was not assigned a value. 
Returns true when the CMDB class attribute is empty.

Element Description
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LIKE Returns true when the value of the CMDB class attribute 
matches the string in the value attribute of the 
property-condition. The string of the value attribute can 
contain % as a wildcard. % may represent 0 or more 
characters.

NOT_EQ Returns true when the value of the CMDB class attribute does 
not equal the value specified in the value attribute of the 
property-condition. See the example below.

NOT_LIKE Returns true when the value of the CMDB class attribute does 
not match the string in the value attribute of the 
property-condition. The string of the value attribute can 
contain % as a wildcard. % may represent 0 or more 
characters.

NOT_NULL Checks where the CI attribute was assigned a value. Returns 
true when the CMDB class attribute is not empty.

Value Description
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Assignment – Task
The assignment task uses the following format:

<task-config>
<contextmenu id="id, id" /> 
<kpis-config>

<kpi-config type="type">
<rule>rule_number</rule> 

<rule-parameter key="key" value="value" type="Type"/>
<rule/>
<trinity-selector>

<CompositeSelector logicalOp="logicalOp">
<Selector key="key" op="op" type="type" value="value" /> 

</CompositeSelector>
</trinity-selector>
<objective>

<operator type="type"/>
<threshold type="OK" value="value"/>
<threshold type="WARNING" value="value"/>
<threshold type="MINOR" value="value"/>
<threshold type="MAJOR" value="value"/>

</objective>
</kpi-config>

</kpis-config>
</task-config>
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The parameters used to define assignment tasks are as follows:

Element Description

task-config An element used to define the task.

contextmenu Optional. An element used to specify the context menu 
you want to add to the CI to which the KPI assignment 
is attached. 

The element’s attribute is id, which represents the 
internal name of the context menu. To add more than 
one context menu to a CI, separate their internal 
names with commas (,).

For details on the context menu internal names, see 
“Context Menu Repository page” on page 716.

kpis-config A collection of kpi-config elements.

Note: If you have used the propagate=sameKPI 
attribute in the condition, you must use the globalRule 
attribute in this element as follows:

➤ <kpis-config globalRule="default"/> to assign the 
default rule to the KPI.

➤ <kpis-config globalRule="<rule_id>"/> to assign the 
specified rule to the KPI.

Note: The globalRule specification is overridden by the 
rules specified using the rule element. 

kpi-config An element used to define the KPI. 

The element’s attribute is type, which represents the ID 
number of the KPI. 

For details on the KPI number, see “KPI Repository 
page” on page 537.

rule An element that specifies the number of the business 
rule you want to attach to the KPI. For details on the 
business rule numbers, see “Parameter Details Dialog 
Box (KPIs)” on page 552.

Note: It can also be a collection of parameters when 
you want to override existing business rule parameters 
or when you want to add new parameters to the 
business rule.
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rule-parameter Optional. An element that defines the business rule 
parameter. The element’s attributes are:

➤ key. The display name of the business rule 
parameter.

➤ value. The value of the parameter. Corresponds to 
the Default Value in the Business Rule Repository.

➤ type. The type of parameter. Corresponds to the 
Type of the parameter. 

For details, see “Parameter Details Dialog Box 
(Rules)” on page 656.

trinity-selector A collection of selector definitions.

Composite
Selector

An element that indicates how to group logically the 
selectors. 

The element’s attribute is logicalOp, which is the 
logical operator. The value can be: AND, OR, NAND, 
or NOR.

Example: To create the a & b || c & d sample filter, use 
the following set of CompositeSelectors:

CompositeSelector logicalOp="OR"
CompositeSelector logicalOp="AND"

Selector "a"
Selector "b"

CompositeSelector logicalOp="AND"
Selector "c"
Selector "d"

Element Description
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Selector An element that filter the samples relevant for the KPI. 
It indicates how to filter the sample fields that are used 
by the business rules to calculate the KPI status. When 
a monitoring (leaf) CI has a KPI and associated business 
rule that are intended to be applied to actual data 
samples, the KPI properties include a selector. 

The element’s attributes are:

➤ key. The name of the sample field.

➤ op. The operator can be:

➤ EQ or NOT_EQ

➤ GT or LT

➤ GTEQ or LTEQ

➤ IN or NOT_IN. Use the |!| separator in the value 
attribute.

➤ MATCH or NOT_MATCH. The expression you 
enter in the value attribute should follow the Java 
standard for regular expression.

➤ PREFIX or NOT_PREFIX. Filters in the samples 
where the sample field value starts with the string 
entered in the value attribute.

➤ SUFFIX or NOT_SUFFIX. Filters in the samples 
where the sample field value ends with the string 
entered in the value attribute.

➤ type. The type of field can be: String, Double, 
Integer, Long, Boolean, Float, or Binary.

➤ value. The value of the field in the sample can be:

➤ RefProp:<name of CI property>. The value can 
contain the reference to a CI property.

➤ RefPropObject:CMDB_ID. The only supported 
value is CMDB_ID. It corresponds to the ID 
number of the CI in the CMDB database. This 
value can only be used for composite selectors. Its 
type is Binary.

Element Description
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objective Optional. A collection of objective definitions. 

Note:

➤ When the KPI assignment receives a creation 
notification from the Universal CMDB, it adds the 
KPI objective configuration to the new CI, according 
to the KPI assignment definition, in the CMDB.

➤ If the KPI Objective is not defined in the 
assignment, the default objectives are taken from 
the business rule repository, according to the 
specified rule type.

➤ The KPI Objective configuration must include the 
following thresholds: OK, MINOR, WARNING, 
MAJOR 

When the KPI assignment receives a creation 
notification from the Universal CMDB, it adds the KPI 
objective configuration to the new CI according to the 
KPI assignment definition, in the Universal CMDB. Use 
the following format:

<objective>
<operator type="operator"/>
<threshold type="OK" value="value"/>
<threshold type="WARNING" value="value"/>
<threshold type="MINOR" value="value"/>
<threshold type="MAJOR" value="value"/>

</objective>
For more information about thresholds and how to 
define them, see “Thresholds” on page 425.

Element Description



Chapter 16 • Working With KPI Assignments and Propagations in Dashboard

462

operator Optional. An element used to define the objective 
operator. The element’s attributes is type. The type can 
be:

➤ default. To indicate to take the default operator 
value from the business rule repository, according to 
the specified business rule type (can be empty). The 
result is the same if the operator is empty.

➤ RefProp:<reference_property_name>. The operator 
type is taken from the created CI. The value of the 
CI property must be one of the following: 
GREATER_THAN, LESS_THAN, 
GREATER_THAN_EQUAL, LESS_THAN_EQUAL, 
default, or the property is empty. If the value of the 
CI is default or if the property is empty, the default 
operator is used. 

➤ GREATER_THAN. The resulting operator is >

➤ LESS_THAN. The resulting operator is <

➤ GREATER_THAN_EQUAL. The resulting operator is 
>=

➤ LESS_THAN_EQUAL. The resulting operator is <=

Element Description
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threshold This element is mandatory. An element used to define 
the thresholds. The element’s attribute is type. The 
type can be:

➤ default. To indicate to take the default threshold 
value from the business rule repository, according to 
the specified business rule type. The resulting 
threshold value is the default value according to the 
business rule (can be empty).

➤ ignore. To skip the threshold checking. This is 
similar to leaving an empty threshold in the KPI 
definition in the Edit KPI dialog box. For details, see 
“How Dashboard KPIs Work” on page 338. The 
resulting threshold value is empty.

➤ RefProp:<reference_property_name>. The threshold 
value is taken from the created CI. If the CI property 
is empty, the result is the same as using default. 
For example:

➤ OK corresponds to RefProp:normal_limit

➤ Warning corresponds to RefProp:warning_limit

➤ Major corresponds to RefProp:major_limit

➤ Minor corresponds to RefProp:minor_limit

➤ <number>. A number that has a float, integer, or 
long format.

Element Description
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Define Propagation Configuration Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to configure a KPI propagation definition.

To Access: Click the New button  in the Edit Group 
page in the Propagation Rules area.

Note: The button is not available for factory 
assignment groups.

Important 
Information

After you have created a propagation definition you 
cannot modify the condition. A workaround is to 
delete the propagation definition and to recreate it 
with a new condition.

The parent CI must be a logical group CI and the 
business rules that are propagated must be group rules.

Included in Tasks “Manage KPI Assignment Groups” on page 442

GUI Element (A-Z) Description

Condition The condition is written in XML. It uses parameters to 
specify the criteria used to trigger the Task. For details 
on the parameters, see “Propagation Definition – 
Condition” on page 465.

Note: when you edit a KPI propagation, the condition 
is not editable.

Description The description of the propagation. 

Name The name of the propagation.

This field is mandatory.

Task The task is written in XML. It specifies the KPIs and 
business rules to be propagated to the specified parent 
CI and the objectives to be used to calculate the status/
value of the KPI. The task is performed after the 
propagation is triggered. For details, see “Propagation 
Definition – Task” on page 467.
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Propagation Definition – Condition
The propagation condition uses the following format:

Validate Click the Validate button to validate the XML code in 
both the Condition and Task areas and to perform the 
indentation of the code. For details, see “Validation” 
on page 436.

<condition childCIClassName="it_world" kpiType="612"
    parentCIClassName="bpi_step" propagate="explicit"/> 

GUI Element (A-Z) Description
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The parameters used to define propagation conditions are as follows:

Element Description

condition An element used to define the condition. 

The element’s attributes are:

➤ childCIClassName. This is the name of the CMDB class (not 
the display name) that corresponds to the child CI of the 
parent CI specified in parentCIClassName. For details on the 
CMDB classes, select Admin > Modeling > CIT Manager, 
select the CI type, and click the Details tab. Use it_world to 
represent the highest level of the Class model. 

➤ kpiType. It can be:

➤ The number of the KPI attached to the child CI specified 
in childCIClassName. The KPI number is listed in the KPI 
Repository (to access, select Admin > Dashboard > 
Repositories > KPIs).

➤ all which represents any KPI attached to the child CI 
specified in childCIClassName. This KPI and the rule 
specified in the task are propagated to the parent CI.

➤ parentCIClassName specifies the name of the CMDB class 
that corresponds to the parent CI of the child specified in 
childCIClassName. This CI is the target of the propagation.  
Use it_world to represent the highest level of the Class 
model. 

➤ propagate can be:

➤ explicit which tells the propagation mechanism that the 
KPI and the rule to be propagated are listed in the task

➤ sameKPI which tells the propagation mechanism that it 
should propagate the specified KPI (as defined in the 
Repository) attached to the specified CI to the parent CI. 
If you use sameKPI you must specify the globalRule 
attribute in the kpis_config element in the task.

Note: This element is mandatory. It can contain one or more 
property-condition elements.
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Propagation Definition – Task
The propagation task uses the following format:

<task-config>
<kpis-config>

<kpi-config type="type">
<rule type="rule_number"> 
<objective>

<objective>
<operator type="operator"/>
<threshold type="OK" value="value"/>
<threshold type="WARNING" value="value"/>
<threshold type="MINOR" value="value"/>
<threshold type="MAJOR" value="value"/>

</objective>
</kpi-config>

</kpis-config>
</task-config>
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The parameters used to define propagation tasks are as follows:

Element Description

task-config An element used to define the task.

kpis-config A collection of kpi-config elements.

Note: If you have used the propagate=sameKPI 
attribute in the condition, you must use the globalRule 
attribute in this element as follows:

➤ <kpis-config globalRule="default"/> to assign the 
default rule to the KPI. The default rule is the default 
group rule assigned to a KPI in the KPI Repository 
(to access, select Admin > Dashboard > Repositories 
> KPIs).

➤ <kpis-config globalRule="<rule_id>"/> to assign the 
specified rule to the KPI.

Note: The globalRule specification is overridden by the 
rules specified using the rule element. 

kpi-config An element used to define the KPI that is to be 
propagated to the specified parent CI. 

The element’s attribute is type, which represents the ID 
number of the KPI. 

For details on the KPI number, see “KPI Repository 
page” on page 537.

rule An element used to define the business rule that is to 
be propagated to the specified parent CI.

The element’s attribute is type, which represents the ID 
number of the rule. To access the rule number, select 
Admin > Dashboard > Repositories > Business Rules, 
the ID number for each rule is displayed in the ID 
column.

Note: The globalRule specification is overridden by the 
rules specified using the rule element. 
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Edit Group Page

objective Optional. A collection of objective definitions. 

Note:

➤ When the KPI propagation mechanism is activated, 
it adds the KPI threshold configuration to the parent 
CI, in the CMDB.

➤ If the objective element is not defined in the 
propagation, the default thresholds are used. For 
details, see “Default Thresholds” on page 426.

➤ If you use it, the objective element must include the 
following thresholds: OK, WARNING, MINOR, 
MAJOR 

Use the following format:

<objective>
<operator type="operator"/>
<threshold type="OK" value="value"/>
<threshold type="WARNING" value="value"/>
<threshold type="MINOR" value="value"/>
<threshold type="MAJOR" value="value"/>

</objective>

Description Enables you to edit an existing group.

To access: In the Assignment Groups page, select a 
group and click the Edit button .

Important 
Information

Depending on the KPI Assignment group you have 
selected, the Assignments area lists different 
assignments. 

Each factory KPI Assignment group has its own group 
of KPI assignments.

Included in Tasks “Manage KPI Assignment Groups” on page 442

Element Description



Chapter 16 • Working With KPI Assignments and Propagations in Dashboard

470

General Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Assignments Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Description The description of the group. The description is 
displayed in the Assignment Groups dialog box. 

Name The name of the group.

This field is mandatory.

Type The type can be:

➤ Factory for factory KPI Assignment groups.

➤ Custom for custom KPI Assignment groups.

GUI Element (A-Z) Description

Select a KPI assignment and click to start the 
assignment of the KPI assignment elements to existing 
CIs when they were stopped and to new CIs. The status 
of the KPI assignment is Running.

Select a KPI assignment and click to stop the 
assignment of the KPI Assignment elements to the 
appropriate CI. The status of the KPI assignment is 
then Stopped.

Click to create a KPI assignment in the Define 
Assignment Configuration dialog box.

Note: This button is disabled for Factory KPI 
assignments.

Select a KPI assignment and click to edit the KPI 
Assignment in the Define Assignment Configuration 
dialog box.
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Select a KPI assignment and click to delete.

Note: This button is disabled for Factory KPI 
assignments.

Select a KPI assignment and click to synchronize the 
selected KPI assignment.

Click to refresh the list of KPI assignments after you 
have added or deleted KPI assignments, or after you 
have modifies KPI assignment names.

Click to enable you to adjust the width of the table's 
columns by dragging the borders of the column to the 
right or the left, or to reset the table columns' width to 
its default setting.

Description The description of the KPI assignment

Name The name of the KPI assignment.

Status The status: 

➤ Running. The KPI assignment has been started and is 
running on the appropriate CIs. 

➤ Stopped. The KPI assignment has been stopped and 
is not running.

GUI Element (A-Z) Description
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17
Repositories Overview

This chapter provides general information on the repositories.

This chapter includes:

Concepts

 ➤  Repositories – Overview on page 476

 ➤  Customizing Repository Elements on page 477

Tasks

 ➤  Customize a Repository Element on page 478

 ➤  Create a KPI, Rule, and Tooltip – Example on page 479

 ➤  Define Repository Elements and KPI Assignments to Monitor Mobile 
Terminals – Scenario on page 484

 ➤  Create a Dynamic URL – Scenario on page 495

 ➤  Customize Dashboard Repository Entities to Model Your Business World – 
Scenario on page 505

Concepts
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Repositories – Overview

HP Business Availability Center repositories provide definitions for objects 
in the HP Business Availability Center system. Many of these definitions can 
be customized as required by your organization.

The Repository page provides a convenient user interface for viewing and 
customizing the definitions contained in the repository XML definition 
files. These files define the templates that are used throughout HP Business 
Availability Center to determine how source data is imported and handled, 
and to determine appearance and functionality for the CIs in the 
presentation layer.

Repositories
The Repository page enables you to access the following repositories:

➤ KPIs. Provides definitions for the Key Performance Indicators (KPIs) used in 
Dashboard. For details, see “KPI Repository Overview” on page 509.

➤ Rules. Provides definitions for the business rules used with the KPIs in 
Dashboard. For details, see “Business Rule Repository Overview” on 
page 556.

The Rules API can be used to create new rules; for details see “Rules API” on 
page 661.

➤ Context menus. Provides definitions for the Configuration Items (CIs) 
menus used in Dashboard. For details, see “Context Menu Repository 
Overview” on page 697.

➤ Context menu items. Provides definitions for the CI menu items that are 
used in the context menus. For details, see “Context Menu Item Repository 
Overview” on page 722.

➤ Tooltips. Provides definitions for the tooltips used to display CI information 
in Dashboard. For details, see “Tooltip Repository Overview” on page 816.

Permissions
To view the repositories you must have the Add permission for Sources 
permission. To set up the permissions, select Admin > Platform > Users and 
Permissions > Permissions Management. 
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Advanced Users
Advanced users can modify existing repository objects and create new ones. 
This may be necessary when you want to customize the way information is 
presented in Dashboard to fit the needs of your organization; or when you 
need to create new objects when integrating data from a new external 
system into Dashboard.

Dashboard and Service Level Management Repositories
Dashboard and Service Level Management use two separate, independent 
sets of repositories. Dashboard has repositories for KPIs, rules, context 
menus, context menu items, and tooltips. Service Level Management has 
repositories for KPIs and rules. These repositories contain different KPIs and 
rules; changing KPIs or rules in Dashboard has no effect on Service Level 
Management (and vice versa).

For details on the Service Level Management repositories, see “KPI 
Repository” and “Business Rule Repository” in Using Service Level 
Management.

Customizing Repository Elements

Within the Repository page, preconfigured repository elements are labeled 
Factory elements (for example Factory KPIs), and modified elements are 
labeled Custom elements.

There are three ways to customize elements in the Repository page:

➤ New Item. Creates a new repository element that is not based on an existing 
element. You customize the new element to fit your needs. 

Note that tooltips can only be modified; you cannot create a new tooltip.

➤ Clone. Creates a new repository element by cloning an existing factory or 
custom element. The original element is still available, and the new cloned 
element can be modified. The cloned element is automatically assigned a 
new ID number.
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➤ Override. Overrides an existing factory element. The original element is 
labeled overridden (disabled) in the Factory area, and an editable copy 
appears in the Custom area. Both the custom element and the original 
element have the same ID number. If you delete the custom element, the 
original factory element is automatically restored.

Note: HP Professional Services offers best practice consulting; it is 
recommended that you use this service before making any changes to the 
repositories. For information on how to obtain this service, contact your HP 
Software Support representative.

Tasks

Customize a Repository Element

This task provides general instructions for creating and editing a repository 
element. For scenarios illustrating how to customize specific types of 
elements, see:

➤ KPIs, Business Rules, and Tooltips. “Create a KPI, Rule, and Tooltip – 
Example” on page 479.

➤ Context Menu Items and Context Menus. “Create a Dynamic URL – 
Scenario” on page 495.

Important: Changes made to the repositories may adversely affect 
functionality. Only administrators with advanced knowledge of Dashboard 
should perform changes. 
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To customize a repository element:

 1 Open the Admin > Dashboard > Repository page and select a repository (for 
example KPIs).

 2 Select an element from the Factory area and click Clone. (You can also create 
or override elements, as described in “Customizing Repository Elements” on 
page 477.)

 3 Click the Edit button corresponding to the cloned element in the Custom 
area, and change its values as required.

 4 Click OK to save the changes.

Create a KPI, Rule, and Tooltip – Example

This example shows how to create a KPI with corresponding rule and 
tooltip.

This task includes the following steps:

➤ “Create a KPI” on page 479

➤ “Create a Rule” on page 480

➤ “Attach the New Rule to the New KPI” on page 482

➤ “Edit the Tooltip” on page 483

 1 Create a KPI
Create a clone of the OT Impact KPI.

 a Select Admin > Dashboard > Repositories > KPIs to open the KPIs page.

 b In the Factory KPIs area, select the OT Impact KPI you want to clone.
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 c Click the Clone button. The cloned KPI appears in the Custom KPIs area.

 d Click the Edit Entity button  to open the KPI Details dialog box. For 
details, see “KPI Details Dialog Box” on page 539.

 e Change the name of the KPI to RUM OT Impact, and click OK.

The result is as follows:

 2 Create a Rule
Create a new rule: RUM Impact Over Time. This is a clone of the Impact 
Over Time rule, and uses different criteria to calculate the financial loss of 
downtime.

 a Select Admin > Dashboard > Repositories > Business Rules tab menu 
option to open the Business Rules page.



Chapter 17 • Repositories Overview

481

 b In the Factory Business Rules area, select the Impact Over Time Rule that 
you want to clone.

 c Click the Clone button.

 d The cloned rule appears in the Custom Business Rules area.

 e Click the appropriate Edit Entity button  to open the Rule Details dialog 
box.

 f In the Display Name box, change the name of the rule to RUM Impact 
Over Time.

 g In the Description box, add - for RUM at the end of the description to 
indicate that the rule is for Real User Monitor.

 h In the Rule Parameters area, click the Edit button  of the 
DollarImpactFactor parameter to open the Parameter Details dialog box.
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 i Change 600 to 1000 in Default Value box.

 j Click OK to save the changes to the parameter.

 k Click OK to save the changes to the rule.

The result is as follows:

 3 Attach the New Rule to the New KPI

You must attach the new rule to the new KPI.

 a Select Admin > Dashboard > Repositories > KPIs to open the KPIs page.

 b In the Custom KPIs area, select the RUM OT Impact KPI.

 c Click the appropriate Edit Entity button  to open the KPI Details dialog 
box. For details, see “KPI Details Dialog Box” on page 539.
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 d In the Applicable Rules list, scroll down to the RUM Impact Over Time 
Rule and select the rule. Make sure that you press the CTRL button when 
you select the rules. If you do not press the CTRL button, all of the 
preselected rules are disabled when you click the rule you want to add to 
the applicable rules.

 e Click OK to save the change.

 4 Edit the Tooltip
A new tooltip was created when you created the RUM Impact Over Time 
rule. Change the tooltip description to match the rule’s description.

 a Select Admin > Dashboard > Repositories > Tooltips to open the Tooltips 
page. The Custom Tooltips area displays the tooltip that corresponds to 
the new rule you created:

 b Click the Edit Entity button  corresponding to tooltip 2000 to open the 
Tooltip Details dialog box.

 c In the Description box, add - for RUM at the end of the tooltip name.
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The result is as follows:

Define Repository Elements and KPI Assignments to 
Monitor Mobile Terminals – Scenario

A hospital uses Mobile Terminals (MTs) to view and update patient records. 
Each MT includes a terminal and a battery mounted on a cart, which is 
moved between rooms. When the batteries run out of power, the MTs are 
often pushed into a corner rather than recharged, and the hospital is unable 
to track which MTs are offline.

To track offline MTs, SiteScope Service monitors are configured to monitor 
the Windows Server Service; if it is not available (if u_iQuality = 3) the MT is 
offline. A View is created in Modeling Studio to represent the hospital, the 
floors, the MTs on each floor, and the SiteScope Service monitors which 
indicate if an MT is offline.
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This scenario describes how Jane, the Dashboard administrator, works with 
the Dashboard repositories and the KPI Assignment mechanism to display 
the following information in Dashboard: which MTs are offline, how many 
are offline on each floor and in the entire hospital, and what percentage are 
offline on each floor and in the entire hospital.

This scenario includes the following steps:

➤ “Clone and Edit the System KPI” on page 485

➤ “Clone and Edit the Generic Formula Rule to Identify Offline MTs” on 
page 486

➤ “Clone and Edit the Sum of Values Rule to Count the Offline MTs” on 
page 487

➤ “Modify the Tooltip to Correspond to the New Rule” on page 487

➤ “Attach the Two New Rules to the New KPI” on page 489

➤ “Assign KPI and Rule to the SiteScope Monitor CIs” on page 490

➤ “Propagate KPIs and Rules to the MT, Floor, and Hospital CIs” on page 492

 1 Clone and Edit the System KPI
By default, the System KPI uses the Percentage business rule. This KPI will be 
used for the floor level CIs, to indicate what percentage of MTs are offline. 
Using the Dashboard KPI Repository, Jane creates another KPI to count the 
number of offline MTs per floor.
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Jane clones the System KPI, and opens the Custom KPI for editing. She 
renames the KPI to Offline MTs, changes its Type to TEXT, and its Formatting 
Method to getIntValue, to display a number rather than status icon.

 2 Clone and Edit the Generic Formula Rule to Identify Offline MTs
Within the sample fields collected from the MTs, if the value of the 
u_iQuality field is 1, the MT is online; if u_iQuality = 3 the MT is offline.

Jane uses the Generic Formula rule to change the value of this field to 1 or 0 
depending on the MT’s online or offline status. This enable the floor level 
CIs to sum the 1s and 0s, and count how many MTs are offline.

Within the Dashboard Business Rule Repository, Jane clones the Generic 
Formula rule, and opens the Custom rule for editing. She changes the name 
of the rule to Indicate Offline MTs and adds a rule description. She defines 
the Rule Type as Monitor, and selects Status and Value for the rule’s Relevant 
result type.
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Within the Rule Parameters area, Jane edits the Formula parameter. She sets 
the formula Type as String, and defines the formula’s Default Value as 
if(u_iQuality,=,3,1,0). This means that if the value of u_iQuality is equal to 3 
(offline), its value is set to 1; otherwise it is set to 0.

 3 Clone and Edit the Sum of Values Rule to Count the Offline MTs
Within the Business Rule Repository, Jane clones and edits the Sum of 
Values rule to sum the values (1s and 0s) of the MTs on each floor, to count 
how many are offline. She changes the name of the cloned rule to Count 
Offline MTs and adds a rule description. By default, the Sum of Values rule 
calculates a sum of child CI values in dollars. Jane removes the dollar sign 
($) from the Units text box.

 4 Modify the Tooltip to Correspond to the New Rule
When Jane cloned the Sum of Values rule a new tooltip was automatically 
created, but its units are in dollars. Jane edits the new tooltip to correspond 
to the new rule.
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Within the Tooltips Repository, Jane opens the tooltip Summary of values 
for kpi in the Custom Tooltips area. She changes the name of the cloned 
tooltip to Count Offline MTs. In the Parameters section, she edits the Total 
parameter, removing the dollar sign ($) in its Value Prefix field. 
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 5 Attach the Two New Rules to the New KPI
Jane now attaches the new rules to the new KPI. Within the KPI Repository, 
she opens the Offline MTs KPI for editing. In the Applicable Rules list, she 
selects both Count Offline MTs and Indicate Offline MTs, while pressing the 
CTRL button. (If she does not press the CTRL button, all of the preselected 
rules are disabled when she selects the new rules.)
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 6 Assign KPI and Rule to the SiteScope Monitor CIs
The SiteScope monitors which monitor MT availability use the naming 
convention MT Monitor <number>. Based on this naming convention, Jane 
uses the Dashboard KPI Assignments tab to define the assignment of the 
Offline MTs KPI and the Indicate Offline MTs rule to these SiteScope 
monitor CIs.

For details about the assignment mechanism, see “Assignments” on 
page 421.

 a Jane is using an assignment from the default SiteScope assignment group 
as the basis of her new assignment. From the SiteScope assignment 
group, she opens the SiteScope Monitors assignment for editing. She 
copies the text from its Task box into a text editor.

 b Jane creates a new Assignment Group called Hospital KPI Enrichments 
Group.

 c She adds an assignment to this group named Hospital KPI Enrichment, 
and types the following in its Condition box (filtering according to the 
naming convention MT Monitor <number>):

<condition cmdb_class="sitescope_monitor">
<property-condition name="data_name" operator="LIKE" value="MT Monitor%"/>

</condition> 
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 d She then opens the Hospital KPI Enrichment assignment. In its Task box, 
she enters the text that she copied from the SiteScope Monitors 
assignment. 

She replaces the text <kpi-config type="1"> and <rule type="4"/> with 
<kpi-config type="2000"> and <rule type="2000"/>, using the IDs of the 
Offline MTs KPI (2000) and the Indicate Offline MTs rule (2000).
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 7 Propagate KPIs and Rules to the MT, Floor, and Hospital CIs
Jane now uses the Dashboard KPI Assignments tab to define propagation of 
the Offline MTs KPI and the Count Offline MTs rule to the MT, Floor, and 
Hospital CIs. 

She also defines the propagation of the System KPI with Percentage rule to 
the Floor and Hospital CIs.

For details about the propagation mechanism, see “Propagations” on 
page 423.

 a Within the Hospital KPI Enrichments Group, Jane adds a propagation 
named Count Offline MTs Propagation. This propagation attaches the 
Offline MTs KPI (2000) and the Count Offline MTs rule (2001) to the MT 
CIs. 

The condition for this propagation is that the parent CI type is 
logical_group (which includes the MT CIs), and the child CI is a 
SiteScope monitor assigned the Offline MTs KPI (2000).

She types the following in the propagation’s Condition box:

In the Task box, she types the following:

 b She then adds another propagation named Count Offline MTs and 
Percentage Propagation. This propagation attaches the Offline MTs KPI 
(2000) and the Count Offline MTs rule (2001) to the Floor and Hospital 
CIs. It also attaches the System KPI and Percentage rule to the Floor and 
Hospital CIs.

The condition for this propagation is that the parent CI type is 
logical_group (which includes the Floor and Hospital CIs), and the child 
CI type is logical_group assigned the Offline MTs KPI (2000).

<condition childCIClassName="sitescope_monitor" kpiType="2000"
parentCIClassName="logical_group" propagate="sameKpi"/> 

<task-config>
<kpis-config globalRule="2001"/>

</task-config> 
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She types the following in the propagation’s Condition box:

In the Task box, she types the following:

 c Jane clicks the Start Assignment and the Synchronize Assignment 
buttons to activate the assignment. 

Dashboard now displays the following:

➤ Each of the SiteScope monitors indicating if an MT is offline is assigned 
the Offline MTs KPI with Indicate Offline MTs rule.

➤ Each of the MT CIs is assigned the Offline MTs KPI with Count Offline 
MTs rule.

<condition childCIClassName="logical_group" kpiType="2000"
parentCIClassName="logical_group" propagate="explicit"/> 

<task-config>
<kpis-config>

 <kpi-config type="2000">
 <rule type="2001"/>

 </kpi-config>
<kpi-config type="1">

 <rule type="17"/>
</kpi-config>

</task-config> 
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➤ Each of the floor CIs is assigned the Offline MTs KPI with Count Offline 
MTs rule, and the System KPI with Percentage rule.

➤ The hospital CIs is assigned the Offline MTs KPI with Count Offline MTs 
rule, and the System KPI with Percentage rule.
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Create a Dynamic URL – Scenario

This scenario describes how to create a dynamic URL context menu item 
and add it to a context menu. 

You want to create new context menu options for CIs in Dashboard. These 
options launch the NNMi views from Dashboard.

The URLs have the following format: 

➤ showForm:
http://unv08nnm:8004/nnm/launch?cmd=showForm&objtype=Node&nod
ename=unv08nnm&j_username=admin&j_password=admin. 

➤ showLayer2:
http://unv08nnm:8004/nnm/launch?cmd=showLayer2Neighbors&objtype
=Node&nodename=unv08nnm&j_username=admin&j_password=admin

➤ showLayer3:
http://unv08nnm:8004/nnm/launch?cmd=showLayer3Neighbors&objtype
=Node&nodename=unv08nnmj_username=admin&j_password=admin

➤ showView:
http://unv08nnm:8004/nnm/launch?cmd=showView&objtype=Node&j_use
rname=admin&j_password=admin

Unv08nnm is the Network Node Manager 8i (NNM 8i) server in the Business 
Service Management (BSM) hosted solution.

The first part of the URL – before the question mark – is the static part of the 
dynamic URL used to create the context menu option and the second part 
of the URL consists of parameters used by the dynamic URL. Each parameter 
and its value is separated from the others by &.

To create the context menu item in the Dashboard Repositories, you can 
either add a completely new menu item, or clone an existing one that is 
similar to what you need and edit its properties. The new menu option 
(NNMi) is added to the context menus used for the NNMi CIs.

This task includes the following steps:

➤ “Create the Context Menu Item Group – Optional” on page 496

➤ “Create the Individual Context Menu Items” on page 496
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➤ “Add the Definition for Each Parameter of the URL” on page 498

➤ “Create the other URLs” on page 500

➤ “Add the Context Menu Items to the NNMi Context Menu Group” on 
page 500

➤ “Assign the NNMi Context Menu to the NNMi CIs” on page 502

➤ “Test the Context Menu” on page 503

 1 Create the Context Menu Item Group – Optional
You create a context menu item group (NNMi) which is like a regular 
context menu item. This step is optional; it is needed only to organize the 
different dynamic URL context menu items.

 a Select Admin > Dashboard > Repositories > Context Menu Items to open 
the Context Menu Items page.

 b In the Custom Context Menu area, click New Item to create a new 
context menu item. The Context Menu Item Details dialog box is 
displayed.

 c In Display Name, enter a name for the context menu you are creating, for 
example, NNMi.

 d Click OK.

 2 Create the Individual Context Menu Items
For each one of the URLs above, you create an individual context menu 
item. For example for the showForm URL:

 a Select Admin > Dashboard > Repositories > Context Menu Items to open 
the Context Menu Items page.

 b In the Custom Context Menu Items area, click New Item to create a new 
menu. The Context Menu Item Details dialog box is displayed.
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 c Enter the following information:

➤ Display Name. Enter a name for the context menu you are creating, for 
example, NNMi - showForm.

➤ Pre-processor Class. Select Dashboard Generic URL from the list.

➤ Post-processor Class. Select Open Window from the list.

When you select the Pre-processor Class and Post-processor Class 
options, the default parameters for each selection are automatically 
added in the Pre-processor Parameters and Post-processor Parameters 
areas.

 d Delete the Unnecessary Default Parameters

Delete the following default parameters: filter.selectedVTIds, 
filter.fromDashboard, autoGenerate, and reportID.
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 e Edit the URL parameter

Click the Edit button for the URL parameter and in the Pre-processor 
Parameter Details dialog box, enter the following information:

➤ Value. Enter the static part of the URL: 
http://unv08nnm:8004/nnm/launch.

➤ Convert to. Leave empty.

➤ Click OK.

Note: For static URLs you can enter the complete URL in the Value field.

 3 Add the Definition for Each Parameter of the URL
For each one of the URLs above, you add the definition for each parameter 
of the URL. For example, the showForm URL has the following parameters:

http://unv08nnm:8004/nnm/launch?cmd=showForm&objtype=Node&nod
ename=unv08nnm&j_username=admin&j_password=admin. 

You must define separately each parameter.

 a In the Context Menu Item Details dialog box click the New button. 
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 b In the Pre-processor Parameter Details dialog box, enter the information 
for each parameter as listed in the table below and click OK.

NODE.PROPS.display_label returns the name of the CI that you right-
click to use the NNMi context menu item. It searches for the CI (NODE) 
where the cursor is located, and then for the CI Property (PROPS) that 
corresponds to the CI name (data_name). The name of the CI that you 
right-click is then changed into the nodename parameter that is used by 
the URL to access the correct information.

You can also use:

➤ NODE.ID to return the CI ID Symbol in the view.

➤ NODE.CMDB.ID to return the CI CMDB ID.

➤ NODE.PROPS.data_name to return the CI name.

cmd=
showForm

objtype=
code

nodename=
unv08nnm

j_username=
admin

j_password=
admin

Key mycmd mysubc
md

mysubsubcm
d

username password

Value showForm Node NODE.PROPS
.display_label

admin admin

Convert 
to

cmd objtype nodename j_username j_password
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 c In the Post-processor Parameters area:

➤ Click the Edit button for WIN_NAME to open the Post-processor 
Parameter Details dialog box. In the Value box, enter a name for the 
window opened by the menu item, for example, NNMi. Click OK.

➤ Click the Edit button for SLAVE_WIN to open the Post-processor 
Parameter Details dialog box. Make sure that the value of the 
SLAVE_WIN parameter is 0 to open a new window. Click OK.

 d Click OK to close the Context Menu Item Details dialog box. The new 
context menu item is displayed in the Custom Context Menu Items area 
of the Repositories Context Menu Items page.

 4 Create the other URLs
In the same way as explained in “Create the Individual Context Menu 
Items” on page 496 and “Add the Definition for Each Parameter of the URL” 
on page 498, create the context menu items for each URL.

Note: showView menu item does not need a mysubsubcmd parameter. 

You can create the additional context menu items by cloning the NNMi - 
showForm menu item and editing the Key and Value fields where necessary.

 5 Add the Context Menu Items to the NNMi Context Menu Group
Create a context menu and add the context menu items you created in the 
previous steps.
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 a Create the context menu.

➤ Select Admin > Dashboard > Repositories > Context Menu to open the 
Context Menu page.

➤ In the Custom Context Menu area, click New Item to create a new 
menu. The Context Menu Details dialog box is displayed.

➤ In Display Name, enter a name for the context menu you are creating, 
for example, NNMi.

➤ Click New to attach a context menu item.
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 b In the Menu Entity Details dialog box:

➤ Context Menu Item. Select NNMi.

➤ Sub-context Menu Item. Select NNMi - showForm, NNMi - showLayer2, 
NNMi - showLayer3, and NNMi - showView.

➤ Click OK.

 6 Assign the NNMi Context Menu to the NNMi CIs
In the relevant view, select the relevant CI and assign the context menu to 
the CI.

 a Select Admin > Dashboard > KPIs

 b Select the appropriate view to assign the Context Menu Item to the 
view’s CIs; for example, select the HP OVO view.

 c Click the NNMi CI in View Explorer and click Edit in the Context Menus 
area of the KPIs page.

 d In the Context Menus List Editor dialog box, move NNMi from the 
Available Context Menus area to the Active Context Menus area.

 e Click OK. The NNMi context menu is displayed in the Context Menus 
area of the KPIs page. 
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 7 Test the Context Menu
When you right-click the NNMi CI in the HP OVO view, the display name of 
the CI is passed to the URL you select. 

Check that the context menu and context menu items are displayed for the 
appropriate CI in the relevant view and that they open the correct URL.

 a Select Applications > Dashboard.

 b Right-click NNMi in the HP OVO view in View Explorer, and click the 
Console tab. The following menu appears:
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The URL shows all the neighbors of the selected CI in the NNM map.
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Customize Dashboard Repository Entities to Model Your 
Business World – Scenario

The flowchart below describes a sample scenario for a company that wishes 
to customize repository entities so that unique terminology and elements of 
the business can be seen in Dashboard. The numbered elements are 
referenced in task steps. 

This task includes the following steps:

➤ “Prepare Customization Requirements” on page 506

➤ “Create Custom CIT to Represent Unique Business Entity” on page 507

➤ “Create a Customized Rule in the Business Rule Repository” on page 507

➤ “Create a Customized Tooltip in the Tooltip Repository” on page 507

➤ “Create a Customized KPI in the KPI Repository” on page 507

➤ “Create a Customized Context Menu Item” on page 507

➤ “Create a Customized Context Menu” on page 508

➤ “Create Views Using Custom CIT and Attach Monitors” on page 508

➤ “Assign the Custom Context Menu to CIs Created Using the Custom CIT” 
on page 508

➤ “Assign the Custom KPI to CIs Created Using the Custom CIT” on page 508
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 1 Prepare Customization Requirements
A cruise ship company wishes to define the following unique business 
elements to see in Dashboard: a logical CI called Cruise Ship to add to views; 
a custom KPI to monitor the dollar impact of down time of monitored ship 
systems; a customized context menu for Cruise Ship CIs that includes a URL 
link to its fleet intranet site.
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 2 Create Custom CIT to Represent Unique Business Entity
In CI Type Manager, the company’s HP Business Availability Center 
administrator adds a new logical CI type called Cruise Ship to the Business 
folder. In the Attributes page, the administrator adds a new editable 
attribute, ship_serial_number, and marks the data_name attribute as the key 
attribute (since it serves as a unique identifier for each ship).

 3 Create a Customized Rule in the Business Rule Repository
In the Business Rule Repository, the administrator creates a customized rule 
to handle the dollar impact of ship system non-availability by cloning the 
Impact Over Time Rule, renaming the cloned rule to Ship Impact Over Time 
Rule, and editing the DollarImpactFactor parameter to 1000 (to represent a 
dollar loss of $1,000 per hour).

 4 Create a Customized Tooltip in the Tooltip Repository
In the Tooltip Repository, the administrator edits the description of the new 
tooltip associated with newly created Ship Impact Over Time Rule that 
appears in the Custom Tooltips section to say: Dollar loss due to no 
availability on ship system.

 5 Create a Customized KPI in the KPI Repository
In the KPI Repository, the administrator creates a customized KPI to monitor 
the dollar impact of ship system non-availability by cloning the OT Impact 
KPI, renaming the cloned KPI to Ship OT Impact, and modifying the 
selected applicable rules—clearing Impact Over Time Rule and selecting Ship 
Impact Over Time Rule.

 6 Create a Customized Context Menu Item
In the Context Menu Item Repository, the administrator clones the Go to 
Report item, renames the cloned item Go to Ship, selects the Dashboard 
generic URL pre-processor class, edits the value of the URL parameter to the 
desired URL address, and selects the Open window post-processor class.
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 7 Create a Customized Context Menu
In the Context Menu Repository, the administrator clones the Group Menu, 
renames the cloned item Ship Group Menu, and edits Ship Group Menu to 
add Go to Ship as a new item in the Go to Report menu item list.

 8 Create Views Using Custom CIT and Attach Monitors
In IT Universe Manager, the administrator creates a new perspective view 
called Cruise Ship Fleet, and adds a Cruise Ship CI for each ship in the fleet. 
The administrator attaches relevant SiteScope and Business Process Monitors 
that were previously configured to monitor ship systems.

 9 Assign the Custom Context Menu to CIs Created Using the 
Custom CIT
When adding Cruise Ship CIs to views, the administrator assigns the Ship 
Group Menu as the context menu for the CIs. The menu is then visible in 
Dashboard views.

 10 Assign the Custom KPI to CIs Created Using the Custom CIT
After creating views that include the Cruise Ship CIs, in the Dashboard 
Administration KPIs tab the administrator assigns the new KPI Ship OT 
Impact to the Cruise Ship CIs. This KPI is then visible in Dashboard views to 
users with appropriate permissions on the views.
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18
KPI Repository

This chapter provides information about the Dashboard KPI Repository.

This chapter includes:

Concepts

 ➤  KPI Repository Overview on page 509

Tasks

 ➤  Customize a KPI on page 510

Reference

 ➤  List of Dashboard KPIs on page 512

 ➤  KPI Repository User Interface on page 536
Concepts

KPI Repository Overview

The KPI Repository page displays the list of factory (predefined) and 
customized KPIs. Those KPIs are available throughout HP Business 
Availability Center to determine how source data is imported.

The Dashboard KPI Repository includes all of the KPIs that can be used in 
the Dashboard application. For details on the Dashboard KPIs, see “List of 
Dashboard KPIs” on page 512.

Each KPI is defined by an ID number in the adapter templates, and is 
assigned a default business rule (a business rule is built on business logic). 
For more information about KPIs, see “KPIs Page” on page 409.
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For details on creating or editing KPIs, see “KPI Repository page” on 
page 537.

Note: If you are using HP Operations Manager i with Business Availability 
Center, then the KPI Repository page contains OMi-related KPIs. For more 
information, see Using HP Operations Manager i.

Dependent KPIs

A KPI is dependent on another KPI when the rule that calculates the value of 
the first KPI uses the results of the second KPI’s rule. For example, if an 
Outage KPI and a Number of Outages KPI are attached to a specific CI, the 
value of the Number of Outages KPI depends on the values of the Outage 
KPI. The KPIs are calculated in a specific order.

Tasks

Customize a KPI

You customize a KPI by creating a new KPI, or by editing an existing KPI.

For a detailed scenario that includes creating KPIs, see “Create a KPI, Rule, 
and Tooltip – Example” and view the appropriate steps.

This task includes the following steps:

➤ “Create a Customized KPI” on page 511

➤ “Edit KPI Details” on page 511

➤ “Specify KPI Parameter Details” on page 511

➤ “Set a KPI and its Parameters Back to Default – Optional” on page 511
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 1 Create a Customized KPI
There are three ways to customize repository elements:

➤ New Item. Creates a new repository element that is not based on an existing 
element. You customize the new element to fit your needs. 

To create a new KPI, click New Item in the KPI Repository page.

➤ Clone. Creates a new repository element by cloning an existing factory or 
custom element. The original element is still available, and the new cloned 
element can be modified. 

To clone a KPI, select a factory KPI and click Clone in the KPI Repository 
page.

➤ Override. Overrides an existing factory element. The original element is 
labeled overridden (disabled) in the Factory area, and an editable copy 
appears in the Custom area. 

To override a KPI, select a factory KPI and click Override in the KPI 
Repository page.

For details, see “KPI Repository page” on page 537.

 2 Edit KPI Details
Click the Edit button corresponding to the custom KPI, and change its 
values as required. For details on the possible values, see “KPI Details Dialog 
Box” on page 539.

 3 Specify KPI Parameter Details
In the Parameter Details dialog box, modify existing information or enter 
new information about the predefined KPI parameters. For details on the 
possible values, see “Parameter Details Dialog Box (KPIs)” on page 552.

 4 Set a KPI and its Parameters Back to Default – Optional
If you want to restore KPI and parameter defaults, select Admin > Dashboard 
> Repositories > KPIs. In the Custom KPIs area, delete the copy of the KPI 
you want to return to default and click OK. The KPI and its parameters are 
returned to their defaults.

Reference
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List of Dashboard KPIs

This section provides information about the KPIs available in the KPI 
repository, and their associated rules.

For details on configuring the KPIs, see “KPI Repository User Interface” on 
page 536.

KPI (KPI #) Description and Associated Rules

Application

(1075)

Displays:

➤ The Diagnostics performance of the Diagnostics Probe and Probe Groups CIs, 
and of the Business Process Monitor (BPM) transactions that are monitored by 
Diagnostics. The status reflected by the Application KPI is defined for the 
Diagnostics Probe and Probe Group CIs by the Probe-related thresholds, 
including the server request threshold and the Probe metrics threshold, which 
you set in the HP Diagnostics application. For the BPM transactions that are 
monitored by Diagnostics, the Application KPI status is defined by the average 
latency of transaction thresholds. For details, see HP Diagnostics User’s Guide.

➤ The status of the Operations Manager application. For details, see 
“Understanding the Host, Host-Software Element, or Application-Host 
Integration Adapters” in Solutions and Integrations.

➤ The status of the application monitored by Netscout. For details, see “NetScout 
nGenius Integration” in Solutions and Integrations.

“Diagnostics for J2EE/.Net General” on page 602

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“SiteScope EMS Multiple Events Rule” on page 624

“Worst Child Rule” on page 641
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Availability 

(7)

Displays information relating to availability measurements for transactions.

“Average Availability of Weighted Volume” on page 582

“Average of Values” on page 583

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“Percentage Rule” on page 611

“RUM Application Session Statistics Monitor Availability Rule” on page 613

“RUM End User Monitor Availability Rule” on page 614

“RUM End User Session Statistics Monitor Availability Rule” on page 617

“RUM Location Session Statistics Monitor Availability Rule” on page 618

“RUM Page Monitor Availability Rule” on page 619

“RUM Session Monitor Availability Rule” on page 621

“RUM Transaction Monitor Availability Rule” on page 622

“Transaction Availability Rule” on page 629

“WS Operation Availability Rule” on page 641

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Backlog

(600)

Backlog KPI for Business Process Insight Data

Displays the backlog information of the Business Process from the HP Business 
Process Insight application. 

At the monitor level, the KPI displays:

➤ The number of instances of the BPI step that is monitored and is currently 
active if the rule associated with the KPI is the BPI Monitor Backlog Count 
rule. 

➤ The total cost of all the instances of the BPI step that is monitored and 
currently active in currency or data units if the rule associated with the KPI is 
the BPI Monitor Backlog Value rule (default). 

At the group level, the default value rule is the Worst Child rule. For details, see 
“Worst Child Rule” on page 641.

At the group level, if the KPI is attached to a Business Process CI, the value of the 
KPI is calculated only for the BPI Business Process Monitor CIs directly under the 
Business Process CI by the BPI Group Rule for BP CI rule. For details, see “BPI 
Group Rule for BP CI” on page 588.

At the group level, if the KPI is attached to a BPI Business Process Step CI, the 
value of the KPI is calculated only for the BPI Business Process Step Monitor CIs 
directly under the BPI Business Process Step CI by the BPI Group Rule for BP Step 
CI rule. For details, see “BPI Group Rule for BP Step CI” on page 588.

“BPI Group Rule for BP CI” on page 588

“BPI Group Rule for BP Step CI” on page 588

“BPI Monitor Backlog Count Rule” on page 593

“BPI Monitor Backlog Value Rule” on page 594

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Backlog

(continued)

Backlog KPI for TransactionVision Data

Displays information on the number of backlogged (in-process) transactions on 
the target machine, as determined by TransactionVision. 

For details on TransactionVision data in Business Availability Center, see 
“TransactionVision Data” in Using TransactionVision.

Note: This KPI does not include predefined objectives, and so displays Info (blue) 
status in Dashboard, meaning that there is no status calculated for the KPI, until 
you define meaningful objectives for it.
You define objectives for the Backlog KPI attached to TV Monitor CIs in the 
Admin > Dashboard > KPIs tab.

“Business Transaction Group Rule” on page 600

“TransactionVision Backlog Rule (In-Process)” on page 634

“Worst Child Rule” on page 641

Bandwidth

(54)

Displays the amount of traffic (in megabytes) between application servers and 
end users accessing the servers (this includes traffic in both directions). This 
includes TCP, HTTP, and HTTPS traffic.

“Best Child Rule” on page 584

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“RUM Server Monitor Bandwidth Rule” on page 620

“RUM Servers Summarized Bandwidth Rule” on page 621

“Summary of Values” on page 629

“Worst Child Rule” on page 641

Business 
Health

(620)

Displays the worst status of the following KPIs monitored by HP Business Process 
Insight, for the process, and its children: Backlog, Duration, Business Impact, 
Value, and Volume. (This can be modified in Admin > Platform > Setup and 
Maintenance > Infrastructure Settings Manager > Applications > Business 
Process Insight > List of Business KPIs.)

The Business Health KPI provides a high-level indication of how the business 
process is currently performing; if the KPI indicates a problem, drill down into 
the process and its monitors to locate the underlying problematic KPI.

“BPI Business Health Status Rule” on page 587

KPI (KPI #) Description and Associated Rules
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Business 
Impact

(602)

Displays the health of the process monitored by the HP Business Process Insight 
application.

➤ At the monitor level, the default rule is BPI Health Average Weighted Status 
Value rule. For details, see “BPI Health Average Weighted Status Value Rule” on 
page 590.

➤ At the group level, the default rule is Worst Child rule. For details, see “Worst 
Child Rule” on page 641.

At the group level, if the KPI is attached to a Business Process CI, the value of the 
KPI is calculated only for the BPI Business Process Monitor CIs directly under the 
Business Process CI.

“BPI Health Average Weighted Status Count Rule” on page 589

“BPI Health Average Weighted Status Value Rule” on page 590

“BPI Health Group Rule for BP CIs” on page 591

“BPI Health Status Percentage Count Rule” on page 591

“BPI Health Status Percentage Value Rule” on page 592

“BPI Health Worst Process Instances Count Rule” on page 592

“BPI Health Worst Process Instances Value Rule” on page 593

“Worst Child Rule” on page 641

Component 
Availability

(53)

Displays information on pages without server errors, for servers monitored by the 
Real User Monitor. 

“Best Child Rule” on page 584

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“RUM Server Monitor Component Availability Rule” on page 620

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Customer

(2)

Displays information relating to customer service. Used for backward 
compatibility. This KPI can be associated with all CIs.

For example, for each one of your customers you can create a customized KPI that 
represents the specific transactions that are relevant to that customer.

“Best Child Rule” on page 584

“Customer Rule” on page 600

“Percentage Rule” on page 611

“Worst Child Rule” on page 641

Delays

(1313)

Displays information on the delayed (late) transactions on the target machine, as 
determined by TransactionVision. A transaction is defined as late when its 
response time exceeds a defined threshold in TransactionVision. For details on 
TransactionVision data in Business Availability Center, see “TransactionVision 
Data” in Using TransactionVision.

This KPI uses, by default, the TransactionVision Delayed Value Rule (In-Process 
Transactions) for TV Monitor CIs. To see data on completed transactions, or data 
based on the rate of delayed transactions, change the rule in the KPI assignment 
for the KPI. For details on KPI assignments, see “Working With KPI Assignments 
and Propagations in Dashboard” on page 419.

Note: This KPI does not include predefined objectives, and so displays Info (blue) 
status in Dashboard, meaning that there is no status calculated for the KPI, until 
you define meaningful objectives for it.
You define objectives for the Delays KPI attached to TV Monitor CIs in the Admin 
> Dashboard > KPIs tab.

“Business Transaction Group Rule” on page 600

“TransactionVision Delayed Rate Rule (Completed Transactions)” on page 634

“TransactionVision Delayed Value Rule (Completed Transactions)” on page 635

“TransactionVision Delayed Rate Rule (In-Process Transactions)” on page 634

“TransactionVision Delayed Value Rule (In-Process Transactions)” on page 635

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Duration

(601)

Duration KPI for Business Process Insight Data

Displays different information depending on the rule associated with the 
Duration KPI.

A tooltip indicates which metric is involved.

At the group level, the Worst Child rule is used to calculate the status of the 
parent CI from the child CIs. 

“BPI Average Weighted Status Rule for Duration KPI” on page 585

“BPI Duration Monitor Rule” on page 587

“BPI Status Percentage Rule for Duration KPI” on page 596

“BPI Worst Violated Instances Rule for Duration KPI” on page 598

“Worst Child Rule” on page 641

Duration KPI for TransactionVision Data

Displays information on the amount of time taken to complete the transactions 
on the target machine, as determined by TransactionVision. The objective for OK 
status for this KPI is taken from the SLA threshold set in TransactionVision. The 
KPI is calculated only for completed transactions.

For details on TransactionVision data in Business Availability Center, see 
“TransactionVision Data” in Using TransactionVision.

Note: This KPI must be manually assigned to TransactionVision CIs.

“Business Transaction Group Rule” on page 600

“TransactionVision Duration Rule (Completed Transactions)” on page 636

“Worst Child Rule” on page 641

Efficacy

(630)

The Efficacy KPI is a custom KPI for measuring the efficiency and capacity of a 
business process. This KPI is not associated with a default business rule, but can 
be used together with an API rule. For more details, see “Rules API” on page 661.

KPI (KPI #) Description and Associated Rules
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Exceptions

(1310)

Displays information on transactions that did not follow the expected flow path 
on the target machine, and are therefore classified as exceptions in 
TransactionVision. For details on TransactionVision data in Business Availability 
Center, see “TransactionVision Data” in Using TransactionVision.

This KPI uses, by default, the TransactionVision Exceptions Value Rule (In-Process 
Transactions) for TV Monitor CIs. To see data on completed transactions, or data 
based on the rate of exceptions, change the rule in the KPI assignment for the 
KPI. For details on KPI assignments, see “Working With KPI Assignments and 
Propagations in Dashboard” on page 419.

Note: This KPI does not include predefined objectives, and so displays Info (blue) 
status in Dashboard, meaning that there is no status calculated for the KPI, until 
you define meaningful objectives for it.
You define objectives for the Exceptions KPI attached to TV Monitor CIs in the 
Admin > Dashboard > KPIs tab.

“Business Transaction Group Rule” on page 600

“TransactionVision Exceptions Rate Rule (Completed Transactions)” on page 636

“TransactionVision Exceptions Value Rule (Completed Transactions)” on 
page 637

“TransactionVision Exceptions Rate Rule (In-Process Transactions)” on page 637

“TransactionVision Exceptions Value Rule (In-Process Transactions)” on page 638

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Failures

(1312)

Displays information on the failed transactions on the target machine, as 
determined by TransactionVision. A transaction is classified as "failed" when it 
does not match the attribute or pattern defined as failure in TransactionVision. 
For details on TransactionVision data in Business Availability Center, see 
“TransactionVision Data” in Using TransactionVision.

This KPI uses, by default, the TransactionVision Failures Value Rule (In-Process 
Transactions) for TV Monitor CIs. To see data on completed transactions, or data 
based on the rate of failed transactions, change the rule in the KPI assignment for 
the KPI. For details on KPI assignments, see “Working With KPI Assignments and 
Propagations in Dashboard” on page 419.

Note: This KPI does not include predefined objectives, and so displays Info (blue) 
status in Dashboard, meaning that there is no status calculated for the KPI, until 
you define meaningful objectives for it.
You define objectives for the Failures KPI attached to TV Monitor CIs in the 
Admin > Dashboard > KPIs tab.

“Business Transaction Group Rule” on page 600

“TransactionVision Failures Rate Rule (Completed Transactions)” on page 638

“TransactionVision Failures Value Rule (Completed Transactions)” on page 639

“TransactionVision Failures Rate Rule (In-Process Transactions)” on page 639

“TransactionVision Failures Value Rule (In-Process Transactions)” on page 640

“Worst Child Rule” on page 641

Generic

(1500)

Displays information calculated by the Generic Formula rule or by the Summary 
of Values rule. 

“Generic Formula Rule” on page 604

“Summary of Values” on page 629

KPI (KPI #) Description and Associated Rules
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HP System

(12)

Displays information relating to service levels for HP OpenView Service Navigator 
metrics. 

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“HP OpenView Service Navigator Rule” on page 607

“HP Worst Child Rule” on page 607

“Percentage Rule” on page 611

“SiteScope Measurement Rule” on page 624

“SiteScope Measurement Time-Based Rule” on page 625

“SiteScope Monitor Rule” on page 626

“SiteScope Monitor Time-Based Rule” on page 626

“Worst Child Rule” on page 641

Latency

(1077)

Displays the average round-trip time for packets, between the end users and the 
servers monitored by the Real User Monitor.

“Average Latency of Weighted Volume” on page 582

“Best Child Rule” on page 584

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“RUM End User Monitor Latency Rule” on page 615

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Locations

(303)

The Locations KPI is a bar that includes up to six colored sections. Each colored 
section represents:

➤ At the group level, the relative amount of Business Process Steps with the 
worst status of all of the children CIs, that corresponds to the color, at that 
location. The Business Process Monitor is the source of the data.

➤ At the monitor level, the relative amount of Business Process Steps with the 
end-user experience status (the worst status between Performance and 
Availability) that corresponds to the color, at that location. The colors 
correspond to the Business Process Monitor Performance/Availability colors.

This KPI is used by the HP Business Availability Center for SAP and for Siebel 
solutions. 

Example: If there are ten SAP Business Process Steps under the Locations 
container, five with Informational end-user experience, two with Minor status, 
two with Critical status, and one with No Data status, the bar displays: 50% 
green, 20% yellow, 20% red, and 10% gray.

The KPI’s tooltip displays a list of locations, their status, and the total number of 
locations. The tooltip’s color represents the worst location status.

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Locations Grouped Parent Rule” on page 609

“Locations Grouped Rule” on page 610

“Percentage Rule” on page 611

“Transaction Availability Rule” on page 629

“Transaction Performance Rule” on page 630

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Network

(308)

Displays:

➤ The status of the network monitored by the Real User Monitor.

➤ The status of the network in the Operations Manager application. This is an 
optional KPI. It is displayed when you select Create Network and Security KPIs 
in the HP Operations Manager integration definition. For details, see 
“Understanding the Host, Host-Software Element, or Application-Host 
Integration Adapters” in Solutions and Integrations.

➤ The status of the router or switch monitored by Netscout. For details, see 
“NetScout nGenius Integration” in Solutions and Integrations.

“Average Network of Weighted Volume” on page 582

“RUM End User Monitor Network Rule” on page 615

“RUM Server Monitor Network Rule” on page 621

“SiteScope EMS Multiple Events Rule” on page 624

“Worst Child Rule” on page 641

Number of 
Open 
Incidents

(2600)

Displays the number of incidents that exist in HP Service Manager, and that 
currently have the initial status and final status defined in the rule parameter and 
are associated with the business service. Tickets can have any status between 
Initial Status and Final Status as long as they had the initial status after the 
integration and that they are not currently closed.

For details on the integration with HP Service Manager, see “HP Service Manager 
Integration with Business Availability Center Components” in Solutions and 
Integrations.

“Number of Open Incidents” on page 611

“Sum of Open Incidents” on page 628

KPI (KPI #) Description and Associated Rules
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Operational 
Status

(615)

Displays the worst status of all operational (non-business) KPIs monitored by 
Business Process Insight, for the process, and its children. 

(The business KPIs include Backlog, Duration, Business Impact, Value, and 
Volume. This can be modified in Admin > Platform > Setup and Maintenance > 
Infrastructure Settings Manager > Applications > Business Process Insight > List 
of Business KPIs. Their worst status is displayed in the Business Health KPI.)

The Operational Status KPI provides a high-level indication of how the 
operational (non-business) KPIs are currently performing; if the KPI indicates a 
problem, drill down into the process steps and any linked system CIs to locate 
the underlying problematic KPI.

“BPI Operational Status Rule” on page 595

OT Impact

(13)

Displays information relating to the financial loss caused to the organization 
when an item is unavailable over time. By default, the calculation is based on the 
Availability KPI. 

At the monitor/leaf level, you should attach the Impact Over Time rule to the OT 
Impact KPI and the Availability KPI to the same CI. The Impact Over Time rule 
measures the total time the Availability KPI attached to the same CI has the red 
status, and then calculates the financial loss using the rule parameter: 
DollarImpactFactor. This parameter represents the amount of dollars lost in an 
hour if the system is unavailable.At the group level, you should attach the Sum of 
Values rule to the OT impact KPI. The Sum of Values rule calculates the sum of all 
of the values of the OverTime Impact KPI of its children.The OT Impact rule 
calculates financial loss as you add the OT Impact KPI. The calculation has no 
time limitation. 

To restart the calculation you can:

➤ change the rule’s objectives 

➤ delete the OT Impact KPI and add it again

Restarting HP Business Availability Center might restart the financial loss 
calculation, but because of dashboard calculation persistency, the last known 
financial value might be recovered instead.

“Impact Over Time Rule” on page 608

“Sum of Values Rule” on page 629

KPI (KPI #) Description and Associated Rules
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Performance

(6)

Displays information related to performance measurements of transactions.

“Average Performance of Weighted Volume in %” on page 583

“Average Performance of Weighted Volume in Seconds” on page 583

“Average of Converted Performance Results in %” on page 583

“Best Child Rule” on page 584

“BPM WS Operation Percentile Performance Rule” on page 599

“BPM WS Operation Performance Rule” on page 600

“Business Transaction Group Rule” on page 600

“Diagnostics WS Operation Percentile Performance Rule” on page 602

“Diagnostics WS Operation Performance Rule” on page 603

“EMS Simple Rule” on page 604

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

Performance 
(Continued)

“Percentage Rule” on page 611

“RUM Application Session Statistics Monitor Performance Rule” on page 613

“RUM End User Monitor Performance Rule” on page 616

“RUM End User Session Statistics Monitor Performance Rule” on page 617

“RUM Location Session Statistics Monitor Performance Rule” on page 619

“RUM Page Monitor Performance Rule” on page 620

“RUM Session Monitor Performance Rule” on page 621

“RUM Transaction Monitor Performance Rule” on page 622

“SiteScope WS Operation Percentile Performance Rule” on page 627

“SiteScope WS Operation Performance Rule” on page 628

“Transaction Performance Rule” on page 630

“Transaction Performance Status Average Rule” on page 630

“Transaction Performance Status Percentage Rule” on page 631

“Transaction Performance Worst Status Rule” on page 631

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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PNR 

(215)

Displays status based on the Point of No Return (PNR) for SLA samples (this data 
is calculated by the corresponding internal PNR rule for the Service Level 
Management application). The status is displayed in bar form in the Dashboard 
tab. The PNR samples measure unavailability in the period of time that has 
elapsed, and how much time remains before the SLA is in breach of contract. 
Note that there are two PNR rules: one is internal and gathers information from 
the Service Level Management application and the other one displays the 
information from the SLM PNR rule on the Dashboard.

“Dashboard PNR Rule” on page 601

RT Impact

(11)

Displays information relating to the financial loss caused to the organization in 
real time; the calculation is based on the Availability KPI. 

At the monitor/leaf level, you should attach the Real Time Impact rule to the RT 
impact KPI and the Availability KPI to the same CI. The Real Time Impact rule 
measures the time the Availability KPI attached to the same CI has the red status, 
and then calculates the financial loss using the rule parameter: 
DollarImpactFactor. This parameter represents the amount of dollars lost in an 
hour if the system is unavailable. If the Availability KPI status is not red, then the 
Real Time Impact value is 0.0$.At the group level, you should attach the Sum of 
Values rule to the RT Impact KPI. The Sum of Values rule calculates the sum of all 
of the values of the Real Time Impact KPI of its children.

When availability status returns to green, the value for this KPI reverts to 0.

“Real Time Impact” on page 612

“Sum of Values Rule” on page 629

KPI (KPI #) Description and Associated Rules
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SAP

(305)

Indicates problems related to the SAP infrastructure. The data that is reported by 
this KPI comes from CCMS measurements from SiteScope.

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Percentage Rule” on page 611

“SiteScope Measurement Rule” on page 624

“SiteScope Measurement Time-Based Rule” on page 625

“SiteScope Monitor Rule” on page 626

“SiteScope Monitor Time-Based Rule” on page 626

“SiteScope Vertical Rule” on page 627

“Worst Child Rule” on page 641

SAP Alert

(306)

SAP Alerts are created by the SAP system for various reasons; for example, an 
incorrect user login, exceeded CCMS thresholds, and so on.

SAP alerts are retrieved from the SAP system by the SiteScope CCMS Alerts 
monitor. They can be displayed in the Dashboard using a SAP Alert KPI whose 
color is determined by the SAP system. 

After you have handled the problem that triggered the alert, perform an alert 
completion procedure. This causes the alert to be acknowledged.

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“SAP Alerts Rule” on page 623

“SiteScope Measurement Rule” on page 624

“SiteScope Monitor Rule” on page 626

“Worst Child Rule” on page 641

Security

(307)

Displays the status of the security in the Operations Manager application. 

This is an optional KPI. It is displayed when you select Create Network and 
Security KPIs in the HP Operations Manager integration definition. For details, 
see “Understanding the Host, Host-Software Element, or Application-Host 
Integration Adapters” in Solutions and Integrations.

“SiteScope EMS Multiple Events Rule” on page 624

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules



Chapter 18 • KPI Repository

528

Sessions

(304)

Displays the number of sessions that are running in a Siebel application server. A 
session is a task that is in running mode and interactive. The value of the number 
of sessions come from a measurement that is provided by the SiteScope Siebel 
monitor. 

The resulting display is a number that is colored according to the objectives set 
for the rule. This KPI does not propagate up in the hierarchy.

For a Siebel CI, this KPI displays the sum of running sessions measurement on all 
underlying hosts (a session is a task that is in running mode and interactive 
state). The SiteScope Siebel monitor is the source of the data.

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Generic Sample Rule” on page 605

“Number of Running Sessions Rule” on page 611

“Number of Tasks in Error Rule” on page 611

“Percentage Rule” on page 611

“Sessions Custom Data Rule” on page 623

“SiteScope Measurement Rule” on page 624

“SiteScope Monitor Rule” on page 626

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Siebel

(300)

This KPI’s color is provided by Siebel-specific monitoring information. It 
separates Siebel problems from more general, infrastructure-related problems. It 
provides Siebel-specific data, such as number of tasks, processes, and so. The 
SiteScope Siebel monitor is the source of the data. 

This KPI propagates up to the Siebel Site CI.

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Generic Sample Rule” on page 605

“Percentage Rule” on page 611

“SiteScope Measurement Rule” on page 624

“SiteScope Monitor Rule” on page 626

“SiteScope Vertical Measurement” on page 627

“SiteScope Vertical Rule” on page 627

“Worst Child Rule” on page 641

SiteScope 
Availability

(1001)

A SiteScope Availability KPI is attached to each SiteScope Profile CI. It displays 
the availability of the SiteScope. SiteScope periodically (every minute) sends an 
out bit to HP Business Availability Center. If the out bit is received by HP Business 
Availability Center, the status of the SiteScope Availability KPI is green. If the out 
bit is not received, the status of the SiteScope Availability KPI is grey (No data). 
This indicates that there is no communication between SiteScope and 
HP Business Availability Center. The statuses of all the SiteScope CIs is also grey. 

“SiteScope Profile Rule” on page 626

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules



Chapter 18 • KPI Repository

530

System

(1)

Displays information relating to system performance for measurements or 
monitors.

For Siebel CIs, this KPI indicates physical problems with this CI or underlying 
CIs, provided by SiteScope physical monitors (for example: CPU monitor, disk 
space monitor, and so forth). SiteScope is the source of the data. 

For SAP CIs, this KPI indicates physical problems with underlying hosts, provided 
by SiteScope physical monitors (for example: CPU monitor, disk space monitor, 
and so on). By default, the System KPI does not appear in the view. If you are 
using a regular SiteScope monitor (which creates the System KPI) and you want 
to display the System KPI in the view, you have to add the System KPI manually 
to the CI.

It can also display the status of the Operations Manager application. For details, 
see “Understanding the Host, Host-Software Element, or Application-Host 
Integration Adapters” in Solutions and Integrations.

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“Percentage Rule” on page 611

“SiteScope EMS Multiple Events Rule” on page 624

“SiteScope Monitor Rule” on page 626

“SiteScope Monitor Time-Based Rule” on page 626

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Tasks in Error

(301)

Displays the number of tasks that are in error, provided by the SiteScope Number 
of Tasks in Error measurement. The source of the data is the Siebel monitor. This 
is a Siebel-specific KPI.

The resulting display is a number that is colored according to the objectives set 
for the rule. 

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Generic Sample Rule” on page 605

“Number of Tasks in Error Rule” on page 611

“Percentage Rule” on page 611

“SiteScope Measurement Rule” on page 624

“SiteScope Measurement with Custom Data Rule” on page 625

“SiteScope Monitor Rule” on page 626

“SiteScope Vertical Rule” on page 627

“Worst Child Rule” on page 641

Throughput 

(400)

For SOA. Displays the number of calls to the item per minute.

For Business Process Insight. Displays the number of calls to the item per minute.

“Best Child Rule” on page 584

“Diagnostics WS Operation Throughput Rule” on page 603

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“Percentage Rule” on page 611

“Summary of Values” on page 629

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Transactions

(302)

The Locations KPI is a bar that includes up to six colored sections. 

➤ At the group level, each colored section represents the relative amount of 
Business Process Steps with the worst status of all of the children CIs, that 
corresponds to the color. The Business Process Monitor is the source of the 
data.

➤ At the monitor level, each colored section represents the relative amount of 
Business Process Steps with the end-user experience status (the worst status 
between Performance and Availability) that corresponds to the color. The 
colors correspond to the Business Process Monitor Performance/Availability 
colors.

This KPI is used by the HP Business Availability Center for SAP and for Siebel 
solutions. 

Example: If there are ten SAP Business Process Steps under the Transactions 
container, five with Informational end-user experience, two with Minor status, 
two with Critical status, and one with No Data status, the bar displays: 50% 
green, 20% yellow, 20% red, and 10% gray.

The KPI’s tooltip displays a list of how many transactions have each status, and 
the total number of transactions. The tooltip’s color is set according to the worst 
transaction status.

KPI (KPI #) Description and Associated Rules
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Transactions 
(continued)

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Percentage Rule” on page 611

“Transaction Availability Rule” on page 629

“Transaction Performance Rule” on page 630

“Transactions Grouped Parent Rule” on page 632

“Transactions Grouped Rule” on page 633

“Worst Child Rule” on page 641

User 

(0)

Displays information related to the end-user performance. 

“Best Child Rule” on page 584

“EMS Simple Rule” on page 604

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“Percentage Rule” on page 611

“Transaction Availability Rule” on page 629

“Transaction Performance Rule” on page 630

“Worst Child Rule” on page 641

Value

(1311)

Value KPI for Business Process Insight Data

Displays different information depending on the rule associated with the Value 
KPI.

At the group level, the Worst Child rule is used to calculate the status of the 
parent CI from the child CIs. 

“BPI Average Weighted Status Rule for Value KPI” on page 586

“BPI Status Percentage Rule for Value KPI” on page 597

“BPI Value Monitor Rule” on page 598

“BPI Worst Violated Instances Rule for Value KPI” on page 598

KPI (KPI #) Description and Associated Rules



Chapter 18 • KPI Repository

534

Value

(continued)

Value KPI for TransactionVision Data

Displays information on the monetary value of the transactions on the target 
machine, as determined by TransactionVision. For details on TransactionVision 
data in Business Availability Center, see “TransactionVision Data” in Using 
TransactionVision.

This KPI uses, by default, the TransactionVision Value Rule (In-Process 
Transaction) for TV Monitor CIs. To see data on completed transactions, change 
the rule in the KPI assignment for the KPI. For details on KPI assignments, see 
“Working With KPI Assignments and Propagations in Dashboard” on page 419.

Note: This KPI does not include predefined objectives, and so displays Info (blue) 
status in Dashboard, meaning that there is no status calculated for the KPI, until 
you define meaningful objectives for it.
You define objectives for the Value KPI attached to TV Monitor CIs in the Admin 
> Dashboard > KPIs tab.

“Business Transaction Group Rule” on page 600

“TransactionVision Completed Transaction Value Rule” on page 640

“TransactionVision Value Rule (In-Process Transaction)” on page 640

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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Volume

(1050)

Volume KPI for Business Process Insight and Real User Monitor Data

Displays information on the total number of times that defined events or errors 
(monitored by the Real User Monitor) occurred.

Displays, in the Business Process Insight-related views:

➤ The number of instances of the BPI Step that are currently active, per hour if 
the rule associated with the KPI is BPI Monitor Volume Count rule.

➤ The cost or value, per hour, of the BPI Step that is currently active, if the rule 
associated with the KPI is BPI Monitor Volume Value rule (default). 

At the group level, if the KPI is attached to a Business Process CI, the value of the 
KPI is calculated, by the BPI Group Rule for BP CI rule, only for the BPI Business 
Process Monitor CIs directly under the Business Process CI. For details on the 
rule, see “BPI Group Rule for BP CI” on page 588.

At the group level, if the KPI is attached to a BPI Business Process Step CI, the 
value of the KPI is calculated, by the BPI Group Rule for BP Step CI rule, only for 
the BPI Business Process Step Monitor CIs directly under the BPI Business Process 
Step CI. For details on the rule, see “BPI Group Rule for BP Step CI” on page 588.

“Best Child Rule” on page 584

“BPI Group Rule for BP CI” on page 588

“BPI Group Rule for BP Step CI” on page 588

“BPI Monitor Volume Count Rule” on page 594

“BPI Monitor Volume Value Rule” on page 595

“Generic Sample Rule” on page 605

“Generic Sum of Values Over Time Rule” on page 605

“RUM End User Monitor Volume Rule” on page 616

“RUM Event Monitor Volume Rule” on page 618

“RUM Location Session Statistics Monitor Volume Rule” on page 619

“RUM Page Monitor Volume Rule” on page 620

“RUM Application Session Statistics Monitor Volume Rule” on page 614

“RUM Session Monitor Volume Rule” on page 622

“RUM Transaction Monitor Volume Rule” on page 622

“Sum of Volume Rule” on page 629

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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KPI Repository User Interface

This section describes:

 ➤  KPI Repository page on page 537

 ➤  KPI Details Dialog Box on page 539

 ➤  Parameter Details Dialog Box (KPIs) on page 552

Volume

(continued)

Volume KPI for TransactionVision Data

Displays information on the volume of completed transactions on the target 
machine, as determined by TransactionVision. For details on TransactionVision 
data in Business Availability Center, see “TransactionVision Data” in Using 
TransactionVision.

Note: This KPI does not include predefined objectives, and so displays Info (blue) 
status in Dashboard, meaning that there is no status calculated for the KPI, until 
you define meaningful objectives for it.
You define objectives for the Volume KPI attached to TV Monitor CIs in the 
Admin > Dashboard > KPIs tab.

“Business Transaction Group Rule” on page 600

“TransactionVision Transaction Volume Rule” on page 641

“Worst Child Rule” on page 641

KPI (KPI #) Description and Associated Rules
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KPI Repository page

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Displays the list of factory (predefined) and customized 
KPIs. Those KPIs are available throughout HP Business 
Availability Center to determine how source data is 
imported.

Enables an advanced user to modify existing repository 
KPIs and create new ones. 

To Access: Admin > Dashboard > Repositories > KPIs

Important 
Information

Cloning or overriding an existing KPI, or creating a 
new KPI, adds the corresponding KPI entry to the 
Custom KPIs list. You can then customize the KPI to 
your organization’s specifications. 

You can define a new KPI. For details, see “KPI Details 
Dialog Box” on page 539. 

You can modify existing detailed information or enter 
new information about the KPI parameters. For details, 
see “Parameter Details Dialog Box (KPIs)” on page 552.

A list of the KPIs, their descriptions, and the rules 
attached to the KPIs is available in “List of Dashboard 
KPIs” on page 512.

Included in Tasks “Customize a KPI” on page 510

GUI Element (A-Z) Description

Click to display help on the KPI.

Select a KPI in the Custom KPIs area, and click the 
button to open the KPI Details dialog box. For details, 
see “KPI Details Dialog Box” on page 539.

Acknowledgment 
Level

The highest KPI status from which you can add an 
acknowledge note in the Dashboard application. This 
is the default acknowledgement level.
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Applicable section The sections of the application where the KPI is in use. 
For example: Dashboard.

Calculation Order The position of the KPI in the ordered list used by 
Dashboard when it calculates the topology. Dashboard 
calculates the higher priority KPIs first, and then the 
lower priority KPIs. This is the default calculation 
order.

Clone In the Factory KPIs or in the Custom KPIs areas, select a 
KPI, and click the Clone button to create a new KPI by 
cloning. You clone an existing KPI to use it as a 
template. The original KPI is still available.

Note: Change the name of the KPI you have cloned to 
make sure you attach the cloned KPI and not the 
original KPI to a specific configuration item (CI).

Default Group Rule This specifies the rule that is defined by default for this 
KPI. 

Display Label The name used for the KPI in Dashboard.

Display Order The order in which the KPIs are displayed in 
Dashboard. This is the default display order.

ID This specifies the ID number used to identify the KPI in 
the source adapter templates. This is the default KPI ID.

GUI Element (A-Z) Description
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KPI Details Dialog Box

New Item Click to create a new KPI. For details, see “Customize a 
KPI” on page 510.

Override In the Factory KPIs or in the Custom KPIs areas, select a 
KPI, and click the Override button to edit an existing 
KPI. You override an existing KPI to replace it with a 
customized KPI. The original KPI is disabled. The 
overriding KPI and the original KPI have the same KPI 
ID. The KPI in the Factory KPIs area displays the 
following indication:

Note: If you delete the custom KPI that overrode the 
factory KPI, the original factory KPI is automatically 
restored.

For details, see “Customize a KPI” on page 510.

Description Enables you to define a new KPI.

To Access: In the KPI Repository page, click New Item 
or click the Edit button for the appropriate KPI in the 
Factory or Custom KPIs area.

Important 
Information

A list of the KPIs, their descriptions, and the rules 
attached to the KPIs is available in “List of Dashboard 
KPIs” on page 512.

Included in Tasks “Customize a KPI” on page 510

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Acknowledgement 
Level

For future use. 

Applicable for User 
Role

Select the type of user. You can define two versions of a 
single Dashboard KPIs for two different user types 
(modes): Operations and Business, where each KPI 
version is geared towards the particular viewing 
requirements of one of the user types. For details, see 
“KPIs for User Modes” on page 355. Select Both if you 
want to have one version of the KPI. If you select 
Operations and Business, it is recommended to modify 
the KPI’s name to reflect the type of user role. For 
example, rename OT Impact: OT Impact - Operations.

Applicable Rules Add rules or remove existing rules from the Applicable 
Rules list. Applicable Rules lists the rules (types of 
calculations) that can be performed on the KPI. One of 
the rules in the list of applicable rules is the default rule 
of the KPI. You can change the default rule of the KPI 
to one of the other rules selected in the Applicable 
Rules list. For example, the applicable rules of the OT 
Impact KPI are: Sum of Values rule and Impact Over 
Time rule. The default rule is Sum of Values.  

Note: Ensure that you press the CTRL button when you 
select the rules. If you do not press the CTRL button, all 
of the pre-selected rules are disabled when you click 
the rule you want to add to the applicable rules.

For details on the rule applicable for a specific KPI, see 
“List of Dashboard KPIs” on page 512. The rules 
included here define the options that are available in 
the View Builder when selecting the rule to assign to a 
KPI. 

Note: You must select a rule in the Applicable Rules list 
to make it available to the KPI.
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Applicable Sections Add sections or remove existing sections from the 
Applicable Sections list. Applicable Sections lists the 
sections (applications and sub-applications) in which 
the KPI can be displayed. For the KPI to be displayed, 
you must select at least one section. 

The available applicable sections are: 

➤ Dashboard 

➤ SLM 

➤ General SLM 

➤ Outage SLM 

➤ PNR

Available Formatting 
Methods

Select the formatting method you want to use for this 
KPI in the Available Formatting Methods list.

Calculation Order Select the KPI position. That number represents the 
position of the KPI in the ordered list used by 
Dashboard when it calculates the topology. Dashboard 
calculates the higher priority KPIs first, and then the 
lower priority KPIs.

Default Group Rule Select the group rule to be used for the next level up in 
the hierarchy. This list displays all of the available 
group rules for the applicable rule you selected in the 
Applicable Rules list. When a KPI is defined for a CI, it 
is usually added to a parent CI. The parent item uses 
the group rule to calculate the KPI status. For a list of 
the group rules, see “List of Dashboard Business Rules” 
on page 581.

Display Label Enter the displayed name for the KPI.

Display Order Select the order in which the KPIs are displayed in 
Dashboard.

GUI Element (A-Z) Description
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Formatting Method The formatting method that is invoked on the 
valueSource is displayed in the Formatting Method 
box. This field can remain blank if it is not required. A 
list of the available formatting methods and their 
description is available in “List of (KPI) Formatting 
Methods” on page 549.

If you need to create a new method, contact HP 
Software Support.

Status Represents the key used to access the appropriate KPI 
results map. If you create a new rule whose key is not 
Status, you must enter the new key in the Status box. 
To create a new rule with a different key, contact HP 
Software Support. 

Default Value: Status

The KPI is critical Select the trend for the KPI – for details on trend, see 
“Trend and History” on page 362. Select: 

➤ values are smaller. When the values are small, the 
KPI is critical. 

➤ no different. When the values are not different, the 
KPI is critical. 

➤ values are bigger. When the values are large, the KPI 
is critical. 

Note: All of the fields listed above are connected to the 
calculation performed by the selected Applicable Rules.

Type Select how you want the KPI to be presented in 
Dashboard: ICON, TEXT, PNR_BAR, BAR, GROUPBAR, 
or GROUPTEXT. For details, see “Type” on page 545.

Units Enter the type of unit applicable to the rule results 
displayed in the KPI. This parameter is for future use. 
For more details on the available units, see “Units of 
Measurement for Objectives” on page 544.

GUI Element (A-Z) Description
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Parameters Area

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Value Represents the value of the key used to access the 
appropriate KPI results map. If you select a specific 
value in the Type list, you may have to change the 
value of the Value box. For details, see “KPI Value” on 
page 548.

Default Value: Value

Value Postfix Enter the row value postfix. This can remain blank if it 
is not required. For example, to indicate that the value 
of the KPI is in Euros, enter EUR.

Value Prefix Enter the row value prefix. This can remain blank if it 
is not required. For example, to indicate that the value 
of the KPI is negative, enter a minus sign (-).

GUI Element (A-Z) Description

Click to delete the parameter.

Click to modify the parameter details. For details, see 
“KPI Details Dialog Box” on page 539.

<Parameter> The name of the parameter. For details on the default 
parameters, see “List of Default KPI Parameters” on 
page 551.

New Click to define a new parameter. For details, see 
“Parameter Details Dialog Box (KPIs)” on page 552. 

GUI Element (A-Z) Description
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Units of Measurement for Objectives

The KPI default units are:

Default Unit (A-Z) Description

<No unit> is displayed after the objective value box for 
business rules that handle volume, where the KPI 
measurement represents a simple numerical count. 
For example, this is the case for the RUM 
Transaction Monitor Volume Rule.

Financial ($) This unit is used for business rules that determine 
financial loss for a CI, for example, the Impact Over 
Time Rule.

Milliseconds or Seconds This unit is used for business rules that handle 
performance time data for a transaction or monitor, 
for example, the Transaction Performance Rule or 
RUM Page Monitor Performance Rule.

Percentage (%) This unit is used for business rules that handle 
availability over time data for a transaction, for 
example, the Transaction Availability Rule, and for 
the PNR Rule, where the KPI measurement 
represents percentage of time remaining for CI 
unavailability before the SLA is in breach of 
contract.
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Type

The type of representation for the KPI can be: 

Type Description

BAR, ICON, 
TEXT

The results of BAR, ICON, and TEXT formats are:
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 GROUPBAR The behavior of the GROUPBAR type depends on the KPI:

➤ Transactions KPIs. When one or more of the CI’s children 
have the Business Process Step type, then the Transactions 
KPI is displayed as a GROUPBAR in the Console tab. 

➤ Locations KPIs. When one or more of the CI’s children has 
the Locations type, then the Locations KPI is displayed as a 
GROUPBAR in the Console tab. For example:

➤ Business Health KPIs. 

➤ At all CI levels, the groupbar displays the number of 
instances for each one of the Business Process Insight 
statuses without consideration of the Weight. At the level 
above the Business Process CI, an icon represents the status 
of the worst child KPI. The Weight information is 
displayed in the tooltip. The tooltip color matches the 
color of the status (in the example below: Minor). The 
status is calculated by the rule assigned to the KPI. 

➤ Above the Business Process CI level, the KPI displays an 
icon that shows the worst child status of the child CIs 
level. 

Note: The default type for the Business Health KPI is 
GROUPBAR.

Type Description
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GROUPTEXT A KPI with the GROUPTEXT type displays:

➤ For any level CI except the top level of the group CI. Displays 
the number of instances for each one of the available statuses 
without consideration of the Weight. The Weight 
information is displayed in the tooltip. The tooltip color 
matches the color of the status (in the example below: 
Minor). The status is calculated by the rule assigned to the 
KPI.

Note: If the numbers are too large, select the compactNumber 
formatting method in the Formatting Method field. This 
method automatically trims the number, and displays the 
first digit of the trimmed number followed by the symbol for 
the number of digits; for example, 1235000 becomes 1M.

➤ At the top level CI level, the KPI displays the spelled-out 
worst child status of the child CIs level. 

PNR_BAR The PNR_BAR representation is as follows:

For more details on the PNR_BAR representation, see “Attach a 
PNR KPI to a CI – Scenario” on page 372.

Type Description
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KPI Value

If you select a specific value in the Type list, you may have to change the 
value of the Value box.

KPI Trend

Service Level Management KPIs are assigned a positive trend (the higher the 
better or the lower the better).

For example:

➤ the Availability KPI is given a positive trend. This means that it becomes 
critical when its value is small because it means that the page whose 
availability is being measured is not available most of the time. The 
Availability KPI performance is best when its value is large.

➤ the Outage Duration KPI is given a negative trend. This means that its 
performance is best when its value is small.

Type Value

ICON Do not change the default of the Value field.

TEXT Change the value of the Value field to one of the following 
values:

➤ NODE.DIM.RESULTS.Value (for a string)

➤ NODE.DIM.RESULT.Message (for an error message)

PNR_BAR, BAR, 
or GROUPBAR

Do not change the default of the Value field.
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List of (KPI) Formatting Methods

The formatting methods that are available are used to format the result that 
is displayed in Dashboard:

Formatting Methods Description

analyzeSiteScopeMessage If, in a message, a long word overlaps the end of the 
line, the word is truncated. The rest of the word and 
the rest of the message are wrapped.

compactNumber Select this method, if the numbers displayed with 
the GROUPTEXT type are too large. This method 
automatically trims the number; for example, 12000 
becomes 12K and 123000000 becomes 123M.

encode Inserts a back slash (\) before special characters.

formatDecimalNumber Returns as a formatted decimal number. The 
number of digits after the decimal point is indicated 
by numAfterDot.

formatDateTime Returns formatted as date and time: DDMMMYYYY 
hh:mm:ss

formatPnrValue Formats the pnr time left in the PNR format.

getIntValue Returns an int number as string.

getMilliAsSec Returns a millisecond value as seconds by dividing 
the value by 1000.

getMustValue Returns ! if there is a value, otherwise returns 
nothing.

getRemedyETTR Deprecated. Use the EMS integration feature. For 
details, see “Integration Administration Application 
Overview” in Solutions and Integrations.

getRemedyResource Deprecated. Use the EMS integration feature. For 
details, see “Integration Administration Application 
Overview” in Solutions and Integrations.

getResourceString Returns the corresponding resource string to the 
given string.
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getStatusString Returns the corresponding resource string to the 
given status string.

getWeightValue Returns the value if there is a value, otherwise 
returns 1.

ifEndCheck Changes an empty string into a comment line. 
Inserts "--->" at the end of the string.

ifStartCheck Changes an empty string into a comment line. 
Inserts "<!--" at the end of the string.

numberToTime Converts a string that can represent a period of time 
in seconds into a more readable format.

resourceFromKey Used to get the resource of the ticketing sample 
field.

returnDateAsString Returns the given date in milliseconds in the date 
format as it appears in the .resources file.

returnDateAsStringInSec Returns the given date in seconds in to the date 
format as it appears in the .resources file.

returnNumOfDigitAfter
Point 

Formats the given string and returns a string that 
shows only 3 digit after the point.

returnNumOfDigitAfter
Point(digits) 

Formats the given string and returns a decimal 
number. The number of digits after the decimal 
point is specified in (digits).

returnNumOfDigitAfter
PointWithDollar 

Converts the given string into a decimal number 
with 3 digits after the decimal point preceded by a 
dollar sign. 

returnNumOfDigitAfter
PointWithEuro 

Converts the given string into a decimal number 
with 3 digits after the decimal point preceded by a 
dollar sign followed by a Euro sign. 

returnWithPercentSign Converts the given string into a decimal number 
with 3 digits after the decimal point followed by a 
percentage sign. 

Formatting Methods Description
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List of Default KPI Parameters 

In the Parameter Details dialog box, you can modify existing detailed 
information or enter new information about the KPI parameters.

The predefined default status parameters are the same for each KPI:

For details, see “KPI Objectives” on page 343.

toLowerCase Returns the lower case of the given string.

toLowerCase_encode Works in the same way as toLowerCase but adds add 
escaping on the return value.

GUI Element (A-Z) Description

critical (Red) Corresponds to a status within the Critical 
objective level. 

downtime (Gray circle and back slash ) Stopped or downtime 
status. The corresponding profile/group/monitor is 
currently disabled. 

OK (Green) Corresponds to a status within the OK 
objective level. 

major (Orange) Corresponds to a status within the Major 
objective level. 

minor (Yellow) Corresponds to a status within the Minor 
objective level. 

stop Stopped or downtime (gray with white slash) status. 
The corresponding profile/group/monitor is 
currently disabled. 

none No Data (gray) status. 

warning Warning (yellow) status. 

info (Blue) Corresponds to a status that indicates that 
the KPI has a value and no status because the KPI’s 
objectives have not yet been specified.

Formatting Methods Description
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Parameter Details Dialog Box (KPIs)

Description Enables you to modify existing detailed information or 
enter new information about the KPI parameters.

To Access: In the KPI Details dialog box, in the 
Parameters area, click the New button to enter new 
parameters or click the relevant Edit button to modify 
an existing parameter.

Important 
Information

For a list of KPI parameters and their default values, see 
each rule description in “List of Dashboard Business 
Rules” on page 581.

Included in Tasks “Customize a KPI” on page 510
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Color To modify the default color of the tooltip’s header and 
border, open the Parameter Details dialog box, enter 
different colors in the Color box using the following 
syntax and save the changes:
<border_color>;<header_color>

where:

➤ <border_color> is the tooltip border color (in hex 
triplet format).

➤ <header_color> is the tooltip header color (in hex 
triplet format).

The colors are separated by semi-colons. 

Example: A hex triplet is a six-digit, three-byte 
hexadecimal number used to represent colors. The 
bytes represent the red, green and blue components of 
the color in respective order. One byte represents a 
number in the range 00 to FF. The hex triplet is formed 
by concatenating three bytes in hexadecimal notation. 
For example, consider the color where the 
red/green/blue values are hexadecimal numbers: 
red=24, green=68, blue=A0 (a greyish-blue color). To 
obtain the hex triplet, write the three hex bytes 
together without spaces, thus: 2468A0. If a byte is less 
than 16 (decimal) or 10 (hex) it must be represented 
with a leading zero to keep the number of digits in the 
triplet equal to six. 

From/To Enter the appropriate values.

When the value of a KPI is in the range indicated by 
the From and To fields, the tooltip for the KPI is 
assigned the color specified in the Color field and the 
KPI is assigned the status icon specified in the Icon 
field.



Chapter 18 • KPI Repository

554

Icon Enter the path to a status icon in the Icon box – for 
details, see “Change the KPI Status Icons” on page 394.

The icon you specify is assigned to the KPI when the 
KPI value is within the range specified in the From/To 
fields

Key Enter the name of the KPI parameter.

Type Enter the type of parameter. Possible values are: 
Boolean (can be 0 or 1), Integer, Long, Double (can be 
a decimal number), or String.

GUI Element (A-Z) Description
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19
Business Rule Repository

This chapter provides information on the Dashboard Business Rule 
Repository.

This chapter includes:

Concepts

 ➤  Business Rule Repository Overview on page 556

 ➤  Monitor Rules and Group Rules on page 559

 ➤  Sample-Based and Time-Based Sampling on page 561

 ➤  Understanding the Percentage Rule on page 562

 ➤  Understanding the Generic Formula Rule on page 566

Tasks

 ➤  Customize a Business Rule on page 568

 ➤  Create a Customized Generic Sample Rule – Scenario on page 571

 ➤  Create a Customized Generic Sum of Values Over Time Rule – Scenario 
on page 573

 ➤  Use the Generic Two Arguments Rule – Scenario on page 575

 ➤  Set Up Rules to Display the Last Sample Details on page 578

 ➤  Save Measurements Data on page 580

Reference

 ➤  List of Dashboard Business Rules on page 581

 ➤  List of Dashboard Business Rule Parameters on page 642

 ➤  Business Rules User Interface on page 649
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Concepts

Business Rule Repository Overview

The Business Rule Repository page displays the list of factory (predefined) 
rules available throughout Dashboard to determine how source data is 
handled by Dashboard Administration.

A business rule is used to calculate the value and status of a Key Performance 
Indicator (KPI). Every KPI can hold three icons: real time status, trend, and 
history. The way status is determined for these icons is described in “KPI 
Status” on page 355.

A rule is the basic object that receives events (either samples or application 
messages), deals with processing the data, and holds the process results. To 
receive the events, the rule uses input filtering criteria called selectors. For 
details, see “Attach KPIs to CIs and Configure the KPIs” on page 374.

For details on editing rules, see “Business Rule Repository page” on 
page 649. If you add a rule, a matching tooltip (with the same ID number) is 
automatically created. For details, see “Tooltip Repository page” on 
page 883.

In the adapter templates, the business rule for each KPI is identified by a 
logic ID (the rule ID). For a list of the rules defined for Dashboard, see “List 
of Dashboard Business Rules” on page 581. 

The Rules API can be used to create new rules; for details see “Rules API” on 
page 661.

Note: If you are using HP Operations Manager i with Business Availability 
Center, then the Business Rule Repository page contains OMi-related 
business rules. For more information, see Using HP Operations Manager i.

Some rules are for use only by Dashboard, and are not available for use in 
custom views.
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This section includes the following topics:

➤ “Advanced Users” on page 557

➤ “Parameters” on page 557

➤ “Business Rule Repository Global Parameters” on page 558

➤ “Rules in Source Adapters, KPI Assignments, and KPI Enrichments” on 
page 558

Advanced Users
You can modify existing repository objects and create new ones. You modify 
existing repository objects when you want to customize the way 
information is presented in Dashboard, to fit the needs of your 
organization. You may create new repository objects when integrating data 
from a new external system into Dashboard.

Parameters
Each rule’s parameters are used to define input for the rule. The values used 
for the parameters can be fixed values (defined within the parameter 
definition) or referenced values taken from the samples. 

The rule parameters are defined in the Business Rule Repository, as part of 
each rule definition. 

Depending on the type of rule, some rule parameters may be defined in an 
adapter template for a data source (as part of the KPI definition). The values 
set for these parameters override the definitions in the Business Rule 
Repository. For a list of rule parameters, see each rule parameter description 
in “List of Dashboard Business Rule Parameters” on page 642.
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Business Rule Repository Global Parameters
You can modify various global parameters for trend and history status in the 
Business Rule Repository, as follows:

➤ You can specify whether or not you want trend status and/or history status 
displayed for CIs.

➤ You can change the window of time used for trend and history calculations.

➤ You can specify the calculation type for history status.

For details, see “Global Attributes Dialog Box” on page 651.

Note that the global parameters can be overridden by defining a different 
value for the relevant parameter within a specific rule.

Rules in Source Adapters, KPI Assignments, and KPI 
Enrichments
In the adapter templates, which are used to map the entities in the data 
source to the configuration items (CIs) used by HP Universal CMDB, or in 
the KPI Assignments and KPI Enrichment Tasks, which are used to assign 
KPIs, rules, context menus, context menu items, and tooltips to a CI, the 
business rule for each KPI is identified by an ID number. For a list of the 
rules ID numbers, see “List of Dashboard Business Rules” on page 581.

To access adapter templates, click Admin > Universal CMDB > Source 
Manager.

To access KPI assignments, click Admin > Dashboard > KPI Assignments.

To access KPI enrichment, click Admin > Integrations > EMS Integrations.



Chapter 19 • Business Rule Repository

559

Monitor Rules and Group Rules

A KPI must always have an associated business rule that defines the business 
logic. The business logic determines how the data is handled to obtain a 
single status rating.

There are two categories of business rules, monitor rules and group rules, as 
described in the following sections. Most KPIs work with at least one rule 
from each category.

This section includes the following topics:

➤ “Monitor Rules” on page 559

➤ “Group Rules” on page 560

Monitor Rules
Monitor rules (also called leaf rules) are business rules that are applied to 
monitor (leaf) CIs. Monitor rules are used to calculate a measurement for the 
KPI based on original sample data that is caught by the KPI selector. For 
example, the Availability Rule calculates the Availability KPI for BPM 
Transaction from Location CIs, based on the sample data received from 
Business Process Monitor.

A monitoring CI is intended to receive incoming metrics, generally received 
using one of the data collector, such as SiteScope, Business Process Monitor, 
or Real User Monitor. Monitoring CIs are automatically added to the 
HP Universal CMDB by the source adapters in Source Manager, according to 
the monitoring definitions. These monitoring CIs have default KPIs that use 
a monitor rule, and predefined selector.

In general, the leaf CIs in a subtree (the CIs that form the lowest level of the 
hierarchy) should always be one of the monitoring CIs. When creating new 
subtrees in your views in IT Universe Manager, you attach monitoring CIs 
created by the source adapters as leaf nodes, and these CIs then pass KPI 
status up the hierarchy.
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Group Rules
Group rules are business rules that determine KPI status based on data 
received from other KPIs, rather than from original sample data. The 
received data can come from the KPIs of child CIs, or from another KPI 
associated with the same CI.

Note: Even though this category are called group rules, some of them are 
also applicable for monitoring/leaf level CIs. For example, the Impact Over 
Time Rule (used with the OT Impact KPI) can be used with a group CI or a 
monitoring CI. What all rules in this category have in common is that their 
status calculations are contingent on data received from other KPI instances, 
rather than from the samples.

The group rules vary in the type of logic they use to arrive at a status result. 
For example:

➤ The rule may select a KPI status held by one of the child CIs, and apply that 
status to the parent, as done by the Worst Child Rule.

➤ The rule may aggregate the received data to calculate a measurement, and 
compare the measurement with defined objectives, as done by the Sum of 
Values Rule.

➤ The rule may calculate a measurement based on the status of another KPI for 
the CI, and compare the measurement with defined objectives, as done by 
the Real Time Impact Rule when receiving status from the Availability KPI.

Each KPI has been assigned a default business rule that is used when you 
attach a new KPI to a CI; the default is generally one of the group rules for 
that KPI. When editing a KPI or attaching a new KPI, you can select a 
different rule, from the list of rules that are applicable for that KPI. 

If a KPI is associated with a logical CI then the rule that calculates the status 
and value of this KPI is probably a group rule – it uses the KPIs of other CIs 
in order to calculate its own status and value (for example: Worst Child 
rule).
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Sample-Based and Time-Based Sampling

Monitor rules are time-based or sample-based. The time-based sampling is 
more accurate than the sample-based sampling when samples are not taken 
regularly; for example, SiteScope sampling accelerates when a problem 
occurs. When samples are taken regularly, time-based and sample-based 
sampling provide the same results.

If you have the following sample:

 

The result of the first part of the sampling period is 5. After that the result of 
each sampling period is 2. 

The sample-based result is calculated as follows: 
(5+8x2)/9= 2.33 
The samplings are as follows: 1 sampling with the value 5 and 8 samplings 
with the value 2. The total number of samplings is 9.

The time-based result is calculated as follows: 
(30x5+30x2)/60=3.5
During 30 seconds the value was 5. During the next 30 seconds the value 
was 2. The total sampling time was 60 seconds.

Note: There is also a time and amount-based calculation method that works 
on the same basis as time-based, but takes into account the amount (value) 
received in the sample as a proportion of the total amount.
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Understanding the Percentage Rule

The Percentage rule is listed in the list of Dashboard rules at “Percentage 
Rule” on page 611.

When the Percentage rule is defined as the KPI rule for a parent group, the 
group is assigned a KPI status based on a percentage calculated from the 
child CIs in the group. If required, significant relationships between CIs 
(usually between the parent CI and one of the children CIs) can be weighted 
(Weight option), so that they have more impact on the percentage 
calculation. You can also define dominant status (Must option) for a 
relationship between CIs (usually between the parent CI and one of the 
children CIs), so that a child CI with low status in the dominant 
relationship influences the status of the group.

Note: For all percentage calculation methods, the number of gray child CIs 
(Info, No data, Stopped, or Downtime statuses) is ignored in the final 
calculation of the parent group score.

The different applications of the Percentage Rule are described in the 
following sections.

Basic Percentage Rule 
When using the Percentage Rule, parent group status is based on a 
percentage (the score for the group), calculated from the number of child 
CIs with red, orange, olive, green, or yellow status. Gray statuses are not 
taken into consideration. (Note that if any of the child CIs are weighted, this 
influences the percentage calculation, as described in Weighted Percentage, 
below.)

Each status has a value, as follows:

Status Value

red 0

orange 5
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Each value is multiplied by the number of children in the group that have 
that status, and the results are totaled and divided by the number of 
children in the calculation, to give an average result. For example, in a 
group of four CIs, two with red status and two with yellow status, the 
calculation would be as follows: 

The average result is then divided by 20 (corresponding to the green status 
value) and multiplied by 100, to give the percentage score for the group: 

The score determines the status for the parent group according to objectives 
defined for the KPI. For details, see “KPI Objectives” on page 343. 

When you assign the Percentage rule to a KPI, the tooltip for the KPI in 
Dashboard, displays the percentage score for the group and the Percentage 
rule objectives.

yellow 10

olive 15

green 20

2 x 0 (red)
2 x 10 (yellow)
Total = 20/4 (number of red and yellow children) = 5 (average result

(5/20) x 100 = 25% (score)

Status Value
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Weighted Percentage 
By default relationships are not weighted (weight = 1). You can change the 
default weight for a relationship in the weight box, accessed in the Define 
Configuration Item Relationship window (described in “New CI Dialog Box” 
in Model Management). 

When a child CIs in a group, is in a relationship with a weight greater than 
1, then the percentage calculations described in Basic Percentage Rule, are 
adjusted to take the weight into account. Each CI status value is multiplied 
by the weight assigned to the CI, and the total is divided by the total weight 
values, to give the average result. 

For example, taking the same group that was used for the basic percentage 
example (four CIs, two with red status and two with yellow status), if one of 
the red CIs has a weight of 4 and one of the yellow CIs has a weight of 2, 
then the average result calculation looks like this:

1 x 4 x 0 (red with weight=4)
1 x 1 x 0 (red with weight=1)
1 x 2 x 10 (yellow with weight=2)
1 x 1 x 10 (yellow with weight=1)
Total = 30/(4+1+2+1) (total weight values for red and yellow children) = 3.75 
(average result)

The percentage score for the group is then calculated in the same way as for 
the basic Percentage Rule: average result is divided by 20 and multiplied by 
100:

Note that CI weights are relevant only when the parent group status is 
calculated using the Percentage Rule.

Note: You can display the weight information in the KPI tooltip in Top 
View. For details, see “Customize Top View Tooltips” on page 130.

(3.75/20) x 100 = 18.75% (score)
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Dominant Child 
By default, all CIs are in non-dominant relationships (must is cleared). You 
can change the setting for a relationship to dominant in the Define 
Configuration Item Relationship window (described in “New CI Dialog Box” 
in Model Management).

When a child CIs in a group is in a dominant relationship, then status is 
calculated for the group by comparing the results from the following two 
status calculation methods:

➤ Dashboard determines the lowest status held among all dominant CIs.

➤ Dashboard determines group status according to the percentage rule 
calculation (as described in Basic Percentage Rule above).

The worst status from the two calculations becomes the status for the group. 

When the group status has been taken from the lowest status held by a 
dominant CI, the tooltip for the parent group displays Score: n/a (Using 
dominant child).

Note: 

➤ Dominant CIs are only relevant when the group is using the Percentage 
Rule to calculate status.

➤ When a CI has both dominant and weighted child CIs only the 
dominant CI is taken into consideration when calculating the status of 
the parent CI using the Percentage rule.



Chapter 19 • Business Rule Repository

566

Understanding the Generic Formula Rule

The Generic Formula rule is listed in the list of Dashboard rules at “Generic 
Formula Rule” on page 604.

This rule can be used to add new business logic behavior to Dashboard. You 
can use the rule to create a set of calculation methods (sum, count, average, 
and so on) that can be applied to every type of sample: legacy (SiteScope, 
Business Process Monitor, and Real User Monitor) and Enterprise 
Management Systems (EMS) samples.

In Dashboard, the rule is time-based and the formula calculates a single 
aggregated result of all of the specified data collected during the period 
specified in the duration parameter.

Note: 

➤ Using the Generic Formula rule might have an impact on performance as 
the rule parses and evaluates string expressions. Using this rule should be 
considered carefully only when no other rule answers the requirements 
and when the application does not include large amounts of monitor 
nodes.

➤ There is no automatic validation to check if the formula supports the 
collected sample structure. There is no automatic validation for the 
correctness or syntax of the formula. If there is a mistake in the formula, 
the status of the KPI appears as a gray icon in Dashboard. 

For example, use this rule to calculate the average of a sample field over a 
period of time multiplied by 2, or the sum of the values of a sample field 
over the specified period of time, divided by the number of values of 
another field.
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Using the Generic Formula Rule
To use the Generic Formula rule, clone it and give the clone a meaningful 
name. You can then customize the cloned rule, attach the rule to a KPI, and 
attach the KPI to a view. The KPI automatically propagates the rule selected 
in the Default Rule list to all of the CI parents.

To edit the formula, click the Edit button for the Formula parameter, and 
enter the formula that you want the rule to use in the Default Value field. 
For more details, see “Parameter Details Dialog Box (Rules)” on page 656.

The formula is based on operands, operators, functions, constants, and 
sample field values. The formula must use only fields from the selected 
samples; you must know the name of the variables in the sample on which 
you want to run the formula. The samples for the rule depend on the 
specific KPI’s selector, therefore the formula must support the collected 
sample structure.

The rule takes values from the specified samples during the time period 
specified in the duration parameter, puts those values in the aggregated 
formula, and compares the result with the specified objectives.

Any valid Dashboard sample is valid for this rule.

The formula language is based on the Generic Data Engine (GDE) parser 
language to be consistent with the open formula writing. For more 
information, see “Working with the Generic Reporting Engine API” in 
Solutions and Integrations.

The formula must always be an aggregated formula. It should contain 
aggregation functions and mathematical operators between them. The 
operands can either be constant numbers or aggregation functions.

The formula elements are:

➤ supported operators: *, +, -, /, ( )

➤ supported aggregation functions: sum, min, max, avg, count, stddev, 
sumofsqr

➤ supported manipulation function: if 
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The rule calculates a single numeric value based on the samples collected 
during the duration. The value is then evaluated according to the given 
objectives and the status is set accordingly. 

For an example of how to create a customized Generic Formula rule, see 
“Example – Write a Generic Formula Rule” on page 569.

Tasks

Customize a Business Rule

You customize a business rule by creating a new business rule, or by editing 
an existing business rule.

For a detailed scenario that includes creating rules, see “Create a KPI, Rule, 
and Tooltip – Example” and view the appropriate steps.

This task includes the following steps:

➤ “Create a Customized Business Rule” on page 568

➤ “Edit Rule Details” on page 569

➤ “Modify Rule Parameters or Global Rule Parameters” on page 570

➤ “Set a Rule and its Parameters Back to Default – Optional” on page 571

➤ “Attach the Rule to a KPI” on page 570

 1 Create a Customized Business Rule
There are three ways to customize repository elements:

➤ New Item. Creates a new repository element that is not based on an existing 
element. You customize the new element to fit your needs. To create a new 
business rule, click New Item in the Business Rule Repository page.

➤ Clone. Creates a new repository element by cloning an existing factory or 
custom element. The original element is still available, and the new cloned 
element can be modified. To clone a business rule, select a factory business 
rule and click Clone in the Business Rule Repository page.
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➤ Override. Overrides an existing factory element. The original element is 
labeled overridden (disabled) in the Factory area, and an editable copy 
appears in the Custom area. To override a business rule, select a factory 
business rule and click Override in the Business Rule Repository page.

For details, see “Business Rule Repository page” on page 649.

 2 Edit Rule Details
Click the Edit button corresponding to the custom business rule, and 
change its values as required. For details on the possible values, see “Rule 
Details Dialog Box” on page 657.

Note: If you are creating a customized Generic Sample rule, a Generic Sum 
of Values Over Time rule, or a Generic Two Arguments rule, and the name of 
the time stamp field in the sample is not time_stamp, in the Rule Parameters 
area of the Rule Details dialog box, click Edit for the Time Stamp Field 
parameter. In the Default Value box, enter the name of the sample time 
stamp field. The type of the sample time stamp field must be time. Click OK 
to save the change.

Example – Write a Generic Formula Rule

For details on the Generic Formula rule, see “Generic Formula Rule” on 
page 604.

➤ The following formula calculates the average of the dResponseTime sample 
field value over the specified period of time, multiplied by 2:

➤ In the following formula, you want to sum only the response time of the 
successful transactions, therefore only the response time for samples with 
u_iStatus=0 is taken into consideration. u_iStatus=1 when the transaction 
fails, and u_iStatus=0 when the transaction is successful. 

Avg(dResponseTime)*2
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The formula calculates the sum of the values of the dResponseTime sample 
field value over the specified period of time, where the value of 
dResponseTime is set to 0 every time the value of the u_iStatus sample field 
equals 1. This sum is divided by the sum of values calculated as follows: the 
value is equal to 1 when the u_iStatus field value is 0, and the value equals 0 
when the u_iStatus field value is different from 0. This formula calculates the 
performance of a certain transaction by aggregating the response time of all 
of the successful transaction and dividing it by the number of successful 
transactions:

 3 Modify Rule Parameters or Global Rule Parameters
You can modify existing information or enter new information about the 
rule parameters and the Objective parameters for a specific rule. For details, 
see “Parameter Details Dialog Box (Rules)” on page 656.

To globally edit a parameter for all factory rules, access, from the Rules page, 
the Global Attributes Details dialog box and modify the appropriate 
parameters. For details, see “Global Attributes Details Dialog Box” on 
page 655.

Note: To override the global parameters values for individual rules, you 
must add the relevant parameter to the relevant rule and then modify its 
value.

 4 Attach the Rule to a KPI
If you have created a new rule, you must add it to the rules already attached 
to the relevant KPI. For details, see the Applicable Rules GUI parameter in 
“KPI Details Dialog Box” on page 539.

sum(if(u_iStatus,=,0,dResponseTime,0))/sum(if(u_iStatus,=,0,1,0)
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 5 Set a Rule and its Parameters Back to Default – Optional
If you have modified a rule or its parameters, you might need to return the 
rule and its parameters to their defaults.

To set a rule and its parameters back to default, select Admin > Dashboard > 
Repositories > Rules. In the Custom Rules area, delete the copy of the rule 
you want to return to default and click OK. The rule and its parameters are 
returned to their defaults.

Create a Customized Generic Sample Rule – Scenario

For a description of the rule, see “Generic Sample Rule” on page 605.

You want to display the comparison between the value of a selected value 
field in the event sample and specific objectives, so the status of the KPI to 
which the customized Generic Sample rule is attached is grey when the 
value of the sample field is less than 1 and larger than 5. To display the 
comparison you must clone the Generic Sample Rule, attach the cloned rule 
to a cloned KPI, and attach the cloned KPI to the appropriate CI.

To create a clone of the Generic Sample rule:

 1 Select Admin> Dashboard > Repositories > Business Rules.

 2 In the Factory Business Rules area, select the Generic Sample Rule and click 
Clone.

 3 In the Custom Business Rule area, click the Edit button  corresponding to 
the Generic Sample Rule to open the Rule Details window.

 4 In the Display Name box, enter Value Event rule as the name of the cloned 
rule.

 5 In the Rule Parameters area, click the Edit button  corresponding to the Field 
Name to open the Parameter Details window. In the Default Value box, 
specify the name of the sample field (value) on which to apply the rule. The 
field must have a numeric value. Click OK to save the change.
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Note: The units of the objectives and of the field value must be the same. 
The result is provided with the same unit too.

 6 If required, in the Objective Parameters area, click the Edit button  
corresponding to the appropriate objective to open the Parameter details 
window and make the changes to the default objectives (values from 1 to 5 
are colored, values less than 1 or more than 5 are colored grey). Click the 
Edit button for each objective parameters and enter the objective value in 
the Default Value box (critical, 5; major, 4; minor, 3; warning, 2; OK, 1). For 
details, see “Parameter Details Dialog Box (Rules)” on page 656.

Note: The units of the objectives and of the field value must be the same. 
The result is provided with the same unit too.

 7 Click OK to save the changes.

To create the KPI for the rule:

 1 Select Admin> Dashboard > Repositories > KPIs.

 2 In the Factory KPIs area, select any KPI and click Clone.

 3 In the Custom KPIs area, click the Edit button corresponding to the KPI you 
just cloned to open the Item Details window.

 4 In the Display Label box, enter Event as a name for the cloned KPI.

 5 In the Default Rule list, select Worst Child.

 6 In the Applicable Rules list, select Worst Child, click CTRL and click the 
cloned Generic Sample Rule (Value Event rule) you just created.

 7 In the Applicable Sections list, select Dashboard.

 8 Click OK to save the changes.
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To attach the customized rule to a KPI for a CI:

 1 Select Admin> Dashboard > KPIs.

 2 Select a view.

 3 Select the appropriate monitor level CI to which you want to attach the KPI.

 4 Click New KPI to open the New KPI window.

 5 In the KPI list, select the Event KPI you just created.

 6 In the Business rule list, select the Value Event rule you just created.

 7 In the Business Rules Parameters area, if required, specify the rule 
parameters.

 8 in the Objectives area, enter the objectives.

 9 In the Selector area, enter event as the name of the sample in the Value box 
that corresponds to the sampleType Field, and enter the other values 
corresponding to the other reference properties that the selector expression 
searches for in the incoming data samples sent from the data source. For 
details on the event sample, see “Sample: Event (event)” in Reference 
Information.

 10 Click OK to save the changes.

Create a Customized Generic Sum of Values Over Time 
Rule – Scenario

For a description of the Generic Sum of Values rule, see “Generic Sum of 
Values Over Time Rule” on page 605.

You want to add the value of the u_iSumNetTime field in the trans_t sample 
for all the trans_t samples that arrive during the time period specified in the 
duration parameter. To display the value you must clone the Generic Sum of 
Values Over Time rule, attach the cloned rule to a cloned KPI, and attach the 
cloned KPI to the appropriate CI.
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To create a clone of the Generic Sum of Values Over Time rule:

 1 Select Admin> Dashboard > Repositories > Business Rules.

 2 In the Factory Business Rules area, select the Generic Sum of Values Over 
Time Rule and click Clone.

 3 In the Custom Business Rule area, click the Edit button  corresponding to 
the Generic Sum of Values Over Time Rule to open the Rule Details window.

 4 In the Display Name box, enter u_iSumNetTime Sum rule as the new name 
for the cloned rule.

 5 In the Rule Parameters area:

 a click the Edit button  corresponding to the Field Name to open the 
Parameter Details window. In the Default Value box, specify the name of 
the field (u_iSumNetTime) on which to apply the rule. The field must 
have a numeric value. Click OK to save the change.

Note: The units of the objectives and of the field value must be the same. 
The result is provided with the same unit too.

 b If required, in the Default value box, click the Edit button  corresponding 
to the duration parameter and specify the sampling duration, in seconds. 
The default is 15 minutes (900 seconds).

 6 If required, in the Objective Parameters area, click the Edit button  
corresponding to the appropriate objective to open the Parameter details 
window and make the changes. For details, see “Parameter Details Dialog 
Box (Rules)” on page 656.

 7 The units of the objectives and of the field value must be the same. The 
result is provided with the same unit too.

 8 Click OK to save the changes.

To define the customized rule for a KPI:

 1 Select Admin> Dashboard > Repositories > KPIs.

 2 In the Factory KPIs area, select any KPI and click Clone.
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 3 In the Custom KPIs area, click the Edit button  corresponding to the KPI you 
just cloned to open the Item Details window.

 4 In the Display Label box, enter u_iSumNetTime_sum as the new name for the 
cloned KPI.

 5 In the Default Rule list, select Worst Child.

 6 In the Applicable Rules list, select Worst Child, click CTRL and click the 
cloned generic rule (u_iSumNetTime Sum rule) you just created.

 7 In the Applicable Sections list, select Dashboard.

 8 Click OK to save the changes.

To attach the customized rule to a KPI for a CI:

 1 Select Admin> Dashboard > KPIs.

 2 Select a view.

 3 Select the appropriate monitor level to which you want to attach the KPI.

 4 Click New KPI to open the New KPI window.

 5 In the KPI list, select the KPI (u_iSumNetTime_sum) you just created.

 6 In the Business rule list, select the generic rule (u_iSumNetTime Sum rule) 
you just created.

 7 Click OK to save the changes.

Use the Generic Two Arguments Rule – Scenario

For a description of the Generic Two Arguments Rule, see “Generic Two 
Arguments Rule” on page 606.

You want to display the sum of Sum of component connection times in the 
transaction breakdown and Sum of component DNS times in the transaction 
breakdown sample field values from the trans_t sample. To display the sum 
you must clone the Generic Two Arguments Rule rule, attach the cloned rule 
to a cloned KPI, and attach the cloned KPI to the appropriate CI.
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To create a customized Generic Two Arguments Rule:

 1 Select Admin> Dashboard, and select Business Rules in the Repositories tab.

 2 In the Factory Business Rules area, select the Generic Two Arguments Rule 
and click Clone.

 3 In the Custom Business Rule area, click the Edit button  corresponding to 
the Generic Two Arguments Rule to open the Rule Details window.

 4 In the Display Name box, enter Sum_Connect_DNS_Time rule a new name 
for the cloned rule.

 5 In the Rule Parameters area:

 a Click the Edit button corresponding to the First Field Name to open the 
Parameter Details window. In the Default Value box, specify 
u_iSumConnectionTime as the name of the first sample field on which to 
apply the rule. The field must have a numeric value. Click OK to save the 
change.

 b Click the Edit button corresponding to the Second Field Name to open 
the Parameter Details window. In the Default Value box, specify 
u_iSumDnsTime as the name of the second sample field on which to apply 
the rule. The field must have a numeric value. Click OK to save the 
change.

Note: The units of the objectives and of the field value must be the same. 
The result is provided with the same unit too.

 c If required, click the Edit button corresponding to the duration 
parameter and in the Default value box, specify the sampling duration, 
in seconds. The default is 15 minutes (900 seconds).

 d Click the Edit button corresponding to the Operator parameter and in 
the Default value box, specify the operator (+) you want to use. 

 e If required, click the Edit button corresponding to the Factor parameter 
and in the Default value box, specify 1. 
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 6 In the Objective Parameters area, click the Edit button corresponding to the 
appropriate objective to open the Parameter details window and make the 
changes. For details, see “Parameter Details Dialog Box (Rules)” on page 656.

Note: The units of the objectives and of the field value must be the same. 
The result is provided with the same unit too.

 7 Click OK to save the changes.

To define the customized rule for a KPI:

 1 Select Admin> Dashboard > Repositories > KPIs.

 2 In the Factory KPIs area, select any KPI and click Clone.

 3 In the Custom KPIs area, click the Edit button  corresponding to the KPI you 
just cloned to open the Item Details window.

 4 In the Display Label box, enter Sum_Connect_DNS_Time as the new name 
for the cloned KPI.

 5 In the Default Rule list, select Worst Child.

 6 In the Applicable Rules list, select Worst Child, click CTRL and click the 
cloned generic rule (Sum_Connect_DNS_Time rule) you just created to add it 
to the list of rules assigned to the KPI.

 7 In the Applicable Sections list, select Dashboard.

 8 Click OK to save the changes.

To attach the customized rule to a KPI for a CI:

 1 Select Admin> Dashboard > KPIs.

 2 Select a view.

 3 Select the appropriate monitor level to which you want to attach the KPI.

 4 Click New KPI to open the New KPI window.

 5 In the KPI list, select the KPI (Sum_Connect_DNS_Time) you just created.
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 6 In the Business rule list, select the generic rule (Sum_Connect_DNS_Time 
rule) you just created.

 7 Click OK to save the changes.

Set Up Rules to Display the Last Sample Details 

You can set up rules to save details from the last sample received for a CI, so 
that these details can be viewed in the Event Details window for the CI or in 
tooltips in Dashboard. For details on how to display the last sample 
information, see “View Sample Details” on page 57.

Note: Storing last sample details may require use of a large amount of 
memory, slowing down Dashboard performance.
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Last sample details are kept in memory using the saveLastSample property. 
You can use this property to store sample details only for specific CI KPIs, or 
for all KPIs.

To save the last sample details, you can:

➤ Set the property for an individual business rule. Override the rule in the 
Business Rule Repository. In the Rule Details window for the new custom 
rule, add the parameter saveLastSample with Type=Boolean and Default 
Value=true. (Note that this property need only be defined for rules that 
apply to monitor CIs and that the parameter does not appear in the Rule 
parameters list.)

➤ Set the property for all business rules. Click the Edit Globals button in the 
Business Rule Repository to view the Global Attributes list. Edit the 
saveLastSample attribute to change its value to true (default setting is false).

For details on editing global attributes, see “Global Attributes Dialog Box” 
on page 651.
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Save Measurements Data

If required, the Save KPI data over time for this CI option in the Global 
Attributes Details dialog box can also be used to save the calculated 
measurement for each of the CI KPIs, at 15 minute intervals (default value). 
This is done by activating the saveValuesToPersistency global attribute in 
the Business Rule Repository. You can also change the default interval by 
modifying the value of the saveValuesToPersistencyInterval option. For 
details on the user interface, see “Global Attributes Details Dialog Box” on 
page 655.

Example

To activate Dashboard to save measurements data:

 1 Access the Dashboard Administration > Repositories > Business Rules page.

 2 Click Edit Globals (in the Factory Rules area).

 3 In the Global Attributes list, click the Edit button for 
saveValuesToPersistency.

 4 In the displayed Global Attributes Details window, change the Value 
parameter from No to Yes.

 5 Click OK.

 6 To change the default interval (900 seconds) for collecting measurements 
data, in the Global Attributes list, click the edit button for the 
saveValuesToPersistencyInterval, and modify the value.

Note: To avoid overloading the database memory, it is recommended that 
you do not define a shorter default interval value.

Reference
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List of Dashboard Business Rules

This section provides detailed information about the rules available in the 
Business Rule Repository.

For more details on the rule’s parameters, see “List of Dashboard Business 
Rule Parameters” on page 642.

Rule (Rule #) Description Parameters

API Duration-Based 
Sample Rule 

(501)

Use this to create a customized rule using the Rules 
API, to calculate KPIs based on values of samples. The 
calculation is based on the samples collected during a 
defined duration.

For details on how the rule works, see “API Duration-
Based Sample Rule” on page 669.

“duration” on 
page 642

“No data 
timeout” on 
page 644

“Sample Fields” 
on page 646

“KPI Calculation 
Script” on 
page 644

“Rule Template 
Setting Key” on 
page 646

“isGroovyRuleTy
pe” on page 644

API Group and Sibling 
Rule 

(500)

Use this to create a customized rule using the Rules 
API, to calculate KPIs based on the values of sibling 
KPIs or those of child CIs.

For details on how the rule works, see “API Group 
and Sibling Rule” on page 663.

“KPI Calculation 
Script” on 
page 644

“Rule Template 
Setting Key” on 
page 646

“isGroovyRuleTy
pe” on page 644
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API Sample Rule 

(502)

Use this to create a customized rule using the Rules 
API, to calculate KPIs based on values of samples. The 
calculation is based on a maximum number of 
samples.

For details on how the rule works, see “API Sample 
Rule” on page 667.

“Maximum 
number of 
samples” on 
page 644

“Sample Fields” 
on page 646

“KPI Calculation 
Script” on 
page 644

“Rule Template 
Setting Key” on 
page 646

“isGroovyRuleTy
pe” on page 644

Average Availability of 
Weighted Volume 

(55)

Calculates the weighted average based on the total 
number of users accessing the page monitored by the 
monitor, based on the Sum of availability of Monitors 
Per volume.

This is a group rule. For details, see “Group Rules” on 
page 560.

“volumeKPI” on 
page 648

Average Latency of 
Weighted Volume 

(83)

Calculates the weighted average of the latency of the 
monitored End User groups weighted by the volume 
of users and the weighted relationships.

For details on weighted relationships, see “Working 
with Relationships” in Model Management.

This is a group rule. For details, see “Group Rules” on 
page 560.

“volumeKPI” on 
page 648

Average Network of 
Weighted Volume 

(93)

Calculates the weighted average of network 
availability, weighted by the volume (number of 
sessions or connections) of each End User (see the 
Sum of Volume and RUM End User Monitor Volume 
rules).

This is a group rule. For details, see “Group Rules” on 
page 560.

“volumeKPI” on 
page 648

Rule (Rule #) Description Parameters
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Average of Converted 
Performance Results 
in % 

(63)

Converts the monitors status into percentages using 
the Average of Performance Results in % rule, then 
calculates the average, compares the average to the 
objectives, and provides the result in percentages.

This is a group rule. For details, see “Group Rules” on 
page 560.

“volumeKPI” on 
page 648

Average of Values 

(31)

Converts the monitors status into percentages using 
the Average of Performance Results in % rule, then 
calculates the average, compares the average to the 
objectives, and provides the result in percentages.

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

Average Performance 
of Weighted Volume 
in % 

(64)

Calculates the average performance based on the 
weighted volume (total number) of users accessing 
the page monitored by the Monitor, where the 
performance of the monitor has been converted to 
percentages by the Average of Performance Results 
rule.

This is a group rule. For details, see “Group Rules” on 
page 560.

“volumeKPI” on 
page 648

Average Performance 
of Weighted Volume 
in Seconds 

(65)

Calculates, in seconds, the average performance 
based on the weighted volume (total number) of 
users accessing the page monitored by the Monitor, 
where the performance of the monitor has been 
converted to percentages by the Average of 
Performance Results rule.

This is a group rule. For details, see “Group Rules” on 
page 560.

“volumeKPI” on 
page 648

Rule (Rule #) Description Parameters
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Best Child Rule 

(2)

Calculates the best result value based on all of the CI’s 
KPI children (based on the highest status held by any 
of the child CIs).

For example, if at least one child CI in a group has 
green status, then the parent CI of the group also 
displays green status.

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

Rule (Rule #) Description Parameters
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BPI Average Weighted 
Status Rule for 
Duration KPI 

(623)

You can specify status weights using the rule 
parameters in the rule definition. The rule calculates 
the following value:
sum (instances x  x weight x status)/
sum (instances x weight)

The resulting value is a number between 0 and 20 
that is translated to the closest status and represented 
by a colored icon.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: Information about the number of instances 
per status is provided by Business Process Insight. The 
weights are the rule parameters. The value for each 
status is calculated by the BPI Average Weighted 
Status rule.

The result of the rule calculation is: 
(20*1*0+15*1*5+5*1*10+10*1*15+1*1*20)/
(20*1+15*1+5*1+10*1+1*1)=5,784 -> 5 is the nearest 
status which is Major.

“OK weight” on 
page 645

“Warning 
Weight” on 
page 648

“Minor weight” 
on page 644

“Major weight” 
on page 644

“Critical 
weight” on 
page 642

Rule (Rule #) Description Parameters

Number of 
Instances

Weight Status

critical 20 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20
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BPI Average Weighted 
Status Rule for Value 
KPI 

(611)

You can specify status weights using the rule 
parameters in the rule definition. The rule calculates 
the following value:
sum (instances x weight x status)/
sum (instances x weight)

The resulting value is a number between 0 and 20 
that is translated to the closest status and represented 
by a colored icon.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: Information about the value of instances 
per status is provided by Business Process Insight. The 
weights are the rule parameters. The value for each 
status is calculated by the BPI Average Weighted 
Status rule.

The result of the rule calculation is: 
(20*1*0+15*1*5+5*1*10+10*1*15+1*1*20)/(20*1+15*1
+5*1+10*1+1*1)=5,784 -> 5 is the nearest status 
which is Major.

“OK weight” on 
page 645

“Warning 
Weight” on 
page 648

“Minor weight” 
on page 644

“Major weight” 
on page 644

“Critical 
weight” on 
page 642

Rule (Rule #) Description Parameters

Number of 
Instances

Weight Status

critical 20 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20
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BPI Business Health 
Status Rule 

(626)

Calculates the status of the Business Health KPI, 
based on the worst status of the business KPIs 
monitored by HP Business Process Insight for the 
process, and its children.

The monitored business KPIs are the following: 
Backlog, Duration, Business Impact, Value, and 
Volume. This can be modified in Admin > Platform > 
Setup and Maintenance > Infrastructure Settings 
Manager > Applications > Business Process Insight > 
List of Business KPIs.

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

BPI Duration Monitor 
Rule 

(608)

The rule calculates different results depending on the 
value of the logic parameter:

➤ logic = maximum. The maximum time it took for 
instances to pass through the monitored BPI Steps 
during the sampling period in Business Process 
Insight. 

➤ logic = minimum. The minimum time it took for 
instances to pass through the monitored BPI Steps 
during the sampling period in Business Process 
Insight.

➤ logic = average. Default. The average time it took 
for instances to pass through the monitored BPI 
Steps during the sampling period in Business 
Process Insight.

➤ logic = weighted_average. The total duration and 
the total weight values are sent by Business Process 
Insight. The weighted_average value displayed by 
the Duration KPI corresponds to: total weighted 
duration/total weight

By default, samples are sent every 15 minutes.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

“logic” on 
page 644

Rule (Rule #) Description Parameters
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BPI Group Rule for BP 
CI 

(619)

Propagates the value and status of the Backlog and 
Volume KPIs attached to the BPI Business Process 
Monitor CI to the Business Process CI.

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

BPI Group Rule for BP 
Step CI 

(621)

Propagates the value and status of the Backlog and 
Volume KPIs attached to the BPI BP Step Monitor CI 
to the Business Process Step CI.

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

Rule (Rule #) Description Parameters
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BPI Health Average 
Weighted Status 
Count Rule 

(614)

You can specify status weights using the rule 
parameters in the rule definition. The rule calculates 
the following value:
sum (instances x weight x status)/
sum (instances x weight)

The resulting value is a number between 0 and 20 
that is translated to the closest status and displayed as 
the color of the tooltip. 

A group bar displays the number of instances per 
instance status up to the Business Process CI level. 

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: The number of instances per BPI status and 
the BPI statuses are provided by Business Process 
Insight. The weight information is taken from the 
values of the rule parameters. The value for each 
status is calculated by the rule.

The result of the rule calculation is: 
(3*1*20 + 5*2*10 + 4*1*0)/(3*1+5*2+4*1) = 160/17 = 
9,411 which is converted into 10 = Minor Dashboard 
status and displayed in the tooltip.

The groupbar displays the following information:

“HealthyWeight
” on page 643

“AtRiskWeight” 
on page 642

“BlockedWeight
” on page 642

Rule (Rule #) Description Parameters

Number of 
Instances

Weight Status

Healthy 3 1 20

At Risk 5 2 10

Blocked 4 1 0
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BPI Health Average 
Weighted Status Value 
Rule 

(617)

You can specify status weights using the rule 
parameters in the rule definition. The rule calculates 
the following value:
sum (instances x weight x status)/
sum (instances x weight)

The resulting value is a number between 0 and 20 
that is translated to the closest status and displayed as 
the color of the tooltip. 

A group bar displays the sum of values of the 
instances per status up to the Business Process CI 
level.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: The number of instances per BPI status and 
the BPI statuses are provided by Business Process 
Insight. The weight information is taken from the 
values of the rule parameters. The cost for each status 
is calculated by the rule.

The result of the rule calculation is: 
(1000*1*20 + 1500*2*10 + 700*1*0)/
(1000*1+1500*2+700*1) = 10.63 which is converted 
into 10 = Minor Dashboard status.

The groupbar displays the following information:

“HealthyWeight
” on page 643

“AtRiskWeight” 
on page 642

“BlockedWeight
” on page 642

Rule (Rule #) Description Parameters

Sum of 
Value

Weight Status

Healthy $1000 1 20

At Risk $1500 2 10

Blocked $700 1 0
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BPI Health Group Rule 
for BP CIs 

(620)

Propagates the value and status of the Business 
Health KPIs attached to the BPI Monitor CIs to the 
Business Process CI.

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

BPI Health Status 
Percentage Count 
Rule 

(615)

The rule calculates the percentage of instances with a 
status equal or better than the status specified in the 
PassedStatus parameter of the rule, relative to the 
total number of instances in the sample; the status is 
derived from the objectives set for the rule. 

A group bar displays the sum of values of the 
instances per status up to the Business Process CI 
level.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: If PassedStatus is defined as 20 
(OK/Healthy), all instances with status 20 or more are 
PassedStatus instances. In the example, 10 instances 
match the criteria. The rule returns: 
(10)/(10+12+8)=25% which is then compared to the 
objectives and translated into a status.

“PassedStatus” 
on page 645

Rule (Rule #) Description Parameters

BPI Statuses from 
HP Business Process 
Insight

Number of 
Instances

Healthy (20 OK) 10

At Risk (10 Minor) 12

Blocked (0 Critical) 8
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BPI Health Status 
Percentage Value Rule 

(618)

The rule calculates the number of instances with a 
status equal or better than the status specified in the 
PassedStatus parameter of the rule, relative to the 
total number of instances in the sample; the status is 
derived from the objectives set for the rule. 

A group bar displays the sum of values per instance 
status up to the Business Process CI level.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: If PassedStatus is defined as 20 
(OK/Healthy), all instances with status 20 or more are 
PassedStatus instances. The rule returns: 
($1000)/(1000+5000+500)=15% which is then 
compared to the objectives and translated into a 
status.

“PassedStatus” 
on page 645

BPI Health Worst 
Process Instances 
Count Rule 

(613)

The samples sent by Business Process Insight, 
includes the number of instances for each status 
(Healthy, At Risk and Blocked), where the statuses are 
calculated by Business Process Insight. 

The rule searches for the worst status in the sample.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: If the sample contains instances with status:

➤ Blocked then the rule returns Critical status.

➤ At Risk then the rule returns Minor status.

If the sample contains instances with other statuses, 
the status returned is OK.

No parameters

Rule (Rule #) Description Parameters

BPI Statuses from 
HP Business 
Process Insight

Cost

Healthy (20 OK) $1000

At Risk (10 Minor) $5000

Blocked (0 Critical) $500
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BPI Health Worst 
Process Instances 
Value Rule 

(616)

The samples sent by Business Process Insight, 
includes the number of instances for each status 
(Healthy, At Risk and Blocked), where the statuses are 
calculated by Business Process Insight. 

The rule searches for the worst status in the sample.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: If the sample contains instances with status:

➤ Blocked and a non-zero value then the rule returns 
Critical status.

➤ At Risk and a non-zero value then the rule returns 
Minor status.

If the sample contains instances with other statuses, 
the status returned is OK.

No parameters

BPI Monitor Backlog 
Count Rule 

(604)

Calculates the number of instances that are currently 
passing through one of the following:

➤ One Business Process Step (when the Backlog KPI is 
assigned to a BPI Business Process Step Monitor 
CI).

➤ A group of BP Steps (when the Backlog KPI is 
assigned to a BPI Value Monitor, a BPI Duration 
Monitor, or a BPI Custom Monitor).

➤ A Business Process (when the Backlog KPI is 
assigned to a Business Process Monitor CI).

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

No parameters

Rule (Rule #) Description Parameters
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BPI Monitor Backlog 
Value Rule 

(605)

Calculates the value/cost of the instances that are 
currently passing through one of the following:

➤ One Business Process Step (when the Backlog KPI is 
assigned to a BPI Business Process Step Monitor 
CI).

➤ A group of BP Steps (when the Backlog KPI is 
assigned to a BPI Value Monitor, a BPI Duration 
Monitor, or a BPI Custom Monitor).

➤ A Business Process (when the Backlog KPI is 
assigned to a Business Process Monitor CI).

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

No parameters

BPI Monitor Volume 
Count Rule 

(606)

The sample contains the number of completed 
instances in the most recent collection interval.

Calculates the number of the instances in the sample, 
that completed passing through one of the following:

➤ One Business Process Step (when the Backlog KPI is 
assigned to a BPI Business Process Step Monitor 
CI).

➤ A group of BP Steps (when the Backlog KPI is 
assigned to a BPI Value Monitor, a BPI Duration 
Monitor, or a BPI Custom Monitor). 

➤ A Business Process (when the Backlog KPI is 
assigned to a Business Process Monitor CI). 

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

No parameters

Rule (Rule #) Description Parameters
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BPI Monitor Volume 
Value Rule 

(607)

Calculates the value/cost of the instances in the 
sample, that completed passing through one of the 
following:

➤ One Business Process Step (when the Backlog KPI is 
assigned to a BPI Business Process Step Monitor 
CI).

➤ A group of BP Steps (when the Backlog KPI is 
assigned to a BPI Value Monitor, a BPI Duration 
Monitor, or a BPI Custom Monitor). 

➤ A Business Process (when the Backlog KPI is 
assigned to a Business Process Monitor CI). 

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

No parameters

BPI Operational Status 
Rule 

(625)

Calculates the status of the Operational Status KPI, 
based on the worst status of the operational (non-
business) KPIs monitored by HP Business Process 
Insight for the process, and its children.

(The business KPIs are the following: Backlog, 
Duration, Business Impact, Value, and Volume. This 
can be modified in Admin > Platform > Setup and 
Maintenance > Infrastructure Settings Manager > 
Applications > Business Process Insight > List of 
Business KPIs.)

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

Rule (Rule #) Description Parameters
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BPI Status Percentage 
Rule for Duration KPI 

(624)

The rule calculates the percentage of instances with a 
status equal or better than the status specified in the 
PassedStatus parameter of the rule, relative to the 
total number of instances in the sample; the status is 
derived from the objectives set for the rule. 

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: If PassedStatus is defined as 10 (minor), all 
instances with status 10 or more are PassedStatus 
instances. In the following example, the instances 
that correspond to the criteria are: 1 instance with OK 
status, 10 instances with the warning status, and 5 
instances with the minor status. The rule returns: 
(1+10+5)/(1+10+5+15+10)=40%.

“PassedStatus” 
on page 645

Rule (Rule #) Description Parameters

Instances Weight Value

critical 10 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20
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BPI Status Percentage 
Rule for Value KPI 

(612)

The rule calculates the percentage of instances with a 
status equal or better than the status specified in the 
PassedStatus parameter of the rule, relative to the 
total number of instances in the sample; the status is 
derived from the objectives set for the rule. 

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

Example: If PassedStatus is defined as 10 (minor), all 
instances with status 10 or more are PassedStatus 
instances. In the following example, the instances 
that correspond to the criteria are: 1 instance with OK 
status, 10 instances with the warning status, and 5 
instances with the minor status. The rule returns: 
(1+10+5)/(1+10+5+15+10)=40%.

“PassedStatus” 
on page 645

Rule (Rule #) Description Parameters

Instances Weight Value

critical 10 1 0

major 15 1 5

minor 5 1 10

warning 10 1 15

OK 1 1 20



Chapter 19 • Business Rule Repository

598

BPI Value Monitor 
Rule 

(609)

The rule calculates different values/costs depending 
on the value assigned to the logic parameter:

➤ logic = maximum. The maximum value/cost of the 
instances that passed through the monitored BPI 
Steps during the sampling period in Business 
Process Insight. 

➤ logic = minimum. The minimum value/cost of the 
instances that passed through the monitored BPI 
Steps during the sampling period in Business 
Process Insight. 

➤ logic = average. Default. The average value/cost of 
the instances that passed through the monitored 
BPI Steps during the sampling period in Business 
Process Insight.

➤ logic = weighted_average. The total value and the 
total weight values are sent by Business Process 
Insight. The weighted_average value displayed by 
the Value KPI corresponds to: total weighted 
value/total weight. 

By default, samples are sent every 15 minutes.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

“logic” on 
page 644

BPI Worst Violated 
Instances Rule for 
Duration KPI 

(622)

The samples sent by Business Process Insight, 
includes the number of instances for each status 
(Minor, Major, and so on), where the statuses are 
calculated by Business Process Insight. 

The rule searches for the worst status in the sample.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

No parameters

BPI Worst Violated 
Instances Rule for 
Value KPI 

(610)

The samples sent by Business Process Insight, 
includes the number of instances for each status 
(Minor, Major, and so on), where the statuses are 
calculated by Business Process Insight. 

The rule searches for the worst status in the sample.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

No parameters

Rule (Rule #) Description Parameters
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BPM WS Operation 
Percentile 
Performance Rule 

(1307)

Calculates the percentile performance of a Web 
service operation defined as the percentage of calls 
that did not pass the Business Process Monitor 
threshold out of available calls.

The rule works as follows:

1  Sums the number of available calls into 
sumOfAvailableCalls. The calculation for each 
sample is: 
calls_count - error_count

2  Sums the number of calls that did not pass the 
SiteScope threshold into 
sumOfNotOverThresholdCalls. The calculation for 
each sample is: 
calls_count - error_count - 
over_threshold_server_time

3  The result is calculated as: 
(sumOfNotOverThresholdCalls x 100) / 
sumOfAvailableCalls
calls_count, error_count, and 
over_threshold_client_time are sample fields.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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BPM WS Operation 
Performance Rule 

(1306)

Calculates the performance of a Web service 
operation defined as the average client time (ms) of 
available calls. The average server time data is 
obtained from Business Process Monitor samples.

The rule works as follows:

1  Sums the number of available calls into 
sumOfAvailableCalls. The calculation for each 
sample is: 
calls_count - error_count

2  Sums the number of available calls into 
sumOfAvailableCallsTime. 

3  The result is calculated as: 
sumOfAvailableCallsTime/sumOfAvailableCalls
calls_count, error_count, and avg_server_time 
are sample fields.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Business Transaction 
Group Rule 

(1417)

Group rule for TransactionVision data. Assigns value 
and status to a Business Transaction CI by taking the 
value and status directly from the child TV Monitor 
CI. 

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

Customer Rule 

(12)

Displays the status of the worst KPI of all of the CI’s 
children.

This is a group rule. For details, see “Group Rules” on 
page 560.

No parameters

Rule (Rule #) Description Parameters
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Dashboard PNR Rule 

(351)

Produces status to be presented in the Dashboard, 
based on Point of No Return (PNR) samples (created 
by the corresponding internal SLM PNR). For details, 
see “Attach a PNR KPI to a CI – Scenario” on 
page 372. The status is displayed in bar form in the 
Dashboard tabs. The PNR samples measure 
unavailability in the period of time that has elapsed, 
and how much time remains before the agreement is 
in breach of contract.

This is a group rule. For details, see “Group Rules” on 
page 560.

How Dashboard calculates unavailability:

Service level agreements regularly include a clause 
covering unavailability, that is, the period of time 
that a system may be down. For example, if 
availability must be 98.5%, then a system may be 
unavailable 1.5% of the time. 

The Dashboard PNR Rule (the rule always assigned to 
the PNR KPI) calculates unavailability according to 
the target availability for the CI (the time that the 
component must be available, according to the SLA). 
This calculation is also based on the measurements 
for the Service Level Management Availability KPI 
that is attached to the CI when creating the SLA.

The following example shows how Dashboard 
calculates the time a system may be unavailable:

If unavailability reaches above this limit, Dashboard 
changes the status icon colors in the SLM tab.

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters

The start of the week is Monday, 8 Aug 05 00:00 AM.
Today is Friday 12 Aug 05 10:15 AM.
The time range is Week to Date.
The time interval is Business Hours, that is, 8:00 AM to 5:00 
PM, Monday to Friday.
The time that has passed for this time range is:
4 whole days (Monday to Thursday) = 4 x 9 = 36 hours.
Part of a day (Friday) = 8:00 AM - 10.15 AM = 2.25 hours.
Total time = 38.25 hours.
Availability (as defined in SLA) = 98.5%
Availability, therefore, must be 98.5% x 38.25 = 37.68 hours.
Maximum unavailability = 38.25-37.68 = 0.57 hours.
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Diagnostics for 
J2EE/.Net General 

(1075)

Calculates the status of the HP Diagnostics 
Application KPI based on the worst of all statuses 
from the J2EE rules calculations. For more details on 
Diagnostics for J2EE/.Net, see the HP Diagnostics 
documentation.

This is both a monitor and group rule. For details, see 
“Monitor Rules and Group Rules” on page 559.

“No data 
timeout” on 
page 644

Diagnostics WS 
Operation Percentile 
Performance Rule 

(1302)

Calculates the percentile performance of a Web 
service operation defined as the percentage of calls 
that did not pass the diagnostics threshold out of 
available calls.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

The rule works as follows:

1  Sums the number of available calls into 
sumOfAvailableCalls. The calculation for each 
sample is: 
calls_count - error_count

2  Sums the number of calls that did not pass the 
diagnostics threshold into 
sumOfNotOverThresholdCalls. The calculation for 
each sample is: 
calls_count - error_count - 
over_threshold_server_time

3  The result is calculated as: 
(sumOfNotOverThresholdCalls x 100) / 
sumOfAvailableCalls
calls_count, error_count, and 
over_threshold_server_time are sample fields.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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Diagnostics WS 
Operation 
Performance Rule 

(1301)

Calculates the performance of a Web service 
operation defined as the average server time (ms) of 
available calls. The average server time data is 
obtained from diagnostics samples.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

The rule works as follows:

1  Sums the number of available calls into 
sumOfAvailableCalls. The calculation for each 
sample is: 
calls_count - error_count

2  Sums the server time of available calls into 
sumOfAvailableCallsTime.

3  The result is calculated as: 
sumOfAvailableCallsTime / sumOfAvailableCalls
calls_count, error_count, and avg_server_time are 
sample fields.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Diagnostics WS 
Operation 
Throughput Rule 

(1303)

Calculates the throughput of a Web service operation 
defined as the total number of calls divided by the 
time frame. The total number of calls is obtained 
from the Diagnostics sample. The time frame is 
defined in minutes, each time the rule is calculated 
according to the following formula: number of 
samples in the sample container x sample aggregative 
time. The aggregative sample time is 5 minutes.This is 
a monitor rule. For details, see “Monitor Rules” on 
page 559.

The rule works as follows:

1  Sums the calls_count filed into sumOfTotalCalls.
sumOfTotalCalls / (sampleContainerSize x 5)

2  The result is calculated as:
calls_count is a sample field.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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EMS Simple Rule 

(0)

Takes the KPI status arriving from the EMS system 
through SiteScope and displays it as is.

Use this rule to display SiteScope status as is, if your 
EMS monitor is measurement-based.

If your EMS monitor is event-based, use the EMS 
Multiple Events Rule. For details, see “SiteScope EMS 
Multiple Events Rule” on page 624.

This is both a monitor and group rule. For details, see 
“Monitor Rules and Group Rules” on page 559.

“No data 
timeout” on 
page 644

“Number of 
Problematic 
Samples” on 
page 645

“Total Number 
of Samples” on 
page 648

Generic Formula Rule 

(1510)

Use this rule to add new business logic behavior to 
Dashboard.

You can use the rule to create a set of calculation 
methods (sum, count, average, and so on) that can be 
applied to every type of sample: legacy (SiteScope, 
Business Process Monitor, and Real User Monitor) 
and Enterprise Management Systems (EMS) samples.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

For details on how the rule works, see 
“Understanding the Generic Formula Rule” on 
page 566. 

For a detailed example of how to create a customized 
Generic Formula rule, see “Example – Write a Generic 
Formula Rule” on page 569.

“Formula” on 
page 643

“duration” on 
page 642

“Time stamp 
field” on 
page 648

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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Generic Sample Rule 

(21)

Use this rule to create a customized rule. The rule 
compares the value of a selected field from a sample 
to the objectives and returns the result of the 
comparison.

The tooltip of the Generic Sample Rule is empty.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

To use the Generic Sample Rule, you must first 
customize the rule, and then attach the rule to a KPI, 
and then attach the KPI to a view. The KPI 
automatically propagates the rule selected in the 
Default Rule list to all of the CI parents.

For a detailed example of how to create a customized 
Generic Sample Rule, see “Create a Customized 
Generic Sample Rule – Scenario” on page 571.

“No data 
timeout” on 
page 644

“Field name” on 
page 643

“Time stamp 
field” on 
page 648

Generic Sum of Values 
Over Time Rule 

(1501)

Use this rule to create a customized rule. The rule 
adds the values of the selected sample field for all of 
the samples that arrive during the time period 
specified in the duration parameter.

The tooltip for the Generic Sum of Value Over Time 
Rule is empty.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

To use the Generic Sum of Values Over Time rule, you 
must first customize the rule, and then attach the 
rule to a KPI, and then attach the KPI to a view. The 
KPI automatically propagates the rule selected in the 
Default Rule list to all of the CI parents. 

For a detailed example of how to create a customized 
Generic Sum of Values Over Time rule, see “Create a 
Customized Generic Sum of Values Over Time Rule – 
Scenario” on page 573.

“No data 
timeout” on 
page 644

“Field name” on 
page 643

“Time stamp 
field” on 
page 648

“duration” on 
page 642

Rule (Rule #) Description Parameters
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Generic Two 
Arguments Rule 

(1500)

Use this rule to perform a specific calculation based 
on the values of two specific fields. The calculation is 
performed as follows: calculate a value based on an 
operation (specified by the arithmetic operator) and 
two fields that are the sample's keys, multiply the 
result by a factor, and then compare the result with 
specified objectives.

You must create a KPI and attach the Generic Two 
Arguments Rule rule to that KPI.

The tooltip for the Generic Two Arguments Rule is 
empty.

This is a monitor rule. For details, see “Monitor 
Rules” on page 559.

For a detailed example of how to create a customized 
Generic Two Arguments rule, see “Use the Generic 
Two Arguments Rule – Scenario” on page 575.

“No data 
timeout” on 
page 644

“First Field 
Name” on 
page 643

“Second Field 
Name” on 
page 647

“Operator” on 
page 645

“Time stamp 
field” on 
page 648

“Factor” on 
page 643

Rule (Rule #) Description Parameters
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HP OpenView Service 
Navigator Rule 

(22)

Calculates the KPI status based on metrics collected 
from UDX event samples or old format HP OpenView 
samples for an HP OpenView Service Navigator 
measurement CI. 

Status is assigned according to the following values:

This is both a monitor and group rule. For details, see 
“Monitor Rules and Group Rules” on page 559.

“Time stamp 
field” on 
page 648

“Number of 
Problematic 
Samples” on 
page 645

“Total Number 
of Samples” on 
page 648

HP Worst Child Rule 

(23)

Calculates the status for the HP System KPI based on 
the worst status held by any of the child CIs. 

For example, if at least one child CI in a group has red 
status, then the parent CI of the group also displays 
red status.

This is a group rule. For details, see “Group Rules” on 
page 560.

“InitStatus” on 
page 643

Rule (Rule #) Description Parameters

KPI Status
Value for an 
HP Sample

Value for 
an old 
format HP 
OpenView 
Sample

Uninitialized 0 0

Informational 1 10

Warning 2 20

Minor 3 30

Major 4 40

Critical 5 50
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Impact Over Time Rule 

(24)

Calculates the financial loss due to non-availability 
over time. 

The non-availability period starts when the status of 
the Availability KPI changed to Critical (red) status 
until the current time. The financial loss for the CI is 
calculated by multiplying the total Critical period by 
an hourly $ amount (defined by the 
DollarImpactFactor parameter for the rule) and 
dividing by 60. The financial loss indication changes 
from green to red when the figure passes the 
objectives defined in the DollarImpactThreshold 
parameter for the rule.

At the monitor level, attach the Impact Over Time 
rule to the OT Impact KPI and the Availability KPI to 
the same CI. The Impact Over Time rule measures the 
time the Availability KPI attached to the same CI has 
the red status, and then calculates the financial loss 
using the rule parameter: DollarImpactFactor. This 
parameter represents the amount of dollars lost in an 
hour if the system is unavailable. If the Availability 
KPI status is not red, then the Real Time Impact value 
is $0.0.

At the group level, attach the Sum of Values rule to 
the RT Impact KPI. The Sum of Values rule 
summarizes all of the values of the Real Time Impact 
KPI of its children.

This is a group rule. For details, see “Group Rules” on 
page 560.

“DollarImpactFa
ctor.”

“StatusDimensio
n” on page 648

Rule (Rule #) Description Parameters
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Locations Grouped 
Parent Rule 

(1110)

When a SAP System CI or a Siebel Enterprise CI has 
Locations group child CIs, the rule uses the results of 
the Locations Grouped rule for each child CI and 
calculates and displays the sum of each status. 

For each result, the tooltip displays the amount of 
children for each status.

This is both a monitor and group rule. For details, see 
“Monitor Rules and Group Rules” on page 559.

Example: If a CI has three child CIs, the Locations 
Parent Group rule summarizes the bars for its 
children. The rule aggregates the bars calculated by 
the Locations Grouped Rule for all of the children 
into one bar. The tooltip displays for each status how 
many children have that specific status.

“Time stamp 
field” on 
page 648

“duration” on 
page 642

Rule (Rule #) Description Parameters
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Locations Grouped 
Rule 

(1105)

For a Locations group CI with child CIs, the rule 
selects the worst status of Performance and 
Availability for each child CI, calculates the sum of 
children with each specific status and displays that 
information in a bar. 

The tooltip displays for each status the sum of all of 
the CI’s children with that status.

This is both a monitor and group rule. For details, see 
“Monitor Rules and Group Rules” on page 559.

Example: The rule calculates the status of the 
Locations CI by taking for each child the worst status 
of Performance and Availability. It then calculates the 
sum of children with each specific status and displays 
that information in a bar:

“No data 
timeout” on 
page 644

“duration” on 
page 642

Rule (Rule #) Description Parameters



Chapter 19 • Business Rule Repository

611

Number of Open 
Incidents 

(2600)

Returns the total number of incidents whose current 
state is the state specified in the Initial State 
parameter and whose severity is lower or equal to the 
value specified in the Severity parameter.

Incidents whose current state corresponds to the Final 
State or whose Severity is higher than the value 
specified in the Severity parameter are not included 
in the calculation.

This is both a monitor and group rule. For details, see 
“Monitor Rules and Group Rules” on page 559.

“Initial State” 
on page 643

“Final State” on 
page 643

“Severity” on 
page 648

Number of Running 
Sessions Rule 

(1107)

The rule receives the number of sessions from the 
SiteScope Number of Running Sessions measurement 
and compares that result with the objectives set for 
the rule. The result is the number of running sessions 
colored according to the objectives set for the rule. 
This rule is used by the HP Business Availability 
Center for Siebel Applications solution.

This is both a monitor and group rule. For details, see 
“Monitor Rules and Group Rules” on page 559.

“No data 
timeout” on 
page 644

Number of Tasks in 
Error Rule 

(1101)

The rule receives the value of SiteScope Number of 
Tasks in Error measurement and compares that result 
with the objectives set for the rule. The result is the 
number of tasks in error colored according to the 
objectives set for the rule. This rule is used by the 
HP Business Availability Center for Siebel 
Applications solution.

This is a group rule. For details, see “Group Rules” on 
page 560.

“No data 
timeout” on 
page 644

Percentage Rule 

(17)

Calculates the weighted average of the statuses of all 
of the children. The result is in percentages.

This is a group rule. For details, see “Group Rules” on 
page 560.

For details on understanding the rule, see 
“Understanding the Percentage Rule” on page 562.

No parameters

Rule (Rule #) Description Parameters
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Real Time Impact 

(19)

Calculates financial loss due to non-availability. 

The non-availability period starts the last time the 
status of the CI Availability KPI changed to Critical 
(red) status to the current time. The financial loss for 
the CI is calculated by multiplying the total Critical 
period by an hourly $ amount (defined by the 
DollarImpactFactor parameter for the rule) and 
dividing by 60.

At the monitor/leaf level, you should attach the Real 
Time Impact rule to the RT impact KPI and the 
Availability KPI to the same CI. The Real Time Impact 
rule measures the time the Availability KPI attached 
to the same CI has the red status, and then calculates 
the financial loss using the rule parameter: 
DollarImpactFactor. This parameter represents the 
amount of dollars lost in an hour if the system is 
unavailable. If the Availability KPI status is not red, 
then the Real Time Impact value is 0.0$.

At the group level, you should attach the Sum of 
Values rule to the RT Impact KPI. The Sum of Values 
rule calculates the sum of all of the values of the Real 
Time Impact KPI of its children.

The financial loss indication changes from green to 
red when the figure passes the threshold defined in 
the DollarImpactThreshold parameter for the rule. 

This is a group rule. For details, see “Group Rules” on 
page 560.

“DollarImpactFa
ctor” on 
page 642

“StatusDimensio
n” on page 648

Rule (Rule #) Description Parameters
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RUM Application 
Session Statistics 
Monitor Availability 
Rule 

(56)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule calculates the result as follows: 
100% x (total number of active sessions - number of 
active sessions with availability events)/total number 
of active sessions. If more than one sample is used for 
the calculation, the sum is weighted, where the 
weight is the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

RUM Application 
Session Statistics 
Monitor Performance 
Rule 

(66)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule calculates the result as follows: 
100% x (total number of active sessions - number of 
active sessions with performance events)/total 
number of active sessions. If more than one sample is 
used for the calculation, the sum is weighted, where 
the weight is the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

Rule (Rule #) Description Parameters



Chapter 19 • Business Rule Repository

614

RUM Application 
Session Statistics 
Monitor Volume Rule 

(76)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule displays the volume, which is 
the number of active sessions. A session is considered 
as active if it was created before the beginning of the 
aggregation interval, or during the aggregation 
interval, or if it was closed during the aggregation 
interval. If more than one sample is used for the 
calculation the total volume is the sum of volumes of 
individual samples.

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

RUM End User 
Monitor Availability 
Rule 

(59)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule calculates the result as follows: 
100% x (total number of active sessions - number of 
active sessions with availability events)/total number 
of active sessions. If more than one sample is used for 
the calculation, the sum is weighted, where the 
weight is the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

Rule (Rule #) Description Parameters
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RUM End User 
Monitor Latency Rule 

(92)

Displays the average roundtrip time for a packet, 
between the end users and the server monitored by 
the Real User Monitor, during the time period 
specified by the duration parameter for the rule. 

If there are TCP measurements, they are used in the 
calculation; if there are only HTTP measurements, 
these are used.

The displayed status color represents the average 
value as follows:

➤ Red (>200)

➤ Yellow (<200)

➤ Green (<50)

The thresholds used by this rule are configured in 
System Availability Management.

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

“first_choice_sa
mple” on 
page 643

RUM End User 
Monitor Network Rule 

(91)

Calculates the network availability, based on 
successful TCP connections. Connection resets and 
timeouts are considered unsuccessful connections.

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

“first_choice_sa
mple” on 
page 643

Rule (Rule #) Description Parameters
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RUM End User 
Monitor Performance 
Rule 

(69)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule calculates the result as follows: 
100% x (total number of active sessions or 
connections - number of active sessions or 
connections with performance events)/total number 
of active sessions or connections.

If there are sessions in the sample, the sessions are 
used in the calculation; if the sample only includes 
connections, the connections will be used.

Performance of connections is calculated by the ratio 
of requests above threshold to total requests. The rule 
does not apply to applications that are TCP-
streaming.

If more than one sample is used for the calculation, 
the sum is weighted, where the weight is the total 
number of sessions or connections (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

“first_choice_sa
mple” on 
page 643

RUM End User 
Monitor Volume Rule 

(79)

Displays the total number of sessions or connections.

If there are sessions in the sample, the sessions are 
used in the calculation; if the sample only includes 
connections, the connections will be used.

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

“first_choice_sa
mple” on 
page 643

Rule (Rule #) Description Parameters
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RUM End User Session 
Statistics Monitor 
Availability Rule 

(57)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule calculates the result as follows: 
100% x (total number of active sessions - number of 
active sessions with availability events)/total number 
of active sessions. If more than one sample is used for 
the calculation, the sum is weighted, where the 
weight is the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

RUM End User Session 
Statistics Monitor 
Performance Rule 

(67)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule calculates the result as follows: 
100% x (total number of active sessions - number of 
active sessions with performance events)/total 
number of active sessions. If more than one sample is 
used for the calculation, the sum is weighted, where 
the weight is the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

Rule (Rule #) Description Parameters
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RUM End User Session 
Statistics Monitor 
Volume Rule 

(77)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule displays the volume, which is 
the number of active sessions. A session is considered 
as active if it was created before the beginning of the 
aggregation interval, or during the aggregation 
interval, or if it was closed during the aggregation 
interval. If more than one sample is used for the 
calculation, the sum is weighted, where the weight is 
the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

RUM Event Monitor 
Volume Rule 

(73)

Counts the total number of times that a defined 
event or error (monitored by the Real User Monitor) 
occurred during the time period specified by the 
duration parameter for the rule. 

The volumes for error have the following thresholds:

➤ Red (>7)

➤ Yellow (<7)

➤ Green (<1)

“duration” on 
page 642

“No data 
timeout” on 
page 644

RUM Location Session 
Statistics Monitor 
Availability Rule 

(58)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule calculates the result as follows: 
100% x (total number of active sessions - number of 
active sessions with availability events)/total number 
of active sessions. If more than one sample is used for 
the calculation, the sum is weighted, where the 
weight is the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

Rule (Rule #) Description Parameters
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RUM Location Session 
Statistics Monitor 
Performance Rule 

(68)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule calculates the result as follows: 
100% x (total number of active sessions - number of 
active sessions with performance events)/total 
number of active sessions. If more than one sample is 
used for the calculation, the sum is weighted, where 
the weight is the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

RUM Location Session 
Statistics Monitor 
Volume Rule 

(78)

Data aggregation is performed in the Real User 
Monitor server. Every 5 minutes a sample is sent to 
HP Business Availability Center. The rule’s 
calculations are based on the last sample received 
from the Real User Monitor server in the selected 
time period. The rule displays the volume, which is 
the number of active sessions. A session is considered 
as active if it was created before the beginning of the 
aggregation interval, or during the aggregation 
interval, or if it was closed during the aggregation 
interval. If more than one sample is used for the 
calculation, the sum is weighted, where the weight is 
the total number of sessions (volume).

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

“relevant_sampl
es” on page 646

“sample_group_
by_fields” on 
page 647

RUM Page Monitor 
Availability Rule 

(49)

Calculates (in percentage) the average availability for 
a page monitored by Real User Monitor, over the time 
period specified in the duration parameter for the 
rule. 

The thresholds for this rule are:

➤ Red (<90%)

➤ Orange (<100%)

➤ Green (=100%)

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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RUM Page Monitor 
Performance Rule 

(60)

Calculate the percentage of pages without 
performance problem (pages with page time over the 
threshold).

The thresholds for this rule are:

➤ Red (<90%)

➤ Orange (<100%)

➤ Green (=100%)

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

RUM Page Monitor 
Volume Rule 

(70)

Counts the total number of hits to a page monitored 
by Real User Monitor, during the time period 
specified by the duration parameter.

The volumes for error have the following thresholds:

➤ Red (>7)

➤ Yellow (<7)

➤ Green (<1)

“duration” on 
page 642

“No data 
timeout” on 
page 644

RUM Server Monitor 
Bandwidth Rule 

(84)

Displays the amount of traffic (in megabytes) 
between the application server and end users 
accessing the server (this includes traffic in both 
directions), during the time period specified by the 
duration parameter. 

If there are TCP measurements, they are used in the 
calculation; if there are only HTTP measurements, 
these are used.

“duration” on 
page 642

“No data 
timeout” on 
page 644

“sample_group_
by_fields” on 
page 647

“first_choice_sa
mple” on 
page 643

RUM Server Monitor 
Component 
Availability Rule 

(80)

Calculates the percentage of pages without server 
errors over the time period specified in the duration 
parameter for the rule, for a server monitored by the 
Real User Monitor.

The threshold for the rule are:

➤ Red (<90%)

➤ Orange (<100%)

➤ Green (=100%)

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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RUM Server Monitor 
Network Rule 

(90)

Calculates the network availability, based on 
successful TCP connections. Connection resets and 
timeouts are considered unsuccessful connections.

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

RUM Servers 
Summarized 
Bandwidth Rule 

(85)

Calculates the total bandwidth of child server CIs. No parameters

RUM Session Monitor 
Availability Rule 

(52)

Calculates the percentage of available sessions (out of 
the total number of sessions), over the time period 
specified in the duration parameter for the rule. A 
session is considered available when all its pages are 
available.

The thresholds for this rule are:

➤ Red (<90%)

➤ Orange (<100%)

➤ Green (=100%)

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

RUM Session Monitor 
Performance Rule 

(62)

Calculates the percentage of sessions that do not have 
a performance problem (out of the total number of 
sessions). A session is considered to have no 
performance problem when each one of its pages 
does not have a performance problem. A page is 
considered to have a performance problem when 
page time is over the threshold.

The thresholds for this rule are:

➤ Red (<90%)

➤ Orange (<100%)

➤ Green (=100%)

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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RUM Session Monitor 
Volume Rule 

(72)

Adds the total number of sessions started for an 
application in the past 24 hours, the total number of 
users starting a session in the past 24 hours, and the 
number of sessions that were closed in the time 
period specified by the duration parameter for the 
rule, for sessions monitored by Real User Monitor.

The volumes for error have the following thresholds:

➤ Red (>7)

➤ Yellow (<7)

➤ Green (<1)

“duration” on 
page 642

“No data 
timeout” on 
page 644

RUM Transaction 
Monitor Availability 
Rule 

(51)

Calculates the percentage of available transactions 
(out of the total number of transactions), over the 
time period specified in the duration parameter for 
the rule. A transaction is considered available when 
all pages accessed by the transaction are available.

The thresholds for this rule are:

➤ Red (<90%)

➤ Orange (<100%)

➤ Green (=100%)

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

RUM Transaction 
Monitor Performance 
Rule 

(61)

Calculates the percentage of transactions (out of the 
total number of transactions) that do not have pages 
with a performance problem. A page is considered to 
have a performance problem when page time is over 
the threshold.

The thresholds for this rule are:

➤ Red (<90%)

➤ Orange (<100%)

➤ Green (=100%)

“volumeKPI” on 
page 648

“duration” on 
page 642

“No data 
timeout” on 
page 644

RUM Transaction 
Monitor Volume Rule 

(71)

Counts the total number of times that a transaction 
monitored by Real User Monitor was completed, 
during the time period specified by the duration 
parameter for the rule.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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SAP Alerts Rule 

(1111)

Displays the SAP samples from SiteScope as is. The 
SAP Alerts include the name of the alert and its status.

HP Business Availability Center displays two types of 
SAP Alerts: 

➤ Dialog alerts under a Dialog work process

➤ Syslog alerts under a SAP R/3 server. 

The status of an alert is displayed by the color of the 
SAP alert KPI (red or yellow), assigned by the SAP 
system. For details on the colors, see “KPI Status” on 
page 355.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Service Level 
Management Tracking 
Period Alert 

(361)

This is an internal rule that is used to send alerts to 
Service Level Management.

“tracking period 
id” on page 648

“No data 
timeout” on 
page 644

Sessions Custom Data 
Rule 

(1106)

Calculates the number of running sessions for a CI 
and all its child CIs.

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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SiteScope EMS 
Multiple Events Rule 

(36)

The rule handles the samples sent to HP Business 
Availability Center by the EMS system. It aggregates 
all the samples received from a specified CI. The rule 
saves up to 10 events. If there are more than 10 
events, the rule discards samples with the lowest 
severity (critical is highest) and then the oldest 
samples.

If the CI has more than one KPI, you must define a 
SiteScope EMS Multiple Events rule for each KPI by 
using the rule parameters to specify the sample field 
you are interested in. Specify information about the 
field in the sample to look at (in the KPI Type field 
name parameter) and the value of that field (in the 
KPI type parameter). 

The EMS Clear Events context menu, Clear Events 
context menu item and EMS Sentence tooltip are 
used to display the data retrieved from the HP 
Operations Manager system. For details, see “EMS 
Show Events” on page 705, “Show Events” on 
page 765, and “EMS Sentence” on page 839. The 
Clear Events context menu item is used to clear 
events in Dashboard.

“No data 
timeout” on 
page 644

Max tooltip 
events. The 
maximum 
number of 
events to show 
in the tooltip. 
The maximum 
is 10.

KPI type field 
name. The name 
of the field in 
the sample.

KPI type. The 
valid value of 
the field in the 
sample

SiteScope 
Measurement Rule 

(3)

Calculates the status based on metrics for a SiteScope 
measurement CI for sampleType: ss_t, monitored by 
the SiteScope Monitor. The following statuses 
correspond to the following values:

➤ Informational (1)

➤ Middle (2)

➤ Critical (3)

For details on the sample, see “Sample: SiteScope 
Measurement (ss_t)” in Reference Information.

“No data 
timeout” on 
page 644

“Number of 
Problematic 
Samples” on 
page 645

“Total Number 
of Samples” on 
page 648

Rule (Rule #) Description Parameters
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SiteScope 
Measurement Siebel 
Processes Rule 

(1104)

Calculates the status based on metrics for a SiteScope 
measurement CI for time sampleType: ss_t, 
monitored by the SiteScope Monitor. The following 
statuses correspond to the following values:

➤ Informational (1)

➤ Middle (2)

➤ Critical (3)

The value displayed corresponds to the number of 
processes. The color of the value is determined by the 
thresholds on the number of sessions (which can be 
25, 64, and so on).

For details on the sample, see “Sample: SiteScope 
Measurement (ss_t)” in Reference Information.

“No data 
timeout” on 
page 644

SiteScope 
Measurement Time-
Based Rule 

(33)

Calculates the status based on metrics for a SiteScope 
measurement CI for time sampleType: ss_t, 
monitored by the SiteScope Monitor. The following 
statuses correspond to the following values:

➤ Informational (1)

➤ Middle (2)

➤ Critical (3)

For details on the sample, see “Sample: SiteScope 
Measurement (ss_t)” in Reference Information.

“duration” on 
page 642

“No data 
timeout” on 
page 644

SiteScope 
Measurement with 
Custom Data Rule 

(1100)

Displays the number of tasks that are in error taken 
from the SiteScope samples with sub-samples listing 
all of the tasks. 

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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SiteScope Monitor 
Rule 

(4)

Calculates the status based on metrics for a SiteScope 
measurement CI for time sampleType: ss_monitor_t, 
monitored by the SiteScope Monitor. The following 
statuses correspond to the following values:

➤ Informational (1)

➤ Middle (2)

➤ Critical (3)

For details on the sample, see “Sample: SiteScope 
Monitor (ss_monitor_t)” in Reference Information.

“No data 
timeout” on 
page 644

“Number of 
Problematic 
Samples” on 
page 645

“Total Number 
of Samples” on 
page 648

SiteScope Monitor 
Time-Based Rule 

(34)

Calculates the status based on metrics for a SiteScope 
measurement CI for time sampleType: ss_monitor_t, 
monitored by the SiteScope Monitor. The following 
statuses correspond to the following values:

➤ Informational (1)

➤ Middle (2)

➤ Critical (3)

For details on the sample, see “Sample: SiteScope 
Monitor (ss_monitor_t)” in Reference Information.

“duration” on 
page 642

“No data 
timeout” on 
page 644

SiteScope Profile Rule 

(35)

Calculates the status of the SiteScope Availability KPI. 
SiteScope periodically (every minute) sends an out bit 
to HP Business Availability Center. If the out bit is 
received by HP Business Availability Center, the 
status of the SiteScope Availability KPI is green. If the 
out bit is not received, the status of the SiteScope 
Availability KPI is grey (No data). This indicates that 
there is no communication between SiteScope and 
HP Business Availability Center. The statuses of all 
the SiteScope CIs is also grey. 

Note: The SiteScope Availability KPI displays values 
for the supported versions of SiteScope (9.0 and up) 
and of HP Business Availability Center (7.0 and up).

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters



Chapter 19 • Business Rule Repository

627

SiteScope Vertical 
Measurement 

(1102)

Takes samples arriving from the Computer Center 
Management System (CCMS) monitor through 
SiteScope and displays them, as is, under SAP KPIs. It 
also takes samples from Siebel Application Server or 
Siebel Web Server monitors and displays them as is 
under Siebel KPIs.

“No data 
timeout” on 
page 644

SiteScope Vertical Rule 

(1108)

Takes samples arriving from the Computer Center 
Management System (CCMS) monitor through 
SiteScope and displays them as is under the SAP KPI. 
The status is taken from the SAP Quality field, the 
message from the SAP Message field, and the value 
from the SAP d_value field. It also takes samples from 
Siebel Application Server or Siebel Web Server 
monitors and displays them as is under Siebel KPIs.

“No data 
timeout” on 
page 644

“Number of 
Problematic 
Samples” on 
page 645

“Total Number 
of Samples” on 
page 648

SiteScope WS 
Operation Percentile 
Performance Rule 

(1305)

Calculates the percentile performance of a Web 
service operation defined as the percentage of calls 
that did not pass the SiteScope threshold out of 
available calls.

The rule works as follows:

1  Sums the number of available calls into 
sumOfAvailableCalls. The calculation for each 
sample is: 
calls_count - error_count

2  Sums the number of calls that did not pass the 
SiteScope threshold into 
sumOfNotOverThresholdCalls. The calculation for 
each sample is: 
calls_count - error_count - 
over_threshold_server_time

3  The result is calculated as: 
(sumOfNotOverThresholdCalls x 100) / 
sumOfAvailableCalls
calls_count, error_count, and 
over_threshold_client_time are sample fields.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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SiteScope WS 
Operation 
Performance Rule 

(1304)

Calculates the performance of a Web service 
operation defined as the average client time (ms) of 
available calls. The average server time data is 
obtained from SiteScope samples.

The rule works as follows:

1  Sums the number of available calls into 
sumOfAvailableCalls. The calculation for each 
sample is: 
calls_count - error_count

2  Sums the number of available calls into 
sumOfAvailableCallsTime. 

3  The result is calculated as: 
sumOfAvailableCallsTime/sumOfAvailableCalls
calls_count, error_count, and avg_server_time 
are sample fields.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Sum of Open 
Incidents 

(2601)

Calculates the sum of all the incidents of the children 
in the group.

No parameters

Rule (Rule #) Description Parameters
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Sum of Values Rule 

(20)

Calculates the total of the dollar loss (as calculated by 
Real Time Impact or Over Time Impact) of all of the 
child CIs of the KPI the rule is attached to. 

This rule calculates the sum total for all child CIs in 
the KPI it is attached to. Based on: Sum of the values 
of the children in the group.

If you add the Impact Over Time and/or Real Time 
Impact rules to the child CIs of a KPI; at the group 
level you can use the Sum of Values rule to view the 
sum of the children’s values.

At the monitor/leaf level, you should attach the 
Impact Over Time rule to the OT Impact KPI and the 
Availability KPI to the same CI. The Impact Over 
Time rule measures the total time the Availability KPI 
attached to the same CI has the red status, and then 
calculates the financial loss using the rule parameter: 
DollarImpactFactor. This parameter represents the 
amount of dollars lost in an hour if the system is 
unavailable.

At the group level, you should attach the Sum of 
Values rule to the OT impact KPI. The Sum of Values 
rule calculates the sum of all of the values of the 
OverTime Impact KPI of its children.

No parameters

Sum of Volume Rule 

(74)

Group rule that calculates the sum of the users 
accessing a page or encountering an error on a page.

No parameters

Summary of Values 

(30)

Calculates the sum of the children’s values. No parameters

Transaction 
Availability Rule 

(5)

Calculates how many Business Process Monitor 
transactions ran successfully during the time period 
specified by the duration parameter.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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Transaction 
Performance Rule 

(13)

Calculates the average response time of the Business 
Process Monitor transactions that ran during the time 
period specified by the duration parameter.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Transaction 
Performance Status 
Average Rule 

(101)

This rule automatically replaces the Transaction 
Performance rule attached to a Performance KPI, 
when Baselining is activated. For details on 
Baselining, see “Baselines” in Using End User 
Management.

The rule compares the response times of the Business 
Process Monitor transactions that ran during the 
sampling period specified by the duration parameter, 
compares them to the baseline threshold to obtain a 
status, and then calculates the average status 
weighted by the values specified in Critical weight, 
Minor weight, and OK weight. If one of those 
weights is set to 0, the status is not included in the 
calculation of the average. If the weight is negative, it 
is considered to be 1. By default, the weights are set to 
1.

This rule replaces the Transaction Performance Rule 
assigned to a Performance KPI, when you change the 
mode to Baselining.

Note: If you assign this rule to a KPI when Baselining 
is not in use, the KPI does not display data.

“duration” on 
page 642

“No data 
timeout” on 
page 644

“Critical 
weight” on 
page 642

“Minor weight” 
on page 644

“OK weight” on 
page 645

Rule (Rule #) Description Parameters



Chapter 19 • Business Rule Repository

631

Transaction 
Performance Status 
Percentage Rule 

(102)

This rule can be attached manually to a Performance 
KPI when Baselining is activated. For details on 
Baselining, see “Baselines” in Using End User 
Management

The rule compares the response times of the Business 
Process Monitor transactions that ran during the 
sampling period specified by the duration parameter, 
compares them to the baseline threshold to obtain a 
status, calculates the number of transactions with an 
OK response time relative to the total number of 
transactions, compares this information with the rule 
objectives, and returns a status. 

If GROUPTEXT format is used for the KPI, then the 
value of the percentage is displayed. For details on 
GROUPTEXT, see “KPI Details Dialog Box” on 
page 539.

Note: If you assign this rule to a KPI when Baselining 
is not in use, the KPI does not display data.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Transaction 
Performance Worst 
Status Rule 

(100)

This rule can be attached manually to a Performance 
KPI when Baselining is activated. For details on 
Baselining, see “Baselines” in Using End User 
Management

The rule calculates the worst response time of the 
Business Process Monitor transactions that ran during 
the sampling period specified by the duration 
parameter and compares it to the baseline threshold 
and returns the resulting status.

Note: If you assign this rule to a KPI when Baselining 
is not in use, the KPI does not display data.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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Transactions Grouped 
Parent Rule 

(1109)

When a SAP System CI or a Siebel Enterprise CI has 
Transactions group child CIs, the rule uses the results 
of the Transactions Grouped rule for each child of the 
CI and calculates and displays the sum of each status. 

For each result, the tooltip displays how many of the 
children have a critical status, how many have the OK 
status, and so on.

Example: If the CI has three child CIs, the 
Transactions Parent Group rule summarizes the bars 
for its children. The rule aggregates the bars 
calculated by the Transactions Grouped rule for all of 
the children into one bar. The tooltip displays for 
each status how many children have that specific 
status:

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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Transactions Grouped 
Rule 

(1103)

For a Transactions group CI with child CIs, the rule 
selects the worst of Performance and Availability for 
each child CI, calculates the sum of children with 
each specific status and displays the information in a 
bar. 

The tooltip displays for each status the sum of all of 
the CI’s children with that status.

Example: 
 

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters



Chapter 19 • Business Rule Repository

634

TransactionVision 
Backlog Rule (In-
Process)

(1426)

Assigns status to a TV Monitor CI based on the 
number of backlogged (in-process) transactions in 
TransactionVision. The number is taken from the last 
arrived sample.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

TransactionVision 
Delayed Rate Rule 
(Completed 
Transactions)

(1411)

Calculates status for a TV Monitor CI based on the 
percentage of late completed transactions out of the 
total completed transactions. The values are taken 
from the last arrived sample from TransactionVision.

Transactions are defined as "late" in 
TransactionVision when their response time exceeded 
the defined threshold in TransactionVision. 

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

TransactionVision 
Delayed Rate Rule (In-
Process Transactions)

(1421)

Calculates status for a TV Monitor CI based on the 
percentage of late in-process transactions out of the 
total in-process transactions. The values are taken 
from the last arrived sample from TransactionVision.

Transactions are defined as "late" in 
TransactionVision when their response time exceeded 
the defined threshold in TransactionVision. 

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

Rule (Rule #) Description Parameters
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TransactionVision 
Delayed Value Rule 
(Completed 
Transactions)

(1412)

Assigns status to a TV Monitor CI based on the 
monetary value of the late completed transactions. 
The value is taken from the last arrived sample from 
TransactionVision.

Transactions are defined as "late" in 
TransactionVision when their response time exceeded 
the defined threshold in TransactionVision. 

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

TransactionVision 
Delayed Value Rule 
(In-Process 
Transactions)

(1422)

Assigns status to a TV Monitor CI based on the 
monetary value of the late in-process transactions. 
The value is taken from the last arrived sample from 
TransactionVision.

Transactions are defined as "late" in 
TransactionVision when their response time exceeded 
the defined threshold in TransactionVision. 

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

Rule (Rule #) Description Parameters
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TransactionVision 
Duration Rule 
(Completed 
Transactions)

(1410)

Calculates status for a TV Monitor CI based on the 
average response time (in seconds) for successful, 
completed transactions in TransactionVision. The 
values for the calculation are taken from the last 
arrived sample.

The objective for OK status is taken from the 
Duration threshold set in TransactionVision. 
Objectives for other statuses must be defined in the 
Admin > Dashboard > KPIs tab.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

No parameters

TransactionVision 
Exceptions Rate Rule 
(Completed 
Transactions)

(1414)

Calculates status for a TV Monitor CI based on the 
percentage of completed transactions marked as 
exceptions, out of the total completed transactions. 
The values are taken from the last arrived sample 
from TransactionVision.

Transactions are defined as "exceptions" by 
TransactionVision when they did not follow the 
expected flow path on the target machine.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

Rule (Rule #) Description Parameters
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TransactionVision 
Exceptions Rate Rule 
(In-Process 
Transactions)

(1424)

Calculates status for a TV Monitor CI based on the 
percentage of in-process transactions marked as 
exceptions, out of the total in-process transactions. 
The values are taken from the last arrived sample 
from TransactionVision.

Transactions are defined as "exceptions" by 
TransactionVision when they did not follow the 
expected flow path on the target machine.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

TransactionVision 
Exceptions Value Rule 
(Completed 
Transactions)

(1413)

Calculates status for a TV Monitor CI based on the 
monetary value of completed transactions marked as 
exceptions. The value is taken from the last arrived 
sample from TransactionVision.

Transactions are defined as "exceptions" by 
TransactionVision when they did not follow the 
expected flow path on the target machine.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

Rule (Rule #) Description Parameters
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TransactionVision 
Exceptions Value Rule 
(In-Process 
Transactions)

(1423)

Calculates status for a TV Monitor CI based on the 
monetary value of in-process transactions marked as 
exceptions. The value is taken from the last arrived 
sample from TransactionVision.

Transactions are defined as "exceptions" by 
TransactionVision when they did not follow the 
expected flow path on the target machine.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

TransactionVision 
Failures Rate Rule 
(Completed 
Transactions)

(1418)

Calculates status for a TV Monitor CI based on the 
percentage of failed completed transactions out of the 
total completed transactions. The values are taken 
from the last arrived sample from TransactionVision.

Transactions are classified as "failed" when they 
match the attribute or pattern defined as failure in 
TransactionVision. 

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

Rule (Rule #) Description Parameters
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TransactionVision 
Failures Rate Rule (In-
Process Transactions)

(1428)

Calculates status for a TV Monitor CI based on the 
percentage of failed in-process transactions out of the 
total completed transactions. The values are taken 
from the last arrived sample from TransactionVision.

Transactions are classified as "failed" when they 
match the attribute or pattern defined as failure in 
TransactionVision. 

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

TransactionVision 
Failures Value Rule 
(Completed 
Transactions)

(1419)

Assigns status to a TV Monitor CI based on the 
monetary value of the failed completed transactions. 
The value is taken from the last arrived sample from 
TransactionVision.

Transactions are classified as "failed" when they 
match the attribute or pattern defined as failure in 
TransactionVision. 

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

Rule (Rule #) Description Parameters
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TransactionVision 
Failures Value Rule (In-
Process Transactions)

(1429)

Assigns status to a TV Monitor CI based on the 
monetary value of the failed in-process transactions. 
The value is taken from the last arrived sample from 
TransactionVision.

Transactions are classified as "failed" when they 
match the attribute or pattern defined as failure in 
TransactionVision. 

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

TransactionVision 
Completed 
Transaction Value Rule 

(1415)

Assigns status to a TV Monitor CI based on the 
monetary value of the completed transactions. The 
value is taken from the last arrived sample from 
TransactionVision.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

TransactionVision 
Value Rule (In-Process 
Transaction)

(1425)

Assigns status to a TV Monitor CI based on the 
monetary value of the in-process transactions. The 
value is taken from the last arrived sample from 
TransactionVision.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

Rule (Rule #) Description Parameters



Chapter 19 • Business Rule Repository

641

TransactionVision 
Transaction Volume 
Rule 

(1416)

Assigns status to a TV Monitor CI based on the 
number of completed transactions in 
TransactionVision. The number is taken from the last 
arrived sample.

For details on TransactionVision data in Business 
Availability Center, see “TransactionVision Data” in 
Using TransactionVision.

Note: To see a status for the KPI, you must define 
meaningful objectives in the Admin > Dashboard > 
KPIs tab.

No parameters

Worst Child Rule 

(1)

Calculates the status based on the lowest status held 
by any of the child CIs. 

For example, if at least one child CI in a group has red 
status, then the parent CI of the group also displays 
red status.

No parameters

WS Operation 
Availability Rule 

(1300)

Calculates the availability of a Web service operation 
defined as the percentage of available calls out of 
total calls.

The rule works as follows:

1  Sums the calls_count field into sumOfTotalCalls.

2  Sums the number of available calls into 
sumOfAvailableCalls. The calculation for each 
sample is: 
calls_count - error_count

3  The result is calculated as:
(sumOfAvailableCalls x 100) / sumOfTotalCalls
calls_count and error_count are sample fields.

“duration” on 
page 642

“No data 
timeout” on 
page 644

Rule (Rule #) Description Parameters
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List of Dashboard Business Rule Parameters

The rule parameters are as follows:

Parameter Description

AtRiskWeight The weight assigned to At Risk instances to 
provide more importance to a specific status. 
You can assign any appropriate number with 
the following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

BlockedWeight The weight assigned to Blocked instances to 
provide more importance to a specific status. 
You can assign any appropriate number with 
the following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

Critical weight The weight assigned to the Critical status. You 
can assign any appropriate number with the 
following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

DollarImpactFactor The financial loss factor per hour. The 
financial loss factor is used to calculate the 
financial impact of a CI non-availability.

duration Dashboard calculates CI status based on the 
samples received during the duration period 
(defined in seconds). For example, if a CI has 
a duration of 5 minutes, status is calculated 
based on the samples received during the past 
5 minutes. Default: 15 minutes
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Factor The factor used to multiply the result of the 
operation performed on the two fields, before 
comparing the result to the objectives.

Field name The name of the sample field you want to 
compare to the objectives. The field must 
have a numeric value.

Final State The final status of the incident received in the 
sample. The default is Closed.

first_choice_sample The sample type to be used when calculating 
data regarding sessions or connections. 
By default, the following samples are used: 
rum_eu_t, rum_tcp_eu_t, rum_server_t, and 
rum_tcp_server_t.

First Field Name The name of the first field on which to apply 
the rule. The field must have a numeric value.

Formula The formula to be used to calculate the value 
or the status of the KPI to which the Generic 
Formula rule is attached, for the time period 
specified in the duration parameter. 

HealthyWeight The weight assigned to Healthy instances to 
provide more importance to a specific status. 
You can assign any appropriate number with 
the following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

Initial State The initial status of the incident received in 
the sample. The default is: Open.

InitStatus Defines a different initial status of a group 
level CI’s KPI until samples are received. (The 
default KPI status for rules that do not include 
an InitStatus parameter is No data. 

Parameter Description
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isGroovyRuleType Internal for API rules; do not modify.

KPI Calculation Script For API rules, defines the calculateKPI method 
implementation.
Default/Mandatory: (no default)/Yes

logic Specifies the type of calculation the rule 
should perform. The valid values can be a 
subset of: maximum, minimum, average, or 
weighted-average.

Major weight The weight assigned to the Major status. You 
can assign any appropriate number with the 
following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

Maximum number of 
samples

The number of most recent samples to be 
included in the API Sample Rule calculation.

Minor weight The weight assigned to the Minor status. You 
can assign any appropriate number with the 
following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

No data timeout The timeout period for a KPI. Defines the 
number of seconds from the time the last 
sample was received for the KPI, until the KPI 
is timed out - at which point the KPI changes 
to No data). The default value for this 
property should be changed with caution. 
Note that a different default value may 
actually be used for Business Process Monitor 
transaction CIs. For details, see “No Data 
Timeout for Transaction CIs” on page 342.

Parameter Description
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Number of Problematic 
Samples

The number of samples that have the 
required status. A specified number of 
samples (specified in the Total Number of 
Samples parameter) is accumulated. The 
status of the rule changes to a new status only 
when, among the accumulated samples, the 
specified number of samples (specified in the 
Number of Problematic Samples parameter) 
has the new status. For example, Total 
Number of Samples=5, Number of 
Problematic Samples=3; if three samples in 
the accumulated samples have a red status, 
the rule status changes to red.

OK weight The weight assigned to the OK status. You can 
assign any appropriate number with the 
following specific cases: 1 is the default, 0 
causes the status to be ignored in the rule 
calculation, or a negative number is 
considered to be 1.

Operator The operator used to calculate the result of 
the first and second fields. It can be: +, -, *, or 
/.

PassedStatus Status level that is set to serve as the lowest 
limit above which the instances are 
considered for the status calculation.
Example: If PassedStatus is defined as 15 
(Warning), all instances with status 15 or more 
(OK, or Warning) are PassedStatus instances. 
The instances with lower levels (Minor, Major, 
or Warning) are not taken into consideration 
in the status calculation.

Parameter Description
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relevant_samples Provides information about the sample on 
which the rule’s calculations are based. This 
parameter is used only in RUM Application / 
End User / Locations Session Statistics 
Monitor Availability / Performance / Volume 
rules.

Rule Template Setting 
Key

Internal for API rules; do not modify.

Sample Fields For API rules, defines the list of sample fields 
whose values can be included in the 
calculation.
Default/Mandatory: (no default)/No

Parameter Description
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sample_group_by_fields Provides information about the sample’s field 
by which the samples are grouped. This 
parameter is used only in RUM Application / 
End User / Locations Session Statistics 
Monitor Availability / Performance / Volume 
rules. Those rules are based on the last sample 
received.
Using sample_group_by_fields, you can 
combine samples from different aggregation 
sources. 
When the end user can access more that one 
application, use grouping by application. The 
end users are then aggregated by application, 
and the last sample can be selected.
When traffic is monitored by more than one 
Real User Monitor engine, use grouping by 
engine_id. The end users (IPs) are then 
aggregated by engine_id, and the last sample 
can be selected.
When the end users (IPs) from the same 
location are monitored and summary for 
location is needed, all end users (IPs) from the 
same location should be merged. It is done by 
grouping by end-users. In case more than one 
Real User Monitor engine is used for 
monitoring, grouping can be extended by 
adding engine_id to grouping parameters. 
The last sample can then be selected.

Second Field Name The name of the second field on which to 
apply the rule. The field must have a numeric 
value.

Parameter Description
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Severity The severity of the sample incident that is 
used in the calculations. 
The values are:
5 – very low
4 – low
3 – medium
2 – urgent
1 – critical

StatusDimension Defines the ID of the KPI for which the other 
rule parameters apply when you want to use 
KPIs other than Availability.

Time stamp field The name of the time stamp field in the 
external source sample, if its name is not 
time_stamp.

Total Number of 
Samples

The total number of samples. See Number of 
Problematic Samples parameter for more 
details.

tracking period id Internal. This parameter must not be 
modified.

volumeKPI The KPI number of the Volume KPI (in Real 
User Monitor). Used to calculate rules in Real 
User Monitor group rules.

Warning Weight The weight assigned to the Warning status. 
You can assign any appropriate number with 
the following specific cases:
1 is the default.
0 causes the status to be ignored in the rule 
calculation. 
A negative number is considered to be 1.

Parameter Description
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Business Rules User Interface

This section describes:

 ➤  Business Rule Repository page on page 649

 ➤  Global Attributes Dialog Box on page 651

 ➤  Global Attributes Details Dialog Box on page 655

 ➤  Parameter Details Dialog Box (Rules) on page 656

 ➤  Rule Details Dialog Box on page 657

Business Rule Repository page

Description Displays the list of factory (predefined) and customized 
rules. Those rules are available throughout HP Business 
Availability Center to determine how source data is 
imported.

Enables an advanced user to modify existing repository 
rules and create new ones. 

To Access: Admin > Dashboard > Repositories > 
Business Rules

Important 
Information

Cloning or overriding an existing rule, or creating a 
new rule, adds the corresponding rule entry to the 
Custom rule list. You can then customize the rule to 
your organization’s specifications. For details, see “Rule 
Details Dialog Box” on page 657.

For a list of Dashboard rules and their details, see “List 
of Dashboard Business Rules” on page 581.

If you add a rule, a matching tooltip (with the same ID 
number) is automatically created. For more details, see 
“Tooltip Repository page” on page 883.

Included in Tasks “Customize a Business Rule” on page 568
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to display help on the rule.

Select a rule in the Custom Rules area, and click the 
button to open the Rules Details dialog box. For details, 
see “Rule Details Dialog Box” on page 657.

Class Name The name of the class the rule belongs to. It includes 
the Java class that implements the rule, with the full 
path to the root.

Clone In the Factory Rules or in the Custom Rules areas, 
select a rule, and click the Clone button to create a new 
rule by cloning. You clone an existing rule to use it as a 
template. The original rule is still available. 

Note: Change the name of the rule you have cloned to 
make sure you attach the cloned rule and not the 
original rule to a specific KPI.

Description The description of the rule.

Edit Globals Click to edit the global parameters of the rules. For 
details, see “Global Attributes Dialog Box” on 
page 651.

ID This specifies the ID number used to identify the rule 
in the source adapter templates. This is the default rule 
ID.
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Global Attributes Dialog Box

New Item Click to create a new rule. For details, see “Customize a 
Business Rule” on page 568.

Override In the Factory Rules or in the Custom Rules areas, 
select a rule, and click the Override button to edit an 
existing rule. You override an existing rule to replace it 
with a customized rule. The original rule is disabled. 
The overriding rule and the original rule have the same 
rule ID. The overriding rule and the original rule have 
the same rule ID. The rule in the Factory Business Rules 
area displays the following indication:

Note: 

➤ If you delete a custom rule that overrides a factory 
rule, the original factory rule is automatically 
restored.

➤ If you have created a new rule, you must attach it to 
a KPI. 

For details, see “Customize a Business Rule” on 
page 568.

Description Lists all rules global parameters. 

To Access: In the Business Rule Repository page, click 
the Edit Globals button. 

Important 
Information

The global attributes for rules are listed in “List of Rule 
Global Attributes” on page 652.

To override the global parameters values for individual 
rules, you must add the relevant parameter to the 
relevant rule and then modify its value.

Included in Tasks “Customize a Business Rule” on page 568

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

List of Rule Global Attributes

GUI Element (A-Z) Description

Click the button relevant to the attribute to edit 
existing global attribute details in the Global Attributes 
Details dialog box. 

<Name> The name of the global attribute. For details on the 
global attributes, see “List of Rule Global Attributes” on 
page 652.

<Value> The value of the global attribute. 

New Click the New button to enter new global attribute 
details in the Global Attribute Details page. For details, 
see “Global Attributes Details Dialog Box” on page 655.

Display Name Usual 
Default 
Value

Description

saveLastSample false Defines whether the last sample is presented in 
Dashboard when clicking on the status icon. 
For details, see “Set Up Rules to Display the Last 
Sample Details” on page 578.

HistoryType Worst Defines the type of history calculation to be 
used when calculating history status. Values 
can be: Worst, Average, or None (no history 
status displayed). For details, see “History 
Calculation” on page 364.

HistorySize 60 Defines a time period (in hours) used when 
calculating history and trend status. 

Enter round hours between 1 and 6.

For details, see “History Calculation” on 
page 364.
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Hidden Parameters

The history and trend statuses use the following hidden parameters. These 
are parameters with default values that are not visible to the user. However, 
if necessary, they can be overridden by defining the parameter in the global 
parameters for the Business Rule Repository. For details on the Trend and 
History statuses, see “Trend and History” on page 362.

saveValuesToPersis
tency

false Set saveValuesToPersistency to true if you want 
Dashboard to save CIs and KPIs value data to be 
displayed in the KPI Over Time with Value 
report. For details, see “KPIs Over Time Report” 
on page 277.

saveValuesToPersis
tencyInterval

900 Defines the periodicity (in minutes) with which 
the value of the KPI is saved to the CMDB (to be 
used in KPI Over Time with Value reports). For 
details, see “KPIs Over Time Report” on 
page 277.

Calculate Trend false Defines whether the trend should be calculated 
(and displayed) or not. For details, see “Trend 
Calculation” on page 365.

Name Default 
Value

Description

TrendRate 0.3 Sets the time rate between the long window 
(period of time defined by the HistorySize 
parameter) and a short window.

Display Name Usual 
Default 
Value

Description
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CalculationGranularity 20 Sets the time difference, in seconds, between 
recalculating statuses for a view. This 
knowledge is shown in <Data Processing 
Server root directory>
\log\EJBcontainer\TrinityStatistic.log.

This determines how many calculations are 
performed for a CI in a certain period of 
time. During normal functioning, Dashboard 
perform the calculation approximately every 
20 seconds (~180 calculations/hour) and 
there is no reason to change the default 
value.

If Dashboard have a heavy calculation load, 
causing the calculations to take more time 
(for example, calculations may be done on a 
history size of three hours instead of one 
hour), Dashboard might automatically adjust 
the granularity to calculate less often. For 
example, calculation may take place every 
minute or more, meaning 60 or less 
calculations an hour. 

If this calculation rate presents a problem, 
you can define the CalculationGranularity 
parameter above, to override the automatic 
granularity rate; however, this modification 
should be made with great caution, and only 
by advanced users. Contact HP Software 
Support for assistance.

Name Default 
Value

Description
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Global Attributes Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to edit all rules global parameters. 

You can also modify existing information or enter new 
information for the global attribute details. 

To Access: In the Global Attributes dialog box, click the 
Edit button  for the relevant attribute or click New. 

Important 
Information

The global attributes for rules are listed in “List of Rule 
Global Attributes” on page 652.

To override the global parameters values for individual 
rules, you must add the relevant parameter to the 
relevant rule and then modify its value.

Included in Tasks “Customize a Business Rule” on page 568

GUI Element (A-Z) Description

History Size 
(approximately)

Enter the time period (in hours) used when calculating 
history and trend status. The range is 1 to 6 hours.

Key Enter the global attribute key.

Type Enter the type of KPI value that is saved to the CMDB. 
Select Boolean, Number, or String.

Value Enter the value of the global attribute. 
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Parameter Details Dialog Box (Rules)

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to modify existing information or to enter 
new information about the rule’s parameters.

To Access: In the Rule Details dialog box, in the Rule 
parameters area, click the New button to enter new 
parameters or click the relevant Edit button to modify 
an existing parameter.

Important 
Information

For a list of rule parameters and their default values, see 
each rule description in “List of Dashboard Business 
Rules” on page 581.

If the CalculationGranularity parameter is not changed 
when there is a heavy calculation load, this does not 
cause wrong results, but note that calculations are done 
on a longer time scale (for example, calculation may be 
done on a history size of three hours instead of one 
hour).

Included in Tasks “Customize a Business Rule” on page 568

GUI Element (A-Z) Description

Default value Enter the value to be listed as the default value of the 
parameter in Dashboard. Note that for some of the 
rules, the default values can be: sampleBased or 
timeBased and indicates if the calculation performed 
by the rule is based on the sample values or is 
calculated.

Description Enter or modify the parameter description.

Name Enter or modify the name of the parameter. The 
parameter name is used as a key.
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Rule Details Dialog Box

Presentation class Enter the name of the presentation class. For future 
use.

Type Enter the type of parameter. Possible values are: 
Boolean (can be 0 or 1), Integer, Long, Double (can be 
a decimal number), or String.

Description Enables you to modify existing detailed information 
for the rule. You can also modify existing information 
or enter new information about the rule parameters 
and the Objective parameters. For more details, see 
“KPI Objectives” on page 343.

To Access: In the Business Rule Repository page, click 
New Item or click the Edit button   for the 
appropriate rule in the Factory or Custom Rules area.

Important 
Information

For a list of the objective parameters and their details, 
see “List of Dashboard Business Rule Parameters” on 
page 642.

After you have created a rule you must attach it to a 
KPI.

Included in Tasks “Customize a Business Rule” on page 568

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

In the Rule parameters area, click to modify an existing 
parameter. 

In the Objective Parameters area, click to modify an 
existing parameter. 

For details, see “Parameter Details Dialog Box (Rules)” 
on page 656.

Click to delete the relevant parameter. 

Class Name Enter the name of the class the rule belongs to. It 
includes the Java class that implements the rule, with 
the full path to the root.

Description Enter the description of the rule.

Display Name Enter the name of the rule as it is to be displayed in the 
UI.

New... In the Rule parameters area, click the New button to 
enter new parameters. 

In the Objective Parameters area, click to enter new 
objective parameters. 

For details, see “Parameter Details Dialog Box (Rules)” 
on page 656.

Objective parameters Default objective values for every rule that uses 
objectives. For details, see “KPI Objectives” on 
page 343.

Relevant result type Select one of the following options:

➤ Status. So the rule result is displayed as a status 
indicator

➤ Value. So the rule is displayed as a value

For details, see “Persistent Data and Historical Data” on 
page 366.
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Rule parameters Parameters used by the rule to calculate the resulting 
value or status. For details, see “List of Dashboard 
Business Rule Parameters” on page 642.

Rule Type Select one of the following options:

➤ Both. So the rule can be applied both to group and 
monitor

➤ Group. So the rule can be applied to a group

➤ Monitor. So the rule can be applied to a monitor

For details, see “Monitor Rules and Group Rules” on 
page 559.

Units Enter the type of unit applicable to the rule results. For 
more details on the available units, see “Units of 
Measurement for Objectives” on page 350.

GUI Element (A-Z) Description
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20
Rules API

This chapter provides information on the Dashboard Rules API.

This chapter includes:

Concepts

 ➤  Rules API Overview on page 662

 ➤  API Group and Sibling Rule on page 663

 ➤  API Sample Rule on page 667

 ➤  API Duration-Based Sample Rule on page 669

 ➤  Creating Rules with the Rules API on page 671

Tasks

 ➤  Define an API Rule in the KPIs Tab – Workflow on page 672

 ➤  Create a Text File-Based API Rule – Workflow on page 674

 ➤  Define an API Rule in the Rule Repository – Workflow on page 680

 ➤  Work with Tooltip Entries on page 682

 ➤  Write to Log Files From the Rules API Code on page 683

Reference

 ➤  Examples - API Group and Sibling Rule on page 685

 ➤  Examples - API Sample Rule on page 693
Concepts
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Rules API Overview

This chapter describes how to use the Rules API to create new business rules. 
Business rules are used to calculate Key Performance Indicators (KPIs). A KPI 
must have an associated business rule that defines how the KPI is calculated. 
The default Dashboard rules appear in section “List of Dashboard Business 
Rules” on page 581.

The recommended way to create new rules is with the Rules API. The Rules 
API enables you to create rules using the Groovy scripting language. Users of 
the Rules API should be familiar with Groovy and Java, and with HP 
Business Availability Center administration and applications.

Important: The Rules API classes are documented in Javadoc format in the 
HP BAC Rules API Reference. These files are located in the following folder:
\\<HP Business Availability Center Gateway Server root 
directory>\AppServer\webapps\site.war\amdocs\eng\doc_lib\Dashboard\
Rules_API\index.html

This section includes the following topics:

➤ “Dashboard API Rules” on page 662

➤ “Creating API Rules” on page 663

➤ “Tooltips and Log Files” on page 663

Dashboard API Rules
There are three types of Dashboard API rules:

➤ Group and Sibling Rule. This rule calculates KPIs based on data received 
from other KPIs, rather than from original sample data. For details, see “API 
Group and Sibling Rule” on page 663.

➤ Sample Rule. This rule calculates KPIs based on original data taken from 
sample fields. The number of samples included in the calculation is limited 
by a maximum number of samples rule parameter. For details, see “API 
Sample Rule” on page 667.
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➤ Duration-Based Sample Rule. This rule calculates KPIs based on original data 
taken from sample fields. A duration parameter defines which samples are 
included in the calculation. For details, see “API Duration-Based Sample 
Rule” on page 669.

Creating API Rules
Rules can be created using the Rules API in three ways: 

➤ Using the KPIs tab to create a rule for a specific KPI.

➤ Using a text file to create a new rule for multiple KPIs.

➤ Using a clone of an API rule in the Rule Repository to create a new rule.

These methods are described in “Creating Rules with the Rules API” on 
page 671.

Tooltips and Log Files
To display KPI information in tooltips when working with the Rules API, see 
“Work with Tooltip Entries” on page 682.

You can write to log files from the Rules API code, as described in “Write to 
Log Files From the Rules API Code” on page 683.

API Group and Sibling Rule

An API Group and Sibling Rule calculates KPIs based on data received from 
other KPIs, rather than from original sample data. The received data can 
come from the KPIs of child CIs, or from another KPI associated with the 
same CI.

Note: If you are creating a sibling rule, make sure that the KPI is calculated 
after its sibling KPIs, as defined by the KPI’s Calculation Order field. For 
details, see “KPI Repository page” on page 537.
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This section includes the following topics:

➤ “Group and Sibling Rule Methods and Fields” on page 664

➤ “Defining a Group and Sibling Rule in the KPIs tab or Rule Repository” on 
page 666

➤ “Defining a Group and Sibling Rule Using a Text File” on page 667

Group and Sibling Rule Methods and Fields
The Group and Sibling rule implements the Rules API Interface 
GroupAndSiblingCalculator, using the following guidelines:

➤ In this interface, the only method is calculateKPI. The method signature is:

public void calculateKPI(CI ci, KPI kpi)

➤ The calculateKPI method includes the parameters ci and kpi, which 
represent the current CI, and the KPI whose value the API rule calculates.

➤ The ci parameter type is CI, and is used as an accessor to KPIs of child CIs 
or sibling KPIs.

➤ The kpi parameter type is KPI, and is used to set calculation results.

In the following illustration, the Calculated KPI is calculated based on the 
sibling or child KPIs, and it is represented by the kpi parameter. 
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The CI to which the Calculated KPI is assigned, is represented by the ci 
parameter, and it is an accessor to the other KPIs.

The Rules API classes are documented in Javadoc format in the HP BAC Rules 
API Reference. These files are located in the following folder:
\\<HP Business Availability Center Gateway Server root 
directory>\AppServer\webapps\site.war\amdocs\eng\doc_lib\Dashboard\
Rules_API\index.html

For detailed examples of Group and Sibling rules, see “Examples - API Group 
and Sibling Rule” on page 685.

API rules can be defined within the Dashboard KPIs tab or Rule Repository, 
or using a text file template, as described in “Creating Rules with the Rules 
API” on page 671.
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Defining a Group and Sibling Rule in the KPIs tab or Rule 
Repository
To define a Group and Sibling rule using the KPIs tab or within the Rule 
Repository, enter the calculateKPI method implementation in the KPI 
Calculation Script area.

The parameters ci and kpi of the calculateKPI method are available for use in 
this script.

For detailed instructions, see “Define an API Rule in the KPIs Tab – 
Workflow” on page 672 or “Define an API Rule in the Rule Repository – 
Workflow” on page 680.

Accessing a Specific Child KPI in the KPIs Tab

When creating a Group rule for a specific KPI in the KPIs tab, to access a 
specific child KPI, the API includes a mechanism to simplify the code. When 
defining your KPI Calculation Script, you can enter the format 
"<CI name>"."<KPI name>". 

For an example of this, see Example - Specific Child CI Group Rule in 
“Examples - API Group and Sibling Rule” on page 685.
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Defining a Group and Sibling Rule Using a Text File
To define a Group and Sibling rule using a text file, use the 
DashboardGroupAndSiblingTemplate.groovy template as described in 
“Create a Text File-Based API Rule – Workflow” on page 674.

Within the text file, enter the calculateKPI method body.

API Sample Rule

A Sample rule calculates KPIs based on original data taken from sample 
fields; the number of samples included in the calculation is limited by a 
maximum number of samples parameter.

This section includes the following topics:

➤ “Sample Rule Methods and Fields” on page 667

➤ “Defining a Sample Rule in the KPIs tab or Rule Repository” on page 668

➤ “Defining a Sample Rule Using a Text File” on page 669

Sample Rule Methods and Fields
The Sample rule implements the Rules API Interface LeafCalculator, using 
the following guidelines:

➤ In this interface, the only method is calculateKPI. The method signature is:

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples)

➤ The calculateKPI method includes the parameters ci, kpi, and samples. These 
represent the current CI, the KPI whose value the rule calculates, and the 
samples to be used in the rule calculation based on the Maximum number of 
samples parameter. (If this parameter value is 1, list one sample in this field.)

➤ The kpi parameter type is KPI, and is used to set calculation results.

➤ The samples parameter is a List of Sample objects, which hold sample 
field values.
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The Rules API classes are documented in Javadoc format in the HP BAC Rules 
API Reference. These files are located in the following folder:
\\<HP Business Availability Center Gateway Server root 
directory>\AppServer\webapps\site.war\amdocs\eng\doc_lib\Dashboard\
Rules_API\index.html

➤ The rule must also set the sampleFields field to define which sample fields 
are held by the Sample object. These values are the values used by the rule.

For detailed examples of Sample rules, see “Examples - API Sample Rule” on 
page 693.

API rules can be defined within the Dashboard KPIs tab or the Rule 
Repository, or using a text file template, as described in “Creating Rules with 
the Rules API” on page 671.

Defining a Sample Rule in the KPIs tab or Rule Repository
To define a Sample rule using the KPIs tab or within the Rule Repository, fill 
in the fields as follows:

➤ Sample Fields. List the sample fields which are held by the Sample object; 
separate between the sample names with a comma (for example: "u_Istatus", 
"dResponseTime").

➤ KPI Calculation Script. Enter the calculateKPI method implementation; do 
not enter the method signature. The parameters ci, kpi, and samples of the 
calculateKPI method are available for use in this script.

➤ Maximum number of samples. By default only the most recent sample is 
included (default=1). You can use this field to change this setting.

For detailed instructions, see “Define an API Rule in the KPIs Tab – 
Workflow” on page 672 or “Define an API Rule in the Rule Repository – 
Workflow” on page 680.
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Defining a Sample Rule Using a Text File
To define a Sample rule using a text file template, use the 
DashboardSampleRuleTemplate.groovy template file as described in “Create 
a Text File-Based API Rule – Workflow” on page 674.

Within the text file, enter the calculateKPI method body, and define the 
sampleFields field.

API Duration-Based Sample Rule

A Duration-Based Sample rule calculates KPIs based on original data taken 
from sample fields; the duration rule parameter defines which samples are 
included in the calculation. For example, if duration is defined as fifteen 
minutes, all samples collected during the last fifteen minutes are included in 
the calculation.

This section includes the following topics:

➤ “Duration-Based Sample Rule Methods and Fields” on page 669

➤ “Defining a Duration-Based Sample Rule in the KPIs tab or Rule Repository” 
on page 670

➤ “Defining a Duration-Based Sample Rule Using a Text File” on page 671

Duration-Based Sample Rule Methods and Fields
The Duration-Based Sample rule implements the Rules API Interface 
LeafCalculator, using the following guidelines:

➤ In this interface, the only method is calculateKPI. The method signature is:

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples)

➤ The calculateKPI method includes the parameters ci, kpi, and samples. These 
represent the current CI, the KPI whose value the rule calculates, and the list 
of samples to be used in the rule calculation.

➤ The kpi parameter type is KPI, and is used to set calculation results.

➤ The samples parameter is a List of Sample objects, which hold sample 
field values.
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The Rules API classes are documented in Javadoc format in the HP BAC Rules 
API Reference. These files are located in the following folder:
\\<HP Business Availability Center Gateway Server root 
directory>\AppServer\webapps\site.war\amdocs\eng\doc_lib\Dashboard\
Rules_API\index.html

➤ The rule must also set the sampleFields field to define which sample fields 
are held by the Sample object. These values are the values used by the rule.

For detailed examples of this rule, see “Examples - API Sample Rule” on 
page 693.

API rules can be defined using the Dashboard KPIs tab, using a text file, or 
within the Rule Repository, as described in “Creating Rules with the Rules 
API” on page 671.

Defining a Duration-Based Sample Rule in the KPIs tab or 
Rule Repository
To defining a Duration-Based Sample rule using the KPIs tab or within the 
Rule Repository, fill in the fields as follows:

➤ Sample Fields. List the sample fields which are held by the Sample object; 
separate between the sample names with a comma (for example: "u_Istatus", 
"dResponseTime").

➤ KPI Calculation Script. Enter the method implementation; do not enter the 
method signature. The parameters ci, kpi, and samples of the calculateKPI 
method are available for use in this script.

➤ No data timeout and duration. (Optional) You can define the timeout 
period and duration parameters, as described in “List of Dashboard Business 
Rule Parameters” on page 642.

For detailed instructions, see “Define an API Rule in the KPIs Tab – 
Workflow” on page 672 or “Define an API Rule in the Rule Repository – 
Workflow” on page 680.
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Defining a Duration-Based Sample Rule Using a Text File
To define a Duration-Based Sample rule using a text file template, use the 
DashboardDurationBasedSampleRuleTemplate.groovy template file as 
described in “Create a Text File-Based API Rule – Workflow” on page 674.

Within the text file, enter the calculateKPI method body, and define the 
sampleFields field.

Creating Rules with the Rules API

There are a number of ways to create rules using the Rules API: 

➤ Defining a rule for a specific KPI using the Dashboard KPIs tab. Each 
Dashboard KPI has three applicable API rules: API Group and Sibling Rule, 
API Sample Rule, or API Duration-Based Sample Rule. From the KPIs tab, you 
can assign one of the API rules to a KPI, and enter a calculation script (and 
other rule details) to define rule logic for that KPI. 

You can then edit the rule details in the KPIs tab at any time to change the 
rule logic for the KPI.

For details, see “Define an API Rule in the KPIs Tab – Workflow” on 
page 672.

➤ Creating a rule using a text file. For each of the three API rules (Group and 
Sibling Rule, Sample Rule, or Duration-Based Sample Rule) there is a 
corresponding template file, located in the <Data Processing server root 
directory>\BLE\rules\groovy\templates directory. You can use one of the 
template files to create a text file defining a new rule. You then add this rule 
to the Rule Repository, and it can be applied like any out-of-the-box rule.

The API code cannot be seen or changed within Dashboard, but only within 
the text file. If you make changes to the code within the text file, these 
changes are applied to all instances where the rule has been assigned, after 
you reload Dashboard rules.

For details, see “Create a Text File-Based API Rule – Workflow” on page 674.
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➤ Defining a rule within the Rule Repository. The Rule Repository contains 
three API rules: API Group and Sibling Rule, API Sample Rule, or API 
Duration-Based Sample Rule. You can use the Rule Repository to clone an 
API rule and enter a calculation script (and other rule details) to define the 
rule logic. 

After the rule is applied to a KPI, you can edit rule details within the KPIs tab 
at any time to change the rule logic for a specific KPI.

For details, see “Define an API Rule in the Rule Repository – Workflow” on 
page 680.

Tasks

Define an API Rule in the KPIs Tab – Workflow

Each KPI has three applicable API rules. Within the KPIs tab, assign one of 
the API rules to a KPI, and enter the calculation script (and other rule 
details) to define the rule logic for that KPI.

This task includes the following steps:

➤ “Assign an API Rule to a KPI” on page 672

➤ “Define the KPI’s Rule Logic” on page 673

 1 Assign an API Rule to a KPI
To assign an API rule for a specific KPI assigned to a CI, select Admin > 
Dashboard > KPIs. Select New KPI to assign a new KPI to the CI, or Edit KPI 
to modify an existing KPI. For details on this process, see “Attach KPIs to CIs 
and Configure the KPIs” on page 374.

From the list of applicable business rules, select one of the API rules: API 
Group and Sibling Rule, API Sample Rule, or API Duration-Based Sample 
Rule. For a description of the rule types see “Rules API Overview” on 
page 662.
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 2 Define the KPI’s Rule Logic
Depending on the type of rule you are creating, define the rule methods and 
fields as described in:

➤ “API Group and Sibling Rule” on page 663

➤ “API Sample Rule” on page 667

➤ “API Duration-Based Sample Rule” on page 669

The following screen illustrates an API Sample rule.
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Create a Text File-Based API Rule – Workflow

There are three rule template files corresponding to the three API rules; each 
template implements the rule’s interface.

Create a text file defining a new rule using one of the templates, and then 
add the new rule to the Business Rule Repository. The rule can then be 
applied like any out-of-the-box rule.

The API code cannot be seen or changed within Dashboard, but only within 
the text file. If you make changes to the code within the text file, these 
changes are applied to all instances where the rule has been assigned, after 
you reload Dashboard rules.

This task includes the following steps:

➤ “Create a Text File for a Rule” on page 674

➤ “Add a Rule in the Rule Repository” on page 675

➤ “Add the Rule to the KPI’s Applicable Rules List” on page 678

➤ “Add Tooltip Parameters to the New Tooltip” on page 679

➤ “Reload Rules After Editing the Text File” on page 679

 1 Create a Text File for a Rule
Based on the type of rule you want to create, copy and rename one of the 
template files located in the <Data Processing server root 
directory>\BLE\rules\groovy\templates directory.

Within your copy of the template, define the rule methods and fields as 
described in:

➤ “API Group and Sibling Rule” on page 663

➤ “API Sample Rule” on page 667

➤ “API Duration-Based Sample Rule” on page 669

Save the file to the <Data Processing server root 
directory>\BLE\rules\groovy\rules directory.
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You must now add a rule in the Rule Repository that uses the rule logic in 
the text file. 

 2 Add a Rule in the Rule Repository
Select Admin> Dashboard > Repositories > Business Rules > New Item and 
add a new rule. For details on adding rules, see “Customize a Business Rule” 
on page 568.

 a In the Display Name field, type the name of the rule you want to create 
(mandatory).

 b In the Class Name field, type groovy: <file name>. Note that the file 
name must be identical (case sensitive) to the file name in the <Data 
Processing server root directory>\BLE\rules\groovy\rules directory.

 c In the Rule type field, select Group to define a Group and Sibling rule. 
Select Monitor for other rules.

 d Create Rule parameters depending on your API rule type, as follows:

➤ In the Rule parameters area, click New.

➤ For API Sample rules:

In the Name field type Maximum number of samples. In the Type 
field, select Integer. In the Default Value field, type 1.

Click OK to Save.

➤ For API Duration-Based Sample rules:

In the Name field type duration. In the Type field, select Long. In the 
Default Value field, type 990.

Click OK to Save.

Repeat these steps to add the No Data Timeout rule parameter (Type: 
Long; Default Value = 990).
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 e Create Objective parameters: critical, major, minor, warning, 
informational, and operator. (Skip this step if you are defining a Group 
and Sibling rule that does not have Objectives, where status is calculated 
by the rule code.)

➤ In the Objective parameters area, click New.

➤ In the Name field, type critical. In the Type field, select Float.

➤ Click OK to save.

Repeat the above steps for each of the other Objective parameters (major, 
minor, warning, informational, and operator). 

➤ When defining the operator parameter, select String in the Type field.
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The following image shows a Sample rule after the rule parameter has been 
added:



Chapter 20 • Rules API

678

The following image shows a Duration-Based Sample rule after the rule 
parameters have been added:

 3 Add the Rule to the KPI’s Applicable Rules List
Add the new rule to the list of applicable rules already attached to the 
relevant KPI. For details, see the Applicable Rules GUI parameter in “KPI 
Details Dialog Box” on page 539.
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 4 Add Tooltip Parameters to the New Tooltip
When a rule is created using this procedure, a corresponding tooltip is 
created in the Tooltip Repository, with no tooltip parameters.

For instructions on adding tooltip parameters to the new tooltip, see “Work 
with Tooltip Entries” on page 682.

 5 Reload Rules After Editing the Text File
If you make changes to the text file at any time after the rule is created, 
perform the following steps to apply the changes.

 a In the browser, enter, using JMX login credentials:

http://<HP Business Availability Center Data Processing server 
name>:29909

 b Click service=BLE Online Server listed under Topaz.

 c In the page that opens, go to the section java.lang.String reloadRules for 
customer rules and repository. Enter the customer ID and click Invoke.
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Define an API Rule in the Rule Repository – Workflow

Within the Business Rule Repository, create an API rule that can be applied 
to multiple KPIs. This is done by cloning one of the three API rules, and 
setting default rule values for specific rule parameters. After the rule is 
applied to a KPI, you can edit its script within the KPIs tab at any time to 
change the rule logic for the specific KPI.

This task includes the following steps:

➤ “Clone an API Rule” on page 680

➤ “Edit Rule Details” on page 680

➤ “Add the Rule to the KPI’s Applicable Rules List” on page 682

 1 Clone an API Rule
Select Admin> Dashboard > Repositories > Business Rules. In the Business 
Rule Repository page, clone one of the following rules: API Group and 
Sibling Rule, API Sample Rule, or API Duration-Based Sample Rule.

For details on cloning a rule, see “Customize a Business Rule” on page 568.

 2 Edit Rule Details

 a Click the Edit button corresponding to the custom rule.

 b In the Display Name field, rename the cloned rule.
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 c Edit the KPI Calculation Script rule parameter. In the Default Value field, 
enter the rule calculation script. The code that you enter is the default 
code for this rule, and appears in the KPIs tab for all KPIs assigned this 
rule. (Do not change any other fields.)

 d If you are creating a Sample rule or Duration-Based Sample rule, edit the 
Sample Fields rule parameter. The sample fields that you enter are the 
default sample fields for this rule, and appear in the KPIs tab for all KPIs 
assigned this rule. (Do not change any other fields.)

For details on these rule parameters, see the following sections (depending 
on the type of rule you are creating):

➤ “API Group and Sibling Rule” on page 663

➤ “API Sample Rule” on page 667

➤ “API Duration-Based Sample Rule” on page 669
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The Rules API classes are documented in Javadoc format in the following 
location HP BAC Rules API Reference. These files are located in the following 
folder:
\\<HP Business Availability Center Gateway Server root 
directory>\AppServer\webapps\site.war\amdocs\eng\doc_lib\Dashboard\
Rules_API\index.html

 3 Add the Rule to the KPI’s Applicable Rules List
Add the new rule to the list of applicable rules already attached to the 
relevant KPI. For details, see the Applicable Rules GUI parameter in “KPI 
Details Dialog Box” on page 539.

Work with Tooltip Entries

The following section describes how to work with tooltip entries in order to 
display information calculated by the Rules API.

 1 Select Admin> Dashboard > Repositories > Tooltips. In the Tooltip 
Repository page, add any required tooltip entries for the new rule. The 
following table lists common tooltip entries and their corresponding value 
sources and formatting methods:

For details, see “Customize a Tooltip” on page 818.

 2 If you have used the kpi.setTooltip method, you must set a corresponding 
tooltip entry in the Tooltip Repository as described above. In the Value 
Source field, type the name of the tooltip entry exactly as used in the code, 
and leave the Formatting Method field empty.

Tooltip Parameter Value Source Formatting Method

Business Rule NODE.DIM.RULE.ID_CUST ruleIDtoString

CI name NODE.PROPS.BamNodeNameKey toLowerCase

Held status since NODE.DIM.RESULT.LastStatusChange returnDateAsString

Status NODE.DIM.RESULT.Status getStatusString

Value NODE.DIM.RESULT.Value returnNumOfDigitAfterPoint
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For example, if your code contains the method invocation 
kpi.setTooltip("total_sales", value), type NODE.DIM.RESULT.total_sales in 
the Value Source field.

Write to Log Files From the Rules API Code

Within your API rules, you can write to log files from rule methods using a 
logger object. There are five log levels: debug, info, warn, error and fatal. 
Each of these uses a specific logger method.

By default, only log method invocations of error and fatal severity are 
written to the log files. You can modify this within the log configuration 
files.

To write to log files using the Rules API:

 1 Within the rule method, implement one of the following methods (listed in 
ascending order of severity):

➤ logger.debug("<API rule name> : log message");

➤ logger.info("<API rule name> : log message");

➤ logger.warn("<API rule name> : log message");

➤ logger.error("<API rule name> : log message");

➤ logger.fatal("<API rule name> : log message");

Type the name of your API rule inside the log message to identify each log 
message with its source rule.
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 2 The Rules API log files are found in the <Data Processing server root 
directory>\log\mercury_online_engine\RulesAPI directory. 

Open one of the following files to view the log messages (depending on 
your rule type):

➤ groupAndSiblingRule.log (for API Group and Sibling rules)

➤ sampleRule.log (for API Sample rules)

➤ durationBasedSampleRule.log (for API Duration-Based sample rules)

To modify the severity level written to a log file:

 1 By default, only log method invocations of error and fatal severity are 
written to log files. To modify this setting, open the log configuration file 
located in <Data Processing server root directory>\conf\
core\Tools\log4j\mercury_online_engine\dashboard_rules.properties.

 2 In the line corresponding with your rule type, replace the string ${loglevel} 
with the severity level you want logged (either DEBUG, INFO, WARN, 
ERROR, or FATAL). Edit the following line, depending on your rule type:

➤ Group and Sibling rules: 
log4j.category.com.mercury.am.rules.dashboard.blDashboardRules.
simplifiedRule.groupAndSiblingRule.DashboardGroupAndSiblingRule = 
${loglevel},  bam.app.rules.api.group.appender

➤ Sample rules: 
log4j.category.com.mercury.am.rules.dashboard.blDashboardRules.
simplifiedRule.leaf.DashboardSimplifiedSampleBasedRule = ${loglevel},  
bam.app.rules.api.leafsample.appender

➤ Duration-Based Sample rules: 
log4j.category.com.mercury.am.rules.dashboard.blDashboardRules.
simplifiedRule.leaf.DashboardSimplifiedTimeBasedRule = ${loglevel},  
bam.app.rules.api.leafduration.appender

Reference
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Examples - API Group and Sibling Rule

This section provides examples of API Group and Sibling Rules. The 
following examples are described:

➤ “Example - Worst Child Rule” on page 686

➤ “Example - Worst Sibling Status Rule” on page 687

➤ “Example - Specific Child CI Group Rule” on page 688

➤ “Example - Sibling Rule Based on Availability and Performance KPIs” on 
page 689

➤ “Example - Group Average Value by CI Type” on page 690

➤ “Example - Using Groovy Closure” on page 691



Chapter 20 • Rules API

686

Example - Worst Child Rule
The following rule finds the worst status from all of the KPIs of the 
calculated CI's child CIs, which are of the same type as the calculated KPI, 
based on active statuses only. Active statuses are CRITICAL, MAJOR, 
MINOR, WARNING, and OK.

public void calculateKPI(CI ci, KPI kpi) {

// Get the calculated KPI's type ID (as defined in the Dashboard KPI Repository).
int kpiId = kpi.getType();
// Get a list of all of the KPIs of the calculated CI’s child CIs, which are of the same
// type as the calculated KPI.
List<KPI> childKpiList = ci.getChildrenKPIsByID(kpiId);
// Create a variable to set the status of the calculated KPI, 
// only if an active status is found.
boolean isActiveStatusFound = false;
// Set the current worst status to OK; if a worse status is found this will be updated.
Status worstStatus = Status.OK;
// Go over the list of child KPIs.
childKpiList.each{KPI childKPI->

// Get the child KPI's status. 
Status childKpiStatus = childKPI.status;
// Check if the child KPI's status is an active status.
if(childKpiStatus.isActive()){

// Mark that an active status was found.
isActiveStatusFound = true;
// Check if the child KPI's status is worse than the current worst status.
if(childKpiStatus.isWorse(worstStatus)){

// Update the worst status.
worstStatus = childKpiStatus;

}
}

}
// Check if an active status was found in the child KPI.
if(isActiveStatusFound){

// Set the calculated KPI status.
kpi.setStatus(worstStatus);

}

}
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Example - Worst Sibling Status Rule
The following rule finds the worst status from sibling KPIs, based on active 
statuses only. Active statuses are CRITICAL, MAJOR, MINOR, WARNING, 
and OK.

public void calculateKPI(CI ci, KPI kpi) {

// Get a list of all the KPIs for the CI.
List<KPI> ciKpiList = ci.getAllKPIs();
/**
 * Create a variable to set the status of the calculated KPI,
 * only if an active status is found.
 */
boolean isActiveStatusFound = false;
// Set the current worst status to OK; if a worse status is found this will be updated.
Status worstStatus = Status.OK;
// Go over the list of the CI's KPIs.
ciKpiList.each {KPI ciKPI ->

/**
* Check that the CI's KPI is not the calculated KPI.
* This is needed because getAllKPIs method returns all the KPIs for the CI.
*/
if (ciKPI !=  kpi) {

/**
 * The ciKPI represents a sibling KPI of the calculated KPI.
 * Get the sibling KPI's status.
 */
Status siblingKpiStatus = ciKPI.status;
// Update worstStatus if necessary.
if (siblingKpiStatus.isActive()) {

isActiveStatusFound = true;
if (siblingKpiStatus.isWorse(worstStatus)) {

worstStatus = siblingKpiStatus;
 }
}

}
}
// Check if an active status was found in the sibling KPI.
if (isActiveStatusFound) {
    // Set the calculated KPI's status.
    kpi.setStatus(worstStatus);
}

}
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Example - Specific Child CI Group Rule
The following rule calculates KPI status based on the Availability KPI of a 
specific child CI (CMDB ID = "96c2df2b544683c7f79bb382d1d7b3a9"). 

If the child CI’s Availability KPI value is 100, the calculated KPI’s status is set 
to OK. All other values set the KPI’s status to CRITICAL.

Status is set only if the child CI exists, has the Availability KPI, and its 
Availability KPI has value.

public void calculateKPI(CI ci, KPI kpi) {

/**
* Get the Availability KPI for the child CI "tx_10 from virtual_host_3".
* The CMDB ID of "tx_10 from virtual_host_3" is 

"96c2df2b544683c7f79bb382d1d7b3a9".
*
* Note: Within the UI, the following line can be written as
* KPI childKPI = "tx_10 from virtual_host_3"."Availability"
*/
KPI childKPI = ci.getChildKpiByChildId(KpiType.Availability, 

"96c2df2b544683c7f79bb382d1d7b3a9");

// Check if childKPI is not null. It is null if no child CI with this CMDB ID exists, or if this 
CI does not have the Availability KPI.
if (childKPI != null) {

// Check if the child KPI has a value.
if (childKPI.valueExist) {

if (childKPI.value == 100.0) {
kpi.status = Status.OK

}
else {

kpi.status = Status.CRITICAL
}

}
}

}
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Example - Sibling Rule Based on Availability and 
Performance KPIs
The following rule calculates KPI status based on the status of sibling 
Availability and Performance KPIs. 

If these KPIs do not exist or do not have active status, no status is set. 

If these sibling KPIs exist and are both OK, the calculated KPI status is set to 
OK. Otherwise, its status is set to CRITICAL. (Active statuses are CRITICAL, 
MAJOR, MINOR, WARNING, and OK.)

public void calculateKPI(CI ci, KPI kpi) {

/**
 * Get the sibling KPI of type Availability.
 * If Availability KPI does not exist, null will be returned.
 */
KPI availabilityKPI = ci.getKPI(KpiType.Availability);
// Get the sibling KPI of type Performance.
KPI performanceKPI = ci.getKPI(KpiType.Performance);

if (availabilityKPI != null && performanceKPI != null) {
// Both KPIs exist for this CI. Check if the KPIs status is active.
if (availabilityKPI.status.isActive() && performanceKPI.status.isActive()) {

// Check the KPI's status.
if (availabilityKPI.status == Status.OK &&

performanceKPI.status == Status.OK) {
/**
 * Both statuses are active and both are OK. Set this KPI's status to OK.
 */
kpi.status = Status.OK

}
else {

/**
 * Both statuses are active, and not both are OK.
 * Set this KPI's status to CRITICAL
 */
kpi.status = Status.CRITICAL

}
}

}
}
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Example - Group Average Value by CI Type
The following rule calculates the average status of the KPIs of child CIs, 
which are of the same CI type as the calculated KPI. 

Only child CIs of type "bpm_tx_from_location" are used in the calculation. 
If there are no child CIs of this type, or no child CI KPIs have value, no value 
is set for the KPI.

public void calculateKPI(CI ci, KPI kpi) {

// Get the calculated KPI's type ID (as defined in the Dashboard KPI Repository).
int kpiId = kpi.getType();
// Get a list of the KPIs of the child CIs, which are of the same CI type as the calculated 
// KPI, whose CI type is  "bpm_tx_from_location".
List<KPI> bpmTxFromLocationChildKpiList = ci.getChildrenKPIsByIDAndCiType(kpiId, 

"bpm_tx_from_location")

// Create a variable to sum the total values from child KPIs. 
// If no child exists or no child has value the variable will remain null.
Double totalChildValue = null;
// Write information to the log file.
logger.debug("DashboardGroupAvgValueByCiTypeRule : number of child CIs with type 

bpm_tx_from_location: " + bpmTxFromLocationChildKpiList.size())
// Go over the list of child KPIs.
bpmTxFromLocationChildKpiList.each {KPI childKPI ->

// Sum values of the child KPIs using the Utils class, which handles null values.
totalChildValue = Utils.sum(totalChildValue, childKPI.value);

}
// Set the calculated KPI's value to the average value, using the Utils class. 
// If totalChildValue is null, null value will be set.
kpi.value = Utils.divide(totalChildValue, bpmTxFromLocationChildKpiList.size());

}
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Example - Using Groovy Closure
The following rule sets the calculated KPI’s status to Critical, if at least one 
Availability KPI with Major status exists for the calculated CI`s child CIs.

This rule illustrates Groovy Closure. Refer to 
http://groovy.codehaus.org/Closures for more information.

public void calculateKPI(CI ci, KPI kpi) {

/**
 * Use Groovy Closure with the CI class getChildrenKPIs method,
 * to get List of KPIs from the CI`s child CIs, where 
 * 1. KPI type is Availability
 * 2. Status is MAJOR
 
 Closure description:

 { KPI childKPI ->
childKPI.type == KpiType.Availability.getID("DASHBOARD") && childKPI.status == 

Status.MAJOR
 }

 The Closure defines one parameter named childKPI of type KPI.

 Each KPI from the CI`s child CIs will be passed to the Closure by the getChildrenKPIs 
method.

 The Closure body returns a boolean value based on the logical expression result.
 Each KPI that the Closure body will return true for, will be part of the returned List 

 The expression KpiType.Availability.getID("DASHBOARD") returns an int representing 
the Availability KPI ID from the Dashboard KPI Repository.
 */
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List<KPI> kpiList = ci.getChildrenKPIs {KPI childKPI ->
childKPI.type == KpiType.Availability.getID("DASHBOARD") && childKPI.status == 

Status.MAJOR
}
// Check if such a KPI exists.
if (kpiList.isEmpty()) {
 // No such KPI exists.

// Write to a log file at debug level.
logger.debug "Closure Rule: no Availability KPI with  MAJOR status exist"

}
else {

//  At least one Availability KPI with MAJOR status exists.
logger.debug("Closure Rule: At least one Availability KPI  with  MAJOR status 

exist")
// Set calculated KPI status to CRITICAL.
kpi.status = Status.CRITICAL;

}
}
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Examples - API Sample Rule

This section provides examples of API Sample Rules. The following examples 
are described:

➤ “Example - Average Availability Rule” on page 693

➤ “Example - Average Performance Rule” on page 694

➤ “Example - Average Performance Rule Using a Rule Parameter Filter” on 
page 695

Example - Average Availability Rule
The following rule calculates average availability of samples, based on the 
u_iStatus sample field.

The rule logic is (available samples / total samples) * 100.

// This rule uses the u_iStatus sample field.
def sampleFields = ["u_iStatus"];

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples) {
// Keep total number of samples for this calculation cycle.
def totalSamples = samples.size();
// Create a variable to count available samples.
def availableSamples = 0;
/**
* Go over the given samples. If a sample's u_iStatus is equal to 0,
* the sample is considered available.
*/
samples.each {Sample currentSample->
if (currentSample.u_iStatus == 0) {

// Increase the count of available samples.
availableSamples++;
}

}
if (totalSamples > 0) {

// Set KPI value, converted to percentage.
kpi.setValue ((availableSamples/totalSamples)*100.0);
}

}
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Example - Average Performance Rule
The following rule calculates average performance in seconds, based on the 
dResponseTime and u_iStatus sample fields. 

Only samples with a u_iStatus value of 0 (available samples) are used in the 
calculation. The rule logic is: sum(dResponseTime) / available samples.

// This rule uses the u_iStatus and dResponseTime sample field.
def sampleFields = ["u_iStatus", "dResponseTime"];

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples) {

// Create a variable to count available samples.
def availableSamples = 0;
// Create a variable to sum response times of available samples.
def totalResponseTime = 0;
/**
 * Go over the given samples. If a sample's u_iStatus is equal to 0,
 * the sample is considered available.
 */
samples.each {Sample currentSample ->

if (currentSample.u_iStatus == 0) {
// Increase the count of available samples.
availableSamples++;
// Add the current sample's dResponseTime value to totalResponseTime.
totalResponseTime += currentSample.dResponseTime

}
}
if (availableSamples > 0) {

// Set KPI value, converted to percentage.
kpi.setValue((totalResponseTime / availableSamples))

}
}
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Example - Average Performance Rule Using a Rule 
Parameter Filter
The following rule calculates average performance in seconds, based on the 
dResponseTime and u_iStatus sample fields. 

Only samples with a u_iStatus value of 0 (available samples) are used in the 
calculation.

The rule uses an optional rule parameter: Response time limit. If this rule 
parameter value has been set in the Dashboard Admin, samples with a 
dResponseTime value greater then the rule parameter value are not used in 
the calculation.

Note: A rule parameter with the same name must be set for the rule in the 
Rule Repository. For details, see “Parameter Details Dialog Box (Rules)” on 
page 656.

The rule logic is: sum(dResponseTime) / available samples.

/ This rule use the u_iStatus and dResponseTime sample fields.
def sampleFields = ["u_iStatus", "dResponseTime"];

public void calculateKPI(CI ci, KPI kpi, List<Sample> samples) {

// Create a variable to count available samples.
def availableSamples = 0;
// Create a variable to sum response times of available samples.
def totalResponseTime = 0;
/**
 * Get the value of the rule parameter named "Response time limit"
 * from the KPI, as defined for the KPI in Dashboard Admin.
 * This rule parameter is optional, so responseTimeLimit can be null.
 */
Long responseTimeLimit = kpi.getRuleParameter("Response time limit")
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/**
 * Go over the given samples. If a sample's u_iStatus is equal to 0,
 * the sample is considered available.
 */
samples.each {Sample currentSample ->

if (currentSample.u_iStatus == 0) {
/**
* Check the value of the rule parameter.
* If it is not null (meaning the user has set a value),
* and the sample's dResponseTime is greater than the
* rule parameter value, the value is not valid.
*/
boolean isSampleValid = true;
if (responseTimeLimit != null) {

// Check if ResponseTime exceeds the rule parameter value.
if (currentSample.dResponseTime > responseTimeLimit) {

// The sample is not valid.
isSampleValid = false;

}
}
if (isSampleValid) {

// Increase the count of available samples.
availableSamples++;
// Add the sample's dResponseTime value to totalResponseTime.
totalResponseTime += currentSample.dResponseTime

}
}

}
if (availableSamples > 0) {

// Set KPI value, converted to percentage.
kpi.setValue((totalResponseTime / availableSamples))

}
}
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21
Context Menu Repository

This chapter provides information on the Dashboard Context Menu 
Repository.

This chapter includes:

Concepts

 ➤  Context Menu Repository Overview on page 697

Tasks

 ➤  Customize a Context Menu on page 699

Reference

 ➤  List of Context Menus on page 701

 ➤  Context Menus User Interface on page 716
Concepts

Context Menu Repository Overview

The Context Menu Repository page displays the list of factory (predefined) 
context menus available throughout Dashboard to determine appearance 
and functionality for the CIs in the presentation layer.

A context menu defines the menu options that are available in the menu for 
a KPI or a CI in the Dashboard application. The adapter template assigns 
every configuration item type (CIT), a default context menu.

The actions required by each menu option are defined in “Context Menu 
Item Repository page” on page 810.
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For example, in the Console tab of the Dashboard application, the menu: 
Go to Report > Trend is displayed:

For details about the menu options, see “Customize Dashboard Display and 
Refresh Rate” on page 69.

For details about creating or editing context menus, see “Context Menu 
Repository page” on page 716.

Note: If you are using HP Operations Manager i with Business Availability 
Center, then the Context Menu Repository page contains OMi-related 
context menus. For more information, see Using HP Operations Manager i.

Advanced Users
You can modify existing repository objects and create new ones. This may 
be necessary when you want to customize the way information is presented 
in Dashboard, to fit the needs of your organization; or you may need to 
create new objects when integrating data from a new external system into 
Dashboard. 

Tasks
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Customize a Context Menu

You customize a context menu by creating a new context menu, or by 
editing an existing context menu.

For a detailed scenario that includes adding context menu items to a context 
menu, see “Create a Dynamic URL – Scenario” on page 495 and view the 
appropriate steps.

This task includes the following steps:

➤ “Create a Customized Context Menu” on page 699

➤ “Edit Context Menu Details” on page 700

➤ “Specify the Menu Entity Details” on page 700

➤ “Set a Context Menu and its Parameters Back to Default” on page 700

 1 Create a Customized Context Menu
There are three ways to customize repository elements:

➤ New Item. Creates a new repository element that is not based on an existing 
element. You customize the new element to fit your needs. To create a new 
context menu, click New Item in the Context Menu Repository page.

➤ Clone. Creates a new repository element by cloning an existing factory or 
custom element. The original element is still available, and the new cloned 
element can be modified. To clone a context menu, select a factory context 
menu and click Clone in the Context Menu Repository page.

➤ Override. Overrides an existing factory element. The original element is 
labeled overridden (disabled) in the Factory area, and an editable copy 
appears in the Custom area. To override a context menu, select a factory 
context menu and click Override in the Context Menu Repository page.

For details, see “Context Menu Repository page” on page 716.
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 2 Edit Context Menu Details
In the Context Menu Details page, you can either modify information or 
enter new information for the context menu. 

You can also modify existing information or add new information about the 
context menu entity. For details on the possible values, see “Context Menu 
Details Dialog Box” on page 718.

 3 Specify the Menu Entity Details
In the Menu Entity Details page, you can either modify existing information 
or enter new information about the menu entity. For details, see “Menu 
Entity Details Dialog Box” on page 719.

 4 Set a Context Menu and its Parameters Back to Default
If you have modified a context menu or its parameters, you might need to 
return the context menu and its parameters to their defaults.

To set a context menu and its parameters back to default, select Admin > 
Dashboard > Repositories > Context Menus. In the Custom Context Menus 
area, delete the copy of the context menu you want to return to default and 
click OK. The context menu and its parameters are returned to their 
defaults.

Reference
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List of Context Menus

This section provides descriptions of the context menus available in the 
Context Menu Repository, and their default context menu items.

Several context menus with the same name might be listed in the Context 
Menu Repository and might have different parameters.

For details about configuring the context menus, see “Context Menus User 
Interface” on page 716.

Context Menu Description Context Menu Items

BMC Measurement 
Menu

Context menu for measurement 
CIs originating from a BMC 
PATROL system.

“Go To Report” on page 744

“Filters” on page 742

“Show Path to Root” on page 767

“Show Problematic Subtree” on 
page 767

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

BPM Group Menu with 
Layers View

Context menu for group CIs. “Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

“Drill to Diagnostics” on page 731

Business Process 
Insight Flow Map Menu

Context menu available on 
Business Process Step nodes in 
the BPI flow map.

“Show Business Process Step 
Summary” on page 764“Show Top 
View” on page 770

“Go to Console” on page 743
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Business Process 
Insight Menu

Context menu for Business 
Process CIs and BPI Monitor CIs.

“Go To Report” on page 744

“Go to BPI Application Health 
Tab” on page 743

“Show Business Impact” on 
page 763

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Find Visible and Hidden Child 
CIs” on page 742

Business Process 
Insight Process Step 
Menu

This Context menu is available 
for Business Process Step CIs, 
from the Business Processes view.

“Go To Report” on page 744

“Go to BPI Application Health 
Tab” on page 743

“Show Business Impact” on 
page 763

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Find Visible and Hidden Child 
CIs” on page 742

Business Process 
Insight Scorecard Menu

Context menu available from the 
Scorecard page, in the Business 
Process Insight application.

“Show Business Process Over 
Time” on page 763“Show Top 
View” on page 770

“Go to Console” on page 743

Context Menu Description Context Menu Items
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Business Process 
Monitor Group Menu

Context menu for group CIs 
where the data originates from a 
Business Process Monitor source.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

“Drill to Diagnostics” on page 731

Business Unit Menu Internal. “SLAs Summary Report” on 
page 776

CI Neighbors Context menu in the CMDB. “Show Related CIs” on page 768

CI Properties Context menu in the CMDB. “Properties” on page 755

CIM Measurement 
Menu 

(Deprecated)

Context menu for measurement 
CIs originating from a Compaq 
Insight Manager (CIM) system.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Config File Menu Not in use. “Go To Report” on page 744

“Show Business Impact” on 
page 763

Dashboard 
Administration Menu

Displays the context menu in 
Dashboard Admin.

“Add KPI” on page 726

“KPI Data Over Time” on page 747

Context Menu Description Context Menu Items
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Default Menu Displays the context menu in 
Dashboard Console tab.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Delete CI Context menu in the CMDB.  “Delete CI” on page 730“Drill to 
Diagnostics” on page 731

Diagnostics BPM Menu Context menu that is used in 
Dashboard in monitoring views, 
to drill from a specific 
transaction to the Diagnostics 
transaction screen.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Drill to Diagnostics” on page 731

Diagnostics Monitor 
Menu

Context menu that is used in 
Dashboard.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

Diagnostics Probe 
Group Menu

Context menu that is used in 
Dashboard Diagnostics Views to 
drill down from a specific probe 
group CI to the Diagnostics 
Console screen.

“Drill to Diagnostics” on page 731

Context Menu Description Context Menu Items
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Diagnostics Probe 
Menu

Context menu that is used from 
the monitoring views in 
Dashboard, to drill down from a 
specific probe CI to the 
Diagnostics transaction screen.

“Drill to Diagnostics” on page 731

EMS Measurement 
Menu 

Context menu for measurement 
CIs originating from an 
Enterprise Management Systems 
(EMS) source.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

EMS Show Events Context menu for CIs:

➤ Originating from the 
Operations Manager source 
adapter.

➤ Originating from Netscout.

“Show Events” on page 765

Group Menu The default context menu for 
most of the business 
configuration item type (CIT)s 
(CITs).

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

HP SC Menu Context menu for Business 
Service CIs or EMS Monitor CIs 
under Business Service CIs.

“HP Service Manager” on page 746

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

Locate CI Context menu after a search 
operation in IT Universe.

“Locate CI in View” on page 749

Context Menu Description Context Menu Items
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Locate CI in SLA Internal.  “Locate CI in SLA” on page 748

OVO Drill Down Event Context menu attached to EMS 
Monitor CIs that enables drilling 
down to the HP Operations 
Manager application.

Limitations:

➤ You must have specified the 
user name, password, and host 
machine in the EMS 
integration definition. For 
details, see “Add Integration 
Dialog Box” in Solutions and 
Integrations.

➤ This capability is only 
supported for one HP 
Operations Manager 
application. If more than one 
Operations Manager 
integration exists, the drill 
down feature works only for 
one of them.

“OVO Drill Down” on page 751

RUM Application Error 
Monitor Menu

Context menu for RUM Error 
Event CIs in the Real User 
Application view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Context Menu Description Context Menu Items
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RUM Application Menu Context menu for Application 
CIs in the Real User Application 
view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

RUM End User Group 
Container Menu

Context menu for RUM End User 
Group Container CIs in the Real 
User End Users view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Invoke Run Books” on page 746

“Find Visible and Hidden Child 
CIs” on page 742

RUM End User Group 
Menu

Context menu for RUM End User 
Groups CIs in the Real User End 
Users view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Invoke Run Books” on page 746

“Find Visible and Hidden Child 
CIs” on page 742

Context Menu Description Context Menu Items
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RUM End User’s Menu Context menu for RUM End User 
Group monitor CIs in the Real 
User End Users view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Invoke Run Books” on page 746

“Find Visible and Hidden Child 
CIs” on page 742

RUM Errors Menu Context menu for RUM Errors 
Event CIs in the Real User 
Application view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

RUM Group Menu Context menu for RUM End User 
Group monitor CIs in the Real 
User End Users view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

“Drill to Diagnostics” on page 731

Context Menu Description Context Menu Items
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RUM HTTP Error 
Monitor Menu

Context menu for RUM HTTP 
Error Monitor CIs in the Real 
User Application view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

RUM Informational 
Event Monitor Menu

Context menu for RUM 
Informational Event Monitor CIs 
in the Real User Application 
view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

RUM Informational 
Events Menu

Context menu for RUM 
Informational Events CIs in the 
Real User Application view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Context Menu Description Context Menu Items
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RUM Page Monitor 
Menu

Context menu for RUM Page 
Monitor CIs in the Real User 
Application view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

“Drill to Diagnostics” on page 731

RUM Server Menu Context menu for RUM Server 
Monitor CIs in the Real User 
Servers view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Invoke Run Books” on page 746

“Find Visible and Hidden Child 
CIs” on page 742

RUM Servers Menu Context menu for RUM Servers 
CIs in the Real User Servers view.

“Go To Report” on page 744

RUM Session Monitor 
Menu

Context menu for RUM Session 
Monitor CIs in the Real User 
Applications view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Context Menu Description Context Menu Items
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RUM Transaction 
Monitor Menu

Context menu for RUM 
Transaction Monitor CIs in the 
Real User Applications view.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

SAP Alert 
Acknowledgment

Context menu for a SAP Alert CI. “Complete Alert” on page 728

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

SAP Menu Context menu for a SAP-related 
CI.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Application Mapping” on 
page 726

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Context Menu Description Context Menu Items
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SAP System Menu Context menu for a SAP System 
CI.

“Go To Report” on page 744

“Filters” on page 742

“Application Mapping” on 
page 726

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

SAP Transaction Menu Context menu for a Transaction 
CI.

“Go To Report” on page 744

“Filters” on page 742

“Application Mapping” on 
page 726

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

SAP Transport Menu Context menu for a Transport CI. “Go To Report” on page 744

“Filters” on page 742

“Application Mapping” on 
page 726

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Service Menu Internal.  “CI Impact Report” on page 728

Context Menu Description Context Menu Items
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Service Mng Menu Internal. “Create New Business Service” on 
page 729

“Edit Business Service” on 
page 731

“Delete Business Service” on 
page 730

“Create New SLA from Business 
Service” on page 729

Siebel Database 
Breakdown Diagnostics 
Menu

Context menu for Siebel-specific 
CIs.

“Go To Siebel Diagnostics” on 
page 744

Siebel Diagnostics 
Menu

Context menu for Siebel-specific 
CIs.

“Go To Siebel Diagnostics” on 
page 744

Siebel Menu Context menu for Siebel-specific 
CIs.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Siebel SARM and DBBD 
Diagnostics Menu

Context menu for Siebel-specific 
CIs.

“Go To Siebel Diagnostics” on 
page 744

SiteScope Web Service 
Monitor Menu

Context menu for SiteScope Web 
Service Monitor CIs.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

Context Menu Description Context Menu Items
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SiteScope Group Menu Context menu for SiteScope 
group CIs.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

SiteScope 
Measurement Menu

Context menu for measurements 
CIs originating from SiteScope.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

SiteScope Monitor 
Menu

Context menu for SiteScope 
monitor CIs when there is no 
measurement level for the 
monitor.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

Top View Menu Context menu for CIs in Top 
View, appended to the CI’s 
standard context menu.

“Expand More Levels” on page 740

“Expand to Problem” on page 741

“Open in New Window” on 
page 749

Transaction 
Measurement Menu

Context menu for transaction 
measurement CIs.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

Context Menu Description Context Menu Items



Chapter 21 • Context Menu Repository

715

TransactionVision 
Menu

Context menu for 
TransactionVision CIs.

“Go to TransactionVision” on 
page 745

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Go To Problem Isolation” on 
page 743

VM Context Menu Context menu in View Manager 
in the CMDB.

“New Folder” on page 749

“Rename Folder” on page 756

“Delete Folder” on page 730

Web Service Menu Context menu for Web Service 
CIs.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Web Service 
Operations Menu

Context menu for Web Service 
Operation CIs.

“Go To Report” on page 744

“Filters” on page 742

“Top View” on page 778

“Acknowledgement” on page 725

“Go To Problem Isolation” on 
page 743

“Find Visible and Hidden Child 
CIs” on page 742

Context Menu Description Context Menu Items
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Context Menus User Interface

This section describes:

 ➤  Context Menu Repository page on page 716

 ➤  Context Menu Details Dialog Box on page 718

 ➤  Menu Entity Details Dialog Box on page 719

Context Menu Repository page

Description Displays the list of factory (predefined) and customized 
context menus. Those context menus are available 
throughout HP Business Availability Center to help 
you navigate to other pages.

Enables an advanced user to modify existing repository 
context menus and create new ones. 

To Access: Admin > Dashboard > Repositories > 
Context Menus

Important 
Information

Cloning or overriding an existing context menu, or 
creating a new context menu, adds the corresponding 
context menu entry to the Custom Context Menus list. 
You can then customize the context menu to your 
organization’s specifications. 

You can modify the context menu information or enter 
new information. You can also modify existing 
information or add new information about the context 
menu entity. For details, see “Context Menu Details 
Dialog Box” on page 718.

You can modify existing information or enter new 
information about the menu entity. For details, see 
“Menu Entity Details Dialog Box” on page 719.

Included in Tasks “Customize a Context Menu” on page 699
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to display help on the context menu.

Select a context menu in the Custom Context Menus 
area, and click the button to open the Context Menus 
Details dialog box. For details, see “Edit Context Menu 
Details” on page 700.

Clone In the Factory Context Menus or in the Custom 
Context Menus areas, select a context menu, and click 
the Clone button to create a new context menu by 
cloning. You clone an existing context menu to use it 
as a template. The original context menu is still 
available. 

Note: Change the name of the context menu you have 
cloned to make sure you attach the cloned context 
menu and not the original context menu to a specific 
KPI.

ID The internal name of the context menu.

Display Name The name of the context menu.



Chapter 21 • Context Menu Repository

718

Context Menu Details Dialog Box

New Item Click to create a new context menu in the Context 
Menu Details dialog box. 

Override In the Factory Context Menus or in the Custom 
Context Menus areas, select a context menu, and click 
the Override button to edit an existing context menu. 
You override an existing context menu to replace it 
with a customized rule. The original context menu is 
disabled. The overriding context menu and the 
original context menu have the same context menu 
ID. The context menu in the Factory Context Menus 
area displays the following indication:

Note: If you later delete the custom context menu that 
overrode the factory context menu, the original factory 
context menu is automatically restored.

Description Enables you to modify the information or enter new 
information for the context menu. You can also 
modify existing information or add new information 
about the context menu entity. 

To Access: In the Context Menu Repository page, click 
the New button, or click the relevant Edit button  
for a cloned or overridden context menu.

Important 
Information

A detailed list of context menus and their details is 
available in “List of Context Menus” on page 701.

Included in Tasks “Customize a Context Menu” on page 699

GUI Element (A-Z) Description
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Menu Entity Details Dialog Box

GUI Element (A-Z) Description

<Menu entity> Click the Delete button  to delete an existing 
menu entity details.

Click the Edit button  to modify existing menu 
entity details. For more details, go to “Menu Entity 
Details Dialog Box” on page 719.

Display Name Enter or modify the name of the context menu. 

New Click the New button to enter new menu entity details. 
For more details, go to “Menu Entity Details Dialog 
Box” on page 719.

Description Enables you to modify existing information or enter 
new information about the menu entity.

To Access: In the Context Menu Details page, click the 
New button, or click the relevant Edit button  for a 
menu entity.

Included in Tasks “Customize a Context Menu” on page 699
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Context Menu Item Select the name of the context menu item (the main 
menu element that is displayed). 

For details about the available context menu items, see 
“List of Context Menu Items” on page 725.

Sub-context Menu 
Items

Select or de-select the sub-menu items. 

For details about the available context menu items, see 
“List of Context Menu Items” on page 725.

Applicable Sections Select or de-select the applications where the menus 
appear. If you specify nothing, the menu appears in all 
tabs.
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22
Context Menu Item Repository

This chapter includes the pages and dialog boxes that are part of the 
Context Menu Item Repository user interface.

The Context Menu Item Repository includes the context menu items 
available in Dashboard and enables you to create new context menu items 
and to edit existing context menu items.

This chapter includes:

Concepts

 ➤  Context Menu Item Repository Overview on page 722

Tasks

 ➤  Customize a Context Menu Item on page 723

Reference

 ➤  List of Context Menu Items on page 725

 ➤  List of Pre-Processor Classes on page 789

 ➤  List of Post-Processor Classes on page 795

 ➤  Context Menu Items User Interface on page 806
Concepts
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Context Menu Item Repository Overview

The Context Menu Item Repository page displays the list of factory 
(predefined) context menu items available throughout Dashboard to 
determine appearance and functionality for the CIs in the presentation 
layer.

The Context Menu Item Repository defines the options available in the 
context menus. Each context menu item either specifies an operation that is 
to take place, or acts as a parent for a sub-menu. For a list of the context 
menu items defined for Dashboard, see “List of Context Menu Items” on 
page 725.

For details about creating or editing context menu items, see “Context 
Menu Item Repository page” on page 810.

Note: If you are using HP Operations Manager i with Business Availability 
Center, then the Context Menu Item Repository page contains OMi-related 
context menu items. For more information, see Using HP Operations 
Manager i.

Advanced Users
You can modify existing repository objects and create new ones. This may 
be necessary when you want to customize the way information is presented 
in Dashboard, in order to fit the needs of your organization; or you may 
need to create new objects when integrating data from a new external 
system into Dashboard. 

Tasks
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Customize a Context Menu Item

You customize a context menu item by creating a new context menu item or 
by editing an existing context menu item.

For a detailed scenario that includes creating a context menu item, see 
“Create a Dynamic URL – Scenario” on page 495 and view the appropriate 
steps.

This task includes the following steps:

➤ “Create a Customized Context Menu Item” on page 723

➤ “Edit Context Menu Item Details” on page 724

➤ “Specify the Processor Parameter Details” on page 724

➤ “Set a Context Menu Item and its Parameters Back to Default” on page 724

 1 Create a Customized Context Menu Item
There are three ways to customize repository elements:

➤ New Item. Creates a new repository element that is not based on an existing 
element. You customize the new element to fit your needs. To create a new 
context menu item, click New Item in the Context Menu Item Repository 
page.

➤ Clone. Creates a new repository element by cloning an existing factory or 
custom element. The original element is still available, and the new cloned 
element can be modified. To clone a context menu item, select a factory 
context menu item and click Clone in the Context Menu Item Repository 
page.

➤ Override. Overrides an existing factory element. The original element is 
labeled overridden (disabled) in the Factory area, and an editable copy 
appears in the Custom area. To override a context menu item, select a 
factory context menu item and click Override in the Context Menu Item 
Repository page.

For details, see “Context Menu Repository page” on page 716.
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 2 Edit Context Menu Item Details
In the Items Details window, you can either modify context menu item 
information or enter new information. 

You can also modify existing information or enter new information about 
the pre- or post-processor parameters. For details on the possible values, see 
“Context Menu Item Details Dialog Box” on page 806.

 3 Specify the Processor Parameter Details

Note: It is not recommended to:

➤ Add new parameters to a pre-processor or post-processor class.

➤ Make changes to a pre-processor or post-processor class as it might 
change the class behavior. Classes are built for specific context menus.

In the Pre- or Post-Processor Parameter Details window, you can either 
modify existing information or enter new information about the 
pre-processor parameter or the post-processor parameter. 

For details about the pre-processor parameters, see “Pre-Processor Parameter 
Details Dialog Box” on page 813.

For details about the post-processor parameters, see “Post-Processor 
Parameter Details Dialog Box” on page 814.

 4 Set a Context Menu Item and its Parameters Back to Default
If you have modified a context menu item or its parameters, you might need 
to return the context menu item and its parameters to their defaults.

To set a context menu item and its parameters back to default, select Admin 
> Dashboard > Repositories > Context Menu Items. In the Custom Context 
Menu Items area, delete the copy of the context menu item you want to 
return to default and click OK. The context menu item and its parameters 
are returned to their defaults.

Reference
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List of Context Menu Items

This section provides details about the context menu items available in the 
Context Menu Item Repository, their pre- and post-processor classes, and 
class parameters.

For details about configuring the context menu items, see “Context Menu 
Items User Interface” on page 806.

For a description of the classes and the complete list of their parameters, see 
“List of Pre-Processor Classes” on page 789 or “List of Post-Processor Classes” 
on page 795.

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters

Acknowledgement Opens the Set/Unset Acknowledgment window relevant to the CI, in 
Dashboard. For details, see “Acknowledge Performance Problems” on 
page 102.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Acknowledgement 
Details

Opens the Acknowledgment details window relevant to the CI, in 
Dashboard. For details, see “Acknowledgments Details Dialog Box” on 
page 109.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ ack.cmdbObjectID

➤ ack.ackID

➤ URL

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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Add KPI Opens the New KPI page in Dashboard Administration. For details, see 
“How Dashboard KPIs Work” on page 338.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Application Mapping Opens the Acknowledgment details window relevant to the CI, in 
Dashboard. For details, see “HP Business Availability Center for SAP 
Applications” in Solutions and Integrations.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

BPI Monitors Over 
Time

Opens the BPI Monitors Over Time report relevant for the CI.

Pre-Processor Class: 

BPIMonitorOTPreprocessor

Parameters:

None

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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Business Process Over 
Time

Opens the BPI Monitors Over Time report relevant for the CI.

Pre-Processor Class: 

BPIBusinessProcessOTReport
Preprocessor

Parameters:

None

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Change Report Opens the Change report in Dashboard. For details, see “Change Report 
Page” in Model Management.

Pre-Processor Class: 

None

Parameters:

➤ USER. Internal. This parameter 
must not be modified.

➤ CMDB_NODE_ID. Internal. This 
parameter must not be 
modified.

➤ PASSWORD. Internal. This 
parameter must not be 
modified.

➤ PROTOCOL. The type of 
protocol to be used

➤ PORT. The target port

➤ URL_SUFFIX. The suffix to add 
at the end of the URL

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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CI Impact Report Opens the Related Change Request report in Dashboard.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Complete Alert Activates a URL call to the relevant SAP system and completes the 
selected SAP alert.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ ALERTTIME

➤ ALSYSID

➤ MSG

➤ szTargetHostName

➤ MSEGNAME

➤ ALINDEX

➤ szTargetHostIP

➤ ALERTDATE

➤ ALUNIQNUM

➤ SapConnId

Configuration Item 
Status Alerts

Opens the Configuration Item Status Alert report relevant to the CI. For 
details, see “Configuration Item Status Alerts Report” in Alerts.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None
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Console Opens the Console tab in the Dashboard Application.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Switch Dashboard Tabs” on 
page 804

Parameters:

➤ TAB_ID

Create New Business 
Service

Available in the Service Level Management application. 

It opens the Business Service CI wizard where you can create a new 
Business Service CI. For details, see “Business Service Wizard” in Service 
Level Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Create New SLA from 
Business Service

Available in the Service Level Management application. 

It enables you to create a new SLA for the selected Business Service CI. It 
opens the Create Agreement wizard with the selected Business Service CI 
already attached. For details, see “Agreement Wizard” in Service Level 
Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Custom Map Opens the Custom Map tab in Dashboard.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Switch Dashboard Tabs” on 
page 804

Parameters:

➤ TAB_ID
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Customer This context menu option is available in the Service Level Management 
application. It displays the customer defined for the selected service.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Delete Business 
Service

This context menu option is available in the Service Level Management 
application. It deleted the selected Business Service CI.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Delete CI Opens a dialog box to confirm that you want to delete the relevant CI in 
IT Universe Manager. 

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Delete Folder Opens the Delete Folder dialog box to enable you to delete the folder.

Pre-Processor Class: 

“View Manager (New Folder) 
Processor” on page 794

Parameters:

➤ URL

Post-Processor Class: 

“General View-Manager Context 
Menu” on page 796

Parameters:

➤ SCROLL

➤ HEIGHT

➤ WIDTH

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

731

Drilldown to Web 
Service Topology

This option is displayed only for Web Service CIs. It opens the 
Diagnostics Service Topology view for the selected Web Service CI.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Disable Disables the KPI attached to a CI in the KPI tab in Dashboard 
Administration. For details, see “Change the No Data Timeout Value for 
Transaction CIs – Optional” on page 369.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ POSTPROCESS_OPERATION. 
Indicates whether the post-
process operation is to be run 
(true) or not (false).

Drill to Diagnostics Drills down in the Diagnostics application. For details, see the 
HP Diagnostics documentation.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Edit Business Service Available in the Service Level Management application.

It opens the Business Service CI wizard in edit mode where you can edit 
the selected Business Service CI. For details, see “Business Service 
Wizard” in Using Service Level Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

732

Enable Enables the KPI attached to a CI in the KPI tab in Dashboard 
Administration. For details, see “Change the No Data Timeout Value for 
Transaction CIs – Optional” on page 369.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ POSTPROCESS_OPERATION. 
Indicates whether the post-
process operation is to be run 
(true) or not (false).

End User Summary Moves to the End User Summary Report in End User Management. The 
End User Summary report displays data for specific end-users that were 
configured for the Real User Monitor in System Availability 
Management. For details, see “End User Summary Report” in Using End 
User Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ autoGenerate

➤ application_id

➤ filter.selectedcmdbidsfromOuter 
Application

➤ menu_item_id

➤ time_view

➤ reportID

➤ isContainer

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication
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Event Analysis (Event 
Monitor)

Opens the “Event Analysis Report” in Using End User Management.

Pre-Processor Class: 

None

Parameters: 

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters: 

➤ menu_item_url

➤ autoGenerate

➤ application_id

➤ filter.selectedcmdbidsfromOuter 
Application

➤ menu_item_id

➤ time_view

➤ reportID

➤ isContainer

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication

Event Count Over 
Time

Moves to the Event Count Over Time Report in End User Management. 
The Event Count Over Time report displays data for all events, or 
sessions with events, in monitored applications that you configured in 
System Availability Management, broken down by time intervals. For 
details, see “Event Count Over Time Report” in Using End User 
Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ application_id

➤ autoGenerate

➤ filter.selectedApplication

➤ menu_item_id

➤ time_view

➤ reportID

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

734

Event Count Over 
Time (Application 
Error Monitor)

Moves to the Event Count Over Time Report in End User Management. 
The Event Count Over Time report displays data for all events, or 
sessions with events, in monitored applications that you configured in 
System Availability Management, broken down by time intervals. For 
details, see “Event Count Over Time Report” in Using End User 
Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ application_id

➤ autoGenerate

➤ filter.selectedApplicationErrors

➤ filter.selectedcmdbidsfromOuter 
Application

➤ menu_item_id

➤ time_view

➤ reportID

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication
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Event Count Over 
Time (HTTP Error 
Monitor)

Moves to the Event Count Over Time Report in End User Management. 
The Event Count Over Time report displays data for all events, or 
sessions with events, in monitored applications that you configured in 
System Availability Management, broken down by time intervals. For 
details, see “Event Count Over Time Report” in Using End User 
Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ application_id

➤ autoGenerate

➤ filter.selectedcmdbidsfromOuter 
Application

➤ filter.selectedApplication

➤ menu_item_id

➤ time_view

➤ reportID

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication
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Event Count Over 
Time (Information 
Event Monitor)

Moves to the Event Count Over Time Report in End User Management. 
The Event Count Over Time report displays data for all events, or 
sessions with events, in monitored applications that you configured in 
System Availability Management, broken down by time intervals. For 
details, see “Event Count Over Time Report” in Using End User 
Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ application_id

➤ autoGenerate

➤ filter.selectedcmdbidsfromOuter 
Application

➤ filter.selectedApplication

➤ menu_item_id

➤ time_view

➤ reportID

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication
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Event Log Report Moves to the Event Log report in End User Management. The 
Event Log report displays a log of the occurrences of a specific event 
type for a selected time frame. For details, see “Event Log” in Using 
End User Management.

Pre-Processor Class: 

None

Parameters:

➤ autoGenerate. This parameter 
must not be modified.

➤ TARGET_LOGIC_APPLICATION. 
This parameter must not be 
modified.

➤ __UIF_FORM. Internal. This 
parameter must not be 
modified.

➤ TARGET_HOST. Where the 
properties of the target host are 
located.

➤ __UIF_APPLICATION. Internal. 
This parameter must not be 
modified.

➤ CI_TYPE. This parameter must 
not be modified.

➤ URL. The URL of the new 
window.

➤ _UIF_ACTION. This parameter 
must not be modified.

➤ _UIF_SOURCE. This parameter 
must not be modified.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

738

Event Summary Moves to the Event Summary report in End User Management. The 
Event Summary report displays a summary of events in monitored 
applications that you configured in System Availability Management. 
For details, see “Event Summary Report” in Using End User Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ application_id

➤ filter.performance

➤ autoGenerate

➤ filter.selectedApplication

➤ menu_item_id

➤ reportID

➤ time_view

➤ filter.applicationErrors
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Event Summary 
(Errors Monitor)

Moves to the Event Summary report in End User Management. The 
Event Summary report displays a summary of events in monitored 
applications that you configured in System Availability Management. 
For details, see “Event Summary Report” in Using End User Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ application_id

➤ filter.selectedcmdbidsfromOuter 
Application

➤ autoGenerate

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication

➤ filter.selectedApplication

➤ menu_item_id

➤ time_view

➤ reportID
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Event Summary 
(Events Monitor)

Moves to the Event Summary report in End User Management. The 
Event Summary report displays a summary of events in monitored 
applications that you configured in System Availability Management. 
For details, see “Event Summary Report” in Using End User Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ application_id

➤ filter.selectedcmdbidsfromOuter 
Application

➤ autoGenerate

➤ filter.events

➤ filter.selectedApplication

➤ menu_item_id

➤ time_view

➤ reportID

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication

Expand More Levels Expands the Top View display to show the default maximum number of 
hierarchy levels for the CI.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“CallJSOnPagePostProcessor” on 
page 796

Parameters:

➤ JS_CALL_PARAMS

➤ JS_METHOD_NAME
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Expand to Problem Expands the Top View display to show the source of a problematic CI.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“CallJSOnPagePostProcessor” on 
page 796

Parameters:

➤ JS_CALL_PARAMS

➤ JS_METHOD_NAME

Filter Subtree Filters the subtree of the selected element according to the previously 
defined filter. For details about the Filters tab, see “Filters Page” on 
page 187.

By default, appears under the Events shortcut menu.

Pre-Processor Class: 

“Prepare Parameters (Dashboard)” 
on page 793

Parameters:

➤ NODE_ID

➤ strutsAction

➤ viewType

Post-Processor Class: 

“Switch Dashboard Tabs with 
Parameters” on page 805

Parameters:

➤ TAB_ID

Filter Subtree 
Monitors

Displays only the CIs that have the monitor type – like the Show 
Monitors Only filter. For details about the Filters tab, see “Filters Page” 
on page 187.

Pre-Processor Class: 

“Prepare Parameters (Dashboard)” 
on page 793

Parameters:

➤ nodeType

➤ NODE_ID

➤ strutsAction

➤ viewType

Post-Processor Class: 

“Switch Dashboard Tabs with 
Parameters” on page 805

Parameters:

➤ TAB_ID
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Filters Opens the Filters tab in Dashboard or is used as a parent menu for other 
filter context menu items; for example, Filter Subtree Monitors. For 
details about the Filters tab, see “Filters Page” on page 187.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Switch Dashboard Tabs” on 
page 804

Parameters:

➤ TAB_ID

Find Visible and 
Hidden Child CIs

Returns all of the visible and hidden child CIs of the selected CI that 
appear in the CMDB. For details, see “Find Visible and Hidden Child CIs 
Dialog Box” on page 73.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ parentCmdbId

➤ URL

➤ NODE_ID

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Geographical Map Opens the Geographical Map tab in Dashboard. For details about the 
Geographical Map tab, see “Geographical Map Page” on page 212.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Switch Dashboard Tabs” on 
page 804

Parameters:

➤ TAB_ID
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Go to BPI Application 
Health Tab

Opens the Health page tab within the HP Business Process Insight 
application. For details, see BPI Application Health in Using Business 
Process Insight.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

DashboardMultiSelectURLPreproc
essor

Parameters:

➤ menu_item_url. Internal use.

➤ application_id. Internal use.

➤ menu_item_id. Internal use.

Go to Console Opens the Dashboard Console tab.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Switch Dashboard Tabs” on 
page 804

Parameters:

➤ TAB_ID

Go To Problem 
Isolation 

Parent menu for redirections to other applications. 

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ menu_item_url

➤ application_id

➤ IS_POPUP

➤ problematicCI

➤ menu_item_id

➤ selectedActionId
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Go To Report Parent menu for redirections to other applications. 

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Go To Siebel 
Diagnostics

Opens the options that enable you to open specific pages in the Business 
Availability Center for Siebel filtered by the selected CI. For details, see 
“Go to Siebel Diagnostics” on page 87.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Go to SiteScope Displays the relevant SiteScope Web page for this CI in a new SiteScope 
browser window, enabling you to view more detailed SiteScope 
parameters and measurements. See the SiteScope documentation for 
directions on using SiteScope.

Note: By default, Dashboard accesses the SiteScope machine using the 
machine host name. If you want access through IP, edit the SiteScope 
context menu item, by changing the value for the pre-processor 
parameter HOST_BY from NAME to IP.

Pre-Processor Class: 

“Goto SiteScope” on page 792

Parameters:

➤ ROOT_PATH

➤ PROFILE_ID

➤ POST_FIX

➤ GROUP_NODE_NAME

➤ HOST_BY

➤ ROOT_POSTFIX

➤ PATH

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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Go to Top View Opens the Dashboard Top View tab, with the view's tree centered on the 
selected CI.

Pre-Processor Class: 

“Prepare Parameters (Dashboard)” 
on page 793

Parameters:

➤ NODE_ID

Post-Processor Class: 

“Switch Dashboard Tabs with 
Parameters” on page 805

Parameters:

➤ TAB_ID

Go to 
TransactionVision

Opens a window in the TransactionVision application to display reports 
that provide you with breakdown information for the transaction at 
component level. This context menu item is available only if 
TransactionVision has been installed.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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HP Service Manager A context menu option available from Business Service CIs or EMS 
Monitor CIs under Business Service CIs, to open the HP Service Manager 
application. 

For details on the integration with HP Service Manager, see “HP Service 
Manager Integration with Business Availability Center Components” in 
Solutions and Integrations.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Invoke Run Books For CIs whose CI type is mapped to an HP Operations Orchestration 
(OO) run book, opens the Related Run Books page in a new window. You 
can then view the mapped run books and invoke them in OO. For 
details, see “Invoke Run Book Page” in Using Problem Isolation.

Pre-Processor Class: 

“RunBookPreprocessor” on 
page 793

Parameters:

➤ FROM_DASHBOARD

➤ CMDB_NODE_ID

➤ SUSPECT_NAME

➤ CI_TYPE

➤ URL

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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KPI Data Over Time The main menu option that lists the Enable/Disable options for a KPI 
attached to a CI in the KPI tab in Dashboard Administration. For details, 
see “Change the No Data Timeout Value for Transaction CIs – Optional” 
on page 369.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

KPIs Over Time Opens the KPI over Time report relevant to the CI. For details, see “KPIs 
Over Time Report” on page 277.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None
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Load View Internal.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ drill_to. Internal. This 
parameter must not be 
modified.

➤ drill_from. The ID of the 
application you are drilling 
from.

➤ probe_group_name. The name 
of the probe to be used when 
opening Diagnostics.

➤ server_name. The name of the 
server to be used when opening 
Diagnostics.

Locate CI in SLA Displays the Search pane where you can specify the CI you want to 
locate in SLA. For details about the search feature, see “Search for CIs in 
Search Mode” in Model Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None
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Locate CI in View Displays the Search pane where you can specify the CI you want to 
locate. For details about the search feature, see “Search for CIs in Search 
Mode” in Model Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

New Folder Opens the Create Folder dialog box to enable you to create a new folder. 
For details, see “View Manager Window” in Model Management.

Pre-Processor Class: 

“View Manager (New Folder) 
Processor” on page 794

Parameters:

➤ URL

Post-Processor Class: 

“General View-Manager Context 
Menu” on page 796

Parameters:

➤ SCROLL

➤ HEIGHT

➤ WIDTH

➤ RESIZE

Open in New Window Opens an external application from Top View. 

For details on configuring this menu item, see “Access an External 
Application from Top View” on page 132.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“CallJSOnPagePostProcessor” on 
page 796

Parameters:

➤ JS_CALL_PARAMS

➤ JS_METHOD_NAME
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Operations Health Moves to the Operations Health report in HP Business Availability 
Center for SOA application. For details, see “Health Report” in Solutions 
and Integrations.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ menu_item_url

➤ application_id

➤ autoGenerate

➤ menu_item_id

➤ reportID

➤ filter.fromDashboard

➤ filter.selectedCIsType
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OVO Drill Down Enables you to access the HP Operations Manager application. For 
limitations, see “OVO Drill Down Event” on page 706.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ OVO Server. The name of the 
OVO Server.

➤ SCROLL. If set to 1, a scrolling 
tab is added to the opened 
window, if required. If set to 0, 
no scrolling tab is added to the 
open window.

➤ HEIGHT. The opened window 
height, in pixels.

➤ SLAVE_WIN. If set to 1 it checks 
that the window closes when 
the application is closed.

➤ OVO User. The user name used 
to access the Operations 
Manager application.

➤ WIDTH. The opened window 
width, in pixels.

➤ WIN_NAME. Specifies the 
window name

➤ RESIZE. If set to 1, the window 
can be resized. If set to 0, the 
window cannot be resized.
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Page Summary Moves to the Page Summary report in End User Management. The Page 
Summary report displays data for specific Web pages that were 
configured for the Real User Monitor in System Availability 
Management. For details, see “Page Summary Report” in Using End User 
Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ autoGenerate

➤ application_id

➤ filter.selectedcmdbidsfromOuter 
Application

➤ selectedApplication

➤ menu_item_id

➤ time_view

➤ reportID

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication
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Pages Layers View Moves to the Page Layers View report in the HP Diagnostics application. 
For details, see HP Diagnostics User’s Guide.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ actionProcessorClass. The 
process to run to gather the 
parameters. This parameter 
must not be modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ drill_to. Internal. This 
parameter must not be 
modified.

➤ action. Internal.

➤ app_url. Internal.

➤ drill_from. The ID of the 
application you are drilling 
from.

➤ type. Defines the type. 

➤ app_context. Internal.

➤ actionForward. The name of the 
menu to go to. This parameter 
must not be modified.
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Probe Group 
Summary 

Moves to HP Diagnostics reports. For details, see HP Diagnostics User’s 
Guide.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ drill_to. Internal. This 
parameter must not be 
modified.

➤ drill_from. The ID of the 
application you are drilling 
from.

➤ probe_group_name. The name 
of the probe group to be used 
when opening Diagnostics.
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Probe Summary Moves to HP Diagnostics reports. For details, see HP Diagnostics User’s 
Guide.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ drill_to. Internal. This 
parameter must not be 
modified.

➤ drill_from. The ID of the 
application you are drilling 
from.

➤ probe_name. The name of the 
probe to be used when opening 
Diagnostics.

➤ server_name. The name of the 
server to be used when opening 
Diagnostics.

Properties Opens the Properties dialog box relevant to the CI. For details, see 
“Working with CIs” in Model Management.

Pre-Processor Class: 

“Show Properties in VT” on 
page 794

Parameters:

➤ URL

Post-Processor Class: 

“Open the Properties Page From 
the View Traverse” on page 801

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ RESIZE
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Provider This context menu option is available in the Service Level Management 
application. It displays the provider of the selected service.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Rename Folder Opens the Rename Folder dialog box to enable you to rename the folder.

Pre-Processor Class: 

“View Manager (New Folder) 
Processor” on page 794

Parameters:

➤ URL

Post-Processor Class: 

“General View-Manager Context 
Menu” on page 796

Parameters:

➤ SCROLL

➤ HEIGHT

➤ WIDTH

➤ RESIZE
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SAP Transaction 
Changes Report

Opens the SAP Transaction Changes report that tracks changes made to a 
SAP Transaction CI when a transport was modified. For details, see “SAP 
Transaction Changes Report” in Solutions and Integrations.

Pre-Processor Class: 

None

Parameters:

➤ reportName. Internal. Do not 
modify.

➤ PASSWORD. Password of the 
HP Universal CMDB server 
administrator. By default, it is 
the password to the HP Business 
Availability Center DPS 
machine. When using an 
external Universal CMDB, this 
defines the password used to 
access the URL of the machine 
on which the external Universal 
CMDB is installed.

➤ USERNAME. The user used by 
HP Universal CMDB server 
administrator.

➤ PROTOCOL. Defines the URL of 
the HP Universal CMDB server.

➤ PORT. Defines the port of the 
HP Universal CMDB server.

➤ URL_SUFFIX. URL suffix of the 
HP Universal CMDB server. By 
default, it is the suffix of the 
URL used to access the 
HP Business Availability Center 
DPS machine. When using an 
external Universal CMDB, this 
defines the suffix of the URL 
used to access the machine on 
which the external Universal 
CMDB is installed.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

758

SAP Transport 
Changes

Opens the SAP Transport Changes report that track changes made to the 
properties of a SAP Transport CI. For details, see “SAP Transport Changes 
Report” in Solutions and Integrations.

Pre-Processor Class: 

None

Parameters:

➤ reportName. Internal. Do not 
modify.

➤ PASSWORD. Password of the 
HP Universal CMDB server 
administrator. By default, it is 
the password to the HP Business 
Availability Center DPS 
machine. When using an 
external Universal CMDB, this 
defines the password used to 
access the URL of the machine 
on which the external Universal 
CMDB is installed.

➤ USERNAME. The user used by 
HP Universal CMDB server 
administrator.

➤ PROTOCOL. Defines the URL of 
the HP Universal CMDB server.

➤ PORT. Defines the port of the 
HP Universal CMDB server.

➤ URL_SUFFIX. URL suffix of the 
HP Universal CMDB server. By 
default, it is the suffix of the 
URL used to access the 
HP Business Availability Center 
DPS machine. When using an 
external Universal CMDB, this 
defines the suffix of the URL 
used to access the machine on 
which the external Universal 
CMDB is installed.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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SAR Compliancy 
Report

Opens the SAR Compliancy report for a Host CI. For details, see “View 
the SAR Compliancy Report” on page 63.

Pre-Processor Class: 

“SARCompliancyReportPreprocess
or” on page 794.

Parameters:

➤ ALLOWED_CI_TYPES

➤ URL_SUFFIX

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

760

Server Requests The option opens the Server Requests View in the HP Diagnostics 
application with the URL(s) that correspond to the Real User Monitor 
Business Process Step CIs selected. 

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ actionProcessorClass. Internal. 
This parameter must not be 
modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ drill_to. Internal. This 
parameter must not be 
modified.

➤ action. Internal. This parameter 
must not be modified.

➤ app_url. Internal.

➤ drill_from. The ID of the 
application you are drilling 
from.

➤ type. Defines the type. 

➤ app_context. Internal.

➤ actionForward. The name of the 
menu to go to. This parameter 
must not be modified.
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Server Summary Moves to the Server Summary report in End User Management. The 
Server Summary report displays data for the servers that are monitored 
by the Real User Monitor probe. For details, see “Server Summary 
Report” in Using End User Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ autoGenerate

➤ application_id

➤ filter.server FilterBean.serverName 
WildCard

➤ time_view

➤ reportID

➤ menu_item_id

➤ reportID

Session Analyzer Moves to the Session Analyzer report in End User Management filtered 
on the selected transaction (or child transactions in the case of a 
transaction group entity) and the Past Hour time period. The Session 
Analyzer report displays session data for specific applications that were 
configured for the Real User Monitor in System Availability 
Management. For details, see “Session Analyzer Report” in Using End User 
Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ application_id

➤ autoGenerate

➤ filter.selectedApplication

➤ menu_item_id

➤ time_view

➤ reportID

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

762

Set/Unset 
Acknowledgement 

Moves to the Top View tab with the Set/Unset Acknowledgment option 
selected for the CI in the Dashboard application. For details, see 
“Acknowledgments Details Dialog Box” on page 109.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ ack.cmdbObjectID

➤ ack.ackID

➤ ack.closeDialog

➤ URL

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Show Business Impact Display information about the Business CIs impacted by the selected CI, 
in a separate window. 

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ CiID

➤ URL

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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Show Business Process 
Over Time

Opens the BPI Business Process Over Time report in a popup window. 
For details, see BPI Application Reports in Using Business Process Insight.

Pre-Processor Class: 

BPIBusinessProcessOTReportPrepr
ocessor.

Parameters:

None

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Show Business Process 
Step Summary

Opens the BPI Business Process Step Summary in a popup window. For 
details, see BPI Application Reports in Using Business Process Insight.

Pre-Processor Class: 

BPIBusinessStepOTReportPreproce
ssor.

Parameters:

None

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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Show Complete 
Subtree 

Moves to the Events tab and displays all CIs (subgroups and monitor 
CIs) that fall in the branches under this CI.

Pre-Processor Class: 

“Prepare Parameters (Dashboard)” 
on page 793

Parameters:

➤ NODE_ID

➤ strutsAction

➤ selectFilterID

➤ viewType

Post-Processor Class: 

“Switch Dashboard Tabs with 
Parameters” on page 805

Parameters:

➤ TAB_ID
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Show Events Activates a popup window that lists the events. Select the appropriate 
event and click the Show events button to clear the event from the 
Dashboard of HP Business Availability Center. A clear event is then 
published on the bus.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ SCROLL. If set to 1, a scrolling 
tab is added to the opened 
window, if required. If set to 0, 
no scrolling tab is added to the 
open window.

➤ HEIGHT. The opened window 
height, in pixels.

➤ SLAVE_WIN. If set to 1 it checks 
that the window closes when 
the application is closed.

➤ Base URL. The location of file: 
/<HP_BAC_web_application_co
ntext_name (usually 
topaz)>/jsps/dash/ClearEventC
ontextMenu.jsp

➤ WIDTH. The opened window 
width, in pixels.

➤ WIN_NAME. Specifies the 
window name.

➤ RESIZE. If set to 1, the window 
can be resized. If set to 0, the 
window cannot be resized.
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Show Impacting SAP 
Transports 

Available for SAP-related Transaction CIs and for group CIs. 

For Transaction CIs, enables you to display the transports that are 
impacting the selected Transaction CI, with no historical limit to the 
information. 

Groups CIs represent the following CIs: SAP Site, SAP Business Process, 
SAP Business Scenario, SAP J2EE Dispatcher, SAP J2EE Server Process, SAP 
Process Step, SAP Project, SAP Transaction, SAP Transport Change, 
Application Component, SAP R/3 Application Server, SAP System, SAP 
Application Server, SAP J2EE Application Server, SAP R/3 Application 
Server, and SAP Gateway.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“SapProblemIsolationPostProcesso
r” on page 803

Parameters:

➤ Base URL

➤ timeInterval

➤ HEIGHT

➤ RESIZE

➤ SCROLL

➤ SLAVE_WIN

➤ WIDTH
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Show Path to Root Moves to the Top View tab with the Show Path to Root option selected 
for the CI in the Dashboard application. For details, see “Menu Options” 
on page 75.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ targetNodeIds

➤ URL

➤ isFullScreen

➤ filterId

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Show Problematic 
Subtree

Moves to the Top View tab with the Expand to Problem option selected 
for the CI in the Dashboard application. For details, see “Menu Options” 
on page 75.

Pre-Processor Class: 

None

Parameters:

➤ targetNodeIds. The ID of the 
target node.

➤ URL. The URL of the new 
window.

➤ isFullScreen. Opens a popup 
window with the path to root. 
This parameter must not be 
modified.

➤ filterId. The ID of the filter. 
Internal. This parameter must 
not be modified.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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Show Processes Opens the Siebel Process Diagnostics Tool. For details, see “Processes 
Tool - Advanced Filter Dialog Box” in Solutions and Integrations.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ CMDB_NODE_ID

➤ URL

➤ COMMAND

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Show Related CIs Opens the Related CIs tab, in IT Universe Manager. For details, see 
“Browse Mode” in Model Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Show Running Tasks Opens the Task Diagnostics Tool view. For details, see “Tasks Diagnostics 
Tool Report” in Solutions and Integrations.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ CMDB_NODE_ID

➤ URL

➤ COMMAND

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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Show SAP Transport 
Impact

Available for SAP-related Transport CIs. 

Enables you to display information for all the transactions in the system 
that impact the selected transport, with no historical limit to the 
information. 

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Show Subtree 
Monitors

Opens the Events tab and displays only the CIs with the monitor type, 
their children CIs and the KPIs attached to those CIs, filtered using the 
Show Monitors Only filter. For details, see “Filters Page” on page 187.

Pre-Processor Class: 

“Prepare Parameters (Dashboard)” 
on page 793

Parameters:

➤ NODE_ID

➤ strutsAction

➤ selectFilterID

➤ viewType

Post-Processor Class: 

“Switch Dashboard Tabs with 
Parameters” on page 805

Parameters:

➤ TAB_ID
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Show Tasks in Error Opens the Siebel Task Diagnostics Tool view. For details, see “Tasks 
Diagnostics Tool Report” in Solutions and Integrations.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ CMDB_NODE_ID

➤ URL

➤ COMMAND

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Show Top View Opens the Dashboard Top View in a popup window, with the view's tree 
centered on the selected CI.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ targetNodeIds

➤ URL

➤ isFullScreen

➤ filterId

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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Siebel Cross-
Performance

Opens the SiteScope Cross-Performance report for Siebel-specific entities. 
For details, see “Group Performance Report” in Using System Availability 
Management.

Pre-Processor Class: 

None

Parameters:

➤ actionProcessorClass. The 
process to run to gather the 
parameters. This parameter 
must not be modified.

➤ stepValue. The time period used 
to calculate reports (every 5 
minutes).

➤ TARGET_HOST. Where the 
properties of the target host are 
located.

➤ PROFILE_ID. The SiteScope 
profile to be used when opening 
SiteScope.

➤ MONITOR_TYPE. The type of 
monitor.

➤ PROFILE_NAME. The name of 
the profile.

➤ timeFrame. The time frame 
during which the report runs.

➤ URL. The URL of the new 
window.

➤ MONITOR_ID.The ID of the 
monitor.

➤ NODE_ID. Converts to nodeId. 

➤ actionForward. The name of the 
menu to go to. This parameter 
must not be modified.

➤ stepUnit. The unit of stepValue.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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Siebel Database 
Breakdown

Opens the Database Breakdown tab in the Business Availability Center 
for Siebel application. For details, see “Siebel Database Breakdown 
Configuration Report” in Solutions and Integrations.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ menu_item_url. The location 
where the parameters are 
calculated. This parameter must 
not be modified.

➤ actionProcessorClass. The 
process to run to gather the 
parameters. This parameter 
must not be modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ CMDB_NODE_ID. Internal. This 
parameter must not be 
modified.

➤ menu_item_id. The ID of the 
menu item.

➤ __sieb_mode. The Siebel mode.

➤ actionForward. Internal.

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

773

Siebel SARM Opens the SARM - User Trace Breakdown tab in the Business Availability 
Center for Siebel application. For details, see “Siebel Views” in Solutions 
and Integrations.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ menu_item_url. The location 
where the parameters are 
calculated. This parameter must 
not be modified.

➤ actionProcessorClass. The 
process to run to gather the 
parameters. This parameter 
must not be modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ CMDB_NODE_ID. Internal. This 
parameter must not be 
modified.

➤ menu_item_id. The ID of the 
menu item.

➤ __sieb_mode. The Siebel mode.

➤ actionForward. Internal.
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SiteScope Cross-
Performance 

Opens the SiteScope Cross-Performance report relevant to the CI. For 
details, see “Cross-Performance Report” in Using System Availability 
Management.

Pre-Processor Class: 

None

Parameters:

➤ actionProcessorClass. The 
process to run to gather the 
parameters. This parameter 
must not be modified.

➤ stepValue. The time period used 
to calculate reports (every 5 
minutes).

➤ TARGET_HOST. Where the 
properties of the target host are 
located.

➤ PROFILE_ID. The SiteScope 
profile to be used when opening 
SiteScope.

➤ MONITOR_TYPE. The type of 
monitor.

➤ PROFILE_NAME. The name of 
the profile.

➤ timeFrame. The time frame 
during which the report runs.

➤ URL. The URL of the new 
window.

➤ NODE_ID. Converts to nodeId. 

➤ MONITOR_ID. The ID of the 
monitor. 

➤ actionForward. The name of the 
menu to go to. This parameter 
must not be modified.

➤ stepUnit. The unit of stepValue.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE
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SiteScope Quick 
Report 

Available for SiteScope Group and SiteScope Monitor CIs.

Opens the SiteScope Quick Report. For details, see “Quick Report” in 
Using System Availability Management.

Pre-Processor Class: 

None

Parameters:

➤ ROOT_PATH. The root path to 
SiteScope.

➤ PROFILE_ID. The SiteScope 
profile to be used when opening 
SiteScope.

➤ POST_FIX. The post fix 
expression to be added to the all 
URLs.

➤ ROOT_CLASS. The name of the 
root class.

➤ GROUP_NODE_NAME. The CIs 
group in SiteScope.

➤ HOST_BY. The SiteScope host.

➤ MONITOR_ID. The ID of the 
monitor.

➤ ROOT_POSTFIX. The SiteScope 
root.html document.

➤ PATH. The path that includes all 
of the SiteScope groups.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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SiteScope Server 
Centric Report 

Available for Windows Resource Monitor and Unix Resource Monitor CIs 
under specific conditions described in the report description.

Opens the Server Centric Report. For details, see “Server-Centric Report” 
in Using System Availability Management.

Pre-Processor Class: 

None

Parameters:

➤ TARGET_HOST. Where the 
properties of the target host are 
located.

➤ MONITOR_TYPE. The type of 
monitor.

➤ HOST_BY. The SiteScope host.

➤ MONITOR_ID. The ID of the 
monitor.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

SLAs Summary Report Internal.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Systinet Web Service 
Data

Opens the HP SOA Systinet application for the Web Service. For details, 
see HP SOA Systinet documentation.

Pre-Processor Class: 

None

Post-Processor Class: 

None

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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TCP Application 
Summary

Opens the TCP Application Summary report and displays data about 
TCP Applications. For details about the report, see “TCP Application 
Summary Report” in Using End User Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ menu_item_url. The location 
where the parameters are 
calculated. This parameter must 
not be modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ filter.selectedApplications. The 
application the CI belongs to.

➤ autoGenerate. Internal. This 
parameter must not be 
modified.

➤ enabled_when. Use:

➤ tcp_app to enable the 
context menu itemonly in 
the TCP application.

➤ web_app to enable the 
context menu item only for 
Web applications.

➤ menu_item_id. The ID of the 
menu item.

➤ time_view. Internal. This 
parameter must not be 
modified.

➤ reportID. The ID number of the 
report.

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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Top View Moves to the Top View tab for the CI in the Dashboard application. For 
details, see “Top View Page” on page 136.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

None

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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Transaction Analysis Moves to the Transaction Analysis report in End User Management 
filtered on the selected transaction (or child transactions in the case of a 
transaction group entity) and the Past Hour time period. The 
Transaction Analysis report provides an in-depth picture of the 
performance of transactions. For details, see “Transaction Analysis 
Report” in Using End User Management.

By default, appears under the Go to Report shortcut menu.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ menu_item_url. The location 
where the parameters are 
calculated. This parameter must 
not be modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ stepValue. The time period used 
to calculate reports (every 5 
minutes).

➤ timeFrame. The time frame 
during which the report runs.

➤ REQUEST_TYPE. Internal. This 
parameter must not be 
modified.

➤ menu_item_id. The ID of the 
menu item.

➤ MEASUREMENT_1_ID_PREFIX. 
Internal. Used to control if the 
report is filtered by location or 
by transaction for Business 
Process Monitor CIs.

➤ actionForward. The name of the 
menu to go to. This parameter 
must not be modified.

➤ stepUnit. The unit of stepValue.

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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Transaction Analysis 
(continued)

➤ MEASUREMENT_0_ID_PREFIX. 
Internal. Used to control if the 
report is filtered by location or 
by transaction for SiteScope CIs

➤ actionProcessorClass. The 
process to run to gather the 
parameters. This parameter 
must not be modified.

➤ clearFilters. Internal.

➤ PROFILE_ID. The SiteScope 
profile to be used when opening 
SiteScope.

➤ autoUpdatePastTime. Internal. 
This parameter must not be 
modified.

➤ MAX_MEASUREMENT_NUM. 
Maximum limit of 
measurements to filter in both 
SiteScope and Business Process 
Monitor. Since this menu can 
be applied also to for any CI 
that includes measurements in 
its subtree, then the filtered 
measurements are counted first. 
If the maximum has not been 
reached then the other CIs are 
counted until 
MAX_MEASUREMENT_NUM is 
reached

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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Transaction Analysis 
(continued)

➤ DIMENSION_ID_PREFIX. 
Internal. Controls if the report 
is filtered by location or by 
transaction (see 
MEASUREMENT_1_ID_PREFIX).

➤ REPORT_NAME. Specifies to 
which report to drill down from 
End User Management (not just 
from Transaction Analysis). This 
is the internal name of the EUM 
reports. It is supported only for 
legacy reports. For details, see 
for details, see “Customizing 
Reports” in Reports.

➤ REPORT_NAME. The name of 
the report.

Transaction Over Time Opens the Transaction Over Time report relevant for the CI.

Pre-Processor Class: 

“Dashboard Generic URL” on 
page 789

Parameters:

➤ FROM_DASHBOARD

➤ SELECTED_MEASUREMENTS1

➤ CMDB_NODE_ID

➤ URL

➤ REPORT_ID

➤ SELECTED_MEASUREMENTS2

➤ DATA_MODEL_SET_ TO_VALUE

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
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Transaction Summary Opens the Transaction Summary report relevant for the CI.

Pre-Processor Class: 

DashboardMultiSelectURLPreproc
essor

Parameters:

➤ FROM_DASHBOARD. Internal 
use.

➤ MULTI_SELECTION_PARAM_
KEYS. Internal use.

➤ MULTI_SELECTION_TYPES_
FILTER. Internal use.

➤ DATA_MODEL_SET_TO_BOTH. 
Internal use.

➤ CMDB_NODE_ID. Internal use.

➤ URL. Internal use.

➤ REPORT_ID. Internal use.

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
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Transaction Summary Moves to the Transaction Summary Reports area for that CI in the End 
User Management User Reports application. The Transaction Summary 
report displays data for specific transactions that were configured for the 
Real User Monitor in System Availability Management. For details, see 
“Transaction Summary Report” in Using End User Management.

By default, appears under the Go to Report shortcut menu.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto RUM Reports” on page 798

Parameters:

➤ menu_item_url

➤ autoGenerate

➤ monitorName

➤ application_id

➤ filter.selectedcmdbidsfromOuter 
Application

➤ filter.selectedApplication

➤ time_view

➤ menu_item_id

➤ reportID

➤ filter.vttTree 
Type4Thecmdbidsfrom 
OuterApplication

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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Transactions Layers 
View

Opens the Transactions view that displays performance metrics for the 
transactions that are being executed by your applications. The 
transaction that corresponds to the selected Business Process Step CI is 
highlighted.

For more information about Diagnostics, see HP Diagnostics User’s Guide.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ actionProcessorClass. The 
process to run to gather the 
parameters. This parameter 
must not be modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ drill_to. Internal. This 
parameter must not be 
modified.

➤ action. Internal. This parameter 
must not be modified.

➤ app_url. Internal.

➤ drill_from. The ID of the 
application you are drilling 
from.

➤ type. Defines the type. 

➤ app_context. Internal.

➤ actionForward. The name of the 
menu to go to. This parameter 
must not be modified.

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
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Transactions View Opens the Transactions view that displays performance metrics for the 
transactions that are being executed by your applications. The 
transaction that corresponds to the selected Business Process Step CI is 
highlighted.

For more information about Diagnostics, see HP Diagnostics User’s Guide.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ actionProcessorClass. The 
process to run to gather the 
parameters. This parameter 
must not be modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ drill_to. Internal. This 
parameter must not be 
modified.

➤ action. Internal. This parameter 
must not be modified.

➤ app_url. Internal.

➤ drill_from. The ID of the 
application you are drilling 
from.

➤ type. Defines the type. 

➤ app_context. Internal.

➤ actionForward. The name of the 
menu to go to. This parameter 
must not be modified.

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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Trend Moves to the Trend Reports area for that CI in the End User 
Management User Reports application. The Trend Report Wizard 
generates a trend report that provides a graphical representation of 
measurement data over a specific time period. For details, see “Trend 
Reports” in Reports.

By default, appears under the Go to Report shortcut menu.

Pre-Processor Class: 

“Goto Trend Report” on page 791

Parameters:

➤ actionProcessorClass

➤ PROFILE_ID

➤ URL

➤ REQUEST_TYPE

➤ NODE_ID

➤ MEASUREMENT_1_ID_ PREFIX

➤ MAX_MEASUREMENT_NUM

➤ actionForward

➤ REPORT_NAME

➤ DIMENSION_ID_PREFIX

➤ MEASUREMENT_0_ID_ PREFIX

Post-Processor Class: 

“Open Window” on page 802

Parameters:

➤ SCROLL

➤ HEIGHT

➤ SLAVE_WIN

➤ WIDTH

➤ WIN_NAME

➤ RESIZE

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
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Triage Moves to the Triage Reports area for that CI in the End User 
Management User Reports application. The Triage report displays 
transaction data for Business Process Monitor, and Real User Monitor 
profiles for the past day. The data is organized by location. For details, 
see “Triage Report” in Using End User Management.

By default, appears under the Go to Report shortcut menu.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto Triage Reports” on page 797

Parameters:

➤ menu_item_url

➤ application_id

➤ menu_item_id

➤ reportID

Triage Raw Data Opens the Triage Raw Data report. For details about the report, see 
“Triage Raw Data Report” in Using End User Management.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

“Goto Triage Reports” on page 797

Parameters:

➤ menu_item_url

➤ application_id

➤ menu_item_id

➤ reportID

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters
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Web Service Health Moves to the Health Report of the CI in the Business Availability Center 
for SOA application. For details, see “Health Report” in Solutions and 
Integrations.

By default, appears under the Go to Report shortcut menu.

Pre-Processor Class: 

None

Parameters:

None

Post-Processor Class: 

None

Parameters:

➤ menu_item_url. The location 
where the parameters are 
calculated. This parameter must 
not be modified.

➤ application_id. The ID of the 
application to be used when 
opening Diagnostics.

➤ autoGenerate. Internal. This 
parameter must not be 
modified.

➤ VT_NODES_SYMBOL_IDS_KEY. 
The symbol ID of the CI, to 
which the context menu item is 
attached, in the view.

➤ menu_item_id. The ID of the 
menu item.

➤ report_ID. The ID of the report 
that is opened by the context 
menu item.

➤ filter.fromDashboard. Used to 
add a dynamic value to the 
URL.

➤ filter.selectedCIsType. Internal. 
This parameter must not be 
modified.

Context Menu Item
Description, Pre-Processor Class and Its Parameters, and Post-Processor 
Class and Its Parameters



Chapter 22 • Context Menu Item Repository

789

List of Pre-Processor Classes

Pre-processor classes correspond to specific menus. In addition, a 
pre-processor class specifies the actions performed before accessing the 
database.

This section includes the following topics:

➤ “Dashboard Generic URL” on page 789

➤ “Goto Trend Report” on page 791

➤ “Goto SiteScope” on page 792

➤ “ITU Internal (Open Modal Window)” on page 793

➤ “Netscout URL” on page 793

➤ “Prepare Parameters (Dashboard)” on page 793

➤ “RunBookPreprocessor” on page 793

➤ “SARCompliancyReportPreprocessor” on page 794

➤ “Show Properties in VT” on page 794

➤ “View Manager (New Folder) Processor” on page 794

Dashboard Generic URL
Builds a generic URL using the following parameters (context menu items 
might use a subset of the listed parameters):

Parameter Definition

ack.ackID The location of the acknowledgment ID.

ack.closeDialog Internal. This parameter must not be modified.

ack.cmdbObjectID The location of the CMDB object ID.

autoGenerate Internal parameter.

COMMAND Internal parameter. 

CMDB_NODE_ID Internal. This parameter must not be modified.

CiID Internal. This parameter must not be modified.
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DATA_MODEL_SET_
TO_VALUE

Internal parameter.

filter.fromDashboard Used to add a dynamic value to the URL.

filterId The ID of the filter. Internal. This parameter 
must not be modified.

filter.selectedVTIds Used to add a dynamic value to the URL.

filter.timeBarBean.view Internal.

FROM_DASHBOARD Internal parameter.

GRAPH_PROVIDER Internal.

isFullScreen Opens a popup window with the path to root. 
This parameter must not be modified.

LoginBtn Internal. This parameter must not be modified.

LoginName The name of the user used to login the Deep 
Transaction Tracking application.

loginURL The URL of the Deep Transaction Tracking 
application.

NODE_ID Converts to nodeId. 

parentCmdbId Internal.

Password The password used to login to the Deep 
Transaction Tracking application.

pm.CMDBObjectID Internal.

pm.VTObjectID Internal.

popUp Internal. This parameter must not be modified.

reportID The ID number of the report.

REPORT_ID Internal parameter.

selectedTxnClasses Internal.

Parameter Definition
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Goto Trend Report
Context menu processor that deals with the Trend report drill down 
functions. It uses the following parameters (context menu items might use a 
subset of the listed parameters).

SELECTED_MEASUREM
ENTS1

Internal parameter.

SELECTED_MEASUREM
ENTS2

Internal parameter.

TX_NAME Internal.

targetNodeIds The ID of the target node.

URL The URL of the new window.

Parameter Description

actionProcessorClass Internal. This parameter must not be modified.

PROFILE_ID Internal. This parameter must not be modified.

URL The URL of the new window.

REQUEST_TYPE Internal. This parameter must not be modified.

NODE_ID Converts to nodeId. 

MEASUREMENT_1_ID_
PREFIX

Internal. Used to control if the report is filtered 
by location or by transaction for Business 
Process Monitor CIs.

MAX_MEASUREMENT_
NUM

Maximum limit of measurements to filter in 
both SiteScope and Business Process Monitor.

actionForward Internal. This parameter must not be modified.

REPORT_NAME Internal. This parameter must not be modified.

Parameter Definition
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Goto SiteScope
Opens the SiteScope Application using the following parameters (context 
menu items might use a subset of the listed parameters):

DIMENSION_ID_PREFIX Internal. Specifies to which report to drill 
down in the Trend report not from the 
Availability and Response Time of Business 
Process Monitor but for other KPIs, such as 
Download Time or DNS Time.

MEASUREMENT_0_ID_
PREFIX

Internal. Specifies to which report to drill 
down in the Trend report not from the 
Availability and Response Time of Business 
Process Monitor but for other KPIs, such as 
Download Time or DNS Time.

Parameter Description

GROUP_NODE_NAME The CIs group in SiteScope.

HOST_BY The SiteScope host.

PATH The path that includes all of the SiteScope 
groups.

POST_FIX The post fix expression to be added to the all 
URLs.

PROFILE_ID The SiteScope profile to be used when opening 
SiteScope.

ROOT_PATH The root path to SiteScope.

ROOT_POSTFIX The SiteScope root.html document.

Parameter Description
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ITU Internal (Open Modal Window)
ITU represents the View manager tab in the CMDB application. The class 
deals with the View Manager tab. The parameter is: 

Netscout URL
Deals with Netscout URL. The class does not use parameters.

Prepare Parameters (Dashboard)
Prepares parameters, in JavaScript. Those parameters are used by Dashboard. 
Context menu items might use a subset of the listed parameters. The 
parameters are:

RunBookPreprocessor
For CIs whose CI type is mapped to an HP Operations Orchestration (OO) 
run book, opens the Related Run Books page in a new window using the 
following parameters:

Parameter Description

IURL The URL of the HP Business Availability Center 
machine.

Parameter Description

NODE_ID  Converts to nodeId. 

nodeType  This parameter must not be modified.

selectFilterID  Dynamic parameter used by the class.

strutsAction  Dynamic parameter used by the class.

viewType  Dynamic parameter used by the class.

Parameter Description

FROM_DASHBOARD Internal. This parameter must not be modified.

CMDB_NODE_ID Internal. This parameter must not be modified.
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SARCompliancyReportPreprocessor
Opens the SAR Compliancy report for a Host CI using the following 
parameters:

Show Properties in VT
When you select the Properties option in the View Explorer context menu, 
the Properties dialog box of the selected CI is displayed. The parameter is:

View Manager (New Folder) Processor
Deals with the View Manager tab. The parameter is:

SUSPECT_NAME Internal. This parameter must not be modified.

CI_TYPE Internal. This parameter must not be modified.

URL The URL of the new window.

Parameter Description

ALLOWED_CI_TYPES CI types for which the report is enabled.

URL_SUFFIX The relative URL of the report.

Parameter Description

URL The URL of the new window.

Parameter Description

URL The URL of the new window.

Parameter Description
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List of Post-Processor Classes

Post-processor classes are build to correspond to specific menus. In addition, 
a post-processor class specifies the actions that are performed after accessing 
the database.

This section includes the following topics:

➤ “CallJSOnPagePostProcessor” on page 796

➤ “Edit View (ITU)” on page 796

➤ “General View-Manager Context Menu” on page 796

➤ “Goto KPIs Over Time Report” on page 796

➤ “Goto Trend Report” on page 797

➤ “Goto Triage Reports” on page 797

➤ “Goto RUM Event Analysis Reports” on page 797

➤ “Goto RUM Reports” on page 798

➤ “Goto SOA Health Reports” on page 800

➤ “ITU Internal (Open Modal Window)” on page 800

➤ “Locate Search Result Elements in the View Traverse” on page 801

➤ “Open the Properties Page From the View Traverse” on page 801

➤ “Open Window” on page 802

➤ “SapProblemIsolationPostProcessor” on page 803

➤ “Show All the Element Neighbors” on page 804

➤ “Switch Application in BAC” on page 804

➤ “Switch Dashboard Tabs” on page 804

➤ “Switch Dashboard Tabs with Parameters” on page 805

➤ “Window” on page 805



Chapter 22 • Context Menu Item Repository

796

CallJSOnPagePostProcessor
Context menu processor to expand Top View levels. The parameters are:

Edit View (ITU)
Context menu processor that deals with the View Manager tab in the CMDB 
application. The parameter is:

General View-Manager Context Menu
Context menu processor that deals with the View Manager tab in the CMDB 
application. Context menu items might use a subset of the listed 
parameters. The parameters are:

Goto KPIs Over Time Report
Context menu processor that deals with opening the KPIs Over Time report.

Parameter Description

JS_CALL_PARAMS Internal. This parameter must not be modified.

JS_METHOD_NAME Internal. This parameter must not be modified.

Parameter Description

PERMISSION_TYPE Internal. This parameter must not be modified.

Parameter Description

HEIGHT The opened window height, in pixels.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

WIDTH The opened window width, in pixels.
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Goto Trend Report
Context menu processor that deals with the Trend report drill down 
functions. This class does not have parameters.

Goto Triage Reports
Context menu processor that deals with opening the Triage report. Context 
menu items might use a subset of the listed parameters. The parameters are:

Goto RUM Event Analysis Reports
Context menu processor that deals with opening the RUM Event Analysis 
report. Context menu items might use a subset of the listed parameters. The 
parameters are:

Parameter Description

application_id The ID of the application to be used when 
opening Diagnostics.

filter.selectedProfileId Internal. This parameter must not be modified.

menu_item_id The ID of the menu item.

menu_item_url The location where the parameters are 
calculated. This parameter must not be 
modified.

reportID The ID number of the report.

Parameter Description

autoGenerate Internal parameter of the RUM Event Analysis 
report.

filter.performance Internal. This parameter must not be modified.

filter.selectedApplication Internal. This parameter must not be modified.

filter.timeBarBean.view Internal. This parameter must not be modified.

popUp Internal. This parameter must not be modified.
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Goto RUM Reports
Context menu processor that deals with opening the Real User Monitor 
report. Context menu items might use a subset of the listed parameters. The 
parameters are:

reportID The ID number of the report.

selectedEventId Internal. This parameter must not be modified.

URL Internal. This parameter must not be modified.

Parameter Description

application_id The ID of the application to be used when 
opening Diagnostics.

autoGenerate Internal parameter of the Raw Data Over Time 
report.

filter.applicationErrors Internal. This parameter must not be modified.

filter.events Internal. This parameter must not be modified.

filter.httpErrors Internal. This parameter must not be modified.

filter.performance Internal. This parameter must not be modified.

filter.httpErrors Internal. This parameter must not be modified.

filter.selectedApplication Internal. This parameter must not be modified.

filter.selectedApplication
Errors

Internal. This parameter must not be modified.

filter.selectedcmdbidsfro
mOuter
Application

Internal. This parameter must not be modified.

filter.server
FilterBean.serverName
WildCard

Internal. This parameter must not be modified.

Parameter Description
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filter.vttTree
Type4Thecmdbidsfrom
OuterApplication

Internal. This parameter must not be modified.

filter.selectedEvents Internal. This parameter must not be modified.

filter.selectedHttpErrors Internal. This parameter must not be modified.

isContainer Internal. This parameter must not be modified.

IS_POPUP Internal. This parameter must not be modified.

menu_item_id The ID of the menu item.

menu_item_url The location where the parameters are 
calculated. This parameter must not be 
modified.

monitorName Internal. This parameter must not be modified.

problematicCI Internal.

reportID The ID number of the report.

reportType Defines which of the results to take from the 
PNR KPI that relays in the SLM tab.

selectedApplication Internal. This parameter must not be modified.

selectedActionId Internal. This parameter must not be modified.

selectedTab Internal. This parameter must not be modified.

time_view Internal. This parameter must not be modified.

__UIF_FORM Internal. This parameter must not be modified.

__UIF_APPLICATION Internal. This parameter must not be modified.

Parameter Description
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Goto SOA Health Reports
Context menu processor that deals with opening the HP Business 
Availability Center for SOA reports. Context menu items might use a subset 
of the listed parameters. The parameters are:

ITU Internal (Open Modal Window)
Context menu processor that deals with the View Manager tab in the CMDB 
application. Context menu items might use a subset of the listed 
parameters. The parameters are:

Parameter Description

application_id The ID of the application to be used when 
opening Diagnostics.

autoGenerate Internal parameter of the Raw Data Over Time 
report.

filter.fromDashboard Internal. This parameter must not be modified.

menu_item_id The ID of the menu item.

menu_item_url The location where the parameters are 
calculated. This parameter must not be 
modified.

reportID The ID number of the report.

VT_NODES_
SYMBOL_IDS_KEY

Internal. The symbol ID of the CI, to which 
the context menu item is attached, in the 
view.

filter.selectedCIsType Internal.

Parameter Description

HEIGHT The opened window height, in pixels.

PARAM0 This parameter is for internal use only. This 
parameter must not be modified.
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Locate Search Result Elements in the View Traverse
Context menu processor that deals with the search capability in View 
Explorer. This class does not have parameters.

Open the Properties Page From the View Traverse
When you select the Properties option in the View Explorer context menu, 
the Properties dialog box of the selected CI is displayed. Context menu 
items might use a subset of the listed parameters. The parameters are:

PARAM1 This parameter is for internal use only. This 
parameter must not be modified.

PARAM2 This parameter is for internal use only. This 
parameter must not be modified.

PARAM3 This parameter is for internal use only. This 
parameter must not be modified.

PARAM4 This parameter is for internal use only. This 
parameter must not be modified.

PERMISSION_TYPE Internal. This parameter must not be modified.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

WIDTH The opened window width, in pixels.

Parameter Description

HEIGHT The opened window height, in pixels.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

Parameter Description
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Open Window
General post processor to open a request in a new window, rather than in 
the application frame. Context menu items might use a subset of the listed 
parameters. The parameters are:

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

SLAVE_WIN If set to 1, it checks that the window closes 
when the application is closed.

WIDTH The opened window width, in pixels.

Parameter Description

ALERTDATE The date when the selected SAP alert occurred.

ALERTTIME The time of the selected SAP alert.

ALINDEX The internal handle for the SAP alert.

ALSYSID The SAP system which the alert came from.

ALUNIQNUM The ID number of the SAP alert, as appears on 
the SAP system.

HEIGHT The opened window height, in pixels.

MSEGNAME Contains the type of the monitor and 
connection parameters (for example: 
SAP_CCMS_calderone_MI6_00).

MSG The name of the SAP alert.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

Parameter Description
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SapProblemIsolationPostProcessor
Context menu processor that deals with Problem Isolation in HP Business 
Availability Center for SAP Applications. The parameters are:

SapConnId Uses the following syntax: <host name>:<user 
name> to connect to a specific SiteScope 
monitor to retrieve the SAP alert. host name is 
the name of the host that contains the R3 
server where the SAP alert originated. user 
name is the name of the user used to access the 
server to which the SiteScope monitor is 
connected.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

SLAVE_WIN If set to 1 it checks that the window closes 
when the application is closed.

szTargetHostIP The IP of the SiteScope that sent the sample.

szTargetHostName The name of the SiteScope host that sent the 
sample.

WIDTH The opened window width, in pixels.

WIN_NAME Specifies the window name.

Parameter Description

Base URL The location of file: 
/<HP_BAC_web_application_context_name (usually 
topaz)>/jsps/dash/ClearEventContextMenu.jsp

timeInterval The period of time for which the historical 
information is kept for group CIs.

Default: 1 week

Parameter Description
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Show All the Element Neighbors
Context menu processor that deals with View Explorer. This class does not 
have parameters.

Switch Application in BAC
Context menu processor for drilling down from one application to another. 
This class does not have parameters.

Switch Dashboard Tabs
Context menu processor that switches tabs in the Dashboard application. 
For examples, opening the appropriate Filters tab from the Console tab. The 
parameter is:

HEIGHT The opened window height, in pixels.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

SLAVE_WIN If set to 1 it checks that the window closes 
when the application is closed.

WIDTH The opened window width, in pixels.

Parameter Description

TAB_ID The ID of the tab. The tab ID is available in the 
application framework. If you change the tab 
ID, it is recommended to change the name of 
the context menu item to match the name of 
the tab that is opened by this option.

Parameter Description
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Switch Dashboard Tabs with Parameters
Context menu processor that passes internal parameters when switching 
from one tab to another in Dashboard. The parameter is:

Window
Context menu processor that deals with opening new windows. Context 
menu items might use a subset of the listed parameters. The parameters are:

Parameter Description

TAB_ID The ID of the tab. The tab ID is available in the 
application framework. If you change the tab 
ID, it is recommended to change the name of 
the context menu item to match the name of 
the tab that is opened by this option.

Parameter Description

HEIGHT The opened window height, in pixels.

RESIZE If set to 1, the window can be resized. If set to 
0, the window cannot be resized.

SCROLL If set to 1, a scrolling tab is added to the 
opened window, if required. If set to 0, no 
scrolling tab is added to the open window.

SLAVE_WIN If set to 1 it checks that the window closes 
when the application is closed.

WIDTH The opened window width, in pixels.

WIN_NAME Specifies the window name.
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Context Menu Items User Interface

This section describes:

 ➤  Context Menu Item Details Dialog Box on page 806

 ➤  Context Menu Item Repository page on page 810

 ➤  Pre-Processor Parameter Details Dialog Box on page 813

 ➤  Post-Processor Parameter Details Dialog Box on page 814

Context Menu Item Details Dialog Box

Description Enables you to modify the information or enter new 
information for the context menu item. You can also 
modify existing information or add new information 
about the pre-processor and post-processor parameters. 

To Access: In the Context Menu Item Repository page, 
click the New button, or click the relevant Edit 
button  for a cloned or overridden context menu 
item.

Important 
Information

It is not recommended to:

➤ Add new parameters to the pre-processor or post-
processor class.

➤ Make changes to a pre-processor or post-processor 
class as it might change its behavior. Classes are 
built for specific context menus.

Included in Tasks “Customize a Context Menu Item” on page 723
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Display Name The name of the context menu item. 

New Click the New button to enter new menu entity details. 
For more details, go to “Menu Entity Details Dialog 
Box” on page 719.

Post-processor Class The name of the post-processor class to be used to 
perform the corresponding action after accessing the 
database, when this menu option is selected from the 
item menu options. 

The list of parameters used by the post-processor class 
for the current context menu item is provided in the 
Post-processor Parameters area. For details, see “Post-
processor Parameters Area” on page 808.

For details about the post-processor classes and their 
parameters, see “List of Post-Processor Classes” on 
page 795.

Pre-processor Class The name of the pre-processor class to be used to 
perform the corresponding action before accessing the 
database, when this menu option is selected from the 
item menu options. 

The list of parameters used by the pre-processor class 
for the current context menu item is provided in the 
Pre-processor Parameters area. For details, see “Pre-
processor Parameters Area” on page 808.

For details about the pre-processor classes and their 
parameters, see “List of Pre-Processor Classes” on 
page 789.
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Pre-processor Parameters Area

The area contains the following items:

Post-processor Parameters Area

Description Lists the parameters for the pre-processor class. 

Important 
Information

The parameters listed in this area belong to the class 
listed in the Pre-processor Class field.

For details about the pre-processor classes and their 
parameters, see “List of Pre-Processor Classes” on 
page 789.

GUI Element (A-Z) Description

<Menu entity> Click the Delete button  to delete an existing 
menu entity details.

Click the Edit button  to modify existing menu 
entity details. For more details, go to “Menu Entity 
Details Dialog Box” on page 719.

New Click the New button to enter new parameters in 
the Pre-Processor Parameter Details dialog box.

Description Lists the parameters for the post-processor class. 

Important 
Information

The parameters listed in this area belong to the class 
listed in the Post-processor Class field.

For details about the post-processor classes and their 
parameters, see “List of Post-Processor Classes” on 
page 795.
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

<Menu entity> Click the Delete button  to delete an existing 
menu entity details.

Click the Edit button  to modify existing menu 
entity details. For more details, go to “Menu Entity 
Details Dialog Box” on page 719.

New Click to enter new parameters in the Post-Processor 
Parameter Details dialog box.
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Context Menu Item Repository page

Description Displays the list of factory (predefined) and customized 
context menu items. Those context menu items are 
available throughout HP Business Availability Center 
to help you navigate to other pages.

Enables an advanced user to modify existing repository 
context menu items and create new ones. 

To Access: Admin > Dashboard > Repositories > 
Context Menu Items

Important 
Information

For a detailed scenario that includes creating a context 
menu item, see “Create a Dynamic URL – Scenario” on 
page 495 and view the appropriate steps.

Cloning or overriding an existing context menu item, 
or creating a new context menu item, adds the 
corresponding context menu item entry to the Custom 
Context Menu Items list. You can then customize the 
context menu item to your organization’s 
specifications. For details, see “Customize a Context 
Menu Item” on page 723.

You can modify the information or enter new 
information for the context menu item. You can also 
modify existing information or add new information 
about the pre-processor and post-processor parameters. 
For details, see:

➤ “Context Menu Item Details Dialog Box” on 
page 806.

➤ “Pre-Processor Parameter Details Dialog Box” on 
page 813.

➤ “Post-Processor Parameter Details Dialog Box” on 
page 814.

A list of the context menu items and their details is 
available in “List of Context Menu Items” on page 725.

Included in Tasks “Customize a Context Menu Item” on page 723



Chapter 22 • Context Menu Item Repository

811

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Click to display help on the context menu.

Select a context menu item in the Custom Context 
Menu Items area, and click the button to open the 
Context Menu Items Details dialog box. For details, see 
“Context Menu Item Details Dialog Box” on page 806.

Clone In the Factory Context Menu Items or in the Custom 
Context Menu Items areas, select a context menu item, 
and click the Clone button to create a new context 
menu item by cloning. You clone an existing context 
menu item to use it as a template. The original context 
menu item is still available. For details, see “Customize 
a Context Menu Item” on page 723.

Note: Change the name of the context menu item you 
have cloned to make sure you attach the cloned 
context menu item and not the original context menu 
item to a specific KPI.

Display Name The name of the context menu item.
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New Item Click to create a new context menu item. For details, 
see “Customize a Context Menu Item” on page 723.

Override In the Factory Context Menu Items or in the Custom 
Context Menu Items areas, select a context menu item, 
and click the Override button to edit an existing 
context menu item. You override an existing context 
menu item to replace it with a customized rule. The 
original context menu item is disabled. The overriding 
context menu item and the original context menu 
item have the same context menu ID. The context 
menu item in the Factory Context Menu Items area 
displays the following indication:

Note: If you later delete the custom context menu item 
that overrode the factory context menu item, the 
original factory context menu item is automatically 
restored.

GUI Element (A-Z) Description
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Pre-Processor Parameter Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to modify existing information or 
enter new information about the pre-processor 
parameter.

To Access: In the Context Menu Item Details dialog 
box, click New or click the Edit button  for the 
appropriate parameter.

Important 
Information

For details about the pre-processor classes and their 
parameters, see “List of Pre-Processor Classes” on 
page 789.

Included in Tasks “Customize a Context Menu Item” on page 723

GUI Element (A-Z) Description

Convert To This key is used if the key is a parameter in the URL. In 
this case, the URL is added with the converted key and 
the value.

Key The parameter’s key. The GenericURLPreprocess 
parameter has certain predefined keys: URL_SUFFIX 
and URL (or a composition of PROTOCOL, HOST, and 
PORT).

Value The parameter’s value. In case of a URL key, it can be a 
certain URL (for example: http://www.hp.com) The value 
can also be retrieved from the CI using an Escaping 
sequence form; for example: NODE-ID to get the CI ID.
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Post-Processor Parameter Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to modify existing information or enter 
new information about the post-processor parameter.

To Access: In the Context Menu Item Details dialog 
box, click New or click the Edit button  for the 
appropriate parameter.

Important 
Information

For details about the post-processor classes and their 
parameters, see “List of Post-Processor Classes” on 
page 795.

Included in Tasks “Customize a Context Menu Item” on page 723

GUI Element (A-Z) Description

Key The parameter’s key.

Value The parameter’s value. The value can also be retrieved 
from the CI using an Escaping sequence form; for 
example: NODE-ID to get the CI ID.
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Tooltip Repository

This chapter provides information about theDashboard Tooltip Repository.

This chapter includes:

Concepts

 ➤  Tooltip Repository Overview on page 816

Tasks

 ➤  Customize a Tooltip on page 818

Reference

 ➤  List of Tooltips on page 822

 ➤  List of Tooltip Parameters on page 872

 ➤  List of Tooltip Parameter Attributes on page 882

 ➤  Tooltips User Interface on page 883
Concepts
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Tooltip Repository Overview

The Tooltip Repository page displays the list of factory (predefined) tooltips 
available throughout Dashboard to specify how source data is imported and 
handled by Dashboard Administration, and to determine appearance and 
functionality for the CIs in the presentation layer.

Each KPI under a CI has a Details tooltip to display additional information 
for the CI. 

Most of the tooltips used in Dashboard correspond directly to a rule. Each 
tooltip class has the same ID number as the rule it is associated with. For 
example, for the rule ID #2, Best Child Rule, there is a corresponding tooltip 
with ID #2, Best Child sentence.

Tooltips are assigned to CIs according to the rule used for the KPI. Most rules 
have an associated tooltip (referred to as the rule sentence), that is 
connected to the associated rule. Note that if you add a new rule to the 
Business Rule Repository, a new tooltip is automatically created for it. To 
delete a tooltip that is connected to a rule, you must delete the rule. For 
more information on the Tooltip Repository or about creating or editing 
tooltips, see “Tooltip Repository page” on page 883.

Note: 

➤ To delete a customized tooltip, you must delete the corresponding rule.

➤ A tooltip and its rule have the same ID number and the same name.

➤ The order of the parameters in the Tooltip Parameters Details page 
reflects the order of the corresponding information in the tooltip in the 
application.

➤ The last sample time is not necessarily the same as the last update time 
because the last sampling might not have any impact on the status.

➤ If you are using HP Operations Manager i with Business Availability 
Center, then the Tooltip Repository page contains OMi-related tooltips. 
For more information, see Using HP Operations Manager i.
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Tooltip Parameters
Each tooltip definition includes parameters. The parameters correspond to 
the type of information displayed in the tooltip in the Dashboard and 
Service Level Management applications. The order of the parameters in the 
tooltip definition corresponds to the order of the information in the 
displayed tooltip. For information on defining/editing tooltip parameters, 
see “Tooltip Repository page” on page 883.

The tooltip parameters correspond to the information displayed in the 
tooltip.

For example, the parameters of the Worst Child Sentence tooltip are 
displayed as entries in the tooltip and are listed in the same order as the 
order of the parameters in the tooltip definition. 

Advanced Users
You can modify existing repository objects and create new ones. This may 
be necessary when you want to customize the way information is presented 
in Dashboard, to fit the needs of your organization; or you may need to 
create new objects when integrating data from a new external system into 
Dashboard.

Tasks
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Customize a Tooltip

When you create a rule, a tooltip is automatically created. You can override 
or copy an existing tooltip and then modify it.

For a detailed scenario that includes creating tooltips, see “Create a KPI, 
Rule, and Tooltip – Example” and view the appropriate steps.

This task includes the following steps:

➤ “Create a Custom Tooltip” on page 818

➤ “Specify the Tooltip Details” on page 819

➤ “Change the Color of the Tooltip Border and Header” on page 821

➤ “Change the KPI Status Icon” on page 821

➤ “Specify the Tooltip Parameter Details” on page 822

➤ “Set a Tooltip and Its Parameters Back to Default” on page 822

 1 Create a Custom Tooltip
You can:

➤ clone (copying) a factory or customized tooltip to use is as a template. To 
clone a tooltip, select a tooltip and click Clone in the Tooltip Repository 
page. 

➤ override an existing tooltip. When you override an existing tooltip, a copy 
appears in the Custom Tooltips area and the existing tooltip is marked with 
(Overridden) in the Factory Tooltips area.

For details, see “Tooltip Repository page” on page 883.

You can then modify the tooltip to your specifications. For details, see 
“Tooltip Details Dialog Box” on page 885.
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Note: 

➤ To delete a customized tooltip, you must delete the corresponding rule.

➤ A tooltip and its rule have the same ID number and the same name.

 2 Specify the Tooltip Details
In the Tooltip Details window, you can either modify the information or 
enter new information. For details on the possible values, see “Tooltip 
Details Dialog Box” on page 885.

You can also modify existing information or enter new information about 
the tooltips parameter details. For details, see “Tooltip Parameter Details 
Dialog Box” on page 886.

Example: Add a Last Sample Time Entry in a Tooltip

To display the last time the sampling was made in a tooltip, you must:

➤ keep the last sample information. For details, see “Set Up Rules to Display 
the Last Sample Details” on page 578.

➤ add the Last Sample Time to the tooltip of monitor rules only

Note: The last sample time is not necessarily the same as the last update 
time because the last sampling might not have any impact on the status.

To add Last Sample Time entry in a tooltip:

 a Select Admin > Dashboard.

 b Click the down arrow  that appears when you move the mouse pointer 
over the Repositories tab title.

 c Select the Tooltips tab menu option to open the Tooltips page.

 d Override or clone the tooltip in which you want to display the last 
sample time.
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 e Click the relevant Edit Entity button , to open the Tooltip Details dialog 
box.

 f Click New to open the Parameter Details dialog box.

 g In the Display Label box, enter Last Sample Time.

 h In the Value Source box, enter NODE.DIM.SAMPLE.time_stamp.

 i In the Available Formatting Method list, select returnDateAsStringInSec. 
The value is automatically entered in the Formatting Method box.

 j Click OK to save the changes.

The tooltip displays the following information:
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 3 Change the Color of the Tooltip Border and Header
A KPI tooltip border and header has a default color, specified in the Color 
box of the KPI’s appropriate parameter, for each one of the ranges specified 
in the From/To boxes. For example: when the Performance KPI has the OK 
status, the tooltip would display the following colors C9E7B2;78B24A:

To modify the default color of the tooltip’s header and border, open the 
definition of the appropriate parameter and enter different colors in the 
Color box. For details, see “Parameter Details Dialog Box (KPIs)” on 
page 552.

 4 Change the KPI Status Icon
Different icons are used for the KPI status for each range specified in the 
From/To fields.

To customize the KPI status icons, create a new set of icons and, where 
applicable, add your icons to the appropriate directories and redirect the 
KPI’s status parameters to those icons or replace the default icons with your 
customized icons using the same names.

For details, see “Change the KPI Status Icons” on page 394.
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 5 Specify the Tooltip Parameter Details
In the Parameter Details window, you can either modify existing 
information or enter new information about the tooltip parameter. For 
details on the possible values, see “Tooltip Parameter Details Dialog Box” on 
page 886.

 6 Set a Tooltip and Its Parameters Back to Default
If you have modified a tooltip or its parameters, you might need to return 
the tooltip and its parameters to their defaults.

To set a tooltip and its parameters back to default, select Admin > Dashboard 
> Repositories > Tooltips. In the Custom Tooltips area, delete the copy of the 
tooltip you want to return to default and click OK. The tooltip and its 
parameters are returned to their defaults.

Reference

List of Tooltips 

This section includes the following topics:

➤ “List of Tooltips, Associated Rules, and Parameters” on page 823

➤ “Example of a Number of Open Incidents Sentence Tooltip” on page 871

➤ “Example of a SiteScope EMS Rule Tooltip” on page 872

For details on configuring the tooltips, see “Tooltips User Interface” on 
page 883.
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List of Tooltips, Associated Rules, and Parameters

This section lists the tooltips available in the Tooltip Repository, their 
associated rules, and parameters.

Tooltip (Tooltip #) Associated Rule Tooltip Parameters

API Duration-
Based Sample Rule 
Sentence

(501)

“API Duration-Based Sample Rule” on 
page 581

➤ Node Name

➤ Status

➤ Value

➤ Calculation Rule

➤ Held Status Since

API Group and 
Sibling Rule 
Sentence

(500)

“API Group and Sibling Rule” on 
page 581

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

API Sample Rule 
Sentence

(502)

“API Sample Rule” on page 582 ➤ Node Name

➤ Status

➤ Value

➤ Calculation Rule

➤ Held Status Since

Average 
Availability of 
Weighted Volume 

(55)

“Average Availability of Weighted 
Volume” on page 582

➤ Node Name

➤ Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational
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Average Latency 
of Weighted 
Volume

(83)

“Average Latency of Weighted Volume” 
on page 582

➤ Node Name

➤ Latency

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Average Network 
of Weighted 
Volume 

(93)

“Average Network of Weighted Volume” 
on page 582

➤ Node Name

➤ Network Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Average of 
Converted 
Performance 
Results in % 

(63)

“Average of Converted Performance 
Results in %” on page 583

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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Average of Values 
for KPIs 

(31)

“Average of Values” on page 583 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Total

➤ Major

➤ Minor

➤ Warning

➤ Informational

Average 
Performance of 
Weighted Volume 
in % 

(64)

“Average Performance of Weighted Volume 
in %” on page 583

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Average 
Performance of 
Weighted Volume 
in Seconds 

(65)

“Average Performance of Weighted Volume 
in Seconds” on page 583

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Best Child 
Sentence 

(2)

“Best Child Rule” on page 584 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Invisible Children

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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BPI Average 
Weighted Status 
Sentence

(611)

“BPI Average Weighted Status Rule for 
Value KPI” on page 586

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Critical samples

➤ Major samples

➤ Minor samples

➤ Warning samples

➤ OK samples

BPI BP Step 
Quantity Group 
Sentence

(621)

 “BPI Group Rule for BP Step CI” on 
page 588

➤ Node Name

➤ Status

➤ Value

➤ Count

➤ Calculation Rule

➤ Held Status Since

BPI Business 
Process Health 
Group Sentence 

(620)

“BPI Health Group Rule for BP CIs” on 
page 591

➤ Node Name

➤ Status

➤ Blocked instances

➤ At risk instances

➤ Healthy instances

➤ Calculation Rule

➤ Held Status Since

BPI Business 
Process Quantity 
Group Sentence 

(619)

“BPI Group Rule for BP CI” on page 588 ➤ Node Name

➤ Status

➤ Value

➤ Count

➤ Calculation Rule

➤ Held Status Since

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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BPI Duration 
Average Weighted 
Status Sentence 

(623)

 “BPI Average Weighted Status Rule for 
Duration KPI” on page 585

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Critical instances

➤ Major instances

➤ Minor instances

➤ Warning instances

➤ OK Instances

BPI Duration 
Average Status 
Percentage 
Sentence 

(624)

 “BPI Status Percentage Rule for Duration 
KPI” on page 596

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Score

➤ Status for

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Min Status

BPI Duration 
Worst Violated 
Instances 
Percentage 
Sentence 

(622)

 “BPI Worst Violated Instances Rule for 
Duration KPI” on page 598

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Score

➤ Status for

➤ Critical instances

➤ Major instances

➤ Minor instances

➤ Warning instances

➤ OK Instances

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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828

BPI Health 
Average Weighted 
Status Count 
Sentence 

(614)

“BPI Health Average Weighted Status 
Count Rule” on page 589

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Status for

➤ Held Status Since

➤ Blocked instances

➤ At risk instances

➤ Healthy instances

BPI Health 
Average Weighted 
Status Value 
Sentence 

(617)

“BPI Health Average Weighted Status 
Value Sentence” on page 828

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Blocked instances

➤ At risk instances

➤ Healthy instances

BPI Health Status 
Percentage Count 
Sentence 

(615)

“BPI Health Status Percentage Count 
Rule” on page 591

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Score

➤ Status for

➤ Major

➤ Minor

➤ Warning

➤ OK

➤ Min Status

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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829

BPI Health Status 
Percentage Value 
Sentence 

(618)

“BPI Health Status Percentage Value Rule” 
on page 592

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Score

➤ Status for

➤ Major

➤ Minor

➤ Warning

➤ OK

➤ Min Status

BPI Health Worst 
Process Instances 
Count Sentence 

(613)

“BPI Health Worst Process Instances 
Count Rule” on page 592

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Blocked instances

➤ At risk instances

➤ Healthy instances

BPI Health Worst 
Process Instances 
Value Sentence 

(616)

“BPI Health Worst Process Instances 
Value Rule” on page 593

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Blocked instances

➤ At risk instances

➤ Healthy instances

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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830

BPI Monitor 
Backlog Count 

(604)

“BPI Monitor Backlog Count Rule” on 
page 593

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Count

➤ Value

➤ Major

➤ Minor

➤ Warning

➤ Informational

BPI Monitor 
Backlog Value 

(605)

“BPI Monitor Backlog Value Rule” on 
page 594

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Count

➤ Value

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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831

BPI Monitor 
Duration 

(608)

“BPI Duration Monitor Rule” on page 587 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Calculation Logic

➤ Held Status Since

➤ Status for

➤ Average

➤ Weighted Average

➤ Minimum

➤ Maximum

➤ Number of instances

➤ Major

➤ Minor

➤ Warning

➤ Informational

BPI Monitor 
Volume Count 

(606)

“BPI Monitor Volume Count Rule” on 
page 594

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Count

➤ Value

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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832

BPI Monitor 
Volume Value 

(607)

“BPI Monitor Volume Value Rule” on 
page 595

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Count

➤ Value

➤ Major

➤ Minor

➤ Warning

➤ Informational

BPI Operational 
Status 

(625)

“BPI Operational Status Rule” on page 595 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

BPI Status 
Percentage 
Sentence 

(612)

“BPI Status Percentage Rule for Value 
KPI” on page 597

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Score

➤ Status for

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Min Status

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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833

BPI Value Monitor 

(609)

“BPI Value Monitor Rule” on page 598 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Calculation Logic

➤ Held Status Since

➤ Status for

➤ Average

➤ Minimum

➤ Maximum

➤ Number of instances

➤ Major

➤ Minor

➤ Warning

➤ Informational

BPI Worst Violated 
Instances 
Sentence 

(610)

“BPI Worst Violated Instances Rule for 
Duration KPI” on page 598

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Critical instances

➤ Major instances

➤ Minor instances

➤ Warning instances

➤ Informational instances

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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834

BPM WS 
Operation 
Percentile 
Performance 
Sentence 

(1307)

“BPM WS Operation Percentile 
Performance Rule” on page 599

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Under threshold calls

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

BPM WS 
Operation 
Performance 
Sentence 

(1306)

“BPM WS Operation Performance Rule” 
on page 600

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Under threshold calls

➤ Avg. Response Time

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Business Impact

(626)

“BPI Business Health Status Rule” on 
page 587

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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835

Business 
Transaction Group 
Rule 

(1417)

“Business Transaction Group Rule” on 
page 600

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Value

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Customer 
Sentence

(12)

“Customer Rule” on page 600 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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836

Diagnostics for 
J2EE General 
Sentence

(1075)

“Diagnostics for J2EE/.Net General” on 
page 602

➤ Node Name

➤ Status. Can be defined as 
OK, Warning or Critical.

➤ Calculation Rule

➤ Description. Describes the 
reason for the status. For 
example, a Critical status for 
a transaction, may be 
explained in the Description 
field as follows: 15% violation 
on latency. This would 
indicate that the average 
latency of the transaction 
exceeded the threshold that 
was set in Diagnostics by 
15% and therefore the status 
of this transaction is defined 
as critical.

➤ Platform

➤ Server Time

➤ Server Requests Count

➤ Average Time

➤ Exceptions Count

➤ Timeout Count

➤ Max Time

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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837

Diagnostics WS 
Operation 
Percentile 
Performance 
Sentence

(1302)

“Diagnostics WS Operation Percentile 
Performance Rule” on page 602

➤ Node Name

➤ Status. Can be defined as 
OK, Warning or Critical.

➤ Calculation Rule

➤ Held Status Since

➤ Under threshold calls

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Diagnostics WS 
Operation 
Performance 
Sentence

(1301)

“Diagnostics WS Operation Performance 
Rule” on page 603

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Avg. Response Time

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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838

Diagnostics WS 
Operation 
Throughput 
Sentence

(1303)

“Diagnostics WS Operation Throughput 
Rule” on page 603

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Calls per minute

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Dollar Impact 
Over Time 
Sentence

(24)

“Impact Over Time Rule” on page 608 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Description

➤ Business Loss

Dollar Impact 
Sentence

(19)

“Real Time Impact” on page 612 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Description

➤ Business Loss

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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839

Downtime 
Sentence

No associated rule ➤ Node Name

➤ Status

➤ Held Status Since

➤ Downtime Until

➤ Location

➤ Caused By

EMS Sentence 

(0)

“EMS Simple Rule” on page 604 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Description

➤ Severity

➤ Severity

➤ Held Status Since

➤ Message

➤ Last Update

➤ Description

➤ Description

End User Network 
Performance 

(91)

“RUM End User Monitor Network Rule” 
on page 615

➤ Node Name

➤ Network Availability

➤ Status

➤ Calculation Rule (includes a 
description of the rule)

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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840

Generic Formula 
Over Time Rule 

(1510)

“Generic Formula Rule” on page 604 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Formula

➤ Value

➤ Average

➤ Major

➤ Minor

➤ Warning

➤ Informational

Generic Sample 
Rule 

(21)

“Generic Sample Rule” on page 605 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Value

➤ Major

➤ Minor

➤ Warning

➤ Informational

Generic Sum of 
Values Over Time 
Rule 

(1501)

“Generic Sum of Values Over Time Rule” 
on page 605

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Value

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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841

Generic Two 
Arguments Rule 

(1500)

“Generic Two Arguments Rule” on 
page 606

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Value

➤ Major

➤ Minor

➤ Warning

➤ Informational

Geo Map 
Sentence 

(172)

No associated rule.

The tooltip is displayed for status 
indicators in geographical maps. For 
details, see “Geographical Map Page” on 
page 212.

➤ Location

➤ Status

➤ Held Status Since

➤ Caused By

History No associated rule.

The tooltip is displayed for the History 
KPI. For details, see “Trend and History” 
on page 362.

Note: The information that is displayed 
depends on the value assigned to the 
HistoryType rule global parameter.

➤ Node Name

➤ History Type

➤ Historical Worst

➤ Historical Average

HP OpenView 
Service Navigator 
Sentence 

(22)

“HP OpenView Service Navigator Rule” 
on page 607

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Description

➤ Severity

➤ Held Status Since

➤ Message

➤ Last Update

➤ Description

➤ owned By

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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842

HP Worst Child 
Sentence 

(23)

“HP Worst Child Rule” on page 607 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

Locations 
Grouped Parent 
Rule 

(1110)

“Locations Grouped Parent Rule” on 
page 609

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

Locations 
Grouped Rule 

(1105)

“Locations Grouped Rule” on page 610 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

No Update 
Sentence

No associated rule.

Internal.

➤ Node Name

➤ Status

➤ Held Status Since

➤ Warning

➤ Last Update

➤ Location

➤ Caused By

➤ Error Message

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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843

Number of Open 
Incidents 
Sentence

(2600)

“Number of Open Incidents” on 
page 611

Example: For a detailed example of the 
tooltip, see “Example of a Number of 
Open Incidents Sentence Tooltip” on 
page 871.

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Number of tickets

➤ Grouping

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Transaction

Number of 
Running Sessions 
Rule 

(1107)

“Number of Running Sessions Rule” on 
page 611

➤ Node Name

➤ Status

➤ Held Status Since

➤ Message

➤ Last Update

➤ Measurement

➤ Monitor

➤ Historical Worst

➤ Historical Average

➤ Trend

Number of Tasks 
in Error Rule 

(1101)

“Number of Tasks in Error Rule” on 
page 611

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

➤ Measurement

➤ Monitor

➤ Historical Worst

➤ Historical Average

➤ Trend

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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844

Percent Sentence 

(17)

“Percentage Rule” on page 611 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Score

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Invisible Calculated Children

RUM Application 
Session Statistics 
Monitor 
Availability 

(56)

“RUM Application Session Statistics 
Monitor Availability Rule” on page 613

➤ Node Name

➤ Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Application 
Session Statistics 
Monitor 
Performance 

(66)

“RUM Application Session Statistics 
Monitor Performance Rule” on page 613

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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845

RUM Application 
Session Statistics 
Monitor Volume 

(76)

“RUM Application Session Statistics 
Monitor Performance Rule” on page 613

➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Component 
Availability 

(80)

“RUM Server Monitor Component 
Availability Rule” on page 620

➤ Node Name

➤ Component Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM End User 
Latency 

(92)

“RUM End User Monitor Latency Rule” 
on page 615

➤ Node Name

➤ Latency

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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846

RUM End User 
Monitor 
Availability 

(59)

“RUM End User Monitor Availability 
Rule” on page 614

➤ Node Name

➤ Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM End User 
Monitor 
Performance 

(69)

“RUM End User Monitor Performance 
Rule” on page 616

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM End User 
Monitor Volume 

(79)

“RUM End User Monitor Volume Rule” 
on page 616

➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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847

RUM End User 
Session Statistics 
Monitor 
Availability 

(57)

“RUM End User Session Statistics Monitor 
Availability Rule” on page 617

➤ Node Name

➤ Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM End User 
Session Statistics 
Monitor 
Performance 

(67)

“RUM End User Session Statistics Monitor 
Performance Rule” on page 617

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM End User 
Session Statistics 
Monitor Volume 

(77)

“RUM End User Session Statistics Monitor 
Volume Rule” on page 618

➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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848

RUM Event 
Monitor Volume 

(73)

“RUM Event Monitor Volume Rule” on 
page 618

➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Location 
Session Statistics 
Monitor 
Availability 

(58)

“RUM Location Session Statistics Monitor 
Availability Rule” on page 618

➤ Node Name

➤ Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Location 
Session Statistics 
Monitor 
Performance 

(68)

“RUM Location Session Statistics Monitor 
Performance Rule” on page 619

➤ Node Name

➤ Performance.

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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849

RUM Location 
Session Statistics 
Monitor Volume 

(78)

“RUM Location Session Statistics Monitor 
Volume Rule” on page 619

➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Page 
Monitor 
Availability 

(49)

“RUM Page Monitor Availability Rule” on 
page 619

➤ Node Name

➤ Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Page 
Monitor 
Performance 

(60)

“RUM Page Monitor Performance Rule” 
on page 620

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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850

RUM Page 
Monitor Volume 

(70)

“RUM Page Monitor Volume Rule” on 
page 620

➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Session 
Monitor 
Availability 

(52)

“RUM Session Monitor Availability Rule” 
on page 621

➤ Node Name

➤ Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Session 
Monitor 
Performance 

(62)

“RUM Session Monitor Performance 
Rule” on page 621

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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851

RUM Session 
Monitor Volume 

(72)

“RUM Session Monitor Volume Rule” on 
page 622

➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Transaction 
Monitor 
Availability 

(51)

“RUM Transaction Monitor Availability 
Rule” on page 622

➤ Node Name

➤ Availability

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

RUM Transaction 
Monitor 
Performance 

(61)

“RUM Transaction Monitor Performance 
Rule” on page 622

➤ Node Name

➤ Performance

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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RUM Transaction 
Monitor Volume 

(71)

“RUM Transaction Monitor Volume 
Rule” on page 622

➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

SAP Alert Status 
Sentence 

(1111)

“SAP Alerts Rule” on page 623 ➤ Alert Description

➤ Short Name

➤ Status

➤ Calculation Rule

➤ Severity. A number 
indicating the severity of the 
alert as it appears in the SAP 
system.

➤ State

➤ Open Time

➤ Held Status Since

➤ Last Update

Server Bandwidth 

(84)

“RUM Server Monitor Bandwidth Rule” 
on page 620

➤ Node Name

➤ Bandwidth

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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Server 
Summarized 
Bandwidth 

(85)

“RUM Servers Summarized Bandwidth 
Rule” on page 621

➤ Node Name

➤ Bandwidth

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Server Network 
Performance 

(90)

“RUM Server Monitor Network Rule” on 
page 621

➤ Node Name

➤ Network Availability

➤ Status

➤ Calculation Rule (includes a 
description of the rule)

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Sessions Custom 
Data Rule 

(1106)

“Sessions Custom Data Rule” on page 623 ➤ Node Name

➤ Status

➤ Held Status Since

➤ Message

➤ Last Update

➤ Measurement

➤ Monitor

➤ Historical Worst

➤ Historical Average

➤ Trend

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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SiteScope 
Availability 

(35)

“SiteScope Profile Rule” on page 626 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Last Update

SiteScope EMS 
Rule 

(36)

“SiteScope EMS Multiple Events Rule” on 
page 624

Example: For a detailed example of the 
tooltip, see “Example of a SiteScope EMS 
Rule Tooltip” on page 872

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ EMS Events

➤ Last Update

SiteScope 
Measurement 
Sentence 

(3)

“SiteScope Measurement Rule” on 
page 624

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Error Message

➤ Last Update

➤ Measurement

➤ Monitor

SiteScope 
Measurement 
Siebel Processes 
Rule 

(1104)

“SiteScope Measurement Siebel Processes 
Rule” on page 625

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

➤ Measurement

➤ Monitor

➤ Historical Worst

➤ Historical Average

➤ Trend

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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SiteScope 
Measurement 
Time-Based 
Sentence 

(33)

“SiteScope Measurement Time-Based 
Rule” on page 625

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Average For

➤ Last Update

➤ Measurement

➤ Monitor

SiteScope 
Measurement 
with Custom Data 
Rule 

(1100)

“SiteScope Measurement with Custom 
Data Rule” on page 625

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

➤ Measurement

➤ Monitor

➤ Historical Worst

➤ Historical Average

➤ Trend

SiteScope Monitor 
Sentence 

(4)

“SiteScope Monitor Rule” on page 626 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

➤ Monitor

➤ Host

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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SiteScope Monitor 
Time-Based 
Sentence 

(34)

“SiteScope Monitor Time-Based Rule” on 
page 626

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Average For

➤ Last Update

➤ Monitor

➤ Host

SiteScope Vertical 
Measurement 

(1108 and 1102)

“SiteScope Vertical Measurement” on 
page 627

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

➤ Measurement

➤ Historical Worst

➤ Historical Average

➤ Trend

➤ Monitor

SiteScope WS 
Operation 
Percentile 
Performance 
Sentence 

(1305)

“SiteScope WS Operation Percentile 
Performance Rule” on page 627

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Under threshold calls

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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SiteScope WS 
Operation 
Performance 
Sentence 

(1304)

“SiteScope WS Operation Performance 
Rule” on page 628

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Avg. Response Time

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

SLM PNR Rule 

(351)

“Dashboard PNR Rule” on page 601 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ SLA

➤ Tracking Period

➤ Time Interval

➤ Calculation Time

➤ PNR Time Left

➤ Max Unavailability

➤ PNR Availability

➤ Target Availability

Stopped Sentence The tooltip does not have associated rule.

Defines the tooltip used for stopped CIs.

➤ Node Name

➤ Status

➤ Held Status Since

➤ Location

➤ Caused By

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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Sum of Values for 
KPI Sentence 

(20)

“Sum of Values Rule” on page 629 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Total

➤ Major

➤ Minor

➤ Warning

➤ Informational

Sum of Volume

(74)

“Sum of Volume Rule” on page 629 ➤ Node Name

➤ Volume

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Major

➤ Minor

➤ Warning

➤ Informational

Summary of 
Values for KPIs

(30)

“Summary of Values” on page 629 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Total

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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Total Number of 
Open Incidents 
Sentence 

(2601)

“Transaction Availability Rule” on 
page 629

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Total number of incidents

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Transaction 
Availability 
Sentence 

(5)

“Transaction Availability Rule” on 
page 629

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Avg. Availability

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Transaction

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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Transaction 
Response 
Sentence 

(13)

“Transaction Performance Rule” on 
page 630

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Avg. Response Time

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Transaction

Transaction 
Response Status 
Average Sentence 

(101)

“Transaction Performance Rule” on 
page 630

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Last Update

➤ Critical samples

➤ Minor samples

➤ OK samples

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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Transaction 
Response Status 
Percentage 
Sentence 

(102)

“Transaction Performance Rule” on 
page 630

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Score

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

➤ Min Status

➤ Critical samples

➤ Minor samples

➤ OK samples

Transaction 
Response Worst 
Status Sentence 

(100)

“Transaction Performance Rule” on 
page 630

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Status for

➤ Last Update

➤ Critical samples

➤ Minor samples

➤ OK samples

Transactions 
Grouped Parent 
Rule 

(1109)

“Transactions Grouped Parent Rule” on 
page 632

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

Tooltip (Tooltip #) Associated Rule Tooltip Parameters



Chapter 23 • Tooltip Repository

862

Transactions 
Grouped Rule 

(1103)

“Transactions Grouped Rule” on 
page 633

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Message

➤ Last Update

TransactionVision 
Completed - Value 

(1415)

“TransactionVision Completed 
Transaction Value Rule” on page 640

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Transactions volume

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

TransactionVision 
Completed - 
Volume 

(1416)

“TransactionVision Transaction Volume 
Rule” on page 641

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Transactions volume

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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TransactionVision 
Completed Delays 
Rate 

(1411)

“TransactionVision Delayed Rate Rule 
(Completed Transactions)” on page 634

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Delays Rate

➤ Number of transactions

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

TransactionVision 
Completed Delays 
Value 

(1412)

“TransactionVision Delayed Value Rule 
(Completed Transactions)” on page 635

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Delays Value

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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TransactionVision 
Completed 
Straight Through 
Processing Rate 

(1414)

“TransactionVision Exceptions Rate Rule 
(Completed Transactions)” on page 636

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Exceptions Rate

➤ Number of transactions

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

TransactionVision 
Completed 
Straight Through 
Processing Value 

(1413)

“TransactionVision Exceptions Value 
Rule (Completed Transactions)” on 
page 637

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Exceptions Value

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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TransactionVision 
in process - 
Backlog 

(1426)

“TransactionVision Backlog Rule (In-
Process)” on page 634

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Backlog count

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

TransactionVision 
in process - Value 

(1425)

“TransactionVision Value Rule (In-Process 
Transaction)” on page 640

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Transactions volume

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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TransactionVision 
in process Delays 
Rate 

(1421)

“TransactionVision Delayed Rate Rule 
(In-Process Transactions)” on page 634

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Delays Rate

➤ Number of transactions

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

TransactionVision 
in process Delays 
Value 

(1422)

“TransactionVision Delayed Value Rule 
(In-Process Transactions)” on page 635

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Delays Value

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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TransactionVision 
in process Straight 
Through 
Processing Rate 

(1424)

“TransactionVision Exceptions Rate Rule 
(In-Process Transactions)” on page 637

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Exceptions Rate

➤ Number of transactions

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

TransactionVision 
in process Straight 
Through 
Processing Value 

(1423)

“TransactionVision Exceptions Value 
Rule (In-Process Transactions)” on 
page 638

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Exceptions Value

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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TransactionVision 
Transaction 
Duration 

(1410)

“TransactionVision Duration Rule 
(Completed Transactions)” on page 636

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Average Duration

➤ Number of Valid Transactions

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Trend The tooltip does not have an associated 
rule.

The tooltip is displayed for the Trend KPI. 
For details, see “Trend and History” on 
page 362.

➤ Node Name

➤ Trend

TV Transaction 
Monitor 
Completed 
Failures Rate 

(1418)

“TransactionVision Failures Rate Rule 
(Completed Transactions)” on page 638

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Failure rates

➤ Number of transactions

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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TV Transaction 
Monitor 
Completed 
Failures Value 

(1419)

“TransactionVision Failures Value Rule 
(Completed Transactions)” on page 639

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Value

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

TV Transaction 
Monitor in process 
Failures Rate 

(1428)

“TransactionVision Failures Rate Rule (In-
Process Transactions)” on page 639

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Delays Rate

➤ Number of transactions

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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TV Transaction 
Monitor in process 
Failures Value 

(1429)

“TransactionVision Failures Value Rule 
(In-Process Transactions)” on page 640

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Value

➤ Status for

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Worst Child 
Sentence 

(1)

“Worst Child Rule” on page 641 ➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Invisible Children

WS Operation 
Availability 
Sentence 

(1300)

“WS Operation Availability Rule” on 
page 641

➤ Node Name

➤ Status

➤ Calculation Rule

➤ Held Status Since

➤ Avg. Availability

➤ Average For

➤ Last Update

➤ Major

➤ Minor

➤ Warning

➤ Informational

Tooltip (Tooltip #) Associated Rule Tooltip Parameters
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Example of a Number of Open Incidents Sentence 
Tooltip
The tooltip is displayed for a KPI whose associated rule is “Number of Open 
Incidents” on page 611.

The tooltip displays the following information:

➤ CI Name. The name of the CI.

➤ Status. The status of the CI.

➤ Calculation Rule. The name of the rule used to calculate the status of the CI.

➤ Held Status Since. The date and time of the last status (color) change of the 
CI. 

➤ Number of tickets. The number of current ticket that have the specified 
initial and final state.

➤ Grouping. List the number of tickets with the specified status.

➤ OK. The threshold definition for the OK status.
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Example of a SiteScope EMS Rule Tooltip
The tooltip is displayed for an Application, Network, Security, or System KPI 
whose associated rule is “SiteScope EMS Multiple Events Rule” on page 624.

The SiteScope EMS Rule tooltip is displayed for an Application, Network, 
Security, or System KPI whose associated rule is the SiteScope EMS Multiple 
Event rule.

The tooltip displays the following information:

➤ CI Name. The name of the CI.

➤ Status. The severity of the event.

➤ Calculation Rules. The name of the rule that calculates the KPI status or 
value.

➤ Held status since. The date and time of the last status (color) change of the 
CI.

➤ Ems Events. Messages sent by the HP Operations Manager server.

List of Tooltip Parameters

The following table lists the tooltip parameters and their descriptions:

Parameter Description

% Available TX The percentage of available transactions.

Alert Description The full description of the alert.

At risk instances The number of instances with status At risk.

Availability The percentage of time the page was available, 
for a Real User Monitor CI.
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Average The average status of the CI.

Average Duration The duration of the completed transactions 
minus the duration of the failed transactions 
divided by the total number of transactions.

Average For The time period for which the average 
response time/average availability was 
calculated. This time period is defined in the 
file for the CI.

Average Time (Probe tooltips only): The average latency of 
all of the server requests on the Virtual 
Machine monitored by the Probe over the last 
five minute period.

Avg. Availability The percentage of successful runs for the 
parent transaction during a time period up to 
the last received update.

Avg. Response Time The average response time for the parent 
transaction during a time period up to the last 
received update.

Backlog count The number of backlogged (in-process) 
transactions.

Bandwidth The number of megabytes that represents the 
traffic in and out of Real User Monitor (for a 
monitor CI) or the status of the monitor with 
the worst status (for a group CI).

Blocked instances The number of instances with status Blocked.

Business Loss The financial loss calculated for the CI.

Calculation Logic The value of logic rule parameter. 

Calculation Rule The name of the rule that calculates the KPI 
status or value.

Parameter Description
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Calculation Time The last calculation time on the Business Logic 
Engine machine.

Calls per minute  The number of calls per minute to the selected 
Web service(s) or Operation(s).

Caused By The name of the KPIs that caused 
unavailability.

CI Name The name of the CI.

Component Availability The availability of the Real User Monitor (for a 
monitor CI) or the status of the monitor with 
the worst status (for a group CI).

Count The number of instances that completed the 
monitored step or group of steps in the most 
recent collection interval for the tooltip.

Critical instances The number of instances with status Critical.

Critical samples The number of samples with Critical status.

Delays Rate The percentage of failed in-process 
transactions out of the total completed 
transactions. Delays ValueThe total value of 
failed in-process transactions.

Delays Value The total value of failed in-process 
transactions. 

Description A description of the CI (the first one represents 
UDX and the second one represents EMS). 
Only the value relevant to the context is 
displayed.

Downtime Until The date and time that downtime is due to 
finish for a CI.

EMS Events The samples description. The samples are 
separated from each other by a horizontal line.

Parameter Description
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Error Message The error message that appears in the sample.

Exceptions Count The amount of exceptions generated over the 
last five minute period.

Exceptions Rate The percentage of transactions that did not 
follow the expected flow path on the target 
machine, out of the total in-process 
transactions.

Exceptions Value The total value of transactions that did not 
follow the expected flow path on the target 
machine.

Failed TX Count The number of transactions that failed.

Failed TX Impact The financial loss (in $) due to transactions 
that failed.

Failure rates The percentage of failed completed 
transactions out of the total number of 
completed transactions.

Formula The formula that is used to calculate the KPI 
status and value.

Grouping List the number of tickets with the specified 
status.

Healthy instances The number of instances with status Healthy.

Held Status Since The date and time of the last status (color) 
change of the CI. 

Historical Average The average status for the CI over a period of 
time.

Historical Worst The worst status for the CI over a period of 
time.

Parameter Description
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History Type The history calculation type to be used when 
calculating history status. Values can be: 
Worst, Average, or None (no history status 
displayed). The value of the parameter is 
assigned to the HistoryType rule global 
parameter. For details, see “Modify Rule 
Parameters or Global Rule Parameters” on 
page 570. If the value is none, the historical 
information is not displayed.

Host The name of the machine associated with the 
monitor.

Informational One of the thresholds used when defining 
status for the CI. The CI changes to 
Informational (green) status when the CI’s 
score is equal to or smaller than this value.

Informational instances The number of instances with status 
Informational.

Invisible Calculated 
Children

All of the child CIs belonging to other views, 
which are connected to this CI but do not 
belong to this view.

Invisible Children The number of child CIs of the selected CI, 
that exist in the CMDB, are hidden in the 
current view, and have at least one KPI 
assigned to them. This parameter is displayed 
as: Hidden child CIs (with attached KPIs) in 
the tooltip itself. For details on Invisible 
Children, see “Find Visible and Hidden Child 
CIs” on page 64.

Last Update The date and time that the last update for the 
CI was received by Dashboard.

Late TX Impact The financial loss (in $) due to transactions 
that were late.

Parameter Description



Chapter 23 • Tooltip Repository

877

Latency The average round trip time for a packet. (The 
time it takes for a packet to go from the client 
to the server and back from the server to the 
client). The latency information is provided by 
the Real User Monitor sample.

Location The location of the CI if a location has been 
specified.

Major One of the thresholds used when defining 
status for the CI. The CI changes to Major 
(orange) status when the CI’s score is equal to 
or smaller than this value.

Major instances The number of instances with status Major.

Major samples The number of samples with Major status.

Max Response Time The maximum response time as provided by 
the Deep Transaction Tracing sample.

Max Time The maximal time an HP Diagnostics 
transaction has run in seconds.

Max Unavailability The maximum time that the item may be 
unavailable, according to the SLA.

Maximum The maximum value of the instances that 
passed through the monitored step or group of 
steps, during the last collection interval. 

Measurement The name of the measurement from SiteScope.

Message The value(s) returned by the monitor the last 
time it ran, as displayed in SiteScope. This may 
simply be the retrieval time and file size or it 
may include specific parameters for a server 
component.

Min Response Time The minimum response time as provided by 
the Deep Transaction Tracing sample.

Parameter Description
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Min Status The value of the PassedStatus rule parameter. 

Minimum The minimum duration of the instances that 
passed through the monitored step or group of 
steps, during the last collection interval 

Minor One of the thresholds used when defining 
status for the CI. The CI changes to Minor 
(yellow) status when the CI’s score is equal to 
or smaller than this value.

Minor instances The number of instances with status Minor.

Minor samples The number of samples with Minor status.

Monitor The monitor type that the CI represents.

Network Availability The percentage of successful connections.

Node Name The name of the CI.

Number of instances The number of instances that completed the 
monitored step or group of steps.

Number of tickets The number of current ticket that have the 
specified initial and final state.

Number of transactions The total number of successful, completed 
transactions.

Number of Valid 
Transactions

The value calculated by the rule. For details, 
see “TransactionVision Duration Rule 
(Completed Transactions)” on page 636.

OK One of the thresholds used when defining 
status for the CI. The CI changes to OK (green) 
status when the CI’s score is equal to or smaller 
than this value.

OK Instances The number of instances with status OK.

OK samples The number of samples with OK status.

Parameter Description
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Open Time The date and time when the alert was issued.

owned By The owner of the CI in HP OpenView (the first 
one represents UDX and the second one 
represents EMS). Only the value relevant to 
the context is displayed.

Performance The average download time, for a Real User 
Monitor CI.

Platform Indicates the platform (J2EE or .NET) on which 
the monitored application is running.

PNR Availability The item’s SLA availability percentage the last 
time data was polled.

PNR Time Left The amount of time left for that measurement 
before the SLA is in breach of contract. 

Response Time 
Threshold

The threshold of the response time as provided 
by the Deep Transaction Tracing sample.

Score The percentage of green and yellow child CIs. 
This is a weighted percentage if any of the 
child CIs have a weight > 1 (check this by 
viewing the tooltips for the child CIs).

Note that Dashboard is calculating status using 
the refined percentage method if a percentage 
is displayed for Score and the group or 
subgroup status is yellow.

If Dashboard is calculating status for the 
group/subgroup using the dominant child 
method, the message n/a (Using dominant 
child) is displayed.

Server Requests Count (BPM Transaction tooltips only.) The amount 
of server requests over the last five minute 
period.

Parameter Description
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Server Time (BPM Transaction tooltips only.) The average 
time taken for the server to process the 
transaction.

Severity The severity of the SiteScope measurement 
(the first one represents UDX and the second 
one represents EMS). Only the value relevant 
to the context is displayed.

Short Name The name of the SAP CCMS measurement 
where the alert occurred.

SLA The name of the SLA attached to this CI.

State The SAP state of the alert: Active.

Status The status of the CI (calculated according to 
one of the status calculation methods). It may 
also display:

Not up to date for decayed CIs, indicating that 
the CI has passed its timeout period. (For a 
SiteScope CI, this status is displayed after a 
SiteScope monitor is disabled.)

Stopped when a Business Process profile is 
stopped.

Status Can be defined as OK, Warning or Critical.

Status for The value of the rule’s duration parameter.

Target Availability The percentage of time that the item must be 
available in order to match in the ‘Exceeded’ 
threshold, according to the SLA.

Time Interval The calendar used for calculating PNR. For 
details, see “Calendars” in Using Service Level 
Management.

Timeout Count The amount of timeouts that occurred during 
the last five minute period.

Parameter Description
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Total The total number of hits/transactions for Real 
User Monitor.

Total number of 
incidents

The total number of incidents.

Total TX Count The total of the number of transactions that 
failed and the number of late transactions.

Total TX Impact The financial loss (in $) due to transactions 
that failed added to the transactions that were 
late.

Tracking Period The tracking period used to calculate the PNR. 
For details, see “Tracking Periods Dialog Box” 
in Using Service Level Management.

Transaction The name of the parent transaction for the CI.

Transactions volume The number of completed transactions.

Trend The trend of the KPI’s status.

Under threshold calls The number of calls that are under the 
threshold defined for the Availability KPI.

Value The value of the field in the sample.

Value The sum of the values of the fields in the 
sample.

Volume The number of hits in Real User Monitor.

Warning One of the thresholds used when defining 
status for the CI. The CI changes to Warning 
(light green) status when the CI’s score is equal 
to or smaller than this value.

Warning instances The number of instances with status Warning.

Parameter Description
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List of Tooltip Parameter Attributes

The following table lists the attributes that may be specified for the tooltip 

Warning samples The number of samples with Warning status.

Weighted Average The value of the weighted average duration 
calculated by the rule.

Attribute Description

Available Formatting Methods Lists the available methods for formatting the 
value of the tooltip parameter. For example: 
toLowerCase. 

Display Label The name of the tooltip parameter displayed 
in the tooltip.

Formatting Method The method selected from the Available 
Formatting Methods list. For details on the 
methods, see “List of (KPI) Formatting 
Methods” on page 396.

Value Postfix The text that appears after the value of the 
tooltip parameter. For example: %.

Value Prefix The text that appears before the value of the 
tooltip parameter. For example: Greater than.

Value Source Indicates where to take the value of the item 
for the KPI.

Parameter Description
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Tooltips User Interface

This section describes:

 ➤  Tooltip Repository page on page 883

 ➤  Tooltip Details Dialog Box on page 885

 ➤  Tooltip Parameter Details Dialog Box on page 886

Tooltip Repository page

Description Displays the list of factory (predefined) and customized 
tooltips. Those tooltips are available throughout 
HP Business Availability Center.

Enables an advanced user to modify existing repository 
tooltips and create new ones. 

To Access: Admin > Dashboard > Repositories > 
Tooltips

Important 
Information

Cloning or overriding an existing tooltip, or creating a 
new tooltip, adds the corresponding tooltip entry to 
the Custom Tooltips list. You can then customize the 
tooltip to your organization’s specifications. For 
details, see “Tooltip Details Dialog Box” on page 885.

A list of the tooltips and their details is available in 
“List of Tooltips” on page 822.

To delete a customized tooltip, you must delete the 
corresponding rule.

A tooltip and its rule have the same ID number and the 
same name.

You can modify the tooltip information or enter new 
information. For details, see “Tooltip Details Dialog 
Box” on page 885. You can modify existing 
information or enter new information about the 
tooltip parameter. For details, see “Tooltip Parameter 
Details Dialog Box” on page 886.

Included in Tasks “Customize a Tooltip” on page 818
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The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

GUI Element (A-Z) Description

Select a tooltip in the Custom Tooltips area, and click 
the button to open the Tooltips Details dialog box. For 
details, see “Tooltip Details Dialog Box” on page 885.

Clone In the Factory Tooltips or in the Custom Tooltips areas, 
select a tooltip, and click the Clone button to create a 
new tooltip by cloning. You clone an existing tooltip to 
use it as a template. The original tooltip is still 
available. For details, see “Customize a Tooltip” on 
page 818.

Note: Change the name of the tooltip you have cloned 
to make sure you attach the cloned tooltip and not the 
original tooltip to a specific rule.

ID The ID number of the tooltip. 

Override In the Factory Tooltips or in the Custom Tooltips areas, 
select a context menu, and click the Override button to 
edit an existing tooltip. You override an existing tooltip 
to replace it with a customized tooltip. The original 
tooltip is disabled. The overriding tooltip and the 
original tooltip have the same tooltip ID. The tooltip in 
the Factory Tooltips area displays the following 
indication:

Note: If you later delete the custom tooltip that 
overrode the factory tooltip, the original factory tooltip 
is automatically restored.
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Tooltip Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to modify the information or enter new 
information. For a list of the tooltips parameters, see 
“List of Tooltip Parameter Attributes” on page 882.

To Access: In the Tooltip Repository page, click the 
New button, or click the relevant Edit button  for a 
cloned or overridden tooltip.

Important 
Information

The order of the parameters in the Parameters area 
reflects the order of the corresponding information in 
the application.

A list of the parameters and their details is available in 
“List of Tooltip Parameter Attributes” on page 882.

Included in Tasks “Customize a Tooltip” on page 818

GUI Element (A-Z) Description

Description The name of the tooltip.

Max Label Width The maximum width for a tooltip parameter name.

Max Value Width The maximum width for a tooltip parameter value.

New Click the New button to create a new parameter. For 
details, see “Tooltip Parameter Details Dialog Box” on 
page 886.

Parameters The parameters included in the tooltip. Different icons 
or buttons appear depending on the procedure you are 
following.
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Tooltip Parameter Details Dialog Box

The following elements are included (unlabeled GUI elements are shown in 
angle brackets):

Description Enables you to modify existing information or enter 
new information about the tooltip parameter. For a list 
of the tooltip parameter details, see “List of Tooltip 
Parameter Attributes” on page 882.

To Access: Click New in the Tooltip Details dialog box, 
or click the Edit button  relevant to the parameter 
you want to modify.

Important 
Information

A list of the parameters and their details is available in 
“List of Tooltip Parameter Attributes” on page 882.

Included in Tasks “Customize a Tooltip” on page 818

GUI Element (A-Z) Description

Available Formatting 
Method

Select the appropriate formatting method from the list 
of available methods. For details, see “List of (KPI) 
Formatting Methods” on page 549.

Display Label The display label of the row. It appears exactly as 
written in the section.

Formatting Method Displays the method you selected in Available 
Formatting Method list. This is the formatting method 
that is invoked on the valueSource. Can be blank if not 
required.

Value Postfix  The row value postfix. Can be blank if not required. 
The postfix appears after the value of the parameter in 
the tooltip. It can be retrieved from the CI using the 
escaping sequence form – if so, the [[%]] string must 
appear before the escaping sequence.
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Value Prefix  The row value prefix. Can be blank if not required. The 
prefix appears before the value of the parameter in the 
tooltip. It can be retrieved from the CI using the 
escaping sequence form - if so, the [[%]] string must 
appear before the escaping sequence.

Value Source  The source of the value to display. It can be retrieved 
from the CI using the escaping sequence form - if so, 
the [[%]] string must appear before the escaping 
sequence.

GUI Element (A-Z) Description
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user interface 107

acknowledge utility
 101
setting for CI 102

Acknowledgement Details, context menu 
item 725
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Acknowledgment Details

CI menu option 75
Acknowledgment History and Details dialog 

box 108
Acknowledgments Details

dialog box 109
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Add Group dialog box 450, 469
Add KPI to Multiple CIs dialog box 397
Add KPI, context menu item 726
Alerts tab 164
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tooltip 823
API Duration-Based Sample, rules 581
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examples 685
API Group and Sibling Rule Sentence tooltip 

823
API Group and Sibling, rules 581
API Sample rule 667

examples 693

API Sample Rule Sentence tooltip 823
API Sample, rules 582
applet

maps 199
Application Mapping, context menu item 

726
Application, KPI 512
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managing scenario 444
Assignment Groups page 451
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condition 454, 465
mechanism 420, 421
task 457, 467

Availability (Dashboard) KPI 513
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Average Availability of Weighted Volume, 

tooltip 823
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582
Average Latency of Weighted Volume, 
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Average Network of Weighted Volume, rule 

582
Average Network of Weighted Volume, 
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Average Performance of Weighted Volume in 

Seconds, tooltip 825
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Backlog, KPI 514, 515
Bandwidth, KPI 515
Best Child Rule 584
Best Child Sentence, tooltip 825
BMC Measurement Menu, context menu 701
BPI Average Weighted Status Rule for 

Duration KPI
rule 585

BPI Average Weighted Status Rule for Value 
KPI

rule 586
BPI Average Weighted Status Sentence 

tooltip 826
BPI BP Step Quantity Group Sentence tooltip 

826
BPI Business Health Status Rule 587
BPI Business Process Health Group Sentence 

tooltip 826
BPI Business Process Quantity Group 

Sentence tooltip 826
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Sentence tooltip 827
BPI Duration Monitor Rule 587
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BPI Group Rule for BP Step CI, rule 588
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Rule 589
BPI Health Average Weighted Status Value 

Rule 590
BPI Health Average Weighted Status Value 

Sentence tooltip 828
BPI Health Group Rule for BP CIs

rule 591
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BPI Health Status Percentage Count Sentence 

tooltip 828
BPI Health Status Percentage Value Rule 592
BPI Health Status Percentage Value Sentence 

tooltip 829
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Rule 592
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Sentence tooltip 829
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Rule 593

BPI Health Worst Process Instances Value 
Sentence tooltip 829

BPI Monitor Backlog Count Rule 593
BPI Monitor Backlog Count, tooltip 830
BPI Monitor Backlog Value Rule 594
BPI Monitor Backlog Value, tooltip 830
BPI Monitor Duration, tooltip 831
BPI Monitor Volume Count, tooltip 831
BPI Monitor Volume Value Rule 594, 595
BPI Monitor Volume Value, tooltip 832
BPI Monitors Over Time, context menu item 

726
BPI Operational Status Rule 595
BPI Operational Status tooltip 832
BPI Status Percentage Rule for Duration KPI 

596
BPI Status Percentage Rule for Value KPI 597
BPI Status Percentage Sentence tooltip 832
BPI Value Monitor Rule 598
BPI Value Monitor tooltip 833
BPI Worst Violated Instances Rule for 

Duration KPI, rule 598
BPI Worst Violated Instances Rule for Value 

KPI, rule 598
BPI Worst Violated Instances Sentence 

tooltip 833
BPM WS Operation Percentile Performance 

Rule 599
BPM WS Operation Percentile Performance 

Sentence
tooltip 834

BPM WS Operation Performance Rule 600
Business Health KPI 515
Business Impact

modify KPIs and rules 60
Business Impact KPI 516
Business Impact report 95

access 59
send as a URL 61, 62
view 58, 63

Business Impact tab 161
modifying CI types displayed 150

Business Impact tooltip 834
Business Logic Engine

changing default time interval 368
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Business Process Insight
Process Diagram tab 255

Business Process Insight Flow Map
licensing for 249
overview 245
Process Diagram page 255
task for viewing data 250

Business Process Insight Flow Map Menu, 
context menu 701

Business Process Insight Menu, context 
menu 702

Business Process Insight Process Step Menu, 
context menu 702

Business Process Insight Scorecard Menu, 
context menu 702

Business Process Monitor Group Menu, 
context menu 701, 703

Business Process Over Time, context menu 
item 727

Business Processes view 34
business rule

clone 568
set up 568

business rules
group rule type 560
monitor rule type 559
repository 556
working with KPIs 341

Business Rules API 661
Business Rules Repository 555
Business Rules Repository global parameters 

558
Business Rules Repository page 649
Business Transaction Flow Map

CI menu option 75
Business Transaction Group Rule 600

tooltip 835
Business Transactions view 38
business user mode 355

C

calculateKPI
API Duration-Based Sample rule 669
API Group and Sibling rule 664
API Sample rule 667

Calculation Granularity 654
calculation of group status 355
Change

CI menu option 80
Change report, context menu item 727
changes

monitor in Dashboard 111
Changes and Tickets tab 115, 165, 169
Chinese characters

Infrastructure settings 126
Top View 126

CI Impact Report, context menu item 728
CI levels

changing in Top View 128
CI menu option

Acknowledgment 75
Acknowledgment Details 75
Business Transaction Flow Map 75
Change 80
Completed 75
Configuration Item Status Alerts 81
Cross-Performance 84
Dashboard 42, 75
Diagnostics Web Service Topology 81
Drill to Diagnostics 76
End User Summary 81
Event Count Over Time 81
Event Summary 82
Event Summary (Error Monitor) 82
Expand more levels 77
Filter Subtree 79
Filter Subtree Monitors 79
Filters 79
Find Visible and Hidden Child CIs 64, 

79
Go to BPI 79
Go to Problem Isolation 89
Go to Report 80
Go to Siebel Diagnostics 87, 88, 89
HP Service Center 90
In-Process 75
Invoke Run Books 90
KPIs Over Time 82
Layers View 76
Operations Health 83
Problem Isolation 75
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Properties 90
SAP Transaction Changes 83
SAP Transport Changes 83
Server Requests 76
Server Summary 84
Session Analyzer 84
Set/Unset Acknowledgment 75
Show Business Impact 90
Show Complete Subtree 79
Show Events 90
Show Path to Root 92
Show Problematic Subtree 93
Show Processes 87
Show Related CIs 91
Show Running Tasks 88
Show Subtree Monitors 79
Show Tasks in Error 88
Siebel Database Breakdown 89
Siebel SARM 89
SiteScope 89
SiteScope Quick Report 85
SiteScope Server Centric Report 85
Summary View 77
Systinet Web Service Data 85
Top View 92
Transaction Analysis 85
Transactions View 77
Trend 86
Triage 86
Web Services Health 86

CI name
modify length

 69
CI Neighbors, context menu 703
CI Properties, context menu 703
CI status

selecting statuses displayed in map 
209

CI types
mapping in flow map 238

CIM Measurement Menu, context menu 703
CIs

acknowledge utility for performance 
problems 102
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Event Details window 57

history statuses 362
mapped to flow maps 239
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CIs 69
modify number of CIs monitored for 

real-time change 369
saving KPIs measurement data 580
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trend statuses 362
types 356
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KPI 510
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Complete Alert, context menu item 728
Completed
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Component Availability KPI 516
Config File Menu, context menu 703
Configuration Item Status Alerts

CI menu option 81
Configuration Item Status Alerts, context 

menu item 728
Configuration Items dialog box 270
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Google Earth 207
Console page 152

Alerts tab 164
Business Impact tab 161
Changes and Tickets tab 165, 169
Dashboard 143
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KPIs tab 159
modifying KPI over time 147
modifying refresh rates 148
modifying tabs displayed 147
overview 143

Console tab
customizing 147

Console, context menu item 729
context menu

BMC Measurement Menu 701
Business Process Insight Flow Map 

Menu 701
Business Process Insight Menu 702
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Business Process Insight Process Step 
Menu 702
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Menu 702

Business Process Monitor Group 
Menu 701, 703
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CI Properties 703
CIM Measurement Menu 703
Config File Menu 703
Dashboard Administration Menu 703
Default Menu 704
Diagnostics BPM Menu 704
Diagnostics Monitor Menu 704
Diagnostics Probe Group Menu 704
Diagnostics Probe Menu 705
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EMS Measurement Menu 705
EMS Show Events 705
Group Menu 705
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Context Menu Details dialog box 718
Context Menu Item
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Change report 727
CI Impact Report 728
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729
Custom Map 729
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Delete CI 730
Delete Folder 730
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Disable 731
Drill do Diagnostics 731
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731
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Event Log Report 737
Event Summary 738
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742
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Transactions Layers View 784
Transactions View 785
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user interface 806
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overview 722
working with 723
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user interface 716
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Dashboard 223
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D
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description 512
Dashboard PNR Rule 601
Dashboard repositories

context menus repository 697
Dashboard tabs

description 22
modify refresh rate 70

Dashboard widget
display 330



Index

896

data collection process
EMS 442
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grey icon 357

Group Menu, context menu 705
group rules 559, 560
GroupAndSiblingCalculator interface 664
GROUPBAR 546
groups

calculation of status 355
dominant child calculation for status 

565
KPI Assignment 448
KPI assignment 422
percentage threshold calculation for 

status 562
weighted percentage calculation for 

status 564

H

hidden child 64
hidden parameters

for business rules 653
Hierarchy tab 157

add Details link to CIs 149
customizing 148
display children section expanded 

149
displaying columns 149
drilling down 149
modifying the number of levels 149

history icon
calculating status 364

history status 365, 371
history statuses

changing the icons 362
for CIs 362

History, tooltip 841
HP Business Process Insight

topology 37
HP Dashboard Ticker 301

control 307
data 305
icons 302
installation 305
launching 305
Message Window 304
overview 301
preferences 308
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requirements 306
Ticker Window 303

HP Dashboard Ticker Window
Dashboard Ticker 303

HP Diagnostics
drilling down 268, 289

HP OpenView Service Navigator Rule 607
HP OpenView Service Navigator Sentence, 

tooltip 841
HP SC Menu, context menu 705
HP Service Center

CI menu option 90
HP Service Manager context menu item 746
HP System, KPIs 521
HP Worst Child Rule 607
HP Worst Child Sentence, tooltip 842

I

icon
green 357
grey 357
olive 357
orange 357
red 357
yellow 357

icons
changing color 394
changing icon set 70
changing image 394
customizing 394

impact
modeling 25

Impact Over Time Rule 608
indicator size

modifying 208
Infrastructure changes

detection 29
In-Process

CI menu option 75
invisible child 64
Invoke Run Books

CI menu option 90
Invoke Run Books, context menu item 746

J

Japanese characters
infrastructure settings 126
Top View 126

K

KPI 479
cloning 509, 510
configure 367
dependent 509
factory 479
numerical code of KPI status 357
overriding 509
set up 510
status name 357
Trend 509
type 509
value 509

KPI Assignment
groups 422
management 421

KPI assignment
groups 448
validation 436

KPI assignment rule
condition 454, 465
task 457, 467

KPI Calculation Script
API Duration-Based Sample rule 670
API Group and Sibling rule 666
API Sample rule 668

KPI Data Over Time, context menu item 747
KPI Details dialog box 539
KPI icons

Top View 140
KPI propagation 420, 421

mechanism 423
validation 436

KPI Repository 509
working with 509

KPI Status icons
changing 125

KPI versions
attach to CI 388
for user mode 386



Index

900

KPIs 511
Application 512
attaching new to CI 368, 374
Availability (Dashboard) 513
Backlog 514, 515
Bandwidth 515
Business Health 515
Business Impact 516
business rules functionality for 341
Component Availability 516
configuring 335
creating KPIs scenario 495
Customer 517
define and edit 367
Delays 517
Duration 518
editing properties for 375
Efficacy 518
Exceptions 519
Failures 520
formatting methods 549
Generic 520
how Dashboard KPIs work 338
HP System 521
Latency 521
list of default KPI parameters 551
Locations 522
Network 523
objectives for

objectives, for KPIs 343
Operational Status 524
OT Impact 524
parameters back to default 511
Performance (Dashboard) 525
PNR (Dashboard) 526
PNR for Dashboard 372
RT Impact 526
SAP 527
SAP Alerts 527
saving measurements data over time 

580
Security 527
selectors for 352
Sessions 528
Siebel 529
SiteScope Availability 529

status and objectives 343
System 530
Task in Error 531
Throughput 531
Transactions 532
User 533
user mode 368
Value 533, 534
Volume 535, 536

KPIs configuration
overview 336

KPIs dialog box 272
KPIs Distribution Over Time report 273

access 268
KPIs Over Time

CI menu option 82
view 267

KPIs Over Time context menu item 747
KPIs Over Time reports 277

accessing 267
collecting data 366
drill down to HP Diagnostics 268, 289
save KPI status information 267

KPIs Repository page 537
KPIs Summary report 291

access 268
KPIs tab 159, 409
KPIs Trend report 294

access 268

L

Last Sample
tooltip parameter 578

last sample time 819
Last Update

tooltip parameter 578
last update 819
Latency, KPIs 521
Layers View

CI menu option 76
drill down 268, 289

LeafCalculator interface 667, 669
limitations

Dashboard 99
Load View, context menu item 748
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Locate CI in SLA, context menu 706
Locate CI in SLA, context menu item 748
Locate CI in View, context menu item 749
Locate CI, context menu 705
location status

importing into Google Earth 205
information 197

location tooltip
maximum number of CIs displayed 

211
Locations Grouped Parent Rule, tooltip 842
Locations Grouped Parent, rule 609
Locations Grouped Rule, tooltip 842
Locations Grouped, rule 610
Locations, KPI 522
log files

for user sessions 72
logs

Dashboard Administration 71

M

map
indicator size 208
location tooltip 211
statuses to be displayed in 209
time delay 209

map applet 199, 201
customize 210
refresh rate 210

maps
for Dashboard 196
Virtual Earth 208, 210

menu entity
specifying details 700

Menu Entity Details dialog box 719
Message Window 310

HP Dashboard Ticker 304
Message Window page 310
mobile console

view Dashboard 317
Mobile Device

display 320
mobile device

view data on 318
modifying 365, 371

monitor changes
overview in Dashboard 111

monitor rules 559
Monitor Volume Sum Rule 629
monitoring service views 438
multiple views

searching for CIs in Filters tab 176
Must

influence on status 360, 361

N

Network, KPI 523
New Folder, context menu item 749
No data timeout

Transaction CIs 342
No Data Timeout value

change 369
No Update Sentence, tooltip 842
Node Details dialog box 94
Number of Open Incidents Sentence, tooltip 

843
Number of Open Incidents, rule 611
Number of Running Sessions Rule, tooltip 

843
Number of Running Sessions, rule 611
Number of Tasks in Error Rule, tooltip 843
Number of Tasks in Error, rule 611
numerical code 357

O

objectives
blank 348
defining 346
example of defining 349, 351
repeated 348
units of measurement 350, 544

olive icon 357
Open in New Window context menu item 

749
Operational Status KPI 524
Operations Health

CI menu option 83
Operations Health context menu item 750
operations user mode 355
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orange icon 357
OT Impact, KPI 524
override

context menu 700
rules 556

OVO Drill Down context menu item 751
OVO Drill Down Event, context menu 706

P

Page Layers View, context menu item 753
Page Summary context menu item 752
Parameter Details dialog box

KPIs 552
rules 656

Percent Sentence, tooltip 844
Percentage Rule 611
percentage, rule 562, 565

weighted percentage status 
calculation method 564

performance
monitoring 25

Performance (Dashboard), KPI 525
performance problems

monitoring 24
permissions

Source Manager 447
PNR (Dashboard), KPI 526
PNR KPI 372
PNR_BAR 542, 547
Post-Processor Parameter Details dialog box 

814
predefined filters 184
pre-processor classes 789
Pre-Processor Parameter Details dialog box 

813
Probe Group Summary context menu item 

754
Probe Summary context menu item 755
Problem Isolation

CI menu option 75
problem management

task to isolate a problem 306
Process Diagram tab

Flow Map 255
processor, context menu item 724

Properties
CI menu option 90

Properties, context menu item 755
Provider, context menu item 756

Q

Quick Filter 178

R

Real Time Impact, rule 612
real-time changes

analyze information 112
real-time status 360
red icon 357
refresh rate

Google Earth 206
map applet 210
modify Dashboard tabs 70

Rename Folder, context menu item 756
reports

Business Impact 58, 63
Dashboard 265

repositories
context menu 701
customization process 478
customizing 477
overview 476

Repository
Business Rules 555
Business Rules API 661

repository
context menu 697
context menu item 721

roles of selector 352
RT Impact, KPI 526
rule 481, 570, 596, 597, 598

factory 481, 570
Rule Details dialog box 657
rules 571, 700, 724, 822

API Duration-Based Sample 581
API Group and Sibling 581
API Sample 582
Average Availability of Weighted 

Volume 582
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Average Latency of Weighted Volume 
582

Average Network of Weighted 
Volume 582

Average of Converted Performance 
Results in % 583

Average Performance of Weighted 
Volume in Percentages 583

Best Child Rule 584
BPI Average Weighted Status Rule for 

Duration KPI 585
BPI Average Weighted Status Rule for 

Value KPI 586
BPI Business Health Status 587
BPI Duration Monitor Rule 587
BPI Group Rule for BP CI 588
BPI Group Rule for BP Step CI 588
BPI Health Average Weighted Status 

Count Rule 589
BPI Health Average Weighted Status 

Value Rule 590
BPI Health Group Rule for BP CIs 591
BPI Health Status Percentage Count 

Rule 591
BPI Health Status Percentage Value 

Rule 592
BPI Health Worst Process Instances 

Count Rule 592
BPI Health Worst Process Instances 

Value Rule 593
BPI Monitor Backlog Count Rule 593
BPI Monitor Backlog Value Rule 594
BPI Monitor Volume Value Rule 594, 

595
BPI Operational Status 595
BPI Status Percentage Rule for 

Duration KPI 596
BPI Status Percentage Rule for Value 

KPI 597
BPI Value Monitor Rule 598
BPI Worst Violated Instances Rule for 

Duration KPI 598
BPI Worst Violated Instances Rule for 

Value KPI 598
BPM WS Operation Percentile 

Performance Rule 599

BPM WS Operation Performance Rule 
600

Business Transaction Group Rule 600
cloning 556
Customer Rule 600
Dashboard PNR Rule 601
Diagnostics for J2EE/.Net General 602
Diagnostics WS Operation Percentile 

Performance 602
Diagnostics WS Operation 

Performance 603
Diagnostics WS Operation 

Throughput 603
editing global parameters 570
EMS Simple Rule 604
Generic Sample Rule 605
Generic Sum of Values Over Time 605
Generic Two Arguments 606
global attributes list 652
global parameters 570
HP OpenView Service Navigator Rule 

607
HP Worst Child Rule 607
Impact Over Time Rule 608
Locations Grouped 610
Locations Grouped Parent 609
modify parameters 570
Monitor Volume Sum Rule 629
Number of Open Incidents 611
Number of Running Sessions 611
Number of Tasks in Error 611
overriding 556
parameters back to default 571, 700, 

724, 822
Percentage Rule 611
Real Time Impact 612
RUM Application Session Statistics 

Monitor Availability 613
RUM Application Session Statistics 

Monitor Performance 613, 614
RUM End User Monitor Availability 

614
RUM End User Monitor Latency 615
RUM End User Monitor Network 615
RUM End User Monitor Performance 

616
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RUM End User Monitor Volume 616
RUM End User Session Statistics 

Monitor Availability 617
RUM End User Session Statistics 

Monitor Performance 617
RUM End User Session Statistics 

Monitor Volume 618
RUM Event Monitor Volume 618
RUM Location Session Statistics 

Monitor Availability 618
RUM Location Session Statistics 

Monitor Performance 619
RUM Location Session Statistics 

Monitor Volume 619
RUM Page Monitor Availability 619
RUM Page Monitor Performance Rule 

620
RUM Page Monitor Volume Rule 620
RUM Server Monitor Bandwidth 620
RUM Server Monitor Component 

Availability 620
RUM Server Monitor Network 621
RUM Servers Summarized Bandwidth 

621
RUM Session Monitor Availability 621
RUM Session Monitor Performance 

621
RUM Session Monitor Volume 622
RUM Transaction Monitor 

Availability Rule 622
RUM Transaction Monitor 

Performance Rule 622
RUM Transaction Monitor Volume 

Rule 622
SAP Alerts 623
Service Level Management Tracking 

Period Alert 623
Sessions Custom Data Rule 623
Sitescope Measurement Rule 624
Sitescope Measurement Siebel 

Processes Rule 625
Sitescope Measurement Time Based 

Rule 625
Sitescope Measurement with Custom 

Data Rule 625
Sitescope Monitor Rule 626

Sitescope Monitor Time Based Rule 
626

SiteScope Profile 626
SiteScope Vertical 627
SiteScope Vertical Measurement 627
SiteScope Web Service Orchestration 

Percentile Performance Rule 627
SiteScope WS Operation Performance 

Rule 628
Sum of Open Incidents Rule 628
Sum of Values Rule 629
Summary of Values 629
Transaction Availability Rule 629
Transaction Performance Rule 630
Transaction Performance Status 

Average Rule 630
Transaction Performance Status 

Percentage Rule 631
Transaction Performance Worst Status 

Rule 631
Transactions Grouped 633
Transactions Grouped Parent 632
TransactionVision Delayed Rate Rule 

(Completed Transactions) 634
TransactionVision Delayed Rate Rule 

(In-Process Transactions) 634
TransactionVision Delayed Value Rule 

(Completed Transactions) 635
TransactionVision Delayed Value Rule 

(In-Process Transactions) 635
TransactionVision Duration Rule 

(Completed Transactions) 636
TransactionVision Exceptions In 

Process Transaction Value Rule (In-
Process Transactions) 638

TransactionVision Exceptions Rate 
Rule (Completed Transactions) 636

TransactionVision Exceptions Rate 
Rule (In-Process Transactions) 637

TransactionVision Exceptions Value 
Rule (Completed Transactions) 637

TransactionVision Failures Rate Rule 
(Completed Transactions) 638

TransactionVision Failures Rate Rule 
(In-Process Transactions) 639
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TransactionVision Failures Value Rule 
(Completed Transactions) 639

TransactionVision Failures Value Rule 
(In-Process Transactions) 640

TransactionVision in process - 
Backlog 634

TransactionVision in process - Value 
640

TV Transaction Value Rule 640
TV Transaction Volume Rule 641
Worst Child Rule 641
WS Operation Availability Rule 641

Rules API 661
creating rules 671
Group and Sibling rule examples 685
KPIs tab workflow 672
log files 683
overview 662
repository workflow 680
Sample rule examples 693
text file workflow 674
tooltips 682

rules repository
working with 556

RUM Application Error Monitor Menu, 
context menu 706

RUM Application Menu, context menu 707
RUM Application Session Statistics Monitor 

Availability, rule 613
RUM Application Session Statistics Monitor 

Availability, tooltip 844
RUM Application Session Statistics Monitor 

Performance, rule 613, 614
RUM Application Session Statistics Monitor 

Performance, tooltip 844
RUM Application Session Statistics Monitor 

Volume, tooltip 845
RUM Component Availability, tooltip 845
RUM End User Group Container Menu, 

context menu 707
RUM End User Group Menu, context menu 

707
RUM End User Latency, tooltip 845
RUM End User Monitor Availability, rule 614
RUM End User Monitor Availability, tooltip 

846

RUM End User Monitor Latency, rule 615
RUM End User Monitor Network, rule 615
RUM End User Monitor Performance, rule 

616
RUM End User Monitor Performance, tooltip 

846
RUM End User Monitor Volume, rule 616
RUM End User Monitor Volume, tooltip 846
RUM End User Session Statistics Monitor 

Availability, rule 617
RUM End User Session Statistics Monitor 

Availability, tooltip 847
RUM End User Session Statistics Monitor 

Performance, rule 617
RUM End User Session Statistics Monitor 

Performance, tooltip 847
RUM End User Session Statistics Monitor 

Volume, rule 618
RUM End User Session Statistics Monitor 

Volume, tooltip 847
RUM End User’s Menu, context menu 708
RUM Errors Menu, context menu 708
RUM Event Monitor Volume, rule 618
RUM Event Monitor Volume, tooltip 848
RUM Group Menu, context menu 708
RUM HTTP Error Monitor Menu, context 

menu 709
RUM Informational Event Monitor Menu, 

context menu 709
RUM Informational Events Menu, context 

menu 709
RUM Location Session Statistics Monitor 

Availability, rule 618
RUM Location Session Statistics Monitor 

Availability, tooltip 848
RUM Location Session Statistics Monitor 

Performance, rule 619
RUM Location Session Statistics Monitor 

Performance, tooltip 848
RUM Location Session Statistics Monitor 

Volume, rule 619
RUM Location Session Statistics Monitor 

Volume, tooltip 849
RUM Page Monitor Availability, rule 619
RUM Page Monitor Availability, tooltip 849
RUM Page Monitor Menu, context menu 710
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RUM Page Monitor Performance Rule 620
RUM Page Monitor Performance, tooltip 849
RUM Page Monitor Volume Rule 620
RUM Page Monitor Volume, tooltip 850
RUM Server Menu, context menu 710
RUM Server Monitor Bandwidth, rule 620
RUM Server Monitor Component 

Availability, rule 620
RUM Server Monitor Network, rule 621
RUM Servers Menu, context menu 710
RUM Servers Summarized Bandwidth, rule 

621
RUM Session Monitor Availability, rule 621
RUM Session Monitor Availability, tooltip 

850
RUM Session Monitor Menu, context menu 

710
RUM Session Monitor Performance, rule 621
RUM Session Monitor Performance, tooltip 

850
RUM Session Monitor Volume, rule 622
RUM Session Monitor Volume, tooltip 851
RUM Transaction Monitor Availability Rule 

622
RUM Transaction Monitor Availability, 

tooltip 851
RUM Transaction Monitor Menu, context 

menu 711
RUM Transaction Monitor Performance Rule 

622
RUM Transaction Monitor Performance, 

tooltip 851
RUM Transaction Monitor Volume Rule 622
RUM Transaction Monitor Volume, tooltip 

852

S

sample time 819
sample-based calculations 561
sample-based sampling 561
samples

saving details for Dashboard CIs 578
viewing details for Dashboard CIs 57

SAP Alert Acknowledgment
context menu 711

SAP Alert Status Sentence, tooltip 852
SAP Alerts, KPI 527
SAP Alerts, rule 623
SAP Menu

context menu 711
SAP System Menu

context menu 712
SAP Transaction Changes

CI menu option 83
SAP Transaction Changes Report, context 

menu item 757
SAP Transaction Menu

context menu 712
SAP Transport Changes

CI menu option 83
SAP Transport Changes, context menu item 

758
SAP Transport Menu

context menu 712
SAP, KPI 527
SAR Compliancy Report, context menu item 

759
scores, for calculating status 360
search

CIs in Filters tab 174
Security, KPI 527
selectors

defining 380
for KPI 352
role 352

Server Bandwidth, tooltip 852
Server Network Performance, tooltip 853
Server Requests

CI menu option 76
Server Requests, context menu item 760
Server Summarized Bandwidth, tooltip 853
Server Summary

CI menu option 84
Server Summary context menu item 761
Service Level Management Tracking Period 

Alert, rule 623
Service Menu

context menu 712
Service Mng Menu

context menu 713
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Service Report
Dashboard application components 

42
service-level agreements

monitoring 25
Session Analyzer

CI menu option 84
Session Analyzer context menu item 762
Sessions Custom Data Rule 623
Sessions Custom Data Rule, tooltip 853
Sessions, KPI 528
Set/Unset Acknowledgement, context menu 

item 762
Set/Unset Acknowledgment

CI menu option 75
setting back to default 511, 571, 700, 724, 

822
Show Business Impact

CI menu option 90
Show Business Impact, context menu item 

763
Show Business Process Over Time, context 

menu item 763
Show Business Process Step Summary, 

context menu item 764
Show Complete Subtree

CI menu option 79
Show Complete Subtree, context menu item 

764
Show Events

CI menu option 90
Show Events, Context Menu Item 765
Show Impacting SAP Transports

context menu item 91, 766
Show Path to Root

CI menu option 92
Show Path to Root, context menu item 767
Show Problematic Subtree

CI menu option 93
Show Problematic Subtree, context menu 

item 767
Show Processes

CI menu option 87
Show Processes, context menu item 768
Show Related CIs

CI menu option 91

Show Related CIs, context menu item 768
Show Running Tasks

CI menu option 88
Show Running Tasks, context menu item 

768
Show SAP Transport Impact, context menu 

item 91, 769
Show Subtree Monitors

CI menu option 79
Show Subtree Monitors, context menu item 

769
Show Tasks in Error

CI menu option 88
Show Tasks in Error, context menu item 770
Show Top View, context menu item 770
Siebel Cross-Performance context menu item 

771
Siebel Database Breakdown

CI menu option 89
Siebel Database Breakdown context menu 

item 772
Siebel Database Breakdown Diagnostics 

Menu
context menu 713

Siebel Diagnostics Menu
context menu 713

Siebel Menu
context menu 713

Siebel SARM
CI menu option 89

Siebel SARM and DBBD Diagnostics Menu
context menu 713

Siebel SARM context menu item 773
Siebel, KPI 529
SiteScope

CI menu option 89
hierarchies 439
monitor set to report to HP Business 

Availability Center 447
work with source adapter 446

SiteScope Availability
tooltip 854

SiteScope Availability, KPI 529
SiteScope Cross-Performance context menu 

item 774
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SiteScope Group Menu
context menu 714

SiteScope host discovery 448
Sitescope Measurement Menu

context menu 714
Sitescope Measurement Rule 624
SiteScope Measurement Sentence, tooltip 

854
Sitescope Measurement Siebel Process Rule 

625
SiteScope Measurement Siebel Processes 

Rule, tooltip 854
Sitescope Measurement Time Based Rule 625
SiteScope Measurement Time-Based 

Sentence, tooltip 855
Sitescope Measurement with Custom Data 

Rule 625
SiteScope Measurement with Custom Data 

Rule, tooltip 855
Sitescope Monitor Menu

context menu 714
Sitescope Monitor Rule 626
SiteScope Monitor Sentence, tooltip 855
Sitescope Monitor Time Based Rule 626
SiteScope Monitor Time-Based Sentence, 

tooltip 856
SiteScope Monitoring CIs 344
SiteScope Profile, rule 626
SiteScope Quick Report

CI menu option 85
SiteScope Quick Report context menu item 

775
SiteScope Server Centric Report

CI menu option 85
SiteScope Server Centric Report context 

menu item 776
SiteScope Vertical Measurement, rule 627
Sitescope Vertical Measurement, tooltip 856
SiteScope Vertical, rule 627
SiteScope Web Service Monitor Menu

context menu 713
SiteScope Web Service Orchestration 

Percentile Performance Rule rule 627
SiteScope WS Operation Percentile 

Performance Sentence, tooltip 856

SiteScope WS Operation Performance Rule 
rule 628

SiteScope WS Operation Performance 
Sentence, tooltip 857

SiteScope, context menu item 744
SLAs

monitoring 24
SLAs Summary Report, context menu item 

776
SLM PNR Rule, tooltip 857
Source Manager

overview 437
permissions 447

Stage 2
Add the Menu Item to a Context 

Menu 500
status

calculating for history icon 364
calculating for trend icon 365
calculations 360
calculations for KPIs 357
calculations for monitor CIs 355
for geographical locations 196

status calculations
dominant child 565
percentage threshold 562
weighted percentage 564

status icons
changing the status icons 357

status indicators
Google Earth 206

status name
KPI 357

status of KPI 357
Statuses dialog box 298
Stopped Sentence, tooltip 857
Sum of Open Incidents Rule 628
Sum of Values for KPI Sentence, tooltip 858
Sum of Values Rule 629
Sum of Volume, tooltip 858
Summary of Values for KPIs, tooltip 858
Summary of Values, rule 629
Summary View

CI menu option 77
drill down 268, 289

Sun JRE plug-in 200
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System Hardware Monitoring view 33
System Software Monitoring 33
System Software Monitoring view 33
system usage, monitoring 72
System, KPI 530
Systinet Web Service Data

CI menu option 85
Systinet Web Service Data, context menu 

item 776

T

table
setting Hierarchy tab 149

task
isolate a problem 306

Task in Error, KPI 531
task to isolate a problem

problem management 306
TCP Application Summary, context menu 

item 777
third-party data

process flowchart 442
threshold status calculation method 562
Throughput, KPI 531
Ticker 301

overview 301
set preferences 306
view Dashboard information 307

Ticker Preferences dialog box 312
Ticker Window page 309
time delay

for maps 209
Time Interval

changing for Business Logic Engine 
368

time zones
settings 43

time-based calculations 561
time-based sampling 561
timestamp 43
tooltip 818, 828

BPM WS Operation Percentile 
Performance Sentence 834

Business Transaction Group Rule 835
factory 818

No Update Sentence 842
SiteScope Availability 854

tooltip details 819, 885
Tooltip Details dialog box 885
tooltip parameter

Availability 872
Status 823, 824, 839, 853, 880

Tooltip Parameter Details 882
tooltip parameter details 822
Tooltip Parameter Details dialog box 886
tooltip repository 815
tooltip, cloning 885
Tooltips

user interface 883
tooltips

API Duration-Based Sample Rule 
Sentence 823

API Group and Sibling Rule Sentence 
823

API Sample Rule Sentence 823
Average Availability of Weighted 

Volume 823
Average Latency of Weighted Volume 

824
Average Network of Weighted 

Volume 824
Average of Values for KPIs 825
Average Performance of Weighted 

Volume in % 825
Average Performance of Weighted 

Volume in Seconds 825
Best Child Sentence 825
BPI Average Weighted Status Sentence 

826
BPI BP Step Quantity Group Sentence 

826
BPI Business Process Health Group 

Sentence 826
BPI Business Process Quantity Group 

Sentence 826
BPI Duration Average Weighted Status 

Sentence 827
BPI Health Average Weighted Status 

Count Sentence 828
BPI Health Average Weighted Status 

Value Sentence 828
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BPI Health Status Percentage Count 
Sentence 828

BPI Health Status Percentage Value 
Sentence 829

BPI Health Worst Process Instances 
Count Sentence 829

BPI Health Worst Process Instances 
Value Sentence 829

BPI Monitor Backlog Count 830
BPI Monitor Backlog Value 830
BPI Monitor Duration 831
BPI Monitor Volume Count 831
BPI Monitor Volume Value 832
BPI Operational Status 832
BPI Status Percentage Sentence 832
BPI Value Monitor 833
BPI Worst Violated Instances 

Sentence 833
Business Impact 834
Customer Sentence 835
customizing border and header 70
Dashboard repository 815
detailed description 822
details 819
Diagnostics for J2EE General Sentence 

836
Diagnostics WS Operation Percentile 

Performance Sentence 837
Diagnostics WS Operation 

Throughput Sentence 838
Dollar Impact Over Time Sentence 

838
Dollar Impact Sentence 838
Downtime Sentence 839
EMS Sentence 839
End User Network Performance 839
example scenario 483
Generic Formula Over Time Rule 840
Generic Sample Rule 840
Generic Sum of Values Over Time 

Rule 840
Generic Two Arguments Rule 841
Geo Map Sentence 841
History 841
HP OpenView Service Navigator 

Sentence 841

HP Worst Child Sentence 842
Locations Grouped Parent Rule 842
Locations Grouped Rule 842
Number of Open Incidents Sentence 

843
Number of Running Sessions Rule 843
Number of Tasks in Error Rule 843
overriding existing 816
parameter details 822
Percent Sentence 844
RUM Application Session Statistics 

Monitor Availability 844
RUM Application Session Statistics 

Monitor Performance 844
RUM Application Session Statistics 

Monitor Volume 845
RUM Component Availability 845
RUM End User Latency 845
RUM End User Monitor Availability 

846
RUM End User Monitor Performance 

846
RUM End User Monitor Volume 846
RUM End User Session Statistics 

Monitor Availability 847
RUM End User Session Statistics 

Monitor Performance 847
RUM End User Session Statistics 

Monitor Volume 847
RUM Event Monitor Volume 848
RUM Location Session Statistics 

Monitor Availability 848
RUM Location Session Statistics 

Monitor Performance 848
RUM Location Session Statistics 

Monitor Volume 849
RUM Page Monitor Availability 849
RUM Page Monitor Performance 849
RUM Page Monitor Volume 850
RUM Session Monitor Availability 850
RUM Session Monitor Performance 

850
RUM Session Monitor Volume 851
RUM Transaction Monitor 

Availability 851
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RUM Transaction Monitor 
Performance 851

RUM Transaction Monitor Volume 
852

SAP Alert Status Sentence 852
Server Bandwidth 852
Server Network Performance 853
Server Summarized Bandwidth 853
Sessions Custom Data Rule 853
set up 818
SiteScope Measurement Sentence 854
SiteScope Measurement Siebel 

Processes Rule 854
SiteScope Measurement Time-Based 

Sentence 855
SiteScope Measurement with Custom 

Data Rule 855
SiteScope Monitor Sentence 855
SiteScope Monitor Time-Based 

Sentence 856
Sitescope Vertical Measurement 856
SiteScope WS Operation Percentile 

Performance Sentence 856
SiteScope WS Operation Performance 

Sentence 857
SLM PNR Rule 857
Stopped Sentence 857
Sum of Values for KPI Sentence 858
Sum of Volume 858
Summary of Values for KPIs 858
Total Number of Open Incidents 

Sentence 859
Transaction Availability Sentence 859
Transaction Response Sentence 860
Transaction Response Status Average 

Sentence 860
Transaction Response Status 

Percentage Sentence 861
Transaction Response Worst Status 

Sentence 861
Transactions Grouped Parent Rule 

861
Transactions Grouped Rule 862
TransactionVision - Value 862
TransactionVision - Volume 862
TransactionVision Delays Rate 863

TransactionVision Delays Value 863
TransactionVision in process - 

Backlog 865
TransactionVision in process - Value 

865
TransactionVision in process Delays 

Rate 866
TransactionVision in process Delays 

Value 866
TransactionVision in process Straight 

Through Processing Rate 867
TransactionVision in process Straight 

Through Processing Value 867
TransactionVision Monitor Duration 

868
TransactionVision Straight Through 

Processing Rate 864
TransactionVision Straight Through 

Processing Value 864
Trend 868
TV Transaction Monitor Completed 

Failures Rate 868
TV Transaction Monitor Completed 

Failures Value 869
TV Transaction Monitor in process 

Failures Rate 869
TV Transaction Monitor in process 

Failures Value 870
working with the repository 818
Worst Child Sentence 868, 870
WS Operation Availability Sentence 

870
Tooltips Repository 815

working with 883
tooltips repository

overview 816
Tooltips Repository page 883
Top View

access external application 132
change color of CI bar with OK status 

129
change fonts 126, 127
change number of displayed CI levels 

128
change number of expanded CI levels 

128
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change text color 126
Chinese and Japanese characters 126
CI menu option 92
customize background image 130
display and customize view 121
display weight in tooltip 131
hide view bar when single root CI 129
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